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Introduction 
This technical guide outlines procedures for CAT’s Content Analysis Program area. It 

entation tool for employees new to content analysis 
d analysts. Most of the processes and procedures 

outlined in this guide were developed over years of experience and in response to a 
 of requests and problems encountered. It is highly recommended that field 
d contractors not diverge from these processes and procedures without 

e the final 
cts may vary for 

r a standard 
 change or be 

d in two sections, which roughly correspond to the main 
nction and the 

processing, log 
 protocols, and 
ng, identifying 

iting narratives, editing, creating appendices, and using MS Word. 

 the Oracle database 
e for their database, 

tractors using 
hat the final 

serves as both a teaching and ori
and as a reference for experience

variety
units an
discussions with CAT specialists. 

Projects vary, as do the needs of the staffs and teams who will prepar
policies, rules, plans, or EISs. Therefore some processes and produ
different projects. This guide provides the methods and procedures fo
content analysis project with the understanding that any aspect may
revised on a project specific basis. 

 The guide is divide
functional elements of content analysis: the office automation fu
content analysis function. Office Automation Processes covers letter 
maintenance, mail identification, postal standards, comment entry,
validation. Content Analysis Processes comprises chapters on codi
public concerns, wr

A significant part of this volume is dedicated to instruction in
software. Not all units or contractors CAT works with use Oracl
however the information is valuable even for those field units and con
other programs to better understand CAT processes, and to insure t
products are comparable and meet the quality standards required.  
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Section 1.1 ~ Processing Incoming Mail 
The following procedure for receiving and processing mail is based on doing content analysis 
manually on hard copies of letters. Coding done on electronic copies would follow a slightly 
different process, but with the objective of creating the same results and products. First, all 
mail is collected and processed in a systematic manner that will allow for accurate tracking 
and the ability to report, on any given day, how much mail has been received and from 
whom. Following is the outline of responsibilities for the mail processor. 
• Pick up the regular mail at scheduled time. Pick up or receive FedEx, UPS, and express 

mail per their schedules. 
• Regularly check the project e-mail inbox and the fax machine for incoming mail. 
• Sort the mail by project and put any non-project mail in the appropriate mailbox or return 

to the post office if it was mis-delivered. 
• Remove the letter from the envelope, making sure to keep the letter and envelope 

together. 
• Split all clearinghouse letters (multiple submissions from one main address) into 

individual letters.  
• Date stamp all letters using a date received stamp. 
• Sort the mail by individual letters, form letters, and early attention letters.  
• Sort letters by single-sided and double-sided for accurate copying. 
• Number all of the letters to be entered into the mailing list data base. Those who submit 

form letters may or may not be entered into the date base depending on the project. If 
they are to be entered, form letters will be numbered as well. Place the number label in 
the upper right-hand corner, staying away from the edges, and handwrite the letter 
number on all subsequent pages of the letter, including the cover sheet and any 
enclosures. 

• Once the mail is date stamped, sorted, and numbered, it is ready for copying and/or 
scanning. 

1.1.1 ~ Helpful Hints 
• Watch for letters or forms that do not pertain to the project. These will not be numbered 

but may be put in a folder in the project file labeled “out-of-scope.” If the letter is for a 
different project, forward it to that project.  

• Watch for more than one letter in an envelope. Each individual letter needs its own letter 
number. 

• Watch for duplicate letters. The sooner multiple copies of the same letter are caught, the 
less chance there is of needlessly processing a duplicate letter. 

• Watch for attachments. Attachments should be processed with the letter they arrived 
with.  
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Section 1.2 ~ Copying Letters/Postcards 
If coding on hard copies and your copying machine can scan and copy at the same time, 
make a scanned copy and a hard copy of each letter. If your copy machine does not scan and 
copy, you may need to make two copies of each letter: a clean copy for the reading file and 
for scanning, and a working copy. If scanning hardcopies for OCR and online coding, copies 
may have to be made of all odd-sized, wrinkled or torn, or two-sided letters prior to scanning. 
Following are the key points for making copies. 
• Identify and copy Immediate Attention letters first for early processing. Any threats of 

harm or litigation should be brought to the attention of the team leader or project 
manager. Team leaders will notify law enforcement of any threats. 

• Keep the numbered letters and postcards together in their respective groups. Copy them 
in ascending numeric order. 

• Clean copies for scanning are single-sided. To save paper, working copies can be double-
sided. Postcards are copied one per page. If you need to copy front and back for 
addresses, both sides of the same card can be on one page. 

• Make sure the letter number, as well as all text, shows up clearly on all copies. 
• Postcards, letters on odd-sized stationary, etc., will need to be hand-fed. Be sure to keep 

these in ascending order. 
• If the copy extends clear to the margins leaving no room for notes and coding, shrink the 

copy so there will be adequate margin space for coding. 
• After copies are made, staple the corresponding envelope to the back of the original letter 

with the address facing out.  
• File the originals and any clean copies in numeric order. Place them in folders and label 

each folder with the following information: “Originals (or clean copies), project name, 
and the letter number range (e.g., 475-780).” Clean copies may be sent on a regular 
schedule to the office that is maintaining the public reading file.  

• If coding on hard copies, use the optional customized rubber stamp and stamp the top of 
the first page of each working copy for entering header codes of demographic 
information. Working copies go to the “MID folder” to be assigned a MID number. 
Working copies of form letters are organized by the assigned form number and put into 
the appropriate folder in the project bin. (See the alternative ways for dealing with forms 
in Section 1.4.) 

• The originals will be used for entering into the correspondence log. For security reasons, 
the originals should be locked up in a filing cabinet when not being accessed. 

1.2.1 ~ Helpful Copying Hints 
• Align postcards on the copier glass two inches from the top and left-hand side. That way 

there is room to write in the margins. 
• Any letters or postcards that are written in pencil or very light writing may need to be 

darkened. Take the copier off of the AUTO mode and adjust the exposure level 
accordingly. 
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• Check the quality and legibility of all copies (e.g., exposure level, cut-offs, etc.) and 
correct when necessary. 

• It may necessary to copy the envelope if the respondent did not provide a complete 
legible address on their letter. 

1.2.2 ~ Letter Attribution Fields 
If coding on hardcopies, a stamp may be used for attribution fields: 

 

1234     I     1     2     1 5 

                                 MID OT      S       RT           DT   IA             

and so on…. 

Customized Rubber stamps can be made to stamp the boxes used for labeling Letter 
Attribution codes. Each box can be labeled with whatever demographic/header codes (letter 
attribution fields) go into that field. Or, if there is no rubber stamp, an alternative method is 
to use dashes to separate codes. If using the dash method, always use an X for a default code 
to denote those fields that are not being used.  If coding online, the same information will be 
identified for each letter. This information provides critical data used in reporting and in the 
demographic appendices. (For description of header information see CH 6, Letter 
Information Block). 

 

Section 1.3 ~ Additional Mail Processing 
Responsibilities  
The mail processor has the following responsibilities in addition to receiving mail and 
copying letters.  
• Coordinate with the project team leaders or managers to update them on volume of mail 

received and to correct numbering or copying discrepancies. 
• Identify form letters, assign form numbers, determine form masters, and post additional 

copies for data entry and coding staff reference. (See Section 1.4~Forms). 
• Identify letter generators and locate the letter generator from the website, print the 

complete list of possible comments, and determine the letter generator masters. 
• Periodically check the “possible forms” folder to determine if there are enough letters to 

constitute a form. 
• Assist the project team leaders or managers with Freedom of Information Act (FOIA) 

requests and prepare any copies necessary to fulfill each request. 
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Section 1.4 ~ Forms or Organized Campaigns 
The process for handling “form” or organized campaign letters is intended to avoid the 
inefficiency of entering multiple copies of the same text into the database while ensuring that 
any new or revised codeable content is captured.  

Form Letter: A form is defined as five or more letters from at least five individuals 
containing text that is identical or so similar that any difference in the wording or order of 
comments does not alter the basic meaning. Sometimes form letters are received with some 
of the text from the original form missing. This could be several words, sentences, or entire 
paragraphs. Form letters without some of the concerns of the original form that offer no new 
information are to be categorized as the form. That is, they have no special status and are not 
recognized in the content analysis process.  

Letters that fit the above description, but have fewer than five copies, or those that have 
“form-like” language are placed in a “Possible Form Letter” folder. These will be 
considered forms if and when the total number of letters meets or exceeds five. Form 
letters are then given to data entry and the form process begins. Letters with identical or 
nearly identical text, of which fewer than five are received, should be entered as individual 
letters with one being coded and entered into the data base and the others replicated with the 
other names and addresses attached. 

Form letters that contain additional codeable, nonrepetitive text are defined as forms-plus. 
Comments are not codeable if they merely restate or offer additional emphasis to what is in 
the form. If a comment in a form has been modified in a way that significantly changes its 
original meaning, it should be recoded and the form should be treated as a form-plus. 

However, treat a letter as an individual, nonform letter if: 
• the form text has been modified so much that all or nearly all of the form needs to be 

recoded (for instance, by the addition of “not”); 
• a letter contains little of the original form and contains additional codeable comments. 

The point is to be efficient—not recapturing existing form content—without losing added or 
revised content. 

Data technicians may need to check with a coder/analyst or manager to determine whether 
extra comments are codeable. 

Form Master: A letter chosen as the template for a particular form is called a form master. 
Form masters are coded, entered into the data base, and used as a template for the pool of 
forms they represent. Once the form master is entered, the remaining corresponding forms 
are either bunched and tallied or entered into the mailing list data base using the letter 
numbers, MIDs, and letter attribution information. One person may be assigned to be in 
charge of identifying and maintaining copies of all forms and to work with the mail processor 
in maintaining a main list of form numbers/names for each project. 
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1.4.1 ~ Form Master Process  
• The mail processor identifies forms and may be the one to determine which letter will 

serve as the form master. Forms-plus and forms without the full text are not designated as 
the form master.  

• Someone will be assigned to code the working copy of the form master, assign comment 
numbers, and write “Start additional comments at comment # __” The form master is 
given a unique number and a name descriptive of the letter’s content. 

Example:  
Form Letter #3 “We support Graylings.” 

• For reference, additional copies of the form master may be put in a folder for coder, mail 
processor, and data entry personnel reference. 

• The coded form master is given a MID, entered into the Oracle database, and placed in 
the Form Master folder. 

• Enter the Form Master’s form number in the Remarks field of the Correspondence Log. 
 

1.4.2 ~  Form Letter Process 
The decision whether form letters will get Mail IDs and be entered into the mailing list is 
made by the project lead for the proposal being commented on. Generally the decision is 
based on anticipated volume as well as legal and data value considerations. If form letters are 
to be entered into the mailing list data base, use the following process: 
• Place identified forms in a folder labeled with a corresponding Form Number to receive a 

MID. 
• Query Project ID and the letter attribution in the Header Entry Form. 
• Enter only the header information, letter number, and MID. 
 
If form letters are not to be entered into the mailing list database, use the following process: 
• After the form has been identified as to type, it is put in the folder or bin for that form 

number. 
• As soon as at least 200 of one form type have been received, these can be tallied in the 

“form tally” window by number of signatures and state. Each group of 200 forms will 
then be bundled and the form number, date of tally, and initials of tallier will be written 
on a cover note.  

• On extremely high volume projects, it is also possible to count one group of 200 forms, 
weigh it, and then determine the subsequent number of forms by weight. 

• When the comment period has ended and all letters received, the final bunches of fewer 
than 200 of each form type can then be tallied or counted and added to the final total. 

• If the form tally method is used, the demographics report on forms will then list how 
many of each type of form was received, how many signatures, and from which states. If 
forms are weighed, only a form count will be provided. 
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Form-Plus Letters Process  
• After form-plus letters are assigned a MID, they are put in the “1st Read” folder of the 

coders’ bin. 
• Additional comments and form comments that have been meaningfully modified are 

bracketed out for coding. 
• When the extra or modified comments have been coded, they are entered into the 

comments database, numbering the newly coded comments using the next sequential 
number after the last comment number on the form master. The rest of the letter is linked 
to the master form by the header codes. 

 
Important: Do not begin additional comments with comment number one. Refer to the 
corresponding form master or "Additional Comments" sheet to determine the starting number 
for the additional comments. 
 

Section 1.5 ~ Out-of-Scope Letters 
Out-of-Scope Letters are letters sent with content that does not pertain to the project. A 
project manager or team leader should make the final determination. If these are not 
identified prior to being MID’d, they will have to be removed from the working database. If 
they need to be removed: 

• Pull all copies and staple them together; 
• Write “Out-of-Scope” on the top copy; 
• Record the information in the Out-of-Scope log in the project log Access database; 
• Record the pertinent information in the MID Delete folder in the project file. A computer 

specialist must delete MID records unless the MID number is reused. 
• Record out of scope letters as “OOS” in the comments column of the project log. 
Out-of-Scope letters are put in a folder labeled “out-of-scope” in the project file. 

Section 1.6 ~ Filing 
Regularly file all original letters, completed working copies, and any additional copies (early 
attention) to provide easy reference during the content analysis process and to protect the 
integrity of the original letters.  
Original Letters: 

After the needed copies are made, the original letters are placed into accordion files in 
numeric order by letter number. Label the accordion files with the following information: 
Project name, originals, letter number range. The folders are then placed in numeric order in 
a filing cabinet or in boxes to eventually be filed in the administrative file. All original letters 
will be listed in the log, and originals should not be removed. The log manager is responsible 



Technical Guide 

1-8 Chapter 1 ~ Mail Processing 

for maintaining the locked cabinet of originals for the duration of the project. (Lost or 
misplaced original letters can create headaches.) 
Working Copies: 

If coding hard copies of letters, working copies are filed in ascending MID order for easy 
reference during the validation process. The MID, written in the upper left-hand corner of the 
copy, is oriented so it is visible at the top of the file, i.e., file the left side up. 

After the working copy is entered into the Content Analysis application (see Chapter 6), it 
is placed in the appropriate MID folder in the “To Be Filed” project bin. 

Place the ordered copies into accordion files and label with the following information: 
Working, project name, MID number range. 

Place the accordion files, in numerical order, in a filing cabinet for easy access. 

Watch for duplicate letters and multiple MIDs while filing. Staple any duplicate letters 
(letters labeled “dup of #____ ”) to the corresponding coded letters. File letters with multiple 
MIDs in a separate folder labeled “Multiple MIDs.” 
Additional Copies: 

Place any clean copies into accordion files in numeric order by letter number. Label the 
accordion files with the following information: Clean, project name, letter number range. 
Clean copies aren't written on, stapled, or marked in any way because they may be used to 
scan the project letters and for the public reading file.  

Often additional copies of letters are created for reference or to keep in a “request for 
information,” “request for extension,” or “early attention” file. If additional copies of letters 
are made, they should be tracked and filed appropriately so they don’t get confused with 
working or original letters.  

 

Section 1.7 ~ Project Bin Setup 
To organize hard copies of letters for each project, bins should be set up and labeled in 
advance for sorting letters into different stages of processing. Use at least three bins with 
hanging folders. These will be the “to be coded” bin, the “to be data entered” bin, and the “to 
be filed” bin. Additional bins or hanging folders within these main bins may be created for 
other types of sorting such as “to be MIDed, “to be copied,” and “problems.” 
 
To Be Coded Bin 

The coding team for a project uses the To Be Coded bin to organize the different phases of 
the coding process. This bin is generally located in the coding room. 

Additional categories in this group may be separate bins or folders in this bin labeled: 
• 1st Read: Place letters that have received a MID and are ready to be coded in this folder. 
• 2nd Read: Place letters that have been coded and are ready to be reviewed and possibly 

revised in this folder.  
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• Out-of-Scope: Place letters that coders identify as not directed at the project in this folder. 
• Problems: Place problems letters such as duplicate letter numbers, letters with illegible or 

missing pages, or fax cover sheets with no letter in this folder. Project managers or team 
leaders may have to assist data entry with some problem letters. 

• Flagged Letters: Place letters that meet the requirements for Early Attention, indicated by 
a red post-it attached to the left side, Comment Extension, indicated by a yellow post-it 
attached to the left side, or letters that contain an information request, indicated by a blue 
post-it attached to the left side, in this folder. These will be processed first. 

Data Entry Bin 

Additional bins or folders in this bin may be labeled: 
• Dups: Place letters that are copies of the same letter sent by the respondent in this folder. 
• MID: Place working copies of processed letters in this folder to receive a Mail ID.  
• Possible Form: Place letters that are form like in content or are from different senders but 

contain identical text in this folder. When their number is five or more it is considered a 
form. 

• Form Master MID: Place the Form Masters in this folder to receive Mail IDs. 
• Flags: Place letters that meet the requirements for Immediate Attention, indicated by a 

red post-it attached to the left side, Comment Extension, indicated by a yellow post-it 
attached to the left side, or letters that contain an information request, indicated by a blue 
post-it attached to the left side, in this folder. Red/Blue flagged letters are the priority for 
data entry. 

• Problems: Letters with missing pages, fax cover sheets with no additional pages, etc., go 
in this folder. (See CH 6, Letter Information Block, CH 4, Protocol for Multiple MIDs, 
and CH 2, Protocol for Log in Problems.) 

• Out-of-Scope: Place letters that are not directed at the project being analyzed in this 
folder.  

• Project Info: This folder contains information on the project, including the coding 
structure, etc. 

• Replicate Letters: Place letters that need to have comments replicated (a time saving 
procedure) in this folder. These are letters containing identical text when there are fewer 
than five. 

• Enter: Place letters that have been coded in this file to be data entered. 
• Form Master Enter: After a Form Master is coded; place it in this folder to be entered into 

the database. 

When form letters are received, two additional folders may be made for each form number 
and labeled: 

• Form (#) to be MIDed 
• Form (#) to be entered 

When letter generator letters are received, two additional folders may be made for each letter 
generator number and labeled: 

• Letter Gen (#)to be MIDed 
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• Letter Gen (#) to be entered 
 
To Be Filed Bin 

It is best to have “to be filed” bins or folders to keep original, working, and any additional 
copies separate. Originals and clean copies are filed by letter number; working copies are 
filed by Mail ID.  
 

 
 



 Technical Guide  
 

Chapter 2 ~ Using Access to Create 
and Populate Correspondence Log  

Create a correspondence log from 
CAT templates

Enter information from original letters

Update daily 

Create and maintain linked copies 

Do a daily backup to CD  

Format log for administrative project 
record CD 
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Section 2.1 ~ Log Entry Form Information 
For each project, a log of all letters received is produced and maintained. As letters are 
received and numbered, names and addresses are entered immediately into the log. This 
allows for real time reports of how many letters have been received and from whom. The 
form CAT has developed is in an Access database. The log tracks each letter number and is 
created and maintained in a database containing the following information, at minimum: 

Letter # (Letter Number) Received Date(s) 
SOP (Stage of Process) Remarks 
Organization Name Optional automated fields: 
Name (Last) Input By 
Name (First) Date Input 
Name (Middle Initial) Modified By 
E-Mail (Address) Date Modified 

Figure 2.1: Log Entry Form 
 

Letter # 

The letter number (assigned by the mail processor) that is found in the upper right hand 
corner of the letter can be auto-filled into the database prior to beginning the logging process. 
SOP 

The Stage of Process is a one digit numeric code that indicates the current stage of process 
for the project. The Stage of Process code remains the same throughout that stage of the 
project, and like the letter number, can be auto-filled into the database prior to beginning the 
logging process.  
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ORGANIZATION 

When the author is speaking on behalf of an organization or business, enter the name of the 
organization/business in this field. This allows for the retrieval of specific information from 
the database, such as how many State agencies have responded to a project, etc. Names, 
addresses, and  organization names should be entered following a standard format. (See 
Section Chapter 5, United States Postal Standards for Addresses). 
NAME 
• Enter last and first names, and middle initial in their respective fields. 
• If the name and/or address on the envelope are different from the name/address in the 

body of the letter, use the name and address data in the body of the letter. (See Chapter 4, 
Creating a New MID.) 

• Be sure to check the envelope for additional information, if needed, such as complete 
names or complete addresses. 

• Enter the author(s) of the letter using the first complete name given.  
• Enter RESIDENT if the author’s name is missing, illegible, or is only a first name, but 

the address is legible.  
• Enter ANON if the signature and address are illegible. Enter ANON if the letter is noted 

anonymous by the author.  
• Enter UNUSED L# if a letter number is skipped (such as out-of-scope).  
• Enter nothing in the name fields if the respondent supplies an e-mail address only. 
E-MAIL 

Enter a complete e-mail address only. Enter the address exactly as it is written, including 
capitals, underscores, and special characters (e.g., LaLoBa@aol.com is not entered 
laloba@aol.com). If the domain is missing, leave the field blank. If there are two e-mail 
addresses, enter both separated by a comma and no spaces between. 
RECEIVED DATE 

Enter the date the letter was received (as reflected in the date stamp). Check all Original 
copies to verify that all received dates have been stamped by mail processors. This is one of 
the most important pieces of information entered in the log.  
REMARKS 
This field is used to enter special aspects of the letter or respondent. The drop-down list 
attached to this field includes the following notations to choose from; however information in 
the comments field is not limited to the drop-down list.  
• OOS (Out of Scope) 
• DUP of L#_____ 
• Form Master1 (identifying the form master of form #1) 
• 1 of 2 Signatures (if two individuals with different names and/or addresses sign a letter) 
• Pet - 122 names (petition with 122 names) 
• Illegible (for unreadable names) 
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• Pages 2 & 4 missing 
• After Comment Period (for letters that may be logged after the Federal Register deadline) 
• Attachment (for a letter with attachment) 
• Cmnty Mtg (community meeting) 
• /s/ (indicating someone other than the author signed the letter) 
• 1 of 2 Orgs (representatives of 2 organizations have signed the letter) 
• YML Only (letter has no codeable comments and has requested to be included on the 

mailing list) 
• NML (letter includes instructions to be excluded from the mailing list) 
• Hnd Dlvrd (Indicates the letter was hand delivered instead of being received by mail) 
• Unused Ltr # (Indicates this letter number was skipped or not used) 
Input By 

This field is automatically filled in with the logging person's computer profile name. This 
happens as soon as the person doing the log entry begins to tab through the fields. 
Date Input 

This field is automatically filled in with the date and time at the same time the Input By field 
is created. 
Next Record Button 

When all necessary fields have been filled, the log person tabs to the next record button, 
presses enter and the next letter record appears. 
Modified by 

This field is automatically filled in with the log person’s computer profile name when the 
record is modified in any way. 
Date Modified 

This field is automatically filled in with the date and time at the same time the Modified By 
field is created. 
Previous Record Button 

Pressing this button allows the log person to return to previously entered records 
Binocular Button 

Pressing this button brings up a “find” box allowing the logging person to enter the piece of 
data being looked for. Using CTRL F will also bring up the find function.  The database is 
indexed and if a match is found the record is retrieved. 
Verified Check Box 

This check box is used to indicate that a difficult to read name has been located and verified 
via the Internet, phone book, etc. When creating MIDs in Oracle for a respondent, use the log 
to verify hard to read information. The log person is creating the correspondence log by 
looking at original copies. They may have also looked up information on the internet to 
verify a name, etc.   
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Section 2.2 ~ Log Responsibilities 
The following steps help to successfully create and maintain a project log: 
• To use CAT’s Access log template, a copy of the Access template will be placed into the 

specific project folder that was set up by the computer specialist onto your C:\Drive or 
local network drive. The log manager will then enter the project name on the files and on 
all of the logs within the files. 

• The Working Log is the individual team members’ working copy. This copy of the log is 
stored on the individual computer desktop. Data is saved automatically and immediately 
to the log via the link between the desktop copy and the backend db on the network drive. 

• Enter information using the original copies. 
• After the letters are logged, place them in the labeled folder until it is full, then place the 

folder in the file cabinet area designated for this project. The log manager is responsible 
for maintaining the originals file cabinet, including locking it at night. 

• Refer to log procedures for guidelines on entering data. Always enter data 
consistently.  

• Check all Access tables within the same project database. (e.g., Dups, Out-of-Scope, 
etc.). Enter information from these logs into the main log on a regular basis, usually 
weekly.  

• Format and print the log as requested. 
• Data may be modified by anyone throughout the project.  
• After project completion, the process of validation begins. The validation compares 

letters to the log, ensuring that respondents’ names are correct. 
• A copy of the final log will be given to the person responsible for creating the project 

CD. 

Section 2.3 ~ Logging FAQ’s 
The following is a partial list of Frequently Asked Questions about the Access log.  

Q: Why do the Modified By and Date Modified fields fill in when a record is created? 
A: These fields fill in when the record is entered because they are part of the underlying 
macro “Input By”. However, when the record is entered and edited at a later date these fields 
fill automatically with updated information. (See Chapter 2, Form Information, Modified 
By.) 

Q: Why are original letters used to log (when possible)? 
A: Original letters are used to log because they usually provide a clearer example of the 
respondent’s name and other information than a copied letter. 

Q: When do I check the “Verified” box? 
A: The “Verified” box is checked whenever a data tech searches for and finds a difficult to 
read name and or address. This may be the person logging, creating mail ids or someone else. 
(See Chapter 2, Form Information, Verified check box.) 
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Q: What goes in the “Remarks” field? 
A: This field is used to capture additional information about the respondent. This field has a 
List of Values (LOV) drop-down menu containing pertinent information. However, 
comments are not limited to this LOV. (See Chapter 2, Form Information, Remarks.) 

Q: How do I go to the record I want to input? 

A: There are several ways to advance to a record:  

At the bottom of the form, highlight the record number and type the record number to be 
input. Press Enter and the 
desired record will appear.  

Press the Find button (the 
binoculars icon) to bring up a 
find box where the desired 
number is input. Press Find and the desired record will appear. (See Chapter 2, Form 
Information, Find Button.) 

Figure 2.4: Record Number Field 

Q: What are the arrows and binoculars buttons for? 

A: These are navigational buttons: The arrow buttons allow the user to go forward one record 
or back to the previous record. (See Chapter 2, Form Information, Next Record Button and 
Previous Record Button.) The binoculars button is described above.  
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Chapter 3 ~  The CAT Oracle 
Program 
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Section 3.1 ~ 

Section 3.2 ~ 

Computer Commands 
The Technical Guide uses words and symbols to describe a variety of actions. They are 
explained in more detail here to clarify the format of the Technical Guide. 

Figure 3.1: Computer Commands 

Command Description 

Enter The word Enter is used when referring to pressing the Enter key on the 
keyboard. 

Execute The word Execute is used when referring to performing an action in the 
program. 

Cancel The word Cancel is used when referring to the process of recanting any action 
performed in the program. 

[ ] Brackets are used when referring to a [function]. 
< > Angle brackets are used when referring to a <hot key>. 

Bold Bold is used when referring to a button, an action or an important word 
(e.g., Enter, Cancel, Never, Always etc.). 

Italics Italics are used to indicate emphasis, provide additional information, or reference 
another section or chapter in the Technical Guide. 

Click The word “click” is used when referring to selecting an icon or button, or 
clicking the mouse. 

Select The word “select” is used when referring to choosing menu items or using the 
mouse. 

Press The word “press” is used when referring to actions performed on the keyboard. 

Using the Oracle Program 
In order to enter data into the Oracle database you must first log on to the program. 
• Double-click on the program icon on your computer desktop. 
• Enter your username and password. These need to be setup by the Oracle Administrator. 

You may tab between fields or use a mouse click. 
• Select the database for your project. 
• Press Enter or click OK. 
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3.2.1 ~ Oracle Applications 
The CAT Oracle program is an executable program with three applications: the Mailing List 
application, the Content Analysis application, and the Form Tally application. Each 
application is used during different stages of the CA process. The Mailing List application is 
used to assign mail identification numbers (MIDs) and to update already existing MIDs. The 
Content Analysis application is used to enter header information and each respondent’s 
comments. The Form Tally application is used to create an accurate count of all form letters 
submitted, by state, but only in those cases where the senders of form letters are not to be 
included in the project mailing list.  

To open an application, select the Menu item File or press <Alt+F> and choose one of the 
following: Mailing List to create or update MIDs, Content Analysis to enter letters, or Form 
Tally to tally form letters. (See Chapter 4, Mail Identification & Chapter 6, Entering Comments 
in the Content Analysis Application.)  

In each application there are different blocks that are tied to different tables in the Oracle 
database. In each of these blocks there is a series of fields in which to enter information. Each 
field is assigned a color that indicates a different mode or requirement. The following is a list of 
each mode and/or requirement: 

Field Colors: 
• Yellow indicates that the application or form is in query mode. 
• Pink or blue indicates that the field information is required. 
• Gray indicates a calculated field and the information in the field are displayed automatically. 
• White indicates that the field is optional. 

Both the Mailing List application and the Content Analysis application open in query mode. It 
is necessary to exit query mode <Ctrl+Q> in any of the forms or applications before opening 
another form or application.  

Important: Do not minimize the forms. Use the buttons found at the bottom of the form to 
navigate between forms (See Chapter 3.4.1.a, Additional Program Forms). 
  
 

Chapter 3 ~ The CAT Oracle  Program 3-3 



Technical Guide 
 

 In each form in the CAT Oracle program there are buttons indicating a List of Values (LOV). 
This list displays all of the possible entries for a field. To display the LOV either click on the 
button to the immediate right of the field or press [F9] while the cursor is in the field. Select the 
desired value by clicking on it or use the up and down arrows and press Enter.

Figure 3.2: Mail List Application 
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Figure 3.3: Content Analysis Application 

 

Each application contains buttons that open different forms. Each of these forms performs a 
different task. The following is a list of the names and functions of the forms accessible from the 
two main applications. 

3.2.2 ~ Mailing List Application  
Click on the Content Analysis button (lower left) to 
toggle between the applications (Mail ID and 
Content Analysis). Click on the Close button to 
close the application. Click on the buttons at the 
bottom of the application to access these forms: 

Content Analysis

Foreign Addresses

Mail ID/Proj
The Foreign Addresses form is used to create 
MIDs that include foreign address data.  Close
The MID/Proj form is used in validation and 
verification of duplicate letters. 

Figure 3.4: Mail ID Application Buttons 
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3.2.3 ~ Content Analysis Application  
Click on the Mailing List button (lower left) to toggle between the applications (Content 
Analysis and Mail ID). Click on the Close button to close the application. Click on the buttons at 
the bottom of the application to open these 5 forms: 
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The Header Entry form is used to enter header information and form letters without additional 
comments. 

Mailing ListThe Replicate form is used to copy 
comments from one letter and paste 
them into another letter. 

Header Entry

Replicate
The Query Comments form is used 
by the coding staff to find duplicate 
letters or letters that can be replicated. 
This form enables the user to query by 
a phrase or word, and thereby 
determine the letter number of a letter 
with similar comments. 

Query Comments 

Immediate Attention
Request For 
Information 

Close The coding staff uses the Immediate 
Attention form to make notes 
regarding a letter requiring immediate 
attention. Figure 3.5: Content Analysis Application Buttons 

The coding staff uses the Request for 
Information form to make notes regarding a letter requesting information. 

(For more information on these forms see Chapter 6.5.3-6.5.7) 

Section 3.3 ~ Menu Bar Drop-down Lists 
The Menu Bar appears as a single line of menu titles and icons across the top of the primary 
window and contains choices for each of the drop-down menus and sub-menus in the CAT 
Oracle program. 
A drop-down menu appears when you choose a menu title in the menu bar. Note: The 
underlined letter indicates a keyboard shortcut. Press <Alt+the letter indicated> to produce 
the drop-down menu. Once the menu is displayed, simply press the letter indicated to perform 
the desired action. 

 

Figure 3.6: Menu Bar 

Menu Bar 

The following pages look at each menu and its properties 
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3.3.1 ~ File Drop-down Menu 
The File drop-down menu items allow for opening 
the various forms and reports within the CAT Oracle 
program, as well as saving, printing, closing, and 
exiting the applications. The sub-menus of this drop-
down menu are covered in more detail throughout this 
technical guide. 

COMMAND DESCRIPTION BUTTON/ICON 
Mailing List Opens the Mailing List form. Mail 

IDs are queried, modified, and 
assigned here  

 

Content Analysis Opens the Content Analysis 
application. Respondents’ 
comments are entered and 
attached to MIDs 

 

Form Tally Opens the Tally form. Forms are 
entered and linked to demographic 
information. 

 

Project Setup Opens a menu of form options for 
entering project codes required for 
a project. Sub-menu items include 
Project Code, Abbreviations, 
County Data, Assigning Group 
and Geographic Location 

 

Letter Setup Opens a menu of form options for 
entering the codes required for 
letter setup. Includes project 
header information that will be 
attached to the respondents’ 
comment. 

 

Comment Setup Opens a menu of form options for 
coding comment information. 

 

Validation, Mailing 
List, Content 
Analysis Report 

Reports   

Client Interface 
Setup 

Creates a user name for a client to 
log in and use the access interface. 
This item is for administrative use 
only. 

 

Clear All 
[Shift + F4] 

Removes current record from 
current block. Cleared record is 
not deleted from database. 

 

Save Enters into the database all 
changes to a screen.  

Print 
[Shift + F8] 

Writes the current window to a file 
and asks if user wants to print it.  

Close Closes the application.  
Exit 
<Ctrl + Q> 

Exits the application. 
 

An arrow 
indicates that 
this item has 
a sub-menu.

 Figure 3.7: File Drop-Down Menu Items 
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3.3.2 ~ Edit Drop-down Menu 
The Edit Menu provides actions for changing or editing 
the contents of documents or other data. These are 
common Edit menu items with mnemonics and keyboard 
shortcuts. 

3.3.3 ~ Record Drop-down Menu 
The Record Menu contains selections that allow you to 
move the insertion point throughout the application, as 
well as delete or insert data. 

COMMAND DESCRIPTION BUTTON/ICON 
Previous Block 
<Ctrl + Page Up> 

Moves cursor to preceding 
block.  

Next Block 
<Ctrl + Page Down> 

Moves cursor to next 
block.  

Clear Block 
[Shift + F5] 

Clears block of all 
information. 

 

Previous Record 
<Shift + Up> 

Moves cursor to preceding 
record.  

Next Record 
<Shift + Down> 

Moves cursor to next 
record.  

Clear Record 
[Shift + F4] 

Clears record of all 
information.  

Remove Removes the record from 
the field. 

 

Insert 
[F6] or <Ctrl + L> 

Allows the insertion of a 
new record.  

Duplicate Record 
[F4] 

Inserts data from previous 
record into new one. 

 

COMMAND DESCRIPTION BUTTON/ICON 
Cut
<Ctrl + X> 

Deletes selected item. 
Item may then be pasted 
into a selected location if 
desired. (See below)  

 

Copy 
<Ctrl + C> 

Copies selected 
information, to be pasted 
in another location 

 

Paste 
<Ctrl + V> 

Inserts cut or copied item 
into selected location.   

Edit 
<Ctrl + E> 

Opens edit form to view 
selected information for 
editing. Also allows 
search and replace of 
information. 

 

Duplicate Field 
[F3] 

Enters data from same 
field in previous record 
into new one. 

 

Figure 3.8: Edit Menu Items Figures 3.9: Record Menu Items 
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3.3.4 ~ Query Drop-down Menu 
The Query Menu provides actions for querying data. 

3.3.5 ~ Window Drop-down Menu 
The Window Menu provides actions for arranging the 
applications and forms within the window, as well as 
listing the windows, applications, and forms that are 
open. 

3.3.6 ~ Help Drop-down Menu 
The Help Menu contains items that assist in trouble 
shooting, showing the keyboard shortcuts, and changing 
your password.  

COMMAND DESCRIPTION BUTTON/ICON 
Enter 
[F7] 

Puts form in query 
mode.  Hit once to 

enter query mode. 
Execute 
[F8] 

Executes query. 

 Hit again to 
execute the query. 

Last criteria Allows for another 
query based on the 
last set of values. 

 

Cancel 
<Ctrl + Q> 

Cancels query  

Count Hits 
[Shift + F2] 

Counts number of 
results from the 
query. 

 

Fetch next set Moves to the next 
record matching the 
original query values 

 

COMMAND DESCRIPTION BUTTON/ICON 
Cascade Arranges open forms

in a slightly 
overlapping 
“cascading” fashion 
within the window. 

   

Tile   Arranges open forms
edge to edge in a 
“tile” fashion within 
the window. 

 

Welcome, etc. Shows all windows in 
the CAET program. A 
check mark indicates 
the selected form, etc. 
To open the form 
simply type the 
number to the left of 
the desired form. 

 

Figure 3.11: Query Menu Items 

Figure 3.10: Window Menu Items 

Figure 3.11: Help Menu Items 
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Section 3.4 ~ Shortcut Keys 
in CAT Oracle Program 
There are shortcut keys in the CAT Oracle program (also 
called Function keys and hot keys). To display the list of 
shortcut keys select Help>Show Keys. (See the table on 
the following page for a complete list of CAT keyboard 
shortcuts.)  

 

 

 
        Help Drop-Down Menu Commands and Descriptions 

COMMAND DESCRIPTION BUTTON/ICON 
Help 
[F1] 

Help desk 
coordinator 

 

Show Keys 
[Ctrl + F1] 

Opens menu 
containing keyboard 
shortcuts. 

 

Display Error 
[Shift + F1] 

Displays more 
information on an 
Oracle Error. 

 

Change Password  Opens form that
allows user to change 
their password. 

 

About  Opens box
identifying CAET 
program and defining 
CAET. 

  

Figure 3.12: Shortcut Keys in CAT Program 
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FUNCTION KEYBOARD SHORTCUT 
Accept (Commit) F10 
Application Menu Ctrl + Corresponding Letter 
Block Menu F5 
Cancel ESC 
Clear Block* Shift + F5 
Clear Form* Shift + F7 
Clear Item* Ctrl + U 
Clear Record* Shift + F4 
Count Query Hits* Shift + F2 
Debug Mode* Ctrl + ? 
Delete Backward* Backspace 
Delete Record* Shift + F6 
Display Error* Shift + F1 
Display Windows Alt + W 
Down Ctrl + L, Down Arrow 
Duplicate Item F3 
Duplicate Record F4 
Edit* Ctrl + E 
Enter Query* F7 
Execute Query* F8 
Exit (Cancel Query)* Ctrl + Q 
Help* F1 
Insert Record F6 or Ctrl + L 
Left* Left Arrow 
List of Values* F9 
Main Menu* Ctrl 
Next Block Ctrl + Page Down 
Next Item* Ctrl + Tab 
Next Item* Tab 
Next Primary Key* Shift + F3 
Next Record Shift + Down 
Next Set of Records Ctrl + > 
Previous Block Ctrl + Page Up 
Previous Item* Shift + Tab 
Previous Item* Shift + Control + Tab 
Previous Menu* Ctrl + Enter 
Previous Record Shift + Up 
Print* Shift + F8 
Redefine Username/Password* Ctrl + N 
Return* Enter 
Right* Right Arrow 
Scroll Down* Page Down 
Scroll Up* Page Up 
Show Keys* Ctrl + F1 
Up* Ctrl + P, Up Arrow 

Figure 3.13: Function and Keyboard Shortcuts 

This list is found in the Help drop-down menu. Select Show Keys to display this list. 

* Indicates the function is also available in query mode. 
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Section 3.5 ~ Project Database Setup 
The project database setup establishes the project coding structure and demographic codes 
that ensure that all entered data are consistent and accessible. This setup step is necessary before 
any letter data can be entered.  The project Team Leader determines the project setup data 
through the creation of the project coding structure at the beginning of each project. Data entry 
enters these data into the program. The Database Administrator can transfer some standardized 
codes from the Master Project codes. After this has been completed, modifications to the Master 
Project codes can be made for individual projects. 

The following is a list of specific areas of the database that require setup at the beginning of a 
project.  
Project Code 

The Project Code (PROJID) is an up to six-character alpha/numeric code used to identify a 
project. Use a project acronym (e.g., SNFP; Sierra Nevada Framework Project) or a shortened 
version of the project name 
(e.g., PLANR; Planning 
Regulations) for the project 
code.
• In the CAT program click 

on File>Project 
Setup>Project Code. 

• A list of projects appears. 
Press [F6] or select 
Record>Insert to insert a 
new project code. 

• Enter the Project Code in 
the Code column and a 
description of the project 
code in the Description 
column.  

• Commit. 
 

Figure 3.14: Project Code Setup Form 

 Phase 

The Phase code is a one-character alpha/numeric code that indicates the stage of the project in 
relation to the NEPA and  policymaking Processes A: Advanced Notice of Proposed Rule 
(ANPR) C: Categorical Exclusion, D: Draft EIS, F: Final EIS, I: Interim Rule, P: Prescoping 
(NOI), S: Scoping, E: Supplemental EIS, R: Proposed Rule, and U: Unspecified.. 
• Click on File>Letter Setup>Phase. 
• In this form, query the appropriate project. 
• Click on the arrows in any block and a drop-down list of all possible entries for that field 

appears. Choose the appropriate entry. 
• Commit. 
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Stage of Process (SOP) 

The Stage of Process code is a one digit numeric code that may indicate the current stage of 
process for the project. This code can also be used to differentiate between different elements of 
a project, such as between internal and external comment, or between before end of comment 
period and after end of comment period letters if the latter are to be analyzed. 
• Click on File>Letter Setup>Stage of Process. 
• In this form, query the appropriate project. 
• Enter the code and a description of the code in the Stage of Process block.  
• Commit. 
Response Type 

The Response Type identifies the specific format of correspondence. These are listed in the 
Master Project codes, and may be adjusted for a specific project. (For instance, there may be no 
public meetings, so public meeting notes may be dropped from the response type list.) 
• Click on File>Letter Setup>Response Type. 
• Query the project in the Response Type field. 
• Enter the letter codes and descriptions. 
• Commit. 
Delivery Type 
The Delivery Type is an up to two-character alpha/numeric code that identifies how the letter 
was received. 
This information is usually fairly tent from project to project, so for accuracy and to 
accommodate possible differences, all of the codes and their respective descriptions are entered 
for each project. These codes can also be found in the Master Project list. 
• Click on File>Letter Setup>Delivery Type. 
• Query the project in the Delivery Type field. 
• Enter the delivery codes and descriptions. 
• Commit. 
Immediate Attention 
Immediate Attention codes are applied only to those letters requiring early attention or response 
from the client. The Immediate Attention codes are listed in order by priority. If more than one 
code applies to a single letter, the code with the highest priority is attached. There are six 
standard numeric immediate attention codes. The Immediate Attention code is an up to two-
character alpha/numeric code. 
• Click on File>Letter Setup>Immediate Attention.  
• Query the project in the Immediate Attention field. 
• Enter Immediate Attention codes and descriptions. 
• Commit. 
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User Type 
The User Type code is an up to four-character alpha/numeric code that identifies the purpose for 
which a respondent uses public lands (e.g., Rock Climber, Hiker, Area Resident, etc.). The field 
may also be used to identify other specifics about a letter or its sender. This is an optional field 
provided at the clients’ request. 
• Click on File>Letter Setup>User Type.  
• Query the project in the User Type field. 
• Enter User Type codes and descriptions. 
• Commit. 
Letter Generator Number 

A letter generator is created when an organization uses an interactive website that contains a 
selection of comments from which a respondent composes a letter. Letter generators are given 
unique numeric codes and descriptive names, and are copied and posted for easy access. 
• Click on File>Letter Setup>Letter Generator. 
• Query the project in the Letter Generator field. 
• Enter Letter Generator numbers and descriptions. 
• Commit. 
Form Number 
A form is defined as five or more letters received separately but containing virtually identical 
text. Each new form is given a unique number (in ascending order) and descriptive name by the 
forms coordinator for tracking purposes. The form code is an up to five-character alpha/numeric 
code. 
• Click on File>Letter Setup>Form Number.  
• Query the project in the Form Number field. 
• Enter the Form Number and description. 
• Commit. 
Common Interest Class 

The Common Interest Class is the up to five-character alpha/numeric code that categorizes 
respondents’ overall views on a particular project. The codes are used on a project specific basis 
at the client’s request. 
• Click on File>Letter Setup>Common Interest Class.  
• Query the project in the Common Interest Class field. 
• Enter the Common Interest codes and descriptions. 
• Commit. 

Request for Information 

The Request for Information code is an up to five-character alpha/numeric code that identifies 
the type of request for information pertaining to the proposal (e.g., requests for a copy of the 
DEIS summary, full copy of the DEIS, a full copy of DEIS on CD, etc.). There are currently 
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sixteen possible Information Request codes. The code is written on a blue “Post-It Flag” and 
attached to the left side of the working copy. 
• Click on File>Letter Setup>Request for Information. 
• Query the project in the Request for Information field. 
• Enter the Request for Information codes and descriptions. 
• Commit. 

Comment Extension Period 

The Comment Extension Period code is used to identify requests to extend the comment period. 
The most common extension requests are for periods of time in multiples of 15 days. The codes 
used consist of the six most often requested time periods and one code for some other or no 
specific time period mentioned. 
• Click on File>Letter Setup>Comment Extension. 
• Query the project in the Comment Extension field. 
• Enter the Comment Extension Period codes and descriptions. 
• Commit. 

Organization 
The Organization code is an up to two-character alpha/numeric code representing various Org 
types. These codes tend to remain the same from project to project, and the master list of Org 
types can be used and adjusted on a project specific basis. 
• Click on File>Letter Setup>Organization Type. 
• Query the project in the Organization Type field. 
• Enter the organization data. 
• Commit. 
Subject 
The Subject code is an up to five-character alpha/numeric code that represents broad themes 
associated with each project, such as natural resources, economics, wildlife, etc. The subject 
code captures the “what” of the requested management action. Subject codes are entered from 
the coding structure that has been developed for the project. A standard coding structure for the 
Master Project can be imported and then adjusted for each project.  
Click on File>Comment Setup>Subject.  
• Query the project in the Project field. 
• Enter the Subject codes and descriptions.  
• Commit. 

• After the subject codes are committed, follow the same steps to enter the subsequent category 
information.  

While doing this you may find that if you enter a code or subject name incorrectly, you cannot 
delete it and instead get an error message that you must complete the field. In this case, go to the 
tool bar along the top, click on record, and then hit remove. Then you can re-enter the code. 
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Category 

The Category code is an up to five-digit alpha/numeric code that that defines a specific subtopic 
within each subject code, arranged from general to specific. These represent the more specific 
topic of a management action. Like the subject codes, there is a generic Master Project list of 
codes that can be imported and then adjusted to the project. 
• Click on File>Comment Setup>Category. 
• Query the project in the Project/Phase block of the Category field. 
• Select a subject and enter each category for that subject code and its description into the 

Category Codes. 
• Select the next subject and enter the corresponding category codes and descriptions.  
• Commit. 
• Repeat this procedure for each subject. 
Category 2 Code 

The Category Two code is used for the Rationale codes, also known as the Effects codes. These 
codes represent the reason, qualifier, or effect of the requested Management Action, which is the 
Subject code. Like the Subject and Category One codes, generic Category Two codes can be 
imported from the Master Project list and then adapted to the specific project. 
 
Site Specific 1 and 2, Optional 1 and 2 
Alternative codes consist of the following fields: Site Specific 1, Site Specific 2, Optional 1, and 
Optional 2. These are used on some projects to identify specific information not provided by the 
Subject and two Category codes. Alternative codes also provide an efficient way to access data 
for some reports. These codes are comment-specific and follow code entries in the left margin of 
the coded letter. Examples of possible Alternative type codes are national forest acronyms, 
regulation numbers, standard and guideline numbers, region numbers, theme codes, and 
Environmental Impact Statement (EIS) alternative numbers. 
• Click on File>Comment Setup> Site Specific 1, Site Specific 2, Optional 1, or 

Optional 2 (All of these forms are formatted identically). 
• Query the project in the selected field. 
• Enter the codes and their descriptions in the appropriate blocks. 
 
Important: Database setup must be completed before the Mail ID process and letter entry can 
begin. 
Remember: Close forms. Do not minimize them.  
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Chapter 4 ~ Mail Identification 
Application 
The mailing list allows us to create, retrieve, and update individual records in the database. 
These records contain the mailing information of people who comment on particular projects. 
These people are known as respondents. 

Working Copies to data entry Mail ID 
Bin 

Query respondent in Mailing List 
form 

Query successful: Record 
MID on working and enter 

letter # in Remarks 

Query unsuccessful: Create 
new MID, record MID on 
working and enter letter # 

in Remarks 

Response and forms with additional 
comments with Mail ID to Coders 

Forms without 
additional 

comments go 
directly to data 

entry to be entered

Section 4.1 ~ Mail ID Basics 
A MID or Mail Identification number is a sequential number created and maintained by 
Oracle. Each respondent is given a MID number so his or her records can be easily accessed. 
The MID is a unique number defined by the mailing and demographic information (e.g. name 
and address or email address) provided by a respondent. It is assigned to the RESPONDENT 
as opposed to the LETTER, which is captured by the letter number. The information is used 
to create mailing labels that allow the client to send information regarding the project to the 
respondents. Email addresses can also be grouped by project to send out project-related 
messages. Once a MID is created in the program, this unique number can be assigned or tied 
to many projects. Mailing labels can be printed in block format for easy referencing by the 
Postal Service. Use the most recent postal standards as a guide for creating MIDs. (See 
Chapter 5, USPS Postal Standards) 
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MIDs are created using the Mailing List application of the CAT program. The Mailing List 
application consists of three blocks: the Mail ID block/table, the Project ID block/table, and 
the Geographic Locations block/table. Use the Mail ID block to create, retrieve, and 
update mailing information. Use the Project ID block to attach the respondent’s record to 
the appropriate project. The Geographic Locations block provides the option to assign 
MIDs to geographic areas other than a State, County, City or Zip, such as “Northeast,” “Bull 
River,” or “South.” The geographic location block is rarely used, and is for those clients who 
may wish to have mailing separate lists for different districts or regions. 

To exit query mode press <Ctrl+Q> or use the Query drop-down menu and select Cancel. To 
re-enter query mode press [F7], go to the Query drop-down menu and select Enter, or click on 
the flashlight icon at the top of the form. 

4.1.1 ~ 

4.1.2 ~ 

Getting Started in the Mailing List Application 
Select Mailing List > File drop-down menu in the Welcome form: The Mailing List 
application opens in query mode, indicated by the yellow fill in the fields. The application 
must be in query mode in order to perform a query. 

 
 

Click once on the flashlight button to enter 
query mode; click again to execute the query. 

Figure 4.1: Flashlight Button  

 

Performing A Query 
Executing a query is asking the computer to search the database for specific information. 
When creating a new MID, perform a query to see if the respondent’s record already exists in 
the database. Queries take place in the Mail ID block. 

Performing queries thoroughly is essential in maintaining an accurate database. 
Multiple MIDs means that a respondent receives multiple copies of the final document, 
which is not cost efficient and makes the agency appear inept. Once a MID is modified or 
created, the number is written clearly in erasable red ink in the MID box in the upper left-
hand corner of the letter. 

Queries are performed in any field or combination of fields. Including more information 
narrows the query and retrieves fewer records. For best results query less information 
to retrieve more results 
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Most records are queried by the last name, physical or email address. However, sometimes 
records are entered incorrectly. Therefore, a respondent is queried in at least two ways. If the 
respondent’s last name is spelled incorrectly, querying by last name and city will not retrieve 
the correct record. Querying by the street name and zip code, however, displays the correct 
record. 

 

 
Figure 4.2: Mailing ID Block 

 
 
There are two fields available in which to enter address information. Most addresses are 
recorded in the Address 1 field. Occasionally, it is necessary to use both the Address 1 and 
Address 2 fields. Therefore, when querying an address, especially those of businesses and 
organizations, query in both of the address fields. 

Every field in the Mailing List application is automatically entered in CAPITAL letters 
except for the Email Address field and the Remarks field. 
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The Percentage Sign 
Use the percentage sign (%) when querying information. The % is a wildcard and allows for 
broader queries. Enter the information for the query then execute the query. To execute a 
query, press [F8], select the Query drop-down menu and click Execute, or click on the 
flashlight icon. 

 
Example: 

A query of %SMITH% retrieves GOLDSMITH, SMITH, and 
SMITHERS, because any record that includes but is not limited to 
SMITH is retrieved. A query of %SMITH retrieves GOLDSMITH 
and SMITH. A query of SMITH% retrieves SMITH, SMITHERS, 
SMITH JR & SMITH PH D. 

The % sign is useful if the name is illegible. 

Example: 

If a respondent’s last name is Johnson, but only “Johns” is legible, a 
query of JOHNS% could retrieve the appropriate MID. 

The % sign is useful when it is unclear how the name might have been input. 

Example: 

Querying %Mally brings up O Mally (an incorrect use of a space) 
and O’Mally. 

Use the % sign to query an address. 

Example: 

A query of %RIVER% retrieves a variety of addresses, from 1310 
RIVERSIDE DR to 2 RIVER LN. 

Use the box number to query a PO Box. 

Example: 

Query %1214% for PO BOX 1214. (To query an address or PO Box, 
if possible include the city, state, or zip code to narrow the search.) 

Use the % sign to query a zip code. 

Example: 

A query of 11703% retrieves records that include 5 and 9 digit zip 
codes. 

Use the % sign to query a fax number if only part of the fax number is legible. 

Use the % sign to query an email address. This field is not case-sensitive. 

Example: 

A query of %MONROE@Hotmail.Com% retrieves the record 
monroe@hotmail.com. Notice a wildcard symbol is placed in front of 
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and at the end of the email address. Many respondents will submit 
more than one email address. This query will find the address 
whether it is at the beginning or end of the multiple addresses. Enter 
all addresses that are known to be for the same respondent.   

Multiple MID Records 

When a query is executed and the records are retrieved there are often multiple records that 
match the query. 

Example: 

If Tom Smith sends a letter and signs it Tom Smith, he receives his 
own MID. If Tom Smith of the same address sends a letter and it is 
signed Tom and Mary Smith, they receive a separate MID. If Tom 
Smith sends a letter on behalf of an organization, like the Sierra 
Club, he is assigned another MID because those comments are 
considered not only his, but the organization’s as well. It is important 
to remember, the respondent must be writing on behalf of the 
organization, not just as a member.  

Multiple matches are indicated at the bottom of the Mailing List application. The word 
“Count” appears followed by a number that indicates the record number currently viewed. If 
the number is followed by a “v” there are additional records that match the criteria of the 
search.  

Move between records by clicking the record up and record down buttons on the toolbar 
or the up/down arrows or Page Up/Page Down keys on the keyboard. 

If a query retrieves more than one record it is important to view each one. As mentioned 
earlier, a respondent may be assigned more than one MID number. Check all of the 
respondent’s records to assure accurate MID assignment. 

This indicates there is more than one record that matches the 
criteria of the query, and that the record currently viewed is 
the first in the list of retrieved records. 

Figure 4.3: Query Results  

To obtain the number of records that match the criteria of a query use the Count Query Hits 
button. In query mode, enter the criteria of the search then press <Shift+F2> (Count Query 
Hits). The number of records that match those criteria is listed at the bottom of the 
application. 

     

Figure 4.4: Count Query Hits  
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If the respondent’s record exists in the database check the Remarks field to see if they have 
already responded to this particular project. If this is the case, check to see if the new letter is 
a duplicate of a letter already received. (See Section 4.3, Protocol For Duplicate Letters) 

If the respondent is queried and exists in the database, record the letter number of the letter in 
the Remarks field of the MID block. (See Section 4.1.2.a Remarks Field) 

4.1.2.a ~ Creating A New Mail ID 
If no records are retrieved when the query is executed, the application remains in query 
mode. Exit query mode in order to create a new MID. Press <Ctrl+Q> or select Cancel from 
the Query drop-down menu. When the query is canceled the field color changes from yellow 
to white (enter mode). 

If several records are retrieved but none of them match the respondent’s information, create a 
new MID. Press [F6] or select Insert from the Record drop-down menu. 

The cursor begins in the Last Name field. 

When entering the respondents’ mailing information, adhere to the USPS postal standards. 
The more consistently these standards are followed, the fewer discrepancies there are in the 
database. The best way to ensure adherence to postal standards is to use the ZIP + 4 web 
page and enter the address into the fields in that site. Their program will supply the correct 
address format. Go to www.usps.com/zip4/ and enter the address and zip code as it appears 
on the letter.     

When querying and creating foreign address MID, cancel the query in the regular MID form 
and press the Foreign Addresses button at the bottom of the form. This will bring up the 
Foreign Addresses MID form in query mode.  
Abbreviations 

Abbreviate organization names, titles, and address information. This will ensure consistency 
and make it much easier to search for names and be able to find them in the database. The 
CAT program provides a list of abbreviations used in the MID process. Click on the 
Abbreviations button in the Mail ID block to open this LOV (List of Values). The 
abbreviations list is only displayed when the Mailing List application is not in query mode. 
To display the Abbreviations list without using the mouse, navigate to the Organization field 
and press [F9]. To exit the Abbreviations LOV click Cancel. 
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Figure 4.3: Abbreviations LOV 

 The Abbreviations button provides a list of commonly used abbreviations. Use the % sign 
to narrow the search. In the example above “car%” brought up a list of words and their 
abbreviations beginning with c-a-r.  

If the abbreviations list provides a plural alternative, do not include the parentheses in the 
abbreviation (e.g., “(s)”). 

This list of values window does not allow you to select to enter data. The data entry person 
will have to manually enter the abbreviation.  

The Mail ID block consists of 23 fields. The following is a list of their names and functions. 
Mail ID Field 

The Mail ID field displays the MID number of the respondent’s record. When the 
respondent’s mailing information is entered and committed, this number is assigned 
automatically. 
PMB or MSC Field 

The attributes associated with the PMB or MSC (Private Mail Box or Mail Stop Code) field 
are discussed in Chapter 5.1.8, Post Office Addresses/Private Main Boxes.  
Client Field 

When consultants, lawyers, or other legal representatives respond on behalf of an 
organization or an individual, use the Client field to indicate whom they represent. The MID 
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is assigned to the lawyer or consultant. Client field information is not included on mailing 
labels. 

Example:  

If a law firm represents several tribes, list the tribes in the Client 
field, the lawyer in the First and Last Name fields, and the law firm 
in the Organization field. 

Always use the ampersand (&) for the word “and” in any relevant field in the Mail ID block. 
These fields include Org, Client, Title, Attn, and First Name. Note: If there is a long list in 
the Client field, separate the names using forward slashes not spaces. 
Attention Field 

Use the Attn field to indicate the recipient of future project-related mailings if the recipient is 
not the author. Use this field only when specified by the author. (See last sentence of Last 
Name Field, below). 

Example: 

Gov. Martz writes a letter but requests that Joe Smith (her aide) 
receive the response. The Attn field reads: JOE SMITH. 

Do not use this field for an individual who signs on behalf of another individual. 
Last Name Field 

Use the Last Name field for the last name of the respondent, and also for any titles such as 
MD, PH D (note the space in PH D), or generational designations such as JR or SR. Do not 
use both DR and PH D for one name; if the respondent's signature contains a title, use that 
one. If not, choose one. Always refer to the signature. The designation ESQ is never used. 

Enter names like O’NEAL and O’MALLY with an apostrophe but without spaces. 

Enter names like MCDONALD, MCLEOD or DELAHOYA without a space. (Remember 
these rules also when performing queries.) 

When 2 or more respondents with different last names sign a letter, enter one last name in the 
Last Name field, and all other names in the First Name field, also using the Middle Initial 
field if possible 

Example: 

Joe Meyers, Stacy M Powers and Marty J Mendel have signed the same 
letter. There is only one address, therefore only one MID is created. The 
First Name field includes Joe Meyers, Stacy M Powers & Marty. The 
Middle Initial field has J, and the Last Name field contains Mendel. 

The secondary first name usually holds the title and should be entered as such. 

Example:  

Jacob Evans and Marie Evans, PH D send a letter. Following the 
above rule, the First Name field includes JACOB & MARIE and the 
Last Name field is EVANS PH D.  
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When the written signature and typed signature at the close of a letter are different, 
include both names in the MID. 

Example:  

Samuel S. Dodge signs a letter, however the name and title directly 
below it indicate that Gerald Dean is the respondent. The First Name 
field includes Gerald Dean & Samuel, the Middle Initial Field 
includes S, and the Last Name field is Dodge. 

Enter double Native American last names only after an Internet search to make sure it’s 
actually two. For example, Thomas J Goes Running may actually be Thomas J GoesRunning. 
Query the program to bring up the name either way.  

When two or more respondents sign a letter and one includes a middle initial, always input 
the respondent with the middle initial last in the First Name field allowing for use of the 
Middle Initial field. Always use the Middle Initial field when possible. 

Example:  

Michael T and Jennifer Atkinson sign a letter. The First Name field 
should read JENNIFER & MICHAEL and the Middle Initial field 
reads T. Thus the printed address will read Jennifer and Michael T. 
Atkinson, with the middle initial appropriately with Michael’s name. 

Exception:  

Sam L and Mrs. Keith write in. Use of the Middle Initial field does 
not take precedence over rule inputting Mrs as the second name. 
First Name field: SAM L & MRS, Last Name Field: Keith.  

Enter the word RESIDENT when the address is legible but the name is not. Before doing 
this, always query the physical address to avoid creating multiple MIDs. Enter ANON, not 
RESIDENT, when only a city and state with no street address are provided. 

Never enter just a first name. Enter RESIDENT in the Last Name field if an address is 
provided. Enter ANON in the Last Name field if an address is not provided. 

When assigning MID's to anonymous letters (no name or address) or letters where the 
respondent information is illegible, enter ANON in the Last Name field. Include any 
demographic information available. Using the postmark is acceptable, but use the state only, 
not the city. 

There are pre-designated ANON MIDs in the database for anonymous letters containing only 
a state name. There is also a pre-designated “generic anon” in the database that is used when 
the letter lacks any mailing or demographic information.  

Enter only the last name if the letter is signed Jones Family, Jones Residence, or if the letter 
is signed with a last name only. 

Never use RESIDENT or ANON in conjunction with an organization or business. 

If the respondent’s name is difficult to read, check the project log, ask a co-worker for their 
opinion, or use the Internet to search for the respondent.  
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Enter the entire hyphenated last name in the Last Name field. If a respondent has two last 
names that are not hyphenated, enter the first last name in the First Name field, and the 
second last name in the Last Name field. 

Example: 

Maria Gonzales-Gomez sends a letter. The First Name field reads 
MARIA; the Last Name field reads GONZALES-GOMEZ. 

Example: 

Sean Simpson O’Rourke sends a letter. The First Name field reads 
SEAN SIMPSON. The Last Name field reads O’ROURKE. 

Example: 

Roy Ford Jr and his wife, signing only as Mrs, send a letter. The First 
Name Field reads ROY & MRS. Last Name field reads FORD JR. 

Example:  

Barb Hayward-Johnson and Scott Johnson send a letter. Because 
JOHNSON is the shared last name it’s entered into the Last Name 
field. The first Name field includes SCOTT & BARB HAYWARD. 
However, if Barb is the only one to send a letter, HAYWARD-
JOHNSON goes in the Last Name field.  

Example: 

 Rachael and C W Quade send a letter. RACHAEL and C are entered 
in the First Name field, W in the Middle Initial field.  

Note: If a person signs a letter on behalf of another person, assign the MID to the individual 
who makes the comments, not the person who signs the letter. 
First Name Field 

The First Name field is used for first names, but can also include additional signatures on a 
letter. Example:  

If a letter is signed by John Jacobs, Millie Nelson, and Tyler Stewart, 
enter JOHN JACOBS & MILLIE NELSON & TYLER in the First 
Name field. Enter STEWART in the Last Name field. 

Include honorifics in the First Name field such as DR, REV, and also the ranks of current or 
retired military personnel. 

Example: 

If Reverend Martin Luther King Jr. writes a letter, enter REV 
MARTIN LUTHER in the First Name field and KING JR in the Last 
Name field. 

Example: 
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Retired Lt. James T Simmons writes a letter. Enter LT JAMES in the 
first name field, T in the middle initial field, and SIMMONS in the 
Last Name field. 

Enter the most complete name given. For example, if the signature is Bill and the 
address label says William, use William 

Do not use periods. 

Do not use Miss, Ms, Mr, or Mrs. 

Exceptions:  
• If Mrs. William Wilson sends a letter, enter MRS WILLIAM in the First Name field, and 

WILSON in the Last Name field. 
• If Mr. and Mrs. James P Jones send a letter, enter JAMES P & MRS in the First Name 

field, and JONES in the Last Name field. 
• If Prof. and Mrs. John Sullivan send a letter, enter PROF JOHN & MRS in the First 

Name field, and SULLIVAN in the Last Name field. 
• If two doctors with the same last name (Drs. Ken & Katherine Larson) send a letter, enter 

DR KEN & DR KATHERINE in the First Name field, and LARSON in the Last Name 
field. 

Never enter just a first name. Enter RESIDENT in the Last Name field if an address is 
provided. The one exception is religious clergy: Sister Katherine or Father Thomas is entered 
in the first name field, and if a last name is provided it's entered in Last Name field. 

Enter ANON in the Last Name field if an address is not provided. 

Never abbreviate a first name, and always enter the most complete name. 

Example: 

Wm. is entered as WILLIAM. 

Example: 

If a respondent signs a letter Mike Jackson, but the return address 
reads Michael Jackson, use MICHAEL in the MID. 

Never use nicknames unless it’s the only name given. 

Example: 

A respondent signs a letter Henry “Skipper” Henderson. Do not 
include Skipper in the MID. However, if Skipper Henderson is the 
only name given, the nickname is used. 

If Mary and John Smith are included in the return address, but Mary Smith signs the letter, 
enter only MARY SMITH in the MID because the comments are hers. 

If the signature reads F W Jones, enter F in the First Name field, W in the Middle Initial 
field, and JONES in the Last Name field. 

If the signature reads J George Jones, enter J GEORGE in the First Name field, and JONES 
in the Last Name field. 
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Never include a space in a first name. Le Roy is entered as LEROY, La Donna as 
LADONNA, and La Verne as LAVERNE.  
Middle Initial 

Only one character may be entered in the Middle Initial field. 

If respondents use their full middle names, enter this information in the First Name field. 

Example: 

Anna Mae Aquash sends a letter. Enter ANNA MAE in the First 
Name field and AQUASH in the Last Name field. 

If respondents use two initials in their names, enter the first initial in the First Name field, 
and the second initial in the Middle Initial field. 

Example: 

Olive I.M. Boyle sends a letter. Enter OLIVE I in the First Name 
field, M in the Middle Initial field, and BOYLE in the Last Name 
field. 

If a letter contains two names, each with a middle initial, enter the names in such a way that 
one of the initials is entered in the Middle Initial field. 

Example: 

Clara E. and Malcolm P. Walker write a letter. Enter CLARA E & 
MALCOLM in the First Name field, P in the Middle Initial field, and 
WALKER in the Last Name field.  

Figure 4.5: Correct Entry of Two Middle Initials 

Organization Field 

Org stands for organization. Use the Org field if the respondent represents an organization. 
Data from this field is used to generate demographic reports; therefore it is important to fill in 
this field when applicable. 

Use the Org field if the letter contains the comments of the organization or business. The text 
will usually include pronouns like “we” and “our.” However, if the respondent merely uses 
the letterhead of an organization or business, and the comments are from an individual who 
does not sign as an official of the organization, place the organization/business name in the 
Address 1 field, the mailing address in the Address 2 field, and do not use the Org field. 
Remember: for delivery purposes a physical address is less important than a PO Box.  

If an organization or business sends a letter and there is no signature, it is acceptable to list 
the organization or business without an individual attached to the MID. 
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If a letter is faxed from a business, but the comments are from an individual and include an 
individual address, do not include the business name in either the Org field or Address 1 
field. 

Do not use ANON or RESIDENT in conjunction with an organization or business. 

Do not abbreviate key words in an organization name. 

 Example: 

ABC Academy should be ABC ACADEMY  

Do not use any punctuation except slashes (/). Replace “and” with &. 

Do not use the word “The” at the beginning of an organization or business name. 

Do not use acronyms in this field unless this is the only information provided. If the 
respondent gives an acronym, search for its meaning on the web. The site 
www.acronymfinder.com is useful in this instance. Also query the address in Zip+4 
website: www.usps.com/zip4/, which may give the business name. Be aware that some 
acronyms have multiple meanings. 

• Always abbreviate the organization type. 

Example: 

Corporation should be CORP - do not use periods. 

• Always abbreviate state names. 

Example: 

Montana should be MT - do not use periods. 

• Do not use apostrophes. 

Example: 

Johnson’s Logging should be JOHNSONS LOGGING 
Title Field 

Use the Title field only if the respondent has a title and an organization affiliation (e.g., 
PRES, V PRES, or SECY). Use standard abbreviations for all titles. 

Example: 

If a respondent signs her letter Josie Simmons, Vice President, but 
she does not specify what she is the Vice President of, then omit the 
title from the MID. 

Do not use PH D in this field; include this title in the Last Name field. 

Use Slashes (/) to separate multiple titles. Do not use Dashes (-). 
Address 1 Field 

The Addr 1 field contains not only PO Boxes and street addresses, but also business name 
information. 

Use Addr 1 to record a more specific department of a large business or university. 
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Example: 

If the Forest Products Laboratory at the University of California 
writes a letter, enter UNIV OF CA in the Org field and FRST 
PRODTS LAB in the Addr 1 field. 

Use appropriate abbreviations for suffixes, directionals, numeric street names, highways, 
rural routes, highway contract routes, and PO Boxes. Use the Abbreviations list or see 
Chapter 5 Postal Standards. Generally, use the Zip+4 website: www.usps.com/zip4/ for 
formatting all addresses. You will enter the name, street address, and zip code, then cut and 
paste the resultant information directly from the site into the Mail ID screen. 

If an address contains two or more consecutive words that appear in the USPS standard 
abbreviation list, abbreviate the last of the words. The first word(s) is part of the primary 
name. 

Example: 

Both 789 MAIN AVENUE DR and 2345 DEER MOUNTAIN RD 
are correct. 

If the respondent provides both a PO Box and a street address, enter the physical street 
address in Addr 1 and the PO Box in Addr 2. When entering the zip code, verify it is the zip 
code for the PO Box.  

Example: 

If respondents list their address as 129 Kennedy Ct/PO Box 305, 
enter 129 KENNEDY CT in the Addr 1 field and PO BOX 305 in the 
Addr 2 field. 

 

If there is not enough room for the unit designator and the secondary address identifier (e.g., 
STE 1300, FL 3, RM 233), enter these alone in Addr 1, and enter the street address in Addr  

Figure 4.6 Unit Designator & Secondary Address Identifier 

Unit Designator
Secondary Address Identifier

Do not use any symbols or formatting unless verified at the Zip+4 website.  

When a clearinghouse is used to process an organization’s letters, enter the clearinghouse’s 
address in the Addr 1 field. Enter whom the clearinghouse is representing in the Client field. 

Note: If an individual sends a letter using the letterhead of an organization (this includes 
ranches and schools), but does not sign as an authorized representative of the organization 
(such as President, Director, or Chairperson) or refer to the organization by using pronouns 
like “we” and “our,” enter the organization name in the Addr 1 field. If the comments are 
those of the author and the organization’s, enter the organization name in the Org field.  

4-14 Chapter 4 ~ Mail Identification Application 
  



 Technical Guide 

County Field 

The County field fills automatically when a zip code is entered. 
Address 2 Field 

The contents of the Addr 2 field depend on the contents of the Addr 1 field. 

If the Addr 1 field is used to specify a department at a university or business, enter the 
mailing address in the Addr 2 field. 

Figure 4.7: Department in Addr 1 

If there is a PO Box and a street address, enter the street in the Addr 1 field, and the PO Box 
in the Addr 2 field. 

Example: 

If respondents list their address as 129 Kennedy Ct/PO Box 305, 
enter 129 KENNEDY CT in the Addr 1 field and PO BOX 305 in the 
Addr 2 field. 

Zip Code Field 

Enter either the five- or nine-digit zip code in the Zip Code field and press Enter. The city, 
state, and county fields fill in automatically. The city and state fields highlight to remind the 
user to verify that the information is correct. If the respondent provides a street address, city, 
and state, but no zip code, use the Zip+4 website to find and enter the zip code. 

Figure 4.8: Highlighted City Field  

When an incorrect zip code is entered, simply move the cursor back one field by pressing 
<Shft+Tab>. Typing the correct zip code replaces the existing information. 

If the street address is not provided, but the city and state are available, always look up the 
zip code for that area at the Zip+4 Website. Select the first zip code from the list that is 
designated “ACCEPTABLE (DEFAULT).” Including the zip code is necessary for gathering 
demographic information. 

If the address is researched at the Zip+4 website, add the additional four digits of the zip code 
to the MID. Record these four digits next to the zip code on the working copy. 

If the four digits are added, include a dash between the original zip code and the plus four 
digits. 
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City Field 

Enter the city name in the City field. When the zip code is entered, the city field is filled in 
automatically. 
State Field 

When the zip code is entered, the State field is entered automatically. The State field 
requires the two-character abbreviation. Access the drop-down list of abbreviations located to 
the immediate right of the State field if filling in the State only, and are unsure of the 

abbreviation.. 

To access drop-down list of state abbreviations, click on the button, 
or press [F9] when the cursor is in the State field. 

Figure 4.9: Drop-Down Button  

When an address is not provided but the letter has a legible postmark, use the postmark for 
gathering demographic information. Use the state only, do not use the city name included in 
the postmark. 
Phone Field 

Phone field is optional. 
Fax Field 

Enter the fax number in the Fax field if one is provided. The dashes are added automatically 
upon exiting the field. 
Email Address Field 

Use the Email Address field for email addresses only. Do not enter websites. An email 
address includes the “@” symbol. 

If a respondent sends email and does not provide name and or address, input the email 
address only. Do not add ANON or RESIDENT in the Last Name field. 

Some email headings provide the email address and a name at the top of the page. Use the 
name at the top only if the email is not signed. Do not use a name in the Last Name or First 
Name fields that is part of the email address only.  

Example: 

Do not use the name Johnnie Jones if the only information on the 
letter is johnniejones@juno.com. Include the Name in the MID if 
Johnnie Jones is provided along with the email address. 

It is acceptable to add multiple email addresses to a respondent’s MID. Use commas to 
separate the information, but do not include spaces. 

Example: 

jim@juno.com,jimmy@hotmail.com,james@yahoo.com  
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Do not add respondents to the mailing list if their MIDs consist of an email address only. 
(See Mailing List Status, below.) 
Remarks Field 

The Remarks field is a record of the letters affiliated with a respondent and particular 
project. Each time a respondent comments on a project, the remarks field of the respondent’s 
MID is updated.  

Each MID’s remark field has a specific string of codes. The purpose of this string of codes is 
to identify the project, the type of document (i.e., a form), and the letter number. It is 
ultimately used to identify duplicate letters and the phase of the project.  

Ml#6435/1706[Sl#p4478(NML)][V2h#20133,l#4727][BTl#361] 

A String of Codes

Note: The easiest way to add the string of codes when creating and updating MIDs is to 
copy and paste the information changing only the letter number each time. 

The string of codes begins with a Project ID Abbreviation. Letters addressing the same 
project are added to the existing string. Letters addressing a different project initiate a new 
string of codes beginning with a new Project ID abbreviation. Use brackets to distinguish 
between projects, but do not include them around the first project listed in the string. Do not 
use spaces to separate the data. 
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Example 
Project  Code Document Phase Remark Code 
215 Appeals AP l u  APl#u 

The Document Code identifies the type of letter.  code is Type of Document 
f Form (is followed by the form number) 
g Letter Generator 
h Hearing (Transcript) 
l Letter 
p Petition 
r Request (followed by a request type) 
w Workshop Notes  
x Resolution 

Phase Code Phase 
d Draft 
f Final 
p Pre-scoping 
s Scoping 
i Interim Directive 
a Advanced Notice of Proposed Rule Making 
E Draft Supplemental EIS 
R Proposed Rule 
u Unspecified 

 

 
Note: If two forms with additional comments are sent by the same respondent, but the 
additional comments differ, indicate that additional comments differ (adtl cmts diff) in the 
remarks field. 

   Example: 

    [P2fl#r1121,1303(adtl cmts diff)] 
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Mailing List Status 

The two abbreviations in this section are only used in special cases. No Mailing List (NML) 
is used if the respondent requests removal from the mailing list of a project or if the 
respondent has a non-deliverable physical or email address (e.g., returned mailings). Enter 
(NML) at the end of the string of codes. Yes Mailing List (YML) is used if the respondent 
does not provide a mailing address, but resides in a town with only one zip code; therefore 
the mail is deliverable due to the size of the town. Verify this at the City/State Website. 
(YML) is also used if the respondent requests to be added to the mailing list for a project but 
makes no comments on the project itself, such as filling out a sign-in sheet used at a public 
hearing. Include (NML) or (YML) at the end of the string of codes for the pertinent project. 

Ml#6435/1706[Sl#p4478(NML)][V2h#20133,l#4727] 

Mailing List Status 
for the SNFP project 

Distinguishing Duplicate Letters 

The Remarks field is the best way of catching duplicate letters. (See Chapter 4.3, Protocol 
For Duplicate Letters). If the letter is a duplicate of another letter for the same project, this 
must be recorded in the Remarks field. Use a slash to indicate duplicate letters. The / literally 
means “is a duplicate of.” 

Example: 

Rosa Parks responds to the Gray Wolf Project. She mails one letter 
and emails a second letter. The first letter is numbered W3075. She is 
assigned a MID and the letter is recorded in the Remarks field as 
Wl#3075. The second letter arrives and is assigned the number 
W4583. Rosa Parks’ information is queried in the database. The 
Remarks field of her MID indicates she has already responded to the 
Gray Wolf Project. The clean copy of L#3075 is checked, and its 
content is identical to the content of letter 4583. In the Remarks field 
(Wl#4583/3075) is recorded. This means Gray Wolf Project letter 
4583 is a duplicate of L#3075. The first letter to be given a MID 
(3075) is the letter that is coded. 

Examples of Strings of Codes 

The following are examples of strings of codes and their literal translations: 

Sf9#s2244[Rf16#6245,l#x6744/7123][Wl#s275(NML)] 

Sierra Nevada Framework Project form 9 #scoping 2244; Forest Transportation 
System Policy form 16 #6245, letter# late scoping 6744 is a duplicate of 7123 (7123 
is the coded letter); Gray Wolf Project letter# scoping 275 No Mailing List for the 
Gray Wolf project 
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Created By, Create Date, Modified By, Modified Date Fields 

The Created By field displays the profile of the user who created the record. The Create 
Date displays the date and time the record is first committed. The Modified By field 
displays the profile of the user who last committed any changes to the record. The Modified 
Date displays the date and time the modifications are committed. These fields fill in 
automatically. It is possible to query by these fields. 

4.1.2.b ~ School Responses 
Schools often respond to projects. Classes sending batches of letters often include different 
information, which require different considerations when assigning a MID. Follow these 
examples: 

Example 1: 

A class sends a batch of letters. The teacher’s name is included in the 
mailing information. Create a MID using the teacher’s name in the 
First and Last Name fields. Enter the name of the school and the 
class name (e.g., 4th Grade Class) in the Addr 1 field and the mailing 
address of the school in the Addr 2 field. List each letter in the 
Remarks field of the teacher’s MID. The mailing list status for this 
MID is “Yes.” Do not list the students’ first names anywhere on the 
MID. 

Example 2: 

A class sends a batch of letters. The teacher’s name is not included in 
the mailing information. Create a MID using the mailing information 
and the name of the school. Enter nothing in the First and Last Name 
fields. Enter the name of the school and the class name in the Addr 1 
field and the mailing address of the school in the Addr 2 field. List 
each letter in the Remarks field of the MID. The mailing list status 
for this MID is “Yes.” Do not list the students’ first names anywhere 
on the MID. 

4.1.3 ~ Project IDs Block 
Navigate to the Project IDs block. The information entered in this block determines whether 
or not the respondent is included on the mailing list, and to which projects the respondent’s 
MID is attached.  

Figure 4.11: Project IDs Block 
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Assigning Group 

The Assigning Group field should be done by an Oracle programmer.  District and Forest 
level offices will want to assign their own group name. 

Example: 

Enter TLRD Tally Lake Ranger District 
ID 

Enter the Project ID in the ID field. Use this only once per project, even though a respondent 
may respond to more than one phase of the project. When the Project ID field is entered 
twice an error message indicates that the row already exists with the same MID code. 

Example: 

Enter GWP for the Gray Wolf Project; enter SNFP once for any 
phase of the Sierra Nevada Framework Project, etc. 

Description 

The Description field fills automatically after entering the project in the ID field. 
Mailing List  

Enter “Y” for Yes or “N” for No. Yes indicates either the respondent provided a complete 
mailing address or lives in a small town with only one zip code. (Use the City/State Website 
to check.) In the latter case, be sure to enter “(YML)” in the Remarks field. This indicates 
the zip code was verified on the Internet and is the only zip code for the town in question. 

To remove an incorrect Y or N or the project code: In the ID or Mailing List field remove the 
record by pressing <Shift+F6> or selecting Remove or Clear Record from the Record 
drop-down menu., or by backspacing out the unwanted character, entering the correct one 
and pressing commit. After removing the record press [F10] (commit). Finally, enter the 
correct code and commit again. 
Created and Modified Fields 

These fields display the date and time the Project ID is committed and modified, as well as 
the profile of the user who created and/or modified the record. 

4.1.4 ~ Editing MIDs 
To edit a record that already exists in the database, simply query by the MID. Once the 
record is retrieved you can edit, add, or remove information. Always remember to commit. 
Find Form 

The Find form, accessed in the Mailing List application, enables the user to perform a query 
and view a list of the results highlight the desired row. Press Tab or click Accept to close 
the Find form and display the Mail ID form with the corresponding MID. To display the Find 
form, the Mailing List application must be in query mode. The Find form is titled “Mail ID 
LOV.” LOV stands for “List of Values.” The fields in this form include: Last Name, First 
Name, Organization, City, and Mail ID. Query by any one or a combination of these fields. 
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Use this form to display possible multiple MIDs. Use the up/down arrow keys to move 
around the form. 

• If an individual writes on behalf of an organization or business and signs as an 
authorized representative or refers to “we” in the letter, the organization or business is 
assigned its own MID. If the respondent writes a letter and uses the organization’s 
letterhead but provides no title and uses the pronoun “I,” then the respondent is 
assigned his or her own MID. Remember: in the former case the organization name 
is entered in the Org field and in the latter case the organization name is entered in the 
Addr 1 field. 

• In some cases, when petitions or other letters with multiple signatures contain 
individual complete addresses for each respondent, the respondents receive their own 
MID. It is acceptable to combine two or three individuals in a MID if they list the 
same address. Assign government officials their own MID regardless of address. If 
the petition contains only one address, choose one name (try to use an individual with 
a title) from the signatures and assign only one MID. 

• A letter written and signed by several individuals from various organizations but 
affiliated with one main organization (with or without a complete address) receives 
one MID. Remember: Enter the organization name in the Org field. 

• To fix the incorrect entry of a MID when in the Content Analysis form: delete the 
incorrect MID, enter the correct MID, press enter, and then commit. 

• When a congressperson or senator sends a letter, check to make sure that it is more 
than a cover letter. Many times individuals write a letter to their congressman or 
senator and these offices forward the letters. Check for a letter attached from the 
respondent. 

• When a clearinghouse is used to process an organization’s letters enter the 
clearinghouses’ address in the Addr 1 field. Enter whom the clearinghouse is 
representing in the Client field. 

Entering the Address 
• If the respondent provides a PO Box only, enter it in the Addr 1 field. 
• If a respondent provides both a physical address and a PO Box, enter the physical 

address in the Addr 1 field and the PO Box in the Addr 2 field. 
• Use standard abbreviations unless the word is part of the street name. 

Example: 

129 STORM CR RD or 12 S ST should be 129 STORM CREEK RD 
or 12 SOUTH ST. 

• Use the proper unit designator, not the pound sign (#) (See Section 5.1.3, 
Directional as Part of Street Name). Use the ZIP+4 Website to verify.  

Example: 
129 MAIN ST # 6 should be 129 MAIN ST APT 6. 

• Never use more than one space between words or numbers. 
• Enter Zip code, City, State and County will automatically fill. 
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Section 4.2 ~ Protocols For Multiple MIDs 
A Multiple MID issued to the same respondent may occur anytime a respondent is assigned 
more than one MID. Multiple MIDs may also be assigned on one response when there are 
more than one respondents who sign the letter. In the first instance, it may be an error to be 
corrected or may be appropriate as described in the following section 4.2.1. In the latter case, 
it is correct to assign MIDs to all signers in some cases on a project-specific basis as 
described in section 4.2.2. 

4.2.1 ~ Multiple MIDs Assigned to One Respondent 
A report is generated after each project to check for multiple MIDs. The following rules are 
used to decide when more than one MID for a respondent is correct. 
Correct uses of Multiple MIDs: 
• Tom Smith responds to a project on his own behalf and is assigned a MID. 
• A new MID is assigned when Tom Smith and Janet Inez write in together (there are two 

signatures, Tom Smith and Janet Inez, and one address, hence one MID).  
• A new MID is assigned when Tom Smith writes a letter as an official of an organization 

with the organization’s address. 
• A new MID is assigned when Tom Smith writes in using email and only includes his 

email address. “N” is entered in the Mailing List field to indicate the lack of a physical 
address. However, if you can know that the Tom Smith who sent the email and the Tom 
Smith who has a physical mailing address are indeed the same person, you may use the 
same MID and include the email address in the appropriate line. 

Correcting Multiple MIDs: 

Tom Smith writes another letter using the same address information as his first letter, but is 
accidentally assigned a new MID. To delete the duplicate MID: 
• Query the MIDs and decide which MID is easiest to remove from the database. The MID 

with the fewest number of letters entered in the Remarks field is the easiest to remove. 
• Record all of the entries in the Remarks field that will be added to the current MID and 

replace them with the word DELETE in the old MID. 
• Remove all Project Codes in the old MID by selecting Remove or Clear Record from 

the Record drop-down menu, or <Shft+F6> followed by [F10] (commit). 
• Record the MID to be deleted in the Delete MID folder in the appropriate project log file.  
• To replace the duplicate MID with the correct one, query each attached letter number 

and project in the Content Analysis application. In the MID field, delete the old MID 
number, enter the correct one, and commit. This step is very important. 
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4.2.2 ~ Multiple MIDs Assigned to One Letter 
In certain cases one letter may be signed by many people, either as a petition or just a letter 
with multiple signatures. In some cases it is appropriate to assign each signer their own MID. 
This is generally true when the signers each represent a different group or agency. If they are 
all signing for the same organization or group, the first or highest ranking signer is most 
often given the MID. With a petition, generally only one MID is assigned, usually to the first 
name on the petition. The policy for issuing MIDs to multiple signers on one letter are best 
determined on a case-by-case basis depending on the project and the signatories. 

Section 4.3 ~ Protocol For Duplicate Letters 
A Duplicate Letter occurs when the same respondent or respondents send more than one 
copy of the same letter or form. 

Query the respondent in the Mailing List application to see if they have already been 
assigned a mail identification number (MID). If the respondent is already in the database, do 
not create a new MID. Check the Remarks and Project ID fields in the respondent’s MID to 
determine if they are attached to the project of inquiry. If it is not a duplicate, follow the 
procedures for updating MIDs. (See Chapter 4.1.4, Editing MIDs). If there is another letter 
for the project, it is necessary to compare the letter about to be MID'd with the letter 
already MID'd. 
• If it is a duplicate, record the MID number in the upper left-hand corner, record “Dup of 

L#7” (7 being the letter number of the previously processed letter) under the duplicate’s 
letter number, then initial. 

• Enter the duplicate’s letter number in the Remarks field of the Mailing List application 
as: l#20/7, which reads, “Letter number 20 is a duplicate of letter number 7.” Letter 
number 7 is already accounted for in the system; therefore it is processed and coded first. 
(If the first letter is missing pages or is not completely legible, you may make the second 
letter the coded copy and the first letter the duplicate.) 

• Staple the working copy of the duplicate letter to the working copy of the coded letter, 
found in the data entry project bin folder. If both copies are not available, put the 
duplicate letter in the project bin folder labeled “Dups.” 

• Open the Dup log and record the pertinent information in each field of the log. 

The log manager transfers information from the project dup folder into the project log’s 
comments column on a weekly basis. 

When entering the comments of a letter and a duplicate letter is attached, check to see that 
the duplicate letter is entered in the Dup log. 
Duplicate letters placed in the “Dup” folder in the data entry project bin are attached to the 
coded letter after all of the working copies have been filed. 
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Section 4.4 ~ Accessing Forms In The Mail List 
Application 
Within the Mail ID application there are the Foreign Mail IDs form and the Mail List/Proj 
form. They are accessed by way of the buttons found at the bottom of the Mail ID 
application. 

The form opens with the MID and Project Code fields in query mode. These fields can be 
queried together or independently. Use the Tab key to move the cursor between the two 
fields. If more than one MID or project is retrieved, use the down arrow key to display each 
record. 

Figure 4.13: Mail ID/Project Form 

4.4.1 ~ Foreign Mail ID Form 
The Foreign Mail ID form is identical to the Mail ID form except the fields Foreign 
State/County/Province, Postal Code, and Country replace the state and zip code fields. 
Follow the steps for creating and/or editing a MID. (See Chapter 4.1.4.a, Creating a New 
Mail ID). If the foreign address seems incomplete research the international standards on the 
Internet. Do not input overseas military addresses in this form. 
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The Find feature in this form differs from the Find feature in the Mail ID block. The only 
fields in this Find form are Last Name, First Name, Country, and Mail ID. Perform a query in 
any of these fields. After retrieving the desired results use the down arrow to scroll through 
the records. Select a record and press Enter, Tab, or click Accept. This closes the Find 
form and displays the record in the Foreign MID form. Only foreign address MIDs are 
retrieved in the Find form of the Foreign MID form. 

4.4.2 ~ 

4.5.1 ~ 

Mail ID/Proj Form 
Use the Mail ID/Proj form in the validation process and to determine duplicate letters. This 
form combines the information in the MID application and the Content Analysis application. 

Querying the MID retrieves the MID information and a list of projects attached to the MID. 
Querying the project retrieves a list of MIDs attached to the project. Query by both fields to 
narrow the search. 

The letters attached to the project displayed in the Project Code field are listed in the Letters 
block. 

 

Example: 

If 62593 is listed in the MID field and GWP is listed in the Project 
Code field, the letters in the Letters block are MID 62593’s letters for 
the Gray Wolf project. 

Use the down arrow to view each project and its corresponding letters. 

The Letters block is linked to the Comments block. The comments and their codes listed in 
the Comments block are attached to the letter highlighted in the Letters block. 

Use the small scroll bars to the right of each comment to view the whole comment. Use the 
large scroll bar to the far right for viewing the remaining comments of the highlighted 
letter.  

Section 4.5 ~ Searching The Internet 
A respondent does not always provide a complete mailing address or have legible 
handwriting. The Internet can provide a more complete listing of an individual’s full name 
and mailing information. Searching the Internet for addresses and complete names helps 
maintain the accuracy of the database. Linking phone and fax numbers to more detailed 
information is done to gather more detailed demographic information.  

Types Of Searches 
The purpose determines the type of search. These searches include: reverse lookup, 
people/address search, map search, acronym search (mainly for businesses and 
organizations), phone search, international address search, and international people search. 
Before selecting a search site, identify the desired results. 

To expedite the search process, it is helpful to add search sites to the Favorites window. 
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Reverse Lookup 

Use this search when the respondent’s name is illegible but the address is not. For example, if 
a respondent provides the address 123 A St Missoula, MT 59802, but the name is illegible, 
enter the address into any number of reverse search sites listed in Section 4.5.3 Helpful 
Websites, to search for the complete name. 

The reverse lookup sites usually provide a field for email addresses that are useful if the 
respondent only provides their email address. Occasionally, the search will turn up an 
address or city and state. 

Reverse lookup searches can be broad or narrow depending on how much information is 
provided. 
People Search 

This search requires a last name, a city and a state. Use this type of search to find the 
complete mailing address of a respondent. Even if the only information provided by the site 
is a city and state, that information should be added to the MID for demographic purposes. 
Map Search 

The map search is useful if the respondent misspells any address components and the Zip+4 
Website cannot verify the address. The map search can also be helpful if the respondent 
provides a corner address. 
Acronym Search 

Use this search if a respondent uses an acronym that is not listed in the Master Acronym List. 
International Address Search 

If a letter is from a foreign country, use this search to clarify the respondent’s address. 
International People Search 

If a letter is from a foreign country, use this search to clarify the respondent’s name. 

4.5.2 ~ 

4.5.3 ~ 

Saving Frequently Used Websites 
Click on Start> Programs> Internet Tools> Internet Explorer. 

Open the web page to be saved by entering the web address in the address field, (e.g., 
www.m-w.com (Merriam Webster On-line dictionary)). 

Open the Favorites window by clicking on the Favorites button at the top of the window. 
The Favorites window opens to the left of the window currently displayed. 

Click on the Add button in the Favorites window. The Website is now saved in the Favorites 
window. 

Helpful Websites 
The following Websites can be helpful in creating and editing MIDs. 
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Lookups 

Area Codes and Phone Find: http://www.primeris.com/fonefind/ - Provides city and state 
possibilities when inputting area code and/or prefix. 

Advanced Name & Address Lookup: www.anywho.com/wp.html  

Ultimate White & Yellow Pages: www.theultimates.com/white/ - Provides white and 
yellow pages searches, an email directory, map sites and reverse phone number searches. 
Each site provides about six different search engines for one search topic. 

US West White & Yellow Pages: www.qwestdex.com/ - Provides searches for businesses, 
residential listings, government listings, and toll free phone numbers. 

Google: www.google.com/ - Large search engine, providing searches for people, business 

Webcrawler People Search: www.webcrawler.com/ - Provides links to yellow pages, people 
searches, maps and directories.  

Yahoo People Search: www.people.yahoo.com

White Pages: www.smartpages.com

Advanced Business Search: www.anywho.com/bgq.html  
Reference 

LookUp Directory: www.infospace.com - Provides links to map guides. 

Yahoo Reference: www.dir.yahoo.com/Reference/ - Provides links to acronym and 
abbreviation websites and dictionaries. 

Thesaurus & Dictionary: www.m-w.com/home.htm

Ask Jeeves: www.askjeeves.com

Acronyms: www.acronymfinder.com
Postal Information 

Zip+4 Code/City/State Zip Code Associations Lookup: www.usps.com/zip4/

Yahoo Postal Info (countries): www.dir.yahoo.com/Reference/Postal_Information/ - 
Provides links to several sites providing postal code information to various countries and to 
USPS sites. 

Canadian Postal Codes: http: www.westminster.ca/

International Postal Standards: www.bitboost.com/ref/international-address-formats.html

International Directory: www.cern.web.cern.ch/CERN/Divisions/SPL/INFO-PAGE.html - 
Provides an international people search. 

Postal Information and Resources: www.postinfo.net

Australian Postal Information: www.auspost.com.au/international/
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Government Information 
Executive Branch Agencies: www.whitehouse.gov/government - Provides links to the three 
branches of government and to federal and independent agencies like the FBI, IRS, and the 
USPS. 

Links to House/Senate members, addresses, etc.: www.thomas.loc.gov/ - Provides links to 
House and Senate members and their staff. 

US Fish & Wildlife Service: www.fws.gov

USGS Survey Results (Fact Sheets By State): www.water.usgs.gov/public/wid/index-
state.html
USDA FS directory: www.fs.fed.us/intro/directory

USDA FS/Region 1 directory: www.fs.fed.us/intro/directory/rg-1.htm

USDA telephone directory: www.usda.gov/phonebook - Provides links to agencies and staff 
offices in the USDA. 

BLM Directory: www.blm.gov/nhp/directory/index.htm

BIA: www.doi.gov/bureau-indian-affairs.html - The “links” page provides links to 
websites of tribes, intertribal organizations, environmental organizations and cultural 
organizations. The home page provides links to offices and divisions of the BIA. 

Agency Search: www.govspot.com - Provides links to local, state and world government 
sites. The three branches of government, justice and military links are also provided. 

Agency Search: www.firstgov.gov/ - Provides an excellent keyword search of government 
agencies. 

Search Site: www.ciir2.cs.umass.edu/Govbot/ - Provides a search of Government websites. 
This site has almost 1.6 million websites in its database.  
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Chapter 5 ~ United States Postal 
Standards for Addresses 
Use the most up-to-date postal standards to create the mail identification numbers (MIDs) 
used to print labels that are easily referenced by the Postal Service. (See Chapter 4, Mail 
Identification). The more consistently these standards are followed, the fewer discrepancies 
there are in the database. 

A standardized address is one that is fully spelled out with the only abbreviations according 
to the Postal Service standards as shown in the Postal Service ZIP+4 Website 
(http://www.usps.com/zip4/). 

 

 
Figure 5.1: Zip+4 Website 

 

 

Chapter 5 ~ US Postal Standards 5-1 

http://www.usps.com/zip4/


Technical Guide  
 

Jointly developed by the Postal Service and mailing industry, standardized address 
information enhances the processing and delivery of mail, reduces undeliverable-as-
addressed mail, and provides mutual cost reduction opportunities through improved 
efficiency. 

Section 5.1 ~ 

5.1.1 ~ 

5.1.2 ~ 

5.1.3 ~ 

Delivery Address Components 
Type all elements of the name and address in upper case letters and Arabic numerals. Avoid 
the use of non-alpha-numeric symbols (e.g. #, -, /) and non-standard abbreviations.  

 

 
 

101 W MAIN ST S APT 12

Secondary 
Address 
Identifier

Secondary 
Address 
Range

Post-directional 

Suffix

Street
Name

Primary 
Address 
Number 

Pre-directional 

Figure 5.2: Delivery Address Components 

Street Name 
The ZIP+4 Website indicates the preferred form for primary street name. 

Example: 

MID-ISLAND PLAZA should be MID ISLAND PLZ 

Directionals 
This is a term the Postal Service uses to refer to the part of the address that gives directional 
information for delivery (i.e., N, S, E, W, NE, NW, SE, and SW). Abbreviate directionals to 
the appropriate one- or two-character abbreviation. Refer to figure 5.2 for examples of pre- 
and post-directionals. 

Directional As Part Of Street Name 
The directional is not abbreviated if it is part of the primary name and appears between the 
street name and the suffix. Verify this at the ZIP+4 Website. 

Example:  

BAY W DRIVE should be BAY WEST DR 

5-2 Chapter 5 ~ US Postal Standards  



 Technical Guide 

Pound Sign (#) 

Avoid using the pound sign (#). Do not use the pound sign (#) as a secondary unit designator 
if the correct designation, such as APT or STE, is evident or is shown in the ZIP+4 Website. 
If you cannot determine whether the pound sign (#) is indicating an apartment number, suite, 
or some other element, and you must use it, put a space between the symbol and number. 
This is also true for international addresses. 

Example: 

1500 E MAIN AVE # 201 should be 1500 E MAIN AVE STE 201 

2585  MAPLE DR., APT # 34 should be 2585 MAPLE DR APT 34 

425 FLOWER BLVD #72 should be 425 FLOWER BLVD # 72 

5.1.4 ~ Suffixes 
Abbreviations 

The suffix of the address should conform to the standard suffix abbreviations listed in the 
ZIP+4 Website. 
Two Suffixes 

If an address has two consecutive words that appear on the suffix table, abbreviate the second 
of the two. The first of the two words is part of the primary name. 

For example: 

789 MAIN AVE DR should be 789 MAIN AVENUE DR 

4523 3RD ST CIRCLE W should be 4523 3RD STREET CIR W 
Numeric Street Names 

When there are duplicate numeric street names within a postal delivery area, one is spelled 
out and one is abbreviated. Enter numeric street names exactly as they appear in the ZIP+4 
Website.  

Example:  

7TH ST or SEVENTH ST   
Corner Addresses 

Corner addresses are replaced by physical street addresses. If a respondent gives a corner 
address with no primary address number, search for it on the Internet (Chapter 4, Mail 
Identification, Section 4.5). If the physical street address is not found, enter the corner 
address. 

Example:  

5TH AND HIGH should be 514 HIGH ST 
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5.1.5 ~ Rural Route Addresses 
Format  

  

Rural Routes are always 
abbreviated RR and 
include a Box number. H E BROWN 

RR 3 BOX 9  
CANTON OH 44730-9521  

 
Figure 5.3: Rural Route 

 

 

Example:  

RURAL ROUTE 2 BOX 152 should be RR 2 BOX 152 
 
Leading Zero 

Do not include a leading zero before the rural route number. 

Example:  

RR03 BOX 98D should be RR 3 BOX 98D 
Hyphens 

Include hyphens as part of the box number only when indicated in the ZIP+4 Website. 

Example:  

RR 4 BOX 19-1A is acceptable. 
Designation RFD and RD 

Change the designations RFD and RD (Rural Free Delivery or Rural Delivery) to RR 

Example:  

RFD ROUTE 4 #87A should be RR 4 BOX 87A 
Additional Designations 

There are no additional designations, such as town or street names, included with the rural 
route addresses. 

Example:  

RR 2 BOX 18 BRYAN DAIRY RD should be RR 2 BOX 18. 

Example:  

RR 3 BOX 22 NORTH HAMPTON should be RR 3 BOX 22 
If secondary name information is used, as in the Bryan Dairy Road example, place it in 
the Addr 1 field, and the Rural Route in the Addr 2 field of the Mail ID block. 
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5.1.6 ~ Highway Contract Route Addresses 
Format 

 

B G LIGHT CO 
HC 72 BOX 293A 
DULUTH MN 55811-9702 

Highway Contract Routes are always abbreviated HC 
and include a Box number.  Do not use the words 
HIGHWAY CONTRACT, ROUTE, NUMBER, NO., or 
the pound sign (#). 

Example: 

HIGHWAY CONTRACT ROUTE 68 BOX 
23A should be HC 68 BOX 23A Figure 5.4: Highway Contract 

 
Leading Zero 

Do not add a leading zero before the highway contract route number. 

Example: 

 HC068 BOX 98D should be HC68 BOX 98D 
Hyphens 

Include hyphens as part of the box number only when indicated by the ZIP+4 Website. 

Example:  

HC 68 BOX 19-2B 
Star Route Designations 

Change the designation STAR ROUTE, which usually refers to highway contract route, to 
HC 

Example:  

 STAR ROUTE 68 BOX # 45 should be HC 68 BOX 45 
Additional Designations 

Do not add designations such as town or street names to the highway contract route 
addresses.  

Example: 

 HC 72 BOX 18 BRYAN DAIRY RD should be HC 72 BOX 18 
If secondary name information is used, as in the above example, place it in the Addr 1 
field, and the Highway Contract Route number in the Addr 2 field of the Mail ID block. 

 
Highway Standardization 

The following are examples of county, state, and local highway primary names and the 
standardized format.  
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Example Standard 
COUNTY HIGHWAY 140 COUNTY HIGHWAY 140 
COUNTY HWY 60E COUNTY HIGHWAY 60E 
CNTY HWY 20 COUNTY HIGHWAY 20 
COUNTY RD 441 COUNTY ROAD 441 
COUNTY ROAD 110 COUNTY ROAD 110 
CR 1185 COUNTY ROAD 1185 
CNTY RD 33 COUNTY ROAD 33 
CA COUNTY RD 150 CA COUNTY ROAD 150 
*CALIFORNIA COUNTY RD 555  CA COUNTY RD 555 
EXPRESSWAY 55 EXPRESSWAY 55 
FARM TO MARKET 1200 FM 1200 
FM 187 FM 187 
HWY FM 1320 FM 1320 
HIGHWAY 101 HIGHWAY 101 
HIWAY 108A HIGHWAY 108A 
HWY 64 HIGHWAY 64 
HWY 11 BYPASS HIGHWAY 11 BYP 
HWY 66 FRONTAGE RD HIGHWAY 66 FRONTAGE RD 
HIGHWAY 3 BYP ROAD HIGHWAY 3 BYPASS RD 
KY ST HWY 1 KY STATE HIGHWAY 1 
KY STATE HIGHWAY 24 KY STATE HIGHWAY 24 
*KENTUCKY STATE HIGHWAY 625 KY STATE HIGHWAY 625 
KENTUCKY 440 KENTUCKY 440 
HIGHWAY 189 KY HIGHWAY 189 
KY 1207 KY HIGHWAY 1207 
KY HWY 75 KY HIGHWAY 75 
I10 INTERSTATE 10 
INTERSTATE 40 INTERSTATE 40 
IH280 INTERSTATE 280 
INTERSTATE HWY 680 INTERSTATE 680 
I 55 BYPASS INTERSTATE 55 BYP 
I 26 BYP ROAD INTERSTATE 26 BYPASS ROAD 
I44 FRONTAGE ROAD INTERSTATE 44 FRONTAGE RD 
ST HIGHWAY 303 STATE HIGHWAY 303 
STATE HIGHWAY 60 STATE HIGHWAY 60 
SR 220 STATE ROAD 220 
ST RD 86 STATE ROAD 86 
STATE ROAD 55 STATE ROAD 55  
SR MM STATE ROUTE MM 
ST RT 175 STATE ROUTE 175 
STATE RTE 260 STATE ROUTE 260 
TOWNSHIP RD 20 TOWNSHIP ROAD 20 
TSR 45 TOWNSHIP ROAD 45 
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Example Standard 
US 41 SW US HIGHWAY 41 SW 
US HWY 44 US HIGHWAY 44 
KENTUCKY 440 KY HIGHWAY 440 

*Excessive characters. Note: When the name of a state is used as a PORTION of the primary 
street name, the standard two-letter abbreviation is recommended. Spell out the state name 
completely when the state name is the complete primary street name, such as “OKLAHOMA 
AVENUE.”  

5.1.7 ~ 

5.1.8 ~ 

General Delivery Addresses 
Format 

Use the words GENERAL DELIVERY, do not abbreviate. Add “ –9999” to the end of the 
zip code. 

Example: 

MR JOHN ADAMS 

GENERAL DELIVERY 

TAMPA FL 33602-9999 

Post Office Box Addresses/Private Mail Boxes 
Format 

PO Boxes are always abbreviated PO BOX. 

Example: 

 

JANICE SMITH 
PO BOX 34 
DULUTH MN 55803-0034 

Figure 5.5: Post Office Box 

PO BOX 11890 

PO BOX G 
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Remove leading zeros in PO Box numbers as shown in the ZIP+4 Website. 

Example:  

PO BOX 00145 should be PO BOX 145 
Designations 

PO Box addresses often appear with the words CALLER, FIRM CALLER, BIN, 
LOCKBOX, or DRAWER. Change these to PO BOX. 

Example:  

DRAWER L should be PO BOX L 
Private Mailbox Address 

Private companies offer mailbox rental service to individuals or businesses. This service may 
require a “box” number for their final sort. Enter this number, with the appropriate designator 
(i.e., MSC (Mail Stop Code) or PMB (Private Mail Box)) in the MSC PMB field of the Mail 
ID block. The MSC or PMB number should never be placed in the Addr 1 or Addr 2 fields of 
the Mail ID block. 

Example: 

ABC COMPANY         should be     MSC 1587  

MSC 1587                                         ABC COMPANY 

12 E MAIN AVE STE 209               12 E MAIN AVE STE 209 

KRYTON TN 38188-3637               KRYTON TN 38188-3637 

 

Section 5.2 ~ 

5.2.1 ~ 

Organization/Business 
Addressing Standards 
Organizations and businesses often include nonessential information in their addresses for 
prestige purposes, and occasionally use multiple versions of their firm name. Organizations 
and businesses do not always apply abbreviation and compression tactics recognized by the 
Postal Service. This inconsistency can result in multiple MIDs and non-deliverable mail. 

The purpose of standard abbreviations and compression guidelines is to provide a uniform 
reference when there is a need to condense address data. The standards contain the following 
components: the preferred arrangement of address information, prioritization of optional line 
compression steps, and a table of standard abbreviations for the most commonly used 
business words. Adhere to these rules of standardization to create and maintain an accurate 
database. 

Address Information Compression Guidelines 
The Postal Service equipment reads a maximum of 40 characters per line with a maximum of 
8 separate words per line. If either parameter is exceeded, the entire line is ignored. Apply 
the following steps, if it is necessary, to reduce the number of words or characters from an 
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organization or business address. The organization/business name is printed on a single line 
for the purpose of creating a mailing label. 
Abbreviations 

Use the standard abbreviations for address information whenever abbreviations are 
necessary. These abbreviations are found in the Abbreviation list accessed in the Mail ID 
block.  
Right-to-Left Evaluation 

Evaluate each of the address data elements in each address line separately. Always work 
from the right to the left within each address line. 

Example: 

Big Business Incorporated is entered BIG BUS INC 
Special Characters 

Remove special characters, multiple blanks, and punctuation as listed below in this order: 
• * Asterisks, except in the Optional Endorsement Line 
• , Commas 
• “ ” Quotations 
• : Colons 
• . Periods 
• ; Semi-colons 
• ( ) Parentheses 
• ‘ Apostrophes 
• @ At 
• - Hyphens, except in hyphenated last names, otherwise replace with a space 
• / Back slash, remove spaces before and after the / 
• & Ampersand. 
•  Certain Words 

Replace or remove certain words as listed below. However, the use of the standard 
abbreviations is preferred over the removal of words. The following compression 
technique is applied only if there is not a standard abbreviation for the word, or to fit words 
into a Mail ID block: 
• Replace and with “&”. 
• Replace number words with numeric symbols: First with 1st. 
• Remove etc., i.e., in care of, and et al. 
• Remove words like the, of, by, for, at, and also. 
• Remove ATTENTION, ATTN: Attention is a Mail ID block field option. 
• Remove gender words like MS, MRS, MISS, MR, SIR, and ESQ. 
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Alternate Location 

When the mailing address information (e.g., APT or STE) is part of the address but does not 
fit in the Addr 1 field, all secondary components should be placed in the Addr 1 field and 
the rest in the Addr 2 field. 
Standard State Name Abbreviations 

An individual state name that appears anywhere in a business or organization address is 
abbreviated because of space restrictions. Use the Standard State Abbreviations found in 
the State field’s list of values in the Mail ID block. Whenever possible, begin an 
organization’s name with the state. 

Example:   

The State Assembly of California is entered CA ASMBLY. 
Repetitive Word Removal 

Remove repetitive words; however, standard abbreviations are preferred over word removal. 
The compression technique in this step is applied only if standard abbreviations do not meet 
data entry needs. 

Example: 

GOODMAN GOODMAN WILSON & HAROLDSON 

GOODMAN WILSON & HAROLDSON – Repetitive word 
removed. 

Vowel Removal 

It is recommended that vowels not be removed if the desired address information can be 
compressed by first using the standard abbreviations. 

If necessary to remove vowels, from the right side of the address lines, beginning with the 
rightmost word, remove vowels on a word-by-word basis to achieve desired compression. If 
the first character of a word is a vowel, do not remove that character. It is also recommended 
that the vowels not be removed from the leftmost words. 

Section 5.3 ~ 
5.3.1 ~ 

Military Addresses 
Overseas Locations 

Enter overseas military addresses in the MID form, 
not in the Foreign MID form. Overseas military 
addresses contain the APO or FPO designation along 
with a two-character “state” abbreviation of AE, AP, 
or AA and the ZIP Code or ZIP+4 codes. 

 

SSGT KEVIN BEASLEY 
UNIT 2050 BOX 4190 
APO AP 96522-1215 

Example: 

APO AE 09001-5275          

FPO AP 96606-278 
Figure 5.6: Military Address 

APO AA 34035-4198 
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APO stands for Army and Air Force Post Office. 

FPO stands for Fleet Post Office. 

AE is used for armed forces in Europe, the Middle East, Africa, and Canada. 

AP is used for armed forces in the Pacific. 

AA is used for armed forces in the Americas excluding Canada. 

5.3.1.a ~ 

5.3.2 ~ 

Section 5.4 ~ 

 APO/FPO Military Addresses Standardization 
Enter APO or FPO in the City field, AE, AP, AA in the State field and the Zip code in the 
Postal Code field. Standardize the APO/FPO military addresses as follows:  

 

SGT ROBERT SMITH  SGT KEVIN TAYLOR SEAMAN JOSEPH DOE 

PSC 802 BOX 74   UNIT 2050 BOX 4190 USCGC HAMILTON 

APO AE 09499-0074   APO AP 96278-2050  FPO AP 96667-3931 

Domestic Locations 
Use only the approved city name as listed in the City State File at the ZIP+4 Website, 
along with the two-character abbreviation and the ZIP Code or Zip+4 code. 

Example:  

MINOT AFB ND 58705-1253 

International Addresses 
Print your delivery addresses in all uppercase letters. If possible, addresses should have no 
more than five lines. 
 
The full address should be typed or legibly written in English using Roman letters and Arabic 
numerals. An address in a foreign language is permitted if the names of the city, province, 
and country are also indicated in English. 
 
The last line of the address block area must include only the complete country name (no 
abbreviations) written in uppercase letters. (Alternative format for Canada shown below.) 
 
Foreign postal codes, if used, should be placed on the line above the destination country. 
Some countries prefer that the postal code follow the name, while others prefer that it 
precede the city or town name. The following shows the order of information for the 
destination address: 
 
LINE 1: NAME OF ADDRESSEE 
LINE 2: STREET ADDRESS OR POST OFFICE BOX NUMBER 
LINE 3: CITY OR TOWN NAME, OTHER PRINCIPAL SUBDIVISION (ie, PROVINCE, 
STATE, COUNTY, ETC.) AND POSTAL CODE (IF KNOWN) (Note: in some countries, 
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the postal code may precede the city or town name) 
LINE 4: COUNTRY NAME (UPPERCASE LETTERS IN ENGLISH) 
 

The following are examples of properly formatted delivery addresses: 

MS JOYCE BROWNING  
2045 ROYAL ROAD  
LONDON WIP 6HQ  
ENGLAND 
 
MS JOYCE BROWNING  
2045 ROYAL ROAD  
06570 ST PAUL  
FRANCE 
 

For mail to Canada, the location of the country name and postal code are interchangeable: 
either one may be placed on the last line, with the other one placed after the city and 
provincial name. 

The following are examples of destination addresses to Canada: 

MS HELEN SAUNDERS  
1010 CLEAR STREET  
OTTAWA ON K1A 0B1  
CANADA 
 
MS HELEN SAUNDERS  
1010 CLEAR STREET  
OTTAWA ON CANADA  
K1A 0B1 
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Chapter 6 ~ Entering Comments in 
the Content Analysis Application 

Coded Working Copy to Data Entry 

Enter Letter Attribution Info 

Link Letter to Mailing Information 

Enter Comments 

File Working Copy 
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6-2  

Use the Content Analysis form to capture the comments of respondents and attach the 
comments to the respondent’s mailing information. The Content Analysis form includes 
the Project/Phase/Stage of Process block/table, the Letters block, the Respondents 
block, and the Comments block. Navigate from block to block by pressing <Ctrl+Page 
Down> or click the Next Block icon. 

Section 6.1  ~ Project/Phase/Stage Of Process 
Block 
This block contains the codes to distinguish between various projects. Identifying a project is 
the first step to enable tracking of a project. 
Project  

Query the project code in this field. This is an up to six-character alpha/numeric code. Note: 
If you use the mouse to access the Project LOV, you do not have to Execute Query. If you 
use the function keys, [F9], or key in the Project ID, you do.  
This code is unique to each project. 

Example: 

The Sierra Nevada Framework Project is entered as SNFP. 
Phase and Stage of Process 

Enter the project code and these fields fill automatically. The phase is entered as a one-
character alpha/numeric code, and the SOP is entered as a one character numeric code. Phase 
is used to denote whether this project is for scoping, a draft EIS, a proposed or interim rule or 
directive, or a final rule, policy, EIS, or plan. Stage of process can be used for a variety of 
purposes, and is most often used now to differentiate between internal and external comment. 
Different project IDs are used to differentiate between phases of projects in Oracle as well. 

Note: If the application is in query mode, and you do not use the LOV, but key in the Project 
ID, you must also key in the Phase and SOP. Then when you Execute Query, the descriptions 
will fill.  

Phase and Stage of 
Process fill automatically

Enter Project Code here 

Figure 6.1: Project/Phase/Stage of Process  

 

Example of Phase: 

DEIS Phase is entered as “D.” 
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Section 6.2   Letter Attribution Block 
The Letter Attribution information is found in the string of boxes at the top of the letter. The 
boxes correspond with the following fields used to complete the Letter Attribution Block: 
Response Type, Delivery Type, Immediate Attention, User Type, Letter Generator, Form 
Number, Common Interest Class, Request for Information, Comment Period Extension, and 
Total Signatures. Check with the coding staff if any information is missing or inconsistent 
with project parameters. 
 

These fields fill 
automatically 

Enter Letter 
Attribution Info 

 
Letter No (Number) Field (required) 

Enter the letter number, an up to six character numeric code, found in the upper right-hand 
corner of the letter. If the letter has already been entered, the following message will be 
displayed: “row exists already with same ProjID, Phase, SOP, Letter No.”  If this message 
appears, it is necessary to query the letter number. A query should reveal that:   
• The header or letter attribution information has already been entered. Begin comment 

entry. 
• The letter number was entered incorrectly. This will require some investigation: 

• In the Mailing List Application, query the MID attached to the letter number. Ensure 
that the correct letter number is in the remarks field.   

• The letter number field is a protected field and can only be updated by the computer 
technician. Follow protocols for correcting protected fields before proceeding with 
entry of this letter.  

• The letter has already been entered and is an actual duplicate letter. This should rarely 
occur because of the use of numbered labels when numbering letters. However, the copy 
machine will occasionally produce two copies of the same letter. If this is the case, shred 
the duplicate letter. 

• Two separate letters received the same letter number. This should also occur very rarely 
because of the use of numbered labels when numbering letters. If this happens, do the 
following:  
• Search for the respondent in the project log to see if the letter number has been 

changed. If not, the person responsible for letter number corrections assigns a new 
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number for the working copy, corrects the original and clean copies, and, on a daily 
basis, informs the log manager of the reassigned letter numbers. 

• On a weekly basis, the log manager records the newly assigned letter numbers in the 
working log. 

• Data entry enters the letter after a new letter number has been assigned, and corrects 
the MID information when necessary. 

Response Type Field (required) 

Enter the up to two-character numeric code for the type of letter. 
Delivery Type Field (required) 

Enter the up to two-character alpha code for how the letter was delivered. 
Immed Attn (Immediate Attention) Field 

Enter the up to two-character alpha/numeric code. A red post-it flag is attached to the left 
side of the page with the Immediate Attention code written on it. 
User Type Field 

Enter the up to four-character alpha/numeric code. This is an optional field provided at the 
clients’ request. 
Letter Generator Field 

Enter the numeric code. 
Form No (Number) Field  
Enter the number of the form, found in the Letter Attribution information.  
CIC (Common Interest Class) Field  

Enter the up to five-character alpha/numeric code. This is an optional field provided at the 
agency’s request. 
Request for Info (Request for Information) Field 

Enter the up to five-character alpha/numeric code. The code is written on a blue “Post-It 
Flag” and attached to the left side of the working copy. If the letter is a FORM with 
additional comments that has been designated "non-codeable" by a coder, then enter an “A” 
in this field for “mailing list only”. 
Cmt Ext (Comment Period Extension) Field  

Enter the alpha/numeric code. 
1st/2nd Read Initials and Dates Field  

Enter the coder initials for the corresponding comments, and then enter the date that the letter 
was coded found in the lower right-hand corner of the letter. If the letter was only read once, 
then leave the 2nd Read fields blank.  
Total Sigs (Signatures) Field  

Attach one or more mail identification numbers (MID) to a letter and the number of 
signatures is automatically tallied. 
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Entered By, Entered Date, and Entered Time Fields 

Commit the comments and these fields are automatically filled. 
Modified By and Date Fields 

Modify the record and these fields are automatically filled. 

Section 6.3  Respondents Block 
This block contains the mailing information to which the comments are attached. 

6.3.1.a  Mail ID Field (required) 

Mailing 
Information 
fills in 
automatically 

Enter the Mail 
ID in this field 

The Mail ID is written in erasable red ink in the 
string of boxes in the upper left-hand corner of the 
letter. Enter the respondent’s Mail ID number in the 
Mail ID field. After pressing Enter, or [F10] 
(Commit) the respondent’s name and address will 
automatically be displayed.  

If the letter has more than one MID, enter the first 
MID then press the down arrow to clear the field. 
The MID field must be empty every time a new 
MID is added or the existing MID in the field will 
be replaced. (It is not necessary to commit after 
each new MID is added.) 

If the respondent’s Mail ID number is not known, 
there is a pull down menu next to the MID field that 
lists all the MIDs for that project.  

Figure 6.3: Respondents Block

A master mailing list box will open. Use the Find 
function to locate the 
respondent’s MID and click 
OK or press the Enter key. 
This inserts the record into the 
field. 

Figure 6.4: Project Respondents drop-down menu

If the MID is not listed in this 
box, it means the respondent’s 
MID is not attached to the 
project listed in the 
Project/Phase/Stage of Process 
block above. To enter more 
than one MID per letter, use 
the down arrow in the MID 
field, enter the additional MID. 
Add the Org Type and number 
of signatures for that MID. 
Commit.  
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Org Type (Organization Type) Field (required) 

The Organization Type code identifies a specific type of organization, association, 
government agency, elected official, or individual. 
Sigs (Signatures) Field (required) 

It is possible for more than one name to be associated with one MID (e.g., if more than one 
person signs their name to a letter). This field indicates the number of signatures associated 
with the MID. 

Section 6.4  Comments Block 
The respondents’ comments are entered in 
this block. The coding team selects the 
comments to be entered by highlighting 
them. They then write the following codes in 
the margin next to the comment: Subject, 
Category, and Category 2; one some projects 
there may also be one or more of Site 
Specific 1 and 2 and Optional 1 and 2 codes. 
(White fields indicate the codes are 
optional.) These numeric codes are entered 
in their corresponding fields. Press [F9] 
while the cursor is in any of these fields or 
click the drop-down menu button for the 
appropriate list of values. 

Enter Comments in This Space 

The Coding Staff 
provides these 
codes 

Figure 6.5:Comments Block 

The keyboard shortcuts <Ctrl+L> or [F6] act 
as the insert record function in the comment 
field. They also move the cursor from the 
comment field to the comment number field. 
Comment Amended Check Box 

If a Coder/Analyst has changed any comment codes after the comment has already been 
entered into the database, there will be a check in the Amended Codes Box.  

 
Comment No (Number) Field 

Data Entry personnel numbers each coded comment in erasable red ink, and sequentially 
enters these in the Comment Number field.  A “comment” is a coherent segment of text that 
will stand-alone as a suggestion, idea, request, or critique. Sometimes the same comment is 
scattered throughout the letter so pay attention to the numbers and any “(cont.)” notes or 
arrows used by the coders. 
Subject Field  

Enter the five-character alpha management action code.  
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Example: 

 A subject code for wildlife related comments might be “RECRE.” 
Category Field 

Enter the to five-character numeric management action code.  

Example:  

 A category code for RECRE might be “45000.” 
Category 2 Field 

Enter the up to five-character alpha/numeric code in this field. This field is used for the 
rationale code.   
Site Specific 1 and Site Specific 2 Fields 

Enter the up to five-character alpha/numeric code in these optional fields.   
Optional 1 and Optional 2 Fields 

Enter the up to five-character alpha/numeric code in these optional fields.  

6.4.1  Entering Text 
After a letter is coded, it is returned to data entry to be entered into the database in such a 
way as to maintain the integrity of the comment.  

For speedier proof reading, the comments are first entered in a Word document, then cut and 
pasted into the Comments Block. Comments received electronically can be saved as a Word 
document. Enter the comments for the letter, then go to the Tools pull down menu and select 
Spelling and Grammar. Make any corrections necessary. After spell checking, cut 
<Ctrl+x> each comment then paste <Ctrl+v> each comment into the Comments 
Block.

• Correct all of the respondent's spelling and punctuation errors made within the comment.  
• If a sentence is unclear due to a missing word, but the meaning is obvious to data entry, 

add the missing word or words by using brackets ([ ]) to indicate the insertion.  
• When beginning a paragraph do not indent. Always separate paragraphs with a blank 

line. 
• If a respondent uses capitalized words for emphasis, DO NOT type in capital letters to 

show the emphasis. Letters written entirely in capital letters need to be retyped in lower 
case letters.  

• Legal documents or Resolutions should be typed exactly as they appear. 

Example: 
                      WHEREAS, the court......  OR 
                      THEREFORE, the city of..... 
• If a respondent uses an acronym, spell it out in brackets following the acronym unless it 

is a commonly recognized one. Check the acronym list (see appendix B) to see if it’s is a 
common acronym or not. If the acronym is not on the list at all, and you know what it 
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means, add it to the acronym list for that project. Otherwise, briefly search the Internet to 
find it so it may be added to the list.   

• If a respondent uses a bullet (●), replace it with a dash (-). 
• If a respondent uses quotation marks (“) for emphasis, they should be entered as such.  
• If a respondent uses the section symbol (§), replace it with [section]. 

Example: 

Enter §23456.82a as [section] 23456.82a. 
• If a respondent uses the ampersand symbol (&) in a comment, replace it with the word 

"and." 

Example: 

Enter My Family & I as My Family and I 
• If a respondent uses strikethroughs to show that they disagree with a particular statement, 

use the following: [delete] and then type what they are crossing out. 

Example:  

“The reservation shall cede the following”   should be entered as: 

 [delete] The reservation shall cede the following [delete]
• If a respondent uses bold, italics, highlights, or underlines, do not indicate an emphasis. 
• If a respondent has a word or words in brackets, enter the comment using double 

brackets. This indicates that data entry personnel did not add them. 

Example: 

Enter [choose] as [[choose]] 
• If a word or words are illegible, indicate this with a question mark in brackets: [?]. 
• If there are coded attachments to the main body of a letter, enter the coded attachments. 

Each separate attachment should be numbered at the top of the first page, and the title of 
the document should be marked and coded. Enter the codes as usual. In the comment 
field, first enter the attachment number in brackets; for example, [ATT 1], then type in 
the title and author that has been marked by the coder, as well as any additional notes 
they have written. If any comments within the attachment have been coded, place the 
attachment number in brackets before the text of the comment. 

• If a letter contains footnotes that are coded, include the footnote with the coded comment 
it references unless the coded footnote is coded differently (Subj./Cat.) then do the 
following: 

Example:  

Enter Footnote comment separately [see cmt 2 as a reference] 
• After entering a comment in Microsoft Word, CHECK YOUR TYPING ACCURACY 

(Spell Check) then cut and paste into Oracle, press [F10] to commit and save. The first 
commit will save all records in the form, such as the MID and Project ID fields. To enter 
the next comment, press [F6] or <Ctrl+L> or click the Next Record icon to insert a new 
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record. The status bar at the bottom of the screen will register the number of comments 
accepted. 

• If a comment is over 4,000 characters (In Word go to Tools>Word Count), you must 
continue the comment on the next comment screen. Enter the appropriate comment 
number, subject, category, category 2, site specific and optional codes.  Begin the 
extended comment with (cont from cmt no.__). 

After completing entry of the comments, initial and date the letter in red ink under the Mail 
ID number. Draw a diagonal line across the comments (also in red ink) to indicate the letter 
has been entered. 
Modifying Protected Fields 

There are certain fields in the CAET Program that are entered and committed, which can 
only be modified by Oracle computer personnel. In the Content Analysis application, these 
are the Project ID field, the Stage of Process field, the Phase field, and the letter number 
field. 
• To correct errors in these protected fields, record the problem in the “Problems” project 

folder on the network drive. 
• Make instructions specific. 

Example: 

Enter: “change letter number 215 to 214” in the Problems folder. 
• Initial and date the instructions. 
• If it is not possible to enter the letter until after the correction has been made, put it in the 

Project Problem folder found in the project’s bin.  

For example: 

If an incorrect letter number is entered in the letter number field, 
inform the computer technician, and then place the letter in the 
Project Problem folder in the project bin. It will be entered after the 
incorrect letter number has been corrected in the database. 

Section 6.5  Converting Electronic Text 
Using Electronic Data 

For some projects, letters can be obtained via the Internet or other electronic formats. When a 
letter is available in .TIF (a very large high quality image) or .PDF (Adobe Acrobat Portable 
Document) file format, it is possible to enter comments into Content Analysis by converting 
the letter into text and then cutting and pasting. This conversion is done by using Optical 
Character Recognition (OCR).TIF Files. 

 
6.5.1  .TIF Files 
• Locate the .TIF file on the Internet or e-mail that you wish to copy comments from. Click 

on the file you wish to convert. 
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                                                                Figure 6.6: Locating .TIF File 
 

• A window will open telling you that you have chosen to download a file. Click OK. 
• A Save As window will appear. Save the document to your Desktop and name it the 

number of the letter you are entering into Content Analysis. Click Save. 
 
 
 
 
 
                            
 
 
   Figure 6.8: Saving .TIF File 
 

• A Download Complete window will appear. From your Desktop, open the 
downloaded document. 

 
 
 
• The first page of the 

document will 
appear with the 
additional pages in 
a vertical row on 
the left side of the 
screen. 

 
 
 
 
 
 

 
Figure 6.9: .TIF File  
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                                     Figure 6.10: Send Text to Word Button           

 
• From the File drop-down menu, select Send Text to Word.... OR click on the Send 

Text to Word button on your toolbar 
                                                
 

• An Error Message reading "Microsoft Office Document Imaging must recognize 
the text in this document (OCR) before you can perform this operation. This 
may take a while" will pop up. Click OK. It usually takes a few seconds.  

 
Figure 6.11: OCR Error Message 

 

 
Figure 6.12: OCR Text Recognition 

 

• When OCR is finished recognizing text, a Send Text to Word message will appear. 
Select All Pages > OK. 
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Figure 6.13: Text to Word Box 

 

• After a few moments, a document will open in Word format. 

Proofread for any errors that OCR may have made in its text recognition process. It is crucial 
to correct errors, or it may change the entire context of a letter.  
• Cut and paste into the Comments Block in the CAT Program. (See Entering Text) 

On your desktop screen, you will notice that the letter icon you have downloaded will still 
appear. When you are finished with the letter, downloaded pages can simply be deleted. 

6.5.2  .PDF Files 
• Locate the .PDF file on the Internet or e-mail that you wish to copy comments from. 

Click on the file you wish to convert, just as you would for a .TIF file. 
• Adobe Acrobat Reader will automatically open, and the selected file will appear. Find the 

page you wish to copy. 
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Figure 6.14: Adobe Acrobat Reader 
 
 
 
 

 
 
• Select the Text Select Box on the Adobe Toolbar. 
 
               Figure 6.15: Text Select Box    
 
 

                                                                        
 
 

• Right Click on the Document, and Select All to 
highlight the text in blue. 

 
 

 
Figure 6.16: Select All 
 

• Right Click on the blue text and Copy. 
 
 
 
 
 
                                                          Figure 6.17: Copying Text 
 

• Paste the selected text into an open Word document. 
Proofread for any errors that may have been made in the text recognition process. It is crucial 
to correct errors, or it may change the entire context of a letter. 
• Cut and paste text into the Comments Block in the CAET Program. (See Entering Text) 

 

6.5.3  Helpful Hints 
• To make proofreading the converted text easier, use the Show/Hide feature button on 

your toolbar to see where Hard Returns are located.  
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Section 6.6  Forms In The Content Analysis 
Application 
Within the Content Analysis application are five other forms useful to data entry and coding 
personnel. They are the Header Entry form, the Replicate form, the Query Comments 
form, the Immediate Attention form, and the Request for Information form. They are 
accessed by way of the buttons found at the bottom of the Content Analysis form. 

This button opens 
the Replicate form. This button opens the 

Query Comments form. 

This button opens the 
Header Entry form. 

Figure 6.18: Buttons for Advanced Features in the Content Analysis Application. 

6.6.1  Header Entry Form 
The Header Entry form is useful for quickly entering form letters. The form letter header or 
letter attribution information is entered first and then all corresponding letter numbers and the 
corresponding MID numbers can be attached all at once. (For a description of form letters 
see Chapter 1). Form letters are organized before entry by corresponding header information. 

Example: 

Combine all of the Form letter #5’s with the header information “I-1-
1” into one group for quick entry.  

This form is also used when the header information for a group of letters is entered in the 
database before the comments are coded. This is done for an advanced look at demographic 
information. 

From the Content Analysis application press the Header Entry button found at the bottom of 
the form. The Header Entry form will open in the query mode and the project ID must be 
queried before continuing. 

The Header Entry form has three blocks: the Project/Phase/Stage of Process block, 
the Header Information block, and the Letter Numbers/Respondents block. 

Project/Phase/Stage of Process 

The form opens in query mode. Query the appropriate project. Check that the Phase and the 
Stage of Process fields are correct. (See Ch. 6, Project/Phase/Stage of Process Block) 
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Phase and Stage of Process 
fill automatically

Enter Project Code here 

Figure 6.19: Project/Phase/Stage of Process Block 

Header Information/Letter Attribution 

Navigate to the header block. Enter the form letter’s header information into the 
corresponding fields. Each field has a pull-down menu to describe the entries.  

 

Enter the Form's Header Information 
into these fields 

Figure 6.20: Header Information Block 

Letter Number/Respondent Information 

After entering the header/letter attribution information, attach the corresponding letter and 
MID numbers by entering them in the appropriate column. There is no limit to the number of 
letters and MIDs entered in this form before saving the information.  

After entering the corresponding letter numbers and MIDs, click the Execute button to save 
and validate the information. Start the process over with a different header. (The Commit 
button is not functional.) The Execute function first checks that the MID and letter number 
are attached to the project listed in the Project field, then commits the information entered in 
the letter number and MID fields. 

In certain circumstances, data entry enters the header information before the letter is coded to 
establish the demographics in the database more quickly. This allows the team to run 
demographic reports before the project has been completed. When you've entered the header 
information, place the letters in the Filing Bin to be filed. It is NOT necessary to write your 
initials in red ink to indicate you have entered them. 

Chapter 6 ~ Entering Comments in the Content Analysis Application 6-15 
 



Technical Guide  
 

You must press Execute to 
enter ‘the information into the 
database, not Commit 

Enter the corresponding 
letter numbers and Mail 
IDs in these fields. 

Figure 6.21: Header Entry Form 

6.6.2  Replicating Form 
Use the Replicate form to copy the comments of one letter and paste them into the 
comments of another letter. 

From the Content Analysis form click the Replicate button found at the bottom of the form. 
The Replicate form opens in the query mode and the project ID is queried before 
continuing. 

The Replicate form has three blocks: the Project/Phase/Stage of Process block, the 
Letter to Be Replicated block, and the View Comments block.  
Project/Phase/Stage of Process  

The Replicate form opens with the Project/Phase/Stage of Process block in query 
mode. Query the appropriate project. Check that the Phase and the Stage of Process fields are 
correct.  
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Enter Project Code here 
Phase and Stage of 
Process fill automatically 

Figure 6.22: Project/Phase/Stage of Process Block 

Letter to be Replicated 

Verify that the header information for the letter having comments added to it is entered and is 
correct by querying it in the Letter to be Replicated block. Then query the letter to be 
replicated.  

Enter Letter Number here 

Figure 6.23: Letter to be Replicated Block 

View Comment 

Query the first comment to be replicated in the View Comment block. 

Example: 

Figure 6.24: View Comments Block 

Query the first comment to 
be replicated here 

If comment numbers 3, 4, 5, and 6 are to be replicated, query 
comment number 3. Verify that this is the correct comment. 
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There are three fields in the lower right-hand corner of the form: the Last Original 
Comment field, the New Letter Number field, and the New First Comment Number 
field. 

• Enter the last comment number to be replicated in the Last Original Comment 
field. 

Examp e: 

Text o  Comment appears in this field 

If repl

T

• Enter the let
Number fiel

• If the letter h
the appropri

Examp

If the 
Numb

After entering all of
has completed succ

6.6.3  Query 
Use the Query Com
another letter. This 
comment and want 
replicated. 

6-18 
l

f

icating comments 3, 4, 5, and 6, enter 6 in the field. 
ter number of the letter the comments will be added to in the New Letter 
d. 
aving the comments added to it already has comments of its own, enter 

ate number into the New First Comment Number field. 

le: 

letter has 8 comments, enter “9” into the New First Comment 
er field. 

 the information, click the Execute button. The message “Replication 
essfully” appears on the screen. 

Enter the letter number the 
comments will be added to.

Enter the last comment number 
to be replicated here. 

Enter the number the comments 
will begin with here. 

You must click Execute to 
enter the information into the 
database, and not Commit. 

Figure 6.25: Replicating Form 

Comments Form 
ments form to determine if the comments of one letter match those of 

is helpful to the coding staff when they recognize certain phrases in a 
to ensure that they are not coding a duplicate letter or a letter than can be 
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From the Content Analysis form click the Query Comments button found at the bottom 
of the form. The Query Comments form opens in the query mode and the project ID is 
queried before continuing. 

The Query Comments form has two blocks: the Project/Phase/Stage of Process block 
and the Comments block. 
Project /Phase/Stage of Process  

The form opens with the Project/Phase/Stage of Process block in query mode. Query the 
appropriate project to retrieve all of the comments entered for the project to date. Check that 

the Phase and the Stage of Process fields are correct.  

Figure 6.26: Project/Phase/Stage of Process Block 

Enter Project Code here Phase and Stage of Process 
fill automatically 

Comments 

Pressing <Ctrl+Page Down> moves the cursor to the Comments block. Query by any word 
or phrase in this field using the “%” (See Section CH 4, Performing a Query). If no records 
are retrieved the field remains in query mode.  

Query by a word or phrase in these fields 

After querying the project, all comments entered 
for the project to date appear in these fields

Figure 6.27: Comments Block 
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6.6.4  Immediate Attention Form 
This form is used to further document Immediate (Early) Attention letters. After completing 
data entry of Immediate Attention letters, Query the project and all the IA letters for the 
particular project will appear in the form. In the remarks field, enter a short summary of why 
the letter needs early attention. For instance, if it receives a FOIA request IA code, then a 
remark comment might look like this: 

Example: 

(Enter initials) This request needs to be filled by August 15, 2003 
due to the FOIA time period. 

Note: The Immediate Attention manager needs to enter a remark for all letters or 
the Immediate Attention Report will not include those letters (See the Database 
Report, Appendix D). 

 

 
 
Figure 6.28: Immediate Attention Form 
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6.6.5  Request for Information Form 
This form is similar to the Immediate Attention Form. You need to enter something in the 
remarks for the RI to run properly.  

Example: 

(Enter initials) Request filled on August 30, 2003. Sent copy of 
DEIS. 

 
 

 
 

Figure 6.29: Request for Information Form 
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Chapter 7 ~ Validation Process 
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Validation is the process by which a project database is checked for accuracy and 
completeness. Validation involves checking the information on a letter against the 
information in the database. In this chapter, some phases of validation refer to using 
“original/clean” letters. This is a matter of preference. If possible, use the original letter, as it 
contains more information. However, sometimes the original letters are sent to the client and 
are not available for use in the validation process. In this case, use the clean copies. 

Validation consists of three (with an optional fourth) phases. Phase I is a validation of the 
letter number, accounting for every letter and ensuring that the letter number is in the 
remarks field of the Mailing List form (See Chapter 4.1.2.a, Creating a New Mail ID, 
Remarks). Phase II is a verification of the name by corroborating the information on the 
letter number report, original or clean copies, and the project log. Phase III is a validation of 
the mailing information, which involves checking the MID Report against the working 
copies. Phase IV is a validation of the header information (See Chapter 6.2, Letter 
Information Block) and the comments entered in the database (See Chapter 6.4, Comments 
Block), which involves checking the header information and number of comments on the 
MID Report against the working copy of the letter. Note: Phase IV is required if a letter 
browser is being created for the project, otherwise it is optional. 

Section 7.1 ~ Pre-Validation Setup  
Do the following in preparation for the Validation process: 
• File all letters in ascending MID order. 
• Staple all duplicate letters to their corresponding letters and file them. 
• Print a copy of the Dup log with the letter numbers in ascending order. 
• Print a copy of the Out-of-Scope log with the letter numbers in ascending order. 
• Ask the log manager to print a copy of the “UNUSED” letter number portion of the 

project log to assist in finding missing letter numbers. 
• Ask the database administrator to print a copy of the last page of the letter number report 

before the full report is run. This page will indicate whether any mistakes were made 
during letter entry. 

Example: 

If the last letter number in the project is 12,051 then any number 
greater than 12,051 is incorrect. 

Section 7.2 ~ Phase I: Letter Number Validation 
Phase I accounts for all letter numbers and verifies the letter number in the Remarks field 
of the Mailing List form. 
Step One 

Identify inconsistencies in the numeric order of the validation report. 
• The project lead produces the letter number validation report with the letter numbers in 

ascending order. 
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• Ask the database administrator to run a missing letter numbers report with the letter 
numbers in ascending order.  

• Transfer the information derived from the missing letter numbers report to the letter 
number validation report. 

Example: 

If there is a gap between letter number 1201 and 1203, write the 
number 1202 between the two. This indicates a missing letter 
number(s) that must be accounted for later in the process. 

Step Two 

Account for duplicate letters, out-of-scope letters, and unused letter numbers. 
• Check the Dup log, the Out-of-Scope log, and the Unused Letter Number list for letter 

numbers not found on the validation report. These are the only legitimate reasons for a 
missing letter number. 

When the missing letter number is accounted for, record the number 
where it would appear on the report and the reason for the 
inconsistency. 

Step Three 
• Circle all duplicate letter numbers within the same column. 
 
 

Letter #  MID  Respondent 
     
     

4  65509  SABRINA BROCK 
    SPOKANE, WA  99203 
    Wl#4 
     

5  65509  SABRINA BROCK 
    SPOKANE, WA  99203 
      Wl#5 
     

6  65606  SHANNON MARTIN 
    BALTIMORE, MD  21224-6321 
    Wl#6 
     

7  62219  HAROLD CHRISTIANSON 
    NEW YORK, NY  10026 
    Wl#7 
     

7  62222  STEVEN WRIGHT 
    FARGO, ND  58102 
    Wl#7 
     

8  62228  CHERYL A MACCARONI 
    TITUSVILLE, NJ  08560-1619 
    Wl#8,f10#2251[Sl#d7560] 
     

8  62110  ANGELA HUGHS 

Figure 7.1: Duplicate Letter Numbers 
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Possible reasons for repeat letter numbers include letters with more than one Mail ID 
attached to it or more than one MID attached inadvertently. 
• Check the remarks on the validation report to verify whether the MID should be attached 

to that letter. 
• After each letter number on that page has been verified, make a check mark in the upper 

right corner to indicate the entire page has been reviewed.  
Step Four 

Investigate the missing letter numbers not found in Step 3.  
• Query the missing letter number in the Remarks field of the Mailing List form and 

compare the results with the letter number report. 

Example: 

To query Gray Wolf L#1234 enter %W%1234%. 

If the query is successful, the letter was assigned a MID, but the MID was not attached to the 
letter: 
• Write the MID next to the missing letter number on the validation report.  
• Check the Remarks field for information to determine why the letter number is missing 

on the validation report. This field also shows if a letter is a duplicate, a multiple-
signature document, etc. 

• Correct all errors. 

If the query is unsuccessful, either the letter did not receive a MID or the letter number was 
incorrectly entered in the Remarks field: 
• Check the originals and cleans to determine if a copy of the letter exists. 
• If it does, use the information to find it in the Mailing List form and the Content Analysis 

form. 
• Check the working copy of the letter to determine if it has been coded. If the letter has 

not been coded, give it to a member of the appropriate coding team to code. Once it’s 
coded, enter the letter and file it. If the working copy of the letter is coded, query the 
letter number in the Content Analysis form to verify that the letter is entered. If the query 
is unsuccessful, enter the letter and file it. On the validation report record “entered,” your 
initials, and the date next to the letter number.  

• If the working copy of the letter cannot be found, check the Comments column in the 
project log to determine if the letter is a duplicate, a petition, or an unused number. A 
letter number is most commonly unused because a letter number is skipped, the letter is 
out-of-scope, or the letter number was never reused. 

• If the working copy of the letter still cannot be found, the database administrator will 
search for it in the database using SQL. If this is unsuccessful, make a photocopy of the 
letter using the clean copy and stamp “COPY” on the first page. Have the “COPY” coded 
and entered. (If the working copy is eventually found it will replace the “COPY”). 

Always query in the Content Analysis application. Often the letter number is entered 
incorrectly and/or attached to the incorrect MID.  
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Step Five 

Verify that the letter number in the Remarks field is accurate. 

Fix any errors in the Mailing List form, and record all changes on the validation report. 

Section 7.3 ~ Phase II: Log Validation  
Phase II ensures that the letter number, name, organization, and e-mail address in the Project 
log match the letter number report and original/clean copy. 

First, compare the original/clean to the letter number validation report, and then compare the 
in the original/clean to the city, state, and zip in the code project log. Next, assure that the 
letter number, name, organization, e-mail address, and comments information on the 
original/clean match the information in the project log.  

Remember: The log person does not spend as much time searching for a respondent on the 
Internet as a data tech. Although the information entered into the log is usually accurate, 
defer to the validation report. 

Section 7.4 ~ Phase III: MID Validation 
Phase III verifies that the mailing information is consistent with the assigned MIDs.  

Compare the information on the original/clean with the “Mail ID for a Project” validation 
report to ensure that the correct MID is attached to the corresponding letter. 
• Compare the letter number on the working with the letter number on the validation report 

to ensure accuracy. 
• Compare the Org on the working copy with the Org on the validation report to ensure 

data entry standards are used.  
• Compare the full name on the letter with that in the database to ensure that the spelling is 

correct. 
• Compare any other mailing list information, i.e., PMB, Attn, Client, Title, FAX. 
• Compare the address on the working copy with the address on the validation report to 

ensure that the two coincide. MIDs must follow the Postal standards.  
• Compare the e-mail information on both the working copy and the validation report. 
• Compare the mailing list status on the validation report and the mailing information on 

the working copy to verify that the appropriate mailing status is assigned. Check in the 
comments for a request to be removed from the mailing list. 

• Verify that the correct form number is entered. 
• Verify that the remarks have the correct project code, document code, letter number, 

and/or form number. 

Place a check mark next to each of the aforementioned components of the MID to indicate 
the information on the validation report has been reviewed.  
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Make all corrections in the Mailing List form, and record the corrections on the validation 
report. When changing a letter number or MID, record the changes on the validation report 
and communicate this information if it affects another person’s validation report. 

Most duplicate letters are discovered in Phase I; however, some are missed. 

 Example: 

A duplicate letter is entered in the Mailing List form but not in the 
dup log, or a duplicate letter has been entered incorrectly in the 
Remarks field.  

If a duplicate letter is discovered, follow the protocols for resolving duplicate letters. (See 
Chapter 4.3, Protocol for Duplicate Letter) 

Section 7.5 ~ Phase IV: Letter Attribution 
Validation  
Phase IV ensures that the header or letter attribution information and the comments entered 
in the database match the working copies. A random ten percent of the working copies are 
checked. Verify that the header information on the letter matches the information on the 
validation report for the following: Org Type, No of Sigs, Response Type, Immediate 
Attention, User Type, Letter Generator No, Form No, Common Interest Class, Req for Info, 
and Cmt Ext. Correct any mistakes in the Content Analysis application. 

Verify that the number of comments coded on the working copy corresponds with the 
number of comments entered in the Content Analysis application. If the two values are 
inconsistent, query the letter in the Content Analysis application to determine the error and 
correct it. 

If a Coder/Analyst has changed any comment codes after the comment has already been 
entered into the database, there will be a check in the Amended Codes Box. It will not be 
necessary to change codes to match the working copy. 

 
Figure 7.2 

Remember: Always communicate clearly with the database specialist, make correction 
requests specific, and always confirm that the problem has been fixed.  
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Chapter 8 ~ Form Tally 
For large projects, the team may receive hundreds of thousands of form letters. Often in these 
situations, the decision will be made to not enter the names and addresses of everyone who 
submitted a form into the database. In this case, the forms are tallied. The Form Tally allows 
us to track how many of each type of form have been received, how many signatures are 
linked to each form, and from which state each form was sent. 

Select Form Tally > File drop-down menu in the Welcome form. 

Section 8.1  ~ Project/Phase/Stage of Process 
Block 
 

 

______________________________________________________________ 

 

Enter Project Code from 
the drop-down menu 

Phase and Stage of 
Process fill automatically 

Figure 8.1: Project/Phase/Stage of Process Block 
 
 

This block contains the codes to distinguish between various projects. Identifying a project is 
the first step in enabling the team to track the form information. (See Chapter 6.1 for a 
detailed description of each field) 

 

Section 8.2  ~ Entering Form Information  
Sequence Number, Form Number, Number of Signatures, and State Abbreviations will be 
used to capture the form information. 
 

 

 

 

 

Enter the Form Number Enter the Abbreviated State of Respondent(s)

Enter number of Respondents 
that have signed the Form Sequence Number 

fills automatically 
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Figure 8.2: Form Information  
 

 

Sequence Number 

This is the number of form letters that you have tallied for this group. This field fills 
automatically and will keep progressing after every form you enter.  Whenever possible, tally 
forms in groups of 100 or 200 in case an error/problem occurs. (See Section 8.4, Helpful 
Hints.) 

 
Form Number 

Forms are sorted during mail processing and will have a corresponding form number (See 
Section 1.4, Forms or Organized Campaigns). Enter this number once, and the same number 
will automatically appear for every form entered within this group.  

 

 

 
Figure 8.3: Entering Form Information 

 
 
Number of Signatures 

Enter the number of respondents that have signed the form. This field will automatically fill 
with a (1) every time you hit <Enter> unless you click in the field and manually change it. 
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State Abbreviation 

Enter the Abbreviated State of the respondent(s). Use the drop-down menu if you need help 
and ANON if there is no state provided.  

 

 

 

 
 

 
 

______________________________________________________________ 

 

 

 

 

 

 

 
Figure 8.4: State Abbreviations drop-down menu 

 

**When there is ONE form with multiple signatures from multiple states, count the number 
of signatures belonging to each state. Enter the TOTAL number of signatures belonging to 
each state in the Form Tally.  

Section 8.3 ~ Saving Tally Information 
When finished tallying a group of forms, click on the Commit Button.  

 
• If all information has been entered correctly, all fields will return blank and a message 

will appear at the bottom of the screen indicating how many records have been saved 
• Secure the group of tallied forms together with a rubber band or paper clip 
• In the top right-hand corner of the first form in the group; indicate the amount of forms 

tallied, the date, the form number, the State (or Misc. if there are several states tallied at 
once), and your initials in red ink 

• Place the tallied group of forms in the "Forms Tallied" bin located near the project filing 
bins 
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Section 8.4 ~ Helpful Hints 
Data entry personnel have found the following tips helpful in completing Form Tallies. 
• If a group of forms will not save, make sure that you did NOT hit the <Enter> key after 

your last entry 

 

The last field must contain 
an entry before it commits 

           Figure 8.5: Form Tally that cannot be committed  

• To remove a record, make sure appropriate record has gray fill, click on <Record, 
<Remove 

 
Figure 8.6: Removing a Record 

• To track your daily records, you may perform a query. To perform a query, click on the 
Queries button and a Query Screen will appear.  
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• If you have made a mistake, the database administrator may alter, add, or delete your 
records. 
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Chapter 9 ~ Coding 
Coding is the foundation of the content analysis process. It provides a starting point for 
identifying public concerns from letters, resolutions, forms, and public hearing transcripts 
whether sent in hard copy or electronically (all generically referred to as “letters” in this 
chapter). Specific codes are applied to each respondent’s comments, which are entered into a 
database. Database reports are then generated and analyzed to develop public concern lists, 
appendices, and summaries. The following description of the coding process explains the 
procedures CAT has used in conjunction with the CAET v1 Oracle program. Other methods 
and programs are available, some of which provide similar results and some which will have 
very different results. Contractors may use other processes or programs as long as they 
produce the same final outputs and the data can be downloaded into CAT’s Oracle database.  

Section 9.1  ~ The Art of Coding 
Public comment letters display a range of depth and emotion. They vary from bold, simple 
statements to highly detailed analyses of a proposal. Coders are charged with the task of 
dissecting pieces of correspondence and determining which statements compose complete 
thoughts that are relevant to the proposal, which are outside the scope of the proposal, and 
what each comment is actually saying. This section explains what a comment is and how to 
identify one in a comment letter. 

 
 
 

Although many Federal agencies use the word “comment” to describe any piece of 
correspondence submitted on a proposed action, the CAT uses the word much more 
specifically. The word “comment” can be defined as a coherent segment of text that will 
stand alone as a suggestion, idea, request, or critique. Each comment is assigned a specific 
Action and Rationale code listed in the coding structure. It is important to note that although 
the CAT approach requires consideration of every word a person writes, a letter may contain 
zero coded comments or dozens of coded comments.  
 
Public comments can range from general statements or questions (“I like this . . . I don’t like 
that . . . You should do this . . . Why are you doing that . .”) to specific discussion of details 
(“Your analysis of the grazing impacts on allotment 5 does not adequately assess the 
contribution of . . . .”). Coding focuses on identifying what the respondent is recommending 
that the agency do, either explicitly or implicitly, and the reasons or qualifiers they provide. 
 
Keep in mind that the main goal of public comment analysis is to consider all public 
concerns, evaluate their impact on proposed actions, and to facilitate accurate and 
comprehensive responses to the comments. If the proposal requires preparation of an 
Environmental Impact Statement, the policy guiding the evaluation and response to 
comments is different than when the proposal is a rule or other federal action. Coders should 
be aware of what the policy requirements are for the specific proposal for which they are 
doing the content analysis. 
 

9.1.1  ~ What is a Comment?
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In addition to the requirements provided by regulation, the process of coding searches public 
comments for people’s explanations of why something should or should not be done. 
Identifying all the reasons for an action is important for the collective consideration of 
comments as is required by the National Environmental Policy Act (NEPA), to determine 
whether the suggestion or request should be implemented, as well as to promote an 
understanding people’s values and develop an adequate response to comment. 

Section 9.2  ~ The Coding Structure  
The coding process begins with the development of a coding structure, which includes codes 
to track information about the respondent, the letter, and the comments. Respondent and 
letter attribute information is captured by a series of codes called header codes, which are 
entered at the top of the letter. The first header code is the Mail Identification number (MID) 
which links the letter to the sender in the Oracle database. (For information on MIDs, see 
chapter 4.) The next header code is Organization Type, followed by number of Signatures, 
Response Type, Delivery Type, Immediate Attention, User Type, Letter Generator number, 
Form number, Common Interest Category, Request for Information, Comment Extension, 
and Total Signatures codes. There will not be a code for all of these fields for every letter. 
Some codes are specific to only certain letters and some codes are used only for certain 
projects. For those that are used, most fields are filled in by the coder. At the beginning of 
each project a team leader will determine which codes will be used. Additional information 
on header codes is located in Appendix E, Templates. 
 
Comment codes are assigned to each comment that has been identified and parsed out by 
coders. Comment codes are arranged in a topical outline with both alpha and numeric 
characters (see Appendix E for Standard Coding Structure Templates). Once comments are 
assigned codes, both the comment and its associated codes are entered into a database where 
they can be sorted and reported in the manner most appropriate for later analysis and 
summarization. The CAET v1 Oracle database provides a robust interrelational program for 
storing large volumes of information and reporting it in a variety of combinations. 
 
The coding structure is logically organized to capture potential public comment on a 
proposal. It includes main topic areas addressed in the proposal as well as those not 
addressed but still likely to receive comment. Letters arriving early in the project may help 
identify additional areas of concern that can be added to the coding structure. The coding 
structure should be both flexible enough to account for a wide range of information and 
specific enough to avoid ambiguity in coding. Coding structures are organized into 
Management Action and Rationale codes.  

 
 
 

The Management Action (Action) code represents a specific action that is requested by the 
individual submitting the comment. An Action code is made up of a subject code and a 
category code. Subject codes are five-character alpha codes that represent broad themes 
associated with a project, such as decision processes, economics, wildlife, etc. The subject 
code is a five-letter abbreviation of the subject title so coders can easily recognize topic areas 

9.2.1  ~ Management Action Codes
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by subject code names. For example, the environment subject code might be assigned the 
code letters ENVIR.  
 
Category codes are five-digit numeric codes that define specific subtopics within each 
subject code, and they are generally arranged from the general to specific with subcategories 
nested within categories. For example, the TRANS subject code may be a general category 
code of 40000 and include a category 40300 entitled Road Management, under which several 
subcategories might be nested including 40310 Roads Analysis; 40320 Road Construction 
and Reconstruction; and 40330 Road Obliteration. (See Example 1)  
Example 1 ~ Action Codes (Subject and Category Codes) 
 

Alternatives/Options  
ALTER  
20000 – Purpose and Need for Proposed Action 
  20100 – Need for an EIS, EA 
 
21000 – Document(s) General (NOI, DIES, Plan) 
 21100 – Technical and Editorial (spelling, grammar, consistency) 
 
22000 – Alternatives  
 22100 – Scope, Issues that should/should not be addressed 

 
 
 

The third code assigned to a comment is the Rationale code. This code represents the 
reasons given for why the specific action is requested, provides some additional qualifiers, or 
identifies the resource that would be affected. Rationale codes are three digit numbers that 
correspond very generally to the numerical scheme of the Action codes.  
 
Example 2 ~ Rationale Codes (Category 2 Codes) 
 
100 – Laws, policies 
110 – Democracy 
120 – Federal, General/Multiple 
 121 – Constitution 
 123 – Federalism, States Rights 
 125 – Individual Rights, Public Own Fed Lands 
 127 – General Welfare, Public Good, Public Interest 
130 – Federal Laws 
 131 – NEPA 
 133 – NFMA 
 135 – Endangered Species Act 
140 – Court decisions (past or pending) 
150 – Tribal Treaties 
160 – Agency Rules, Plans, Policies 
 161 – Appeals and Objections 
 163 – National Fire Plan 
 165 – Enforcement  
170 – Rules, Plans, etc. of Other Federal Agencies 
180 – Rules, Plans, etc. of States 
190 – County or Municipal Rules, Plans, Etc. 
 
200 – Natural Environment, General/Multiple (national treasure, national heritage, pristine areas) 
 201 – Environmental Quality and Ecosystem Integrity 
 

9.2.2  ~ Rationale Codes

Subject 
code 

Category 
codes 
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Alternative codes are optional additional codes that may be used to segregate other types of 
information about a comment. There are four possible alternative codes: Site Specific 1, Site 
Specific 2, Optional 1, and Optional 2. These may be used on some projects to identify 
specific information not provided by Subject, Category, and Category 2 codes. Alternative 
codes also provide an efficient way to access data for specific reports. These codes are 
comment-specific and would be placed following the Action and Rationale code entries in 
the left margin of a hard copy of a coded letter. Examples of possible alternative codes are 
road or trail numbers, alternatives, standard and guideline numbers, region numbers, theme 
codes, or management area identifying codes. (See Figure 9.3 below). 

Figure 9.3 ~ Alternative Codes Letter with alternative codes 

9.2.3  ~ Alternative Codes

SITE SPECIFIC 1 FIELD 

 
PNF - Plumas NF 
ENF - Eldorado National Forest 
LNF - Lassen National Forest 
MDF - Modoc National Forest 
TNF - Tahoe National Forest 
LMU - Lake Tahoe Basin Management Unit 
STF - Stanislaus National Forest 
SQF - Sequoia National Forest 
SNF - Sierra National Forest 
INF - Inyo National Forest 
PSW - Pacific Southwest Research Station 
RO5 - Regional Office, Region 5 
SAC - Sacramento/Sierra Nevada Framework Project 
TOF – Humboldt/Toiyabe NF, Region 4 
XXX – No specific forest 

 100000 
 

99991 G 1 1 E        
    MID         OT    S     RT   DT     IA    UT    LG    F     CIC   RI   CE 
GG 01/01/01 
 
USDA Forest Service 
Sierra Nevada Framework 
PO Box 7669 
Missoula, MT 59807 

 
Comments on Sierra Nevada Forest Plan 
Amendment Draft Environmental Impact 

Statement 
 

ECONO [I am sitting here, in the middle of our grazing 
81200  allotment on the Modoc National Forest, writing to 
100      you about a most important proposal. If either of the  
MDF    preferred alternatives are implemented our livelihood will             

be negatively effected…] 
 
  
PLANN [I’m having a hard time becoming motivated to write  
15100  these comments. We have been bombarded with such an 
100  array of proposals that we can’t keep them straight. We  
XXX don’t understand what the overall, combined effect of the 

roadless, roaded, business plan, water plan, framework, etc. will 
be. No analysis has been offered to the public. I’ve heard the 
same from USFS personnel, we don’t have the time to do our 
work plus the reading, research, and critical thinking and writing 
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Section 9.3  ~ The Coding Process 
 
The job of the coder is to identify each complete, stand-alone comment and determine which 
Action and Rationale codes best apply to it. Each comment should contain a requested action, 
either implicit or explicit. For example, an explicit requested action might say something 
like: “The Forest Service must revise the species-of-interest and species-of-concern section 
to include several State listed species.” An implicit request might read: “The species lists are 
incomplete because they do not include State-listed species.” Both of these comments are 
asking for essentially the same management action and would receive the same code. 
 
Because of the way people express themselves, the process of identifying a single, stand 
alone comment can be difficult and rather subjective. Sometimes there are several 
management action requests that form a more comprehensive argument that is a different 
requested action than what is contained in each sentence. Sometimes it is difficult to 
determine exactly what a comment is about. The main thing to remember is that the primary 
purpose of the coding process is to identify all concerns so that decision makers can make the 
most informed decision, and to facilitate response to comment. Therefore coders should parse 
out comments in such a way that will be most useful to the decision makers.  
 
In addition: 
 

• Be concise and avoid coding lengthy sections to one code. However, in order to 
accurately reflect a person’s sentiments, it may be appropriate to code a large portion 
of a response document as one comment. Code what is necessary to capture the 
essence of the concern and why someone feels a certain way, but do not include 
repetitive or unnecessary verbiage. 

• Be as specific as possible without losing the substance of the comment. In other 
words, do not split paragraphs so that the full meaning or emphasis of the comment is 
lost. When in doubt, lump rather than split the comment. If the coded comment 
cannot stand alone, then go back and reread the entire section and include any 
additional information necessary to form an understandable comment. 

• Try to avoid redundancy. If you’ve already captured the facts or sentiments of a 
statement in an earlier comment in the same letter, then skip it. You don’t need to 
code every line, especially when it’s been expressed somewhere else in the document. 
You may want to write “already captured” in the left margin as a hint to your second 
reader. If you are coding on an electronic copy, you can notate that a particular 
concern has already been captured. 

 
 
 

Sometimes a public comment does not appear to be relevant to the project. Such comments 
are considered “out of scope”— meaning they are beyond the scope of the project. There are 
two different kinds of out of scope letters, each of which we deal with in a different way. The 

9.3.1  ~ Out of Scope
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first kind is a letter that is not actually about the proposal that somehow gets mixed in with 
the project letters. Usually the mail sorters notice and identify this kind of out of scope letter 
and redirect to the correct person, project, or agency.  
 
The other kind of out of scope letter is where the letter actually is addressed to the particular 
project but is not really relevant to it. A caution here is that CAT defines out of scope much 
more broadly than most interdisciplinary teams. If a comment reflects an individual, stand 
alone concern about the proposal, we do not consider it out of scope even if it is outside the 
scope of the decision being made. For instance, while a concern about the impacts of timber 
harvest on global climate may be far beyond the scope of a proposal to categorically exclude 
small timber harvests from environmental analyses, the concern is legitimately relevant to the 
proposal. While not necessarily related to evaluation of alternatives or modification of 
analyses, comments outside the scope of the project can provide important insight into the 
people’s concerns and how they perceive the project. Only those comments that have no 
apparent relevance to the proposal are labeled out of scope. Entire letters that are “out of 
scope” are generally logged and referenced as out of scope. 
 
Sometimes comments are within the scope of the project but are not codeable. Examples of 
this type of comment would include attachments such as newspaper articles or pictures (see 
Coding Attachments later in this chapter) or anecdotal comments such as: “My family has 
been spending our summers in Housekeeping Camp for the past 20 years . . .”. Uncodeable 
comments are not parsed out or assigned comment codes. 

 

 

After isolating the individual comment, apply the most appropriate codes. Read each 
comment and identify: 

WHO is the comment directed to? 
WHAT is the respondent asking for? 
WHERE is the location that the comment is directed to? 
WHEN should this activity/action take place? 
WHY is the respondent asking for a certain activity/action? 
HOW can the Forest Service (or other agency) accomplish what the 
respondent is asking for? 
 

The following is a set of basic rules and processes to ensure accurate and efficient subject 
and category coding: 
• Be consistent when selecting a subject and category code for certain types of comments. 

For example, all comments about snowmobile use management should get coded to the 
same action code. The Rationale code may differ depending on the reason given or 
affected resource. For example, the comment “Restrict snowmobiles from traveling off 
trails because the compaction of the snow reduces the advantages lynx have in chasing 
prey,” would be coded to snowmobile management with a Rationale code of wildlife, 
more specifically lynx if the code is there. The comment “Do not restrict snowmobiles 
only to groomed trails because concentrating use in too small an area increases safety 
hazards,” would also be coded to snowmobile management but with a Rationale code of 

9.3.2  ~ Action and Rationale Coding 
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safety. Consistency helps ensure that information is located within relatively discrete 
sections of the database, which increases the efficiency and accuracy of the public concern 
identification process. When overlap or ambiguity occurs, team members decide as a 
group where the specific comment type should be coded. These items should then be 
documented in a “coding bin” (list of group coding updates), which should be posted in a 
common area or made available to all in some form where it can be referenced regularly. 

• Pick the Action code that best captures the action requested by the individual writing the 
comment. Often it is easier to identify the Action AFTER identifying the Rationale code. 
Once you grasp what outcome someone is aiming for, it may be easier to discern how they 
hope to achieve it. Note, however, that sometimes respondents will indicate what outcome 
they hope to achieve, but not what action will accomplish it. In such cases you may have 
to code the action and effect to the same code. For example, if a respondent says only 
“protect the environment,” they are asking for a result rather than an action, and they don’t 
provide a method or decision that would accomplish it. This would be coded to a general 
environment action code and a general environmental integrity Rationale. A comment 
such as “protect the environment by adopting Alternative C,” would be coded to the action 
code for “alternative C” and a general environmental integrity Rationale code.  

• Pick the Rationale code that best captures the expected result or reason for a requested 
action. Look for certain key prepositions, such as “for,” “to,” “because,” “when,” etc., 
which likely reference results. For example, a comment like “do not implement this timber 
management policy because it will cause increased soil erosion” would be coded to a soils 
Rationale code. “Revise the wildlife management section TO protect black bears,” would 
be coded to a wildlife Rationale code, and more specifically one for bears if there is one. 
Also be alert to the preposition “by,” as it is likely to indicate an action rather than effect. 
For example, “Ensure the integrity of elk security areas BY restricting OHVs,” would be 
coded to an OHV action and a wildlife, specifically elk or elk security, Rationale code. Be 
careful to not interpret a comment to protect or preserve something as a management 
action. Rather, the thing they are requesting protection for is the outcome, whether or not 
they explain how to protect it. 

 
 

When a comment has been identified, bracket out the comment and write the appropriate 
code in the left margin near where the comment begins. When coding on hard copies, always 
code in pencil to allow for corrections. Do not include unnecessary transitional phrases such 
as “also,” “furthermore,” “finally,” or “in addition,” at the beginning of a coded comment. 
Begin your first bracket after the transitional phrase, and make sure the rest of the sentence 
can stand alone to represent the respondent’s comment accurately. 

9.3.3.a  ~ Repeating Lead-in Phrases 
When splitting out bulleted statements or separate sentences from within a paragraph to place 
into different code categories, consider whether you have coded a complete thought or 
concern. In order to ensure the integrity of the comment, sometimes you should include the 
lead-in statement with each bulleted comment. See Example 4 (below) for an example of 
repeating a lead statement for bulleted comments. Without the lead-in statement, the bulleted 

9.3.3  ~ Coding Techniques
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comments lose the intent of the writer. Code the lead-in statement by writing “REPEAT” in 
the left margin along with the total number of comments included with the statement. In this 
example you would write “REPEAT 3 X” in the left margin by the lead-in statement and the 
second reader would color the lead statement the same as other coded comments. 
 
Example 4 
  
 Tall Tree National Forest 
 Land and Resource Plan Revision 
 
 Date XX, 2006 
 
 
   Before the Forest Service designates Cold Peak Mountain as suitable for 
 motorized recreation, it must first:   Repeat 3 X with next 3 bullets 
 
 PRCSS 10100   Consult with the local tribes who use the area for gathering 
   202  pinon nuts; 
 
 PRCSS 10200    Consult with the Department of Fish and Wildlife over the  

406  status of the Meadow Mushwort; 
 

 ECON 60200   Complete the social and economic analysis for motorized recreation in  
    810         the area; and 
 
 LEGAL 30310    Revise and update the 2002 EIS for the motorized trail construction  
    540  and reconstruction project to include the proposed two-mile loop to  
  Willow Camp. 
 
 

9.3.3.b  ~ Coding Long, Dense Letters 
Very detailed, lengthy letters often contain many codeable comments. These letters can be 
challenging and may also be a bit confusing. You will need to be more attentive when coding 
lengthy letters. Some will receive a red flag and an Immediate Attention code (see Immediate 
Attention in Appendix E) that shows they require detailed review by the agency. In most 
cases, you will also code them, but the amount you code will be determined by the type of 
letter and the client’s needs and wishes. You may want to consult with your team leader 
when you begin to receive very lengthy letters on a project. Below are a few types of large 
letters and some advice on handling them: 
• Letters that analyze the proposal in detail. These letters may be 10 to 50 pages long or 

more. As long as the comments can be separated and sorted without losing valuable 
context, code as you would normally. Because authors of these letters often repeat themes 
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in introductions and summaries, as well as in the body of the letter, watch out for 
duplication. If you have already coded a particular sentiment on page 3, don’t code it 
again on page 16. If the comment on page 16 is more clearly worded or includes more 
useful detail, code the comment on page 16 and erase or delete the codes for the same type 
of comment on page 3. As an explanation for your second reader and others, write or 
notate that the concern for the comment not coded has already been captured. 

• Legal letters that analyze the proposal in detail and supply numerous pages of legal 
arguments and citations. Again, as long the comments can be separated and sorted 
without losing valuable context, code them. However, you will want to cut out not only 
duplication, but also much of the legal minutiae not central to the authors’ main points. 
These letters generally are well-organized around topic headings that identify 
respondents’ primary concerns. Make sure to code any informative topic headings and 
adequate supporting information. Some of the legal arguments will be relevant and should 
be coded, but pages of case histories often add little value to the database. Check with 
your team leader or ask an experienced second reader to check your coding. The second 
reader is responsible for ensuring that the first reader attaches red flags to these letters (see 
following Section 9.3.3. for First and Second Readings). A red flag indicates to client that 
the particular letter is worthy of special attention and consideration. 

• Letters with voluminous attachments, including articles, research studies, statistics, etc. 
Sometimes letters with attachments can pass the 1,000-page mark, and while some of 
these attachments must be coded, some will have only the title or brief description and 
citation coded. Consult with your team leader regarding how much to code (see section 
9.3.3.c ~ Coding Attachments). 

• Letters with fully developed, detailed alternatives. Often the text of a fully developed 
alternative loses value out of context. Usually you will code some of the summary 
information but not the entire text. Check with your team leader regarding the client’s 
wishes for how to analyze a comprehensive alternative. 

9.3.3.c  ~ Coding Attachments 
Some individuals responding to a call for public comment will include attachments in the 
form of newspaper articles or editorials, journal articles, doctoral dissertations, or other 
written material. Some attachments will be coded in their entirety, others will have only the 
title or brief summary and citation coded. Very lengthy attachments often will have abstracts 
or summaries that can be coded rather than the entire text. If an attachment is EITHER not 
written by the author of the comment letter, OR is not about the proposal at hand, only the 
title or a summary description of the attachment will be coded. The title or summary is coded 
to the standard attachment code ATTMT 99999, and then the subject of the attachment to the 
appropriate Rationale code. Code only the title of the attachment (or brief description) and 
the citation (author and publication). If author of the attachment is the same as the person 
submitting it, and the attachment is about or related to the proposal, you will code the 
attachment as you would any other letter except that you will notate that it is from an 
attachment by noting “from Att. 1” or “From Att. 2”.  
 
If, for example, an individual attaches a journal article written by a colleague on the impact 
of roadless areas on water quality, the attachment will be assigned an Action code of 
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ATTMT 99999 and a Rationale code that captures the water quality aspect of the article. The 
balance of the attachment would not be coded. If, however, an individual submits the same 
journal article that she herself wrote, and the proposal that the comment was submitted on 
relates to roadless areas or water quality, each relevant comment in the attachment would be 
coded, prefaced by the note “From Att. 1.” 
 
Another type of attachment that occasionally appears is when an individual submits an 
introductory email with the comment letter attached as a separate word document. In this 
situation, first ensure that the document has indeed been attached to the email and is 
downloaded or opened. The cover letter would not be coded if there were no concerns 
regarding the project in it. The attached document should be coded as usual (assuming it was 
written by the sender of the email). 

 
 
 

During the beginning of most projects, letters are read by two different coders to help the 
team develop consistency and to ensure accuracy of the coding. The following defines the 
roles and responsibilities of first and second readers in the coding process. 
First Reader’s Responsibilities: 
The first reader reviews letters and codes comments according to the coding structure and 
“coding bin” items. The specific tasks of the first reader include the following: 
1) Ensuring that a letter is in scope. If not, the letter is labeled “Out of Scope” and is not 
 coded. 
2) Ensuring that a letter is not a form (see Chapter 8 ~ Processing Forms). 
3) Assigning header codes (see section 9.2 and Appendix E for demographic and header 
information). 
4) Placing brackets before and after each codeable, relevant, stand alone comment. 
5) Assigning Action and Rationale codes to each comment. 
6) Assigning alternative codes if applicable. 
7) Applying red or blue flags, if applicable, to the left edge of the page on hard copies, 
noting in the appropriate spot that a letter requires immediate attention for electronic copies. 
8) Initialing and dating the lower right corner of the first page if coding on hard copies. 
Second Reader’s Responsibilities: 
The second reader reviews the coded letters and either concurs with the first reader or revises 
the coded comment(s). Before making changes, the second reader needs to consult with the 
first reader. If the second reader finds regular occurrences of what the reader perceives to be 
a specific coding error, the second reader should discuss the perceived inaccuracy with the 
first reader and determine the best code for that specific type of comment. The specific tasks 
of the second reader include the following: 
1) Checking header information for accuracy. 
2) Checking that correct alternative codes have been assigned, if applicable. 
3) Checking Action and Rationale codes for accuracy. 
4) Coloring comments if coding on hard copies. 

9.3.4  ~ First and Second Reads
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5) Initialing and dating the lower right corner of the first page below the initials of   
the first reader if coding on hard copies. 

Coloring the comments 
The second reader also has the task of coloring the coded comments if coding on hard copies. 
After reviewing the coded letter, the second reader colors each comment with highlighter 
pens. Coloring helps to reduce error and eye strain when comments are entered into the 
database. The basic rules of coloring are these: 
• Use only transparent colored highlighter pens. 
• Color the comment along with its corresponding codes in the same color, alternating 

colors for subsequent comments. 
• Color only around the perimeter of the comment and codes. Do not highlight all text or 

every other line in the comment. 
• Avoid dark colored highlighter pens that make it difficult for data entry people to read the 

text (purple, etc.). 

Alternate Second Read Option 
There is another type of second read that may be employed instead of or in addition to the 
second readings. This type of read is generally known as the “group read” and involves 
printing out a database and then reviewing it as a group to help ensure consistent and correct 
coding. Often this kind of review is employed after a number of letters have been coded and 
entered into the database. In this case, comments that have do not belong where they have 
been coded stand out as being noticeably out of place. This process, which may be modified 
for different projects, can be summarized as followed: 
1)   First reads are done as usual. 
2)   A certain percentage will be second read, and header codes checked for accuracy. 
3)  The comments are entered into the database. 
4)  A database is printed and reviewed for accuracy by the coding team. Each Action and 

Rationale code is checked for consistency. 
5)   Discrepancies are discussed with the group and changes agreed upon. 
6)  Any changes are made in the database. 
6)   If coding was done on hard copies, the original coded letters are pulled and codes     

changed as needed. 
Depending on the size and complexity of the project, a database may be reviewed only once 
or may be reviewed several times at various stages of the project. In some cases, only certain 
sections of the database may have to be reviewed by the coding team. A team leader will 
usually make the determination as to the frequency and detail of database review sessions 
needed. 
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Section 9.4  Processing Form Letters 
The process for handling “form” or organized campaign letters is designed to avoid the 
inefficiency of entering multiple copies of the same text into the database while ensuring that 
any new or revised codeable content is captured.  

A form is defined as five or more letters from at least five individuals containing text that is 
identical or so similar that any difference in the wording or order of comments does not alter 
the basic meaning. Sometimes form letters are received with some of the text from the 
original form missing. This could be several words, sentences, or entire paragraphs. Form 
letters without some of the concerns of the original form that offer no new information are to 
be categorized as the form That is, they have no special status and are not recognized in the 
content analysis process.  

Form letters that contain additional codeable, nonrepetitive text are defined as forms-plus. 
Comments are not codeable if they merely restate or offer additional emphasis to what is in 
the form. If a comment in a form has been modified in a way that significantly changes its 
original meaning, it should be recoded and the form should be treated as a form-plus. 

However, treat a letter as an individual, nonform letter if: 
• the form text has been modified so much that all or nearly all of the form needs to be 

recoded (for instance, by the addition of “not”); 
• a letter contains little of the original form and contains additional codeable comments. 

The point is to be efficient—not recapturing existing form content—without losing added or 
revised content. 

Once a form has been identified, it is given a unique number and descriptive name. Select 
one copy as the “form master” to be coded and entered into the database with all of the 
content information. 

After the form master has been created, additional instances of that form are linked to the 
form master data by the designated form number (see example 6). There are two main 
methods for processing form letters, depending on the size and type of project and the 
client’s needs. In one case, the names and addresses of all who submit form letters are 
entered into the mailing list data base and are linked to the form number for the form each 
one sent. In the other situation, names and addresses are not included in the mailing list, and 
the form number and the state from which it was sent are tallied. 

To process forms–plus, enter the form number in the header with a plus (+) sign (see example 
7) and use the same Mail ID process as for nonforms. Code and number additional comments 
using the next sequential number after the last comment number on the form master.  

One coder is generally designated as the “forms coordinator” for a project and is responsible 
for numbering and tracking new forms. In addition, the forms coordinator is responsible for 
the following tasks: 

• Coding all new forms and numbering each comment. 

• Writing “FORM MASTER” along with a descriptive name and a form number on the 
form – preferably at the top of the letter when possible. 
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• Making 3 copies of the form master. 

• One copy plus the master goes to data entry. 

• One copy is filed in a separate folder for the forms coordinator. 

• One copy is posted in a convenient location for easy access by coders (coding room 
wall or forms book). 

If coding is done online, copies of forms should be made available either online or in a 
common area for coders to reference. Often individuals will submit some comments that are 
the same or very similar to comments on a form. These should be recognized and coded the 
same as the similar comments on the form. If the text of a letter is very nearly identical to a 
form letter with no significant difference, it should be included as that form. All coders are 
responsible for checking any suspected forms against copies of the masters and for giving 
new forms that they may identify to the forms coordinator to process.  
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Figure 9.5 Example 6 ~ Form Master 
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Figure 9.6 Example 7 ~ Form with additional comments 
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The Analysis Team produces a public concern list in its analysis of public comment as one tool 
to assist clients in meeting regulatory requirements. A public concern list identifies distinct 
concepts respondents want the client agency to address and organizes these topics into a 
condensed format to facilitate the client agency’s issue identification and response to comment. 
To develop a public concern list, the team evaluates public comments, selects quotations that are 
representative of key ideas, and distills these key ideas into statements that summarize 
respondents’ sentiments regarding a project. 

Section 10.1 ~ Database Analysis 
After a letter has been coded, all reference information and comments are entered into a 
computer program called the comment database. The database allows the team to store and 
organize every segment of information through electronic associations. The team can use these 
associations to recall pertinent information according to multiple variables. During the analysis 
phase of a project, team leaders will periodically distribute a printout of the comment database to 
team members. As standard procedure, all comments coded to specific action codes are grouped 
together for the database reports; however, the needs of a particular project may require a 
different configuration. For further detail on the structure of database printouts, please refer to 
the sample printout that accompanies this chapter. 

Analysts are responsible for the last four steps in the process illustrated in the flow chart at the 
beginning of this chapter. Step 2, analysis of the database report, involves reading through 
assigned sections to identify relevant and coherent quotes that express distinct concepts the client 
agency can or should address. The team refers to a relevant and coherent quote from a 
respondent as a sample statement. Not all comments in the database are sample statements. The 
standards for identifying sample statements (SS) are further defined below. In Step 3 analysts 
must recognize related statements and select the SSs that best represent distinct concepts the 
agency can or should address. Working from these distinct concepts, the analyst drafts a sentence 
that accurately captures the idea as an action or decision to be made by the client agency, or a 
topic to be addressed in subsequent publications of the agency’s proposal. A sentence capturing 
the action, decision, or topic for agency review is known as a public concern. Public concerns 
(PC) are further defined following a discussion of SSs. 

Sample statements are quotes from the comment database (or directly from letters under rare 
circumstances) that satisfy three requisite standards. Comment segments that are relevant, 
coherent, and express a distinct concept the client agency can or should address are identified as 
sample statements. Conceptually, SSs presents the subject of a respondent’s concern and why the 
individual or group believes it is of importance. Sample statements may also impart the author’s 
suggestion(s) on how, when, or where the concern should be addressed. Sometimes a full 
comment from the database may serve as a SS but often sample statements are only a segment of 
the database entry. 

The standard for relevancy dictates that a quote must meet at least one of the following criteria: 
• Addresses the details or themes of the agency’s proposal. 
• Refers to actions, complications (indirect effects), statutory requirements, or questions 

connected to the agency’s proposal. 
• Requests that no actions be taken or no changes made to existing policies. 
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An agency may identify specific topics it considers irrelevant to the proposal but the team retains 
the authority to include these comments or topics in the analysis if the project team believes it is 
a concern the agency legitimately should address. 

The standard for coherency dictates that a quote must meet all of the following criteria: 
• Presents an identifiable question, suggestion, interest, or request. 
• Possesses adequate grammatical accuracy to express a clear concept. 
• Communicates sufficient information to form a complete thought the agency can address. 

The standard for a distinct concept the client agency can or should address dictates that a quote 
must meet at least one of the following criteria: 
• Informs the agency of the respondent’s preferred action or decision regarding the proposal 

(may or may not be one of the agency’s preferred alternatives or the proposed action). 
• Identifies a topic to be addressed in subsequent publications of the agency’s proposal. 
• Questions the accuracy of information as presented in the published document. 
• Questions the adequacy of environmental and/or other analyses as presented in the proposal. 
• Questions the appropriate use and/or span of the responsible agency’s authority (this includes 

appropriate scale of planning, public involvement, and legal authorities). 
• Identifies a suggestion consisting of statements of value or preference with a rationale. 
• Requests revisions that may— 

• Help to clarify, improve, or evaluate the adequacy of the public involvement, planning or 
NEPA process. 

• Result or call for a modification of the proposal. 
• Result in additional analysis. 

The process for applying SS standards is summarized by the following flowchart: 

 
Database 
Comment → Is It 

Relevant? → No. → 
Comment 
is not a 
SS. 

        

  ↓             

        → → Yes. → Is It 
Coherent? → No. → 

Comment 
is not a 
SS. 

    

      ↓         

            → → Yes. → 
Is It A 
Distinct 
Concept? 

→ No. → 
Comment 
is not a 
SS. 

          ↓     

                → → Yes. → Comment 
is a SS. 

 

Public Concerns are statements drafted by the analyst to summarize the content and context of 
SSs to facilitate the agency’s response to topics within public comment. A public concern 
identifies who should respond (which may actually be a subsequent document); and what is the 
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question, problem, suggestion, or interest expressed by respondents. Whenever clearly stated by 
respondents, public concerns also identify the environment or resource affected by an action, the 
hierarchical or geographical location for decisionmaking, and the stage of planning or 
implementation at which the question, problem, suggestion, or interest should be addressed. 
Some public concerns are specific to sections of the proposed action and others address broad 
themes that may underlie or inform the agency’s proposed action. 

For more information on the structure of PCs and SSs for public concern reports, please see 
sections 10.2.2 and 10.2.5, respectively. 

10.1.1 ~ Techniques for Database Analysis 
The goal of database analysis is to select the sample statements that best express a public concern 
and encompass the full range of rationales presented by respondents. Analysis Team members 
may use a variety of techniques to accomplish the task of database analysis but all acceptable 
techniques must conform to the following standards: 
• Accuracy – the analyst must endeavor to capture public concerns within the context of the 

actual statements. What a respondent may have “really meant” or “should have said” is 
beyond the realm of analysis. There are some limited exceptions to this standard with regard 
to capturing comments within the required structure of a PC. (See the General Guidelines in 
section 2.3). 

• Consistency – the analyst must attempt to review each assigned segment of the database 
following the same criteria (within each report and for successive reports). 

• Brevity – the analyst must strive to focus the consideration of public comment upon coherent 
subjects and abridge the extent of considerations by excluding duplicative, incoherent, or 
irrelevant comments/comment segments. 

• Thoroughness – all sections of the database must be reviewed for each report. Additionally, 
the analyst must recognize that a database comment may contain more than one relevant SS 
and, thus, may present more than one PC. 

• Timeliness – the analyst must be able to complete this process with enough time to write and 
edit a full PC list before the deadline set by the team leader or project editor. 

As well as these standards, there are some general guidelines to consider when analyzing a 
database report: 
• Establish reasonable time limits to analysis. If an existing PC cannot be identified or a new 

one drafted relatively quickly, reevaluate the comment for compliance with SS criteria. If the 
comment is confirmed to meet SS criteria, the analyst should seek advice from the project 
editor or team leader. 

• Scan each section prior to beginning detailed analysis. Mark obviously duplicative 
comments, such as minor alterations of form letter submissions. 

• Write “hold” (or some other marker) near SSs that present a definite PC but are not 
articulately stated. “Hold” SSs may be reviewed in conjunction with subsequent database 
reports to help identify new SSs that may articulate the concern more clearly. If a more 
eloquent SS cannot be identified, then a PC can be drafted for the “hold” SS to make sure the 
topic receives agency review. 
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Though each analyst will develop a personalized technique that may be adjusted from one 
project to another, there are at least two effective base techniques for database analysis. 
Option 1 

Read each comment within a database section (either a full Action Code or limited to an 
Rationale code within the Action Code) and follow these steps: 
• Mark relevant, coherent comment segments that meet the SS criteria. 

1) Note comments that explicitly state or clearly imply what the agency should do. 
“Please consider the impacts on small communities before you move forward with this plan. A 
reduction in recreation opportunities will destroy our economy.” 

This comment explicitly states a request and provides a meaningful context 
underlying the request. 

“The Forest Service gives too much power to bureaucrats in Washington. Local people know what’s 
best for the land and those who make their living from it.” 

Though not as explicit, the respondent clearly implies a suggestion that local citizens 
should be given more say in decision-making. 

2) Avoid comments that present only statements of fact or emotion. 
“Wolves were once plentiful across this beautiful land but now they can only be found in a few 
isolated places.” 

This statement of fact provides no meaningful concern to which the agency can 
respond. Does the person support wolf recovery, want further research, or simply 
prefer to announce the obvious? 

“What gives you the right to do this to us? Have you no decency?!?” 

Though the respondent clearly does not like the proposal, without more specific 
identification of an aspect to which the writer objects, the agency cannot provide a 
meaningful response. 

3) Be spare with comments that are too clever or simplistic to elicit a meaningful response 
from the agency. 
“I like wolves, especially bar-b-qued.” 

The agency could not possibly respond to this statement in a meaningful way. 
“This forest plan is just another example of how the Forest Service caters to extraction industries.” 

Though the author’s perspective is clear and a workable PC could be written—‘The 
FS should not cater to extraction industries’—without an indication of how the plan 
caters to extraction industries, the agency doesn’t have much upon which to base a 
response. 

4) Be careful with comments that are so complex that a legitimate PC statement would have 
to restate a significant portion of the comment – review these comments according to the 
guidelines for Technical and Editorial statements established in section 10.6. 

• Write notes in the margin/open spaces to capture the key concept(s). 
• Disregard comments that do not meet SS criteria or are redundant. 

Review written notes and follow these additional steps: 
• Identify comments that express a similar concept or suggest a similar action for the agency to 

consider but provide different rationales to support their positions. 
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1) When logical and possible, draft a PC broad enough to capture each SS. 
“The Forest Service needs to adopt the SEPRT Alternative because it is the only one that guarantees 
protection of all forest resources.” 
“Please adopt the SEPRT Alternative. Economic considerations must come second to protecting the 
environment.” 
“The SEPRT Alternative is your only real choice. The jerks who created this problem are going to file 
suit if you choose anything other than Alternative 3 (No Action) so you might as well go for broke.” 

These three respondents support the same Alternative but for divergent reasons. Each 
is directly urging selection of a specific alternative and provides a straightforward 
rationale for that position. Therefore, the SSs would best be captured under one PC 
with a subconcern (section 10.4) to capture the rationale presented in each SS. 

2) When the rationales are too disparate or constitute fundamentally different manifestations 
of the requested action, the accuracy standard may dictate that the SSs be captured under 
different PCs. 
“I support the proposal to reclassify wolves from endangered to threatened. Reclassification will help 
promote recovery by reasonably addressing the concerns of those who see wolves as a threat to their 
livelihood without relaxing regulations to such a point that wolves are likely to face extinction.” 
“Gray Wolf recovery is a success. The proposal to reclassify should be implemented as soon as 
possible.” 
“Wolves should have been reclassified years ago. There are so many in this area now that I fear for the 
safety of my children when they play outside. Environmentalists keep saying that wolves don’t attack 
people but what happens when one finally does? I’m in favor of any proposal that will allow people 
more freedom to protect themselves.” 

The first and third SSs support the same proposal but from nearly opposite 
perspectives. Though the agency may choose to provide the same response to these 
divergent motivations, the team’s responsibility is to reflect, as accurately as possible, 
the spirit of public comment as well as the overlaying theme. Therefore the fist and 
third SSs should be captured under different PCs. The second SS is opaque and may 
be closely aligned with either perspective and should be dropped unless the database 
report gives more context to help determine the intent of the author. 

• Identify existing PCs that may accurately capture each new SS. 
1) Evaluate whether the new SS provides substantive context to the PC beyond that 

established within existing SSs. 
2) Mark the PC # for these additional SSs. 
3) Disregard SSs that do not provide additional substantive context. 

• Note modifications for existing PCs that can be reasonably broadened or narrowed to capture 
new SSs. 

• Identify SSs that constitute new concerns and draft a PC for each. Mark other new SSs that 
may be incorporated within the new PC. 

Option 1 Advantages and Disadvantages 

Advantages 
• Written notes reflect a relatively complete analysis enabling a fellow team member to enter 

the material if needed. 
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• This method allows the analyst to consider all relevant material within a section before 
making PC/SS decisions (reduces potential for duplicative or hairsplitting entries). 

• The first pass through a database printout emphasizes the identification of key concepts 
within possible SSs, reducing the potential for an analyst to become bogged down with how 
to write a PC for a particular SS when there may be other, possibly better, SSs deeper into the 
section. 

Disadvantages 
• Two passes through the database and detailed notes may be difficult to accomplish during 

project crunch times. 
• May lend itself to over-analysis of questionable SSs. 
Option 2 

Read each comment within a database section and follow these steps: 
• Mark relevant, coherent comment segments that meet the SS criteria (please refer to 

examples from Option 1). 
• Immediately identify an appropriate existing PC or draft a new public concern for each SS. 
• Disregard comments that do not meet SS criteria or are redundant. 

Enter new material into a Word Chapter Template. These Chapter Templates are available from 
CAT upon request. 

Some analysts employ a variation on this approach by entering new material as it is identified 
rather than after completing analysis of the full section. However, we try to discourage this 
variation because it increases the potential for entering PCs that will be significantly modified or 
even wholly replaced by subsequent SSs in the database report. 
Option 2 Advantages and Disadvantages 

Advantages 
• Though some analysts may not be comfortable enough to make decisions on the first run 

through the database, this option is quicker than Option 1 and should reduce the potential for 
over-analysis. 

Disadvantages 
• Single review of comments may lead the analyst to make too quick a decision on 

complicated expressions of opinion or fact. 
• Without a second review of comments, the analyst may tend to select inadequate SSs. 
• Immediate decisionmaking may increase the potential for duplicative or hairsplitting entries. 

The analyst’s PC report may become overloaded with highly particular PCs and bury the 
themes that underlie the respondent concerns. 

10.1.2 ~ Redirecting Miscoded or Potentially Overlapping 
Material 
The multifaceted process of coding comments often results in similar concepts appearing in 
different sections of the database reports. Sometimes comments may be miscoded, despite the 
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precautions of the coding process. Whatever the reason, it is important that team members 
communicate with each other to address these matters without stalling progress towards 
completion of the analysis. In the end, a project may necessitate some degree of thematic overlap 
as a result of the client’s requests or complex interrelationships between different segments of 
the proposal. To accomplish this facet of database analysis, the following guidelines have been 
established: 
• Evaluate the comment for relevancy to the client’s proposal and coherency of expression. 
• Assess the comment for compliance with the SS criteria detailed in Section 2.1. 
• Draft a PC for SSs that meet the criteria and deliver to the team member analyzing the 

section where it may be more appropriately placed. 
• Allow the team member time to review the possible PC and, if appropriate, discuss options 

for addressing the material. 

Section 10.2 ~ Structure of Public Concerns 
PCs are always directly followed by SS(s) that support the concern statement. Generally it is 
good to have three to five SSs in support of each public concern but each PC must have at least 
one supporting sample statement. 

Public concerns are not “issues.” The National Environmental Policy Act establishes a legal 
definition for the term “issue” within an agency’s decision-making process [reference CEQ 
regs?]. The agency has the authority and responsibility to determine if a PC (or multiple concerns 
if combined) constitutes an issue, therefore, these documents do not refer to any topic as an 
issue. 

Public concern statements follow a standard format consisting of the actor, “should,” verb, 
action or effect, affected environment or resource, and location, level, or time (when 
possible). 

The actor is the organization (usually a government agency) responsible for making decisions 
based on public comment and formulating responses to explain those decisions.  

The “should” is a mechanism within each PC statement to positively and assertively focus 
analysis upon actions the responsible agency can accomplish or effects the document can 
address. In limited cases, the “should” can be replaced by “must” or “should not.” 

The verb clarifies a method of approach for the responsible agency (either in terms of active 
management or amending the published document). The actor-verb agreement material below 
provides a short sampling of appropriate verbs relating to the agency as actor and a document as 
actor. Section 3.4.2 details a more extensive list of verbs appropriate for use in narratives. 

The action or effect is the key concept (the question, problem, suggestion, or interest) expressed 
in respondent comments. 

The affected environment or resource is the direct object of the action or effect. The affected 
environment or resource often accentuates the rationale underlying a respondent’s assertions or 
clarifies the larger context that informs a highly specific suggestion. Not all respondents clearly 
identify an affected environment or resource; therefore not all PCs contain this element. 
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The location or level is the geographic location of a concern and/or the hierarchical level at 
which the concern should be addressed. The time is the stage of planning or implementation at 
which a suggestion should be incorporated. Not all respondents clearly identify a location, level, 
or a time; therefore not all PCs contain these elements. 

Each public concern should be numbered in order, preceding the statement. 

Examples: 

1. Public Concern: The Bitterroot National Forest [actor] should conduct 
[should and verb] salvage logging [action] to reduce fuels [affected resource]. 

2. Public Concern: The Forest Service [actor]  in the Final EIS should address 
[should and verb] the cumulative increase in water yield [affected 
environment] as a result of fire and intermediate harvesting [effect]. 

3. Public Concern: The Ciudad National Forest [actor] should prohibit [should 
and verb] roadbuilding [action] in the Lohantan Basin [location]. 

4. Public Concern: The Forest Service [actor] should protect [should and verb] 
local economies [affected environment] by granting final decision authority 
[action] to the forests and districts [level]. 

Section 10.3 ~ How to Word a Public Concern 
Extracting a PC from one or more SSs can be challenging for several reasons. Respondents do 
not always express their ideas eloquently, succinctly, or within the clear parameters of the 
agency’s proposal. However, these problems do not diminish the validity of an individual’s 
concerns. This section presents general guidelines for PC development as well as some 
procedures for handling common problem areas. 
General Guidelines 

Be as Literal as Possible when Interpreting Sample Statements – One of the biggest 
challenges to drafting a PC is to identify the central concept and accurately capture it within the 
standard PC format. Analysts can reduce the risk of introducing personal bias into a PC by 
seeking to interpret public comments as literally as possible. One method to accomplish the 
literal interpretation goal involves using the respondent’s own language in the PC (when it is 
clear and concise). The critical step in using this technique is to identify a short segment that 
captures the respondent’s central concept without simply restating the full comment as a PC. 

Public Concern: The Forest Service should in the Final EIS display forest 
growth baseline numbers as an indicator of wildfire potential. 
“It appears the forest growth baseline numbers have conveniently been left out of the DEIS. Our forest 
grows 2.2 billion board feet of timber each and every year. Restricted logging and thinning over the last 6 
years account for less than 30% of growth, adding to wild fire acres burned. The most liberal alt. in DEIS 
allows less than 30% to be thinned (690 MBF). This increases wild fire potential.” 

Make Sure the SSs and PC Are in Agreement –A concern statement must be supported by its 
associated SSs. It should not state more than the SSs support. Additionally, each SS must support 
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the PC statement. While it is good to include multiple SSs, each providing distinct context to the 
PC, every SS must have a direct relationship to the PC rather than serving to clarify another SS. 

State in the Positive When Possible – Though “should not” statements are acceptable for 
limited cases, statements made in a negative form are much more likely to become convoluted 
than those stated in a positive form. 

(Marginally Acceptable) Public Concern: The Forest Service should not 
promote transportation management decisions that cause habitat 
fragmentation and erosion. 
“We need to protect these important habitats from being fragmented. Building logging roads cuts through 
sensitive habitat and wildlife corridors as well as causes erosion in steep areas.” 

(Much Better) Public Concern: The Forest Service should emphasize habitat 
connectivity and soil retention within transportation management decisions. 
“We need to protect these important habitats from being fragmented. Building logging roads cuts through 
sensitive habitat and wildlife corridors as well as causes erosion in steep areas.” 

Keep It Simple and Concise – If a PC statement is longer than three lines the key concept is 
likely to be buried. Instead, evaluate the material following the Technical and Editorial (T&E) 
criteria (section 2.2.3) or seek advice from the project editor. Keep PCs free of superfluous 
language that is not specific to understanding the sample statements. They should contain no 
unnecessary words. 

Use Consistent Terminology – Variety is good in narrative analysis, but PCs are the framework 
for the agency’s response to public comment and should be as consistent as possible. Do not vary 
key references between PC statements. A “final rule” is always a “final rule” and should not be 
alternately referred to as a “proposal,” a “plan,” or a “final document.” The “U.S. Fish and 
Wildlife Service” should not be called the “Service” or the “Agency.” 

Be Specific – When appropriate reference specific regulations, acts, or laws (e.g., use 
“American’s With Disabilities Act” if respondents refer to “the disability law”). 

Use Key Process Words and Phrases – Sometimes analysts can concisely and accurately 
capture a respondent’s intent by using common process words such as “objectives,” and 
“standards,” 

Public Concern: The Boiselle National Forest should establish in the 
Management Plan clear standards for streamside vegetation stabilization. 
“You haven’t even addressed how this plan will affect streamside vegetation stability. Field personnel need 
guidance before they try to implement this proposal. Nothing should be finalized unless the plan contains 
clear directions for these people.” 

Or phrases such as “address the cumulative impacts of …,” and “establish evaluation criteria 
for… .” 

Public Concern: The Boiselle National Forest should address in the Final 
Management Plan the cumulative impacts of vehicle-induced pollution on 
aquatic and avian species. 
“Increasing human population within Sinkhole National Park means increased non-point source pollution 
from parking lots, residential and working facilities, and vehicle deposits on road beds. This may adversely 
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affect populations of aquatic insects, especially those that are sensitive to pollution, which may adversely 
affect bat, bird and fish populations.” 

Often laundry lists of actions or resources can be concisely and accurately captured by using 
standard terminology such as “ecosystem health” “ 

Avoid Comparative Structures – Comparative structures (such as “more” or “rather than;”) are 
a common gateway to tortured and ineffective PC statements. Statements such as, “The Forest 
Service should provide more funding for …” appear very inviting but the ID team will be 
saddled with pondering, “more than what?” before they can even respond to the concern. “Rather 
than” structures are also problematic because they tend to de-emphasize or obfuscate the 
preferred action and/or affected resource by inserting a wildcard comparative element. 

Public Concern: The Park Service should emphasize adequate staff and 
funding for facility maintenance. 
“The Park Service wastes our taxes on these endless planning efforts. Instead of blowing money on glossy 
documents that are obsolete before they even reach our doorsteps, you should be using your time and 
money to fix the campground toilets and other NECESSARY facilities.” 

Even though the respondent spends a fair amount of space criticizing the agency’s planning 
efforts, this individual’s main point is that more attention needs to be directed at the facilities 
visitors use on a regular basis. Although it may seem reasonable to craft a PC statement that 
proposes ‘the Park Service should do X rather than Y,’ the ID team needs to focus on the 
management action they should consider and the potential for beneficial impact on the 
affected resource. In the above example, the concern the ID team needs to address is 
adequate staff and funding for facility maintenance. The diversion of limited funds to 
produce materials for public consumption is a relevant, yet tangential, perspective. 

Avoid Use of Acronyms – Most acronyms should be spelled out. Often our PC lists are not 
accompanied by an acronym decoder list so we should try to keep them free of these opaque 
references as much as possible. 

When the Proper Actor Is Not Clear: 
“Congress should fully fund all Park Service efforts to repair recreational facilities.” 

The actor in each PC statement should be the responsible agency. A respondent may explicitly 
state that another party (such as the U.S. Congress, the President, an uninvolved government 
agency, a non-governmental organization, etc.) should address a demand. The responsible 
agency cannot, however, direct any of these entities to act. An agency can, though, coordinate 
cooperative effort, seek authorization, request additional support, etc. In very limited 
circumstances an agency may be able to provide a meaningful response to a PC that identifies 
another agency as the primary actor (advice should be sought from the project editor or team 
leader regarding this possibility within a project). If an analyst cannot identify language that 
accurately captures the sentiment of the comment segment AND states it as an action within the 
authority of the responsible agency, the comment segment should be reviewed for compliance 
with SS criteria. 

Public Concern: The National Park Service should request full Congressional 
funding for projects to repair recreational facilities. 
“Congress should fully fund all Park Service efforts to repair recreational facilities.” 
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When the “should” Statement Is Implied: 
“CASPOs rely on dense, old growth stands for nesting. Over the past thirty years intensive logging of 
Pacific Northwest ecosystems has reduced the availability of adequate CASPO habitat.” 

Some respondents do not clearly state what they want the agency to do in response to a proposal 
even though it may be clear they are expressing a concern. If a more direct SS cannot be 
identified, use helpful process phrases such as those detailed earlier to capture the implied action 
within our PC format. 

Public Concern: The Forest Service should consider the impacts of timber 
management practices on California Spotted Owl habitat. 
“CASPOs rely on dense, old growth stands for nesting. Over the past thirty years intensive logging of 
Pacific Northwest ecosystems has reduced the availability of adequate CASPO habitat.” 

When Respondents Provide a Laundry List: 
“First you took away our hunting rights with endangered species laws. Then you cut off weekend recreation 
with road closures and special management areas. Now you want to take away our jobs with reduced 
timber sales and more hoops for mineral exploration. Yet you say you are not responsible for what happens 
to our towns! What happens when we become the endangered species?!” 

Some sample statements include a laundry list of items for consideration or respondents will 
share a concern but for a variety of reasons. To help facilitate the response to comment PC 
statements should not include a list of considerations. In these situations the analyst should look 
for a thematic phrase to capture the central concept. Phrases such as “cumulative effects” and 
“systemic impacts” can help to concisely capture a closely related list. 

Public Concern: The Forest Service should consider the cumulative impacts of 
management decisions on local communities. 
“First you took away our hunting rights with endangered species laws. Then you cut off weekend recreation 
with road closures and special management areas. Now you want to take away our jobs with reduced 
timber sales and more hoops for mineral exploration. Yet you say you are not responsible for what happens 
to our towns! What happens when we become the endangered species?!” 

Section 10.4 ~ Subconcerns 
A subconcern (SC) is a topic of public comment that is most logically evaluated within the 
parameters of a larger PC. A SC is constituted upon an expression that could stand alone but is 
so interrelated with a broader PC that separating it out as its own PC would likely produce a 
redundant response from the agency ID team. There are two scenarios that are most likely to 
produce a SC: 
• Many respondents express the same idea but provide a myriad of distinct rationales to 

support their common conclusion. 

Public Concern: The Yosemite Valley Plan should retain historic bridges in 
Yosemite Valley. 
“I join many of my constituents in objection to the removal of the Sugar Pine, Stoneman and Housekeeping 
bridges from Yosemite Valley. As I mentioned to you in our meeting, I believe very strongly that these 
bridges are an important and valued historical attribute of Yosemite National Park and that all efforts 
should be made to preserve them as part of any future management of Yosemite Valley.” 
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“I am opposed to the removal of historic bridges, particularly Stoneman and Sugar Pine Bridges. These 
stone bridges are truly a work of art. I believe these stone bridges are in keeping with the natural setting and 
do not detract from the visitor’s experience. These bridges also can serve a continuing useful purpose if 
used for pedestrian and bicycle paths.” 

PROVIDE PROOF OF DETRIMENTAL EFFECTS TO THE MERCED RIVER 

“It is very bewildering that if a bridge has been determined to adversely affect the flow of the Merced 
River, then all Alternatives should address that problem; remove, rebuild or relocate. We, therefore, object 
to the removal of any bridge unless absolutely proven that it is detrimental to the river, and that issue has 
never been publicly shown to be true. They have historical value and beauty.” 

MITIGATE BRIDGE IMPACTS ON THE MERCED RIVER 

“The bridges afford important access benefits to disabled visitors, to hikers of limited ability who wish to 
make short ‘loops,’ and to bicyclists who are furthering the SEIS goals by helping to reduce automobile 
congestion in the Valley. If saving these historic resources can be reconciled with a stronger riparian 
management strategy, I would endorse a blended alternative that accomplished this while repairing flood-
damaged facilities.  For example, can levees and channeling be altered to allow the river to meander around 
the bridges, thereby reducing upstream erosion and helping to restore certain surrounding meadows outside 
the campgrounds?” 

• A respondent expresses a topic and rationale similar to others but asserts that the application 
should be focused (geographically, administratively, or conceptually) on a more restricted 
scale. 

Public Concern: The U.S. Department of Defense should consider additional 
alternatives to those identified in the proposed action. 
“The alternatives identified and dismissed in the public notice to transfer management of base lands to the 
BLM are totally inadequate. We’ve provided the Secretary of the Army with several viable alternatives that 
are not even addressed in your document. We demand a substantive evaluation of the SVCOC alternatives 
before the DOD proceeds to a final decision on this matter.” 

ANALYZE ALTERNATIVES FOR USE OF THE AIRFIELD 

“The D-M Airfield is a valuable asset and should not be casually discarded. It should be used to promote 
economic development within the valley. Your proposal doesn’t consider any options other than closure. 
Some base resources may need to be decommissioned for safety or security reasons but the airfield could 
be sold to private investors, transferred to the county, or allocated to a non-profit management group. The 
proposal needs to be redone to include meaningful analysis of these, and possibly other, alternatives.” 

A subconcern is located under a PC and receives a distinct heading to demark it from other SSs 
under the PC. The SC heading should be a brief phrase capturing the fundamental concept that 
distinguishes the SS(s) from the parent PC. SCs are primarily a tool the team uses to organize 
subservient topics and accurately identify highly specific comments within PC lists. 

Section 10.5 ~ How to Structure Sample 
Statements for Use in a Public Concern List 

Sample statements consist of the comment segment within quotation marks followed by an 
attribution. The attribution is a systematic method of identifying contextual information about 
each respondent without revealing the identity of the author. One exception, however, is if the 
respondent is an elected official. In this case, the name of the elected official is included in the 
attribute information. The specific style of attributions will vary from project to project but it is 
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of significant importance to maintain consistency of attribution within any given project so as to 
avoid implications of disparate treatment for different authors.  

It is important to emphasize again that every SS must support the PC statement with which it is 
associated. If a comment does not stand alone, with a direct and meaningful relationship to the 
PC, it should not be used as a SS. In other words, a comment should not be included to clarify or 
support the context of another comment. It may be necessary to rewrite the concern statement to 
establish a direct relationship with each SS. Every PC statement must have at least one SS. 
Ideally PCs will have 3 to 5 SSs. More than five SSs is excessive and likely either includes 
significant overlap or a PC statement that is too broad to accurately capture the associated SSs. 
Conversely, if every PC provides only one SS it may indicate that the PC statements are too 
narrowly worded and reflect hairsplitting differences rather than substantive diversity of public 
concern. 

10.5.1 ~ Editing Sample Statements 
The analyst’s role is to facilitate the client’s response to comment. This means we also have a 
responsibility to present public comments in a form that will help generate a meaningful 
response from the agency. Minor editing of SSs improves the potential for serious consideration 
of a public comment as well as reduces the potential for publishing an error that was inserted into 
the comment during its entry into the CA database. Use the following guidelines when 
considering edits to SSs: 
• Spelling – Correct misspelled words and remove [sic] marks. Read all SSs thoroughly for 

misspellings. Do not rely on spell check to catch all misspellings. 
• Grammar – Be spare in adding or removing text to achieve grammatical clarity. 

“Wolves the last symbol of everything wild and beautiful. Please let me know how I can keep these 
wonderful creatures extinct.” 

• Appropriate grammatical correction: 
“Wolves are the last symbol of everything wild and beautiful. Please let me know how I can keep these 
wonderful creatures extinct.” 

• Questionable grammatical correction: 
“Wolves are the last symbol of everything wild and beautiful. Please let me know how I can keep these 
wonderful creatures [from becoming] extinct.” 

• Inappropriate/unnecessary grammatical correction: 
“Wolves are the last symbol of everything wild and beautiful. Please let me know how I can help to 
keep these wonderful creatures extinct.” 

• Best correction: 
Look for a different SS that captures the concern but lacks the obvious incongruity in this 
quote. 

• Capitalization, Punctuation, and Quotation Marks – Use your time judiciously. Capitalize 
words that should be capitalized; insert correct punctuation; and convert internal quotation 
marks to single quotes. Don’t spend an inordinate amount of time trying to decide if caps or 
excess punctuation should be removed. Sometimes authors will capitalize a whole string of 
words or even sentences for emphasis. Use of multiple exclamation marks is another 
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common occurrence. While these may be visually distracting, there is no need to spend time 
converting material that is essentially a matter of preference. 

• Editing out text – Ellipsis Marks (Gregg Manual, paragraphs 274-280, 291). Sometimes 
respondents include personal histories, annotated legal precedents, or other digressions in the 
middle of a significant comment. Sometimes an individual will write two or more pages to 
convey one fundamental concept. While this material is important to the author and may 
yield some degree of insight into a comment, they often include information that is irrelevant 
or redundant.  In either case, the digression usually distracts attention away from a concern 
that legitimately needs to be addressed. Analysts should use the following guidelines when 
editing out text from a SS (this example does not necessarily represent a comment that needs 
to be edited down but simply shows how to accomplish the task for different needs). 
“I believe Yosemite National Park should be protected from money hungry capitalists and massive 
commercialization. Shouldn’t the Park be protected for future generations? I want my children to 
experience it as I did.” 

• Omitted words within a sentence: 
“I believe Yosemite National Park should be protected from . . . massive commercialization. Shouldn’t 
the Park be protected for future generations? I want my children to experience it as I did.” 

• Omitted sentences: 
“I believe Yosemite National Park should be protected from money hungry capitalists and massive 
commercialization. . . . I want my children to experience it as I did.” 

• Omitted words at the end of a sentence: 
“I believe Yosemite National Park should be protected from money hungry capitalists and massive 
commercialization. Shouldn’t the Park be protected . . . ? I want my children to experience it . . . .” 

Section 10.6 ~ Technical and Editorial Comments 
Technical and editorial (T&E) comments are primarily remarks that identify text corrections with 
the intended purpose to provide greater clarity/consistency within the proposal rather than a 
change in meaning. T&E comments of this nature include the following: 
• Identification of grammatical mistakes. 
• Corrections of inaccurate support material references. 
• Suggestions of alternative word choices to clarify language without changing the intended 

meaning. 
• Identification of inconsistent terminology/phraseology. 

In addition, comments that suggest a more accurate application of scientific models or procedural 
decisionmaking may be considered T&E comments if their application would not constitute a 
change in the intention of the proposal. In this case, the author would have to explicitly state that 
their suggestion would not change the intentions of the proposal. Otherwise, such a comment 
should be captured within a PC. 

For some projects (and under limited circumstances) the team may identify another type of 
comment within the T&E category. If the client agrees to the circumstances, analysts may 
identify as T&E statements that provide such a highly technical response to the proposal so that 
only the agency’s Interdisciplinary Team can properly evaluate their meaning and intention. In 
these cases, the comments are so dependant on context that an adequate PC statement would 
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have to recapitulate most of the SS and would be best handled by direct agency review. This 
provision does not mean that the T&E category is an appropriate place to shove troublesome 
SSs. Again, the circumstances are restrictive and analysts should always seek advice from the 
editor or team leader before assigning such a comment to the T&E category. 

The Analysis Team does not draft a PC statement for T&E comments. T&Es are usually placed 
at the end of chapters, sections or sub-sections depending on project needs. They are 
distinguished from PCs by a distinct font heading stating only “Technical and Editorial.” If a 
project requires PC numbering to help facilitate response to comment, then every T&E should 
have its own number. 

Section 10.7 ~ Entering and Ordering Public Concerns 
After the analyst has identified SSs within the database and drafted PCs (or noted existing PCs) 
for each SS, these materials should be entered into the document outline as provided by the 
document editor. All PCs and SSs should be grouped under the appropriate chapter and sub-
sections. The editor will provide further instruction on the proper protocols to use when readying 
the document for an initial edit.  

Section 10.8 ~ Public Concern List Review 
Before submitting a public concern list to the project editor, please review your document in 
light of the following checklist: 
• Number each PC in consecutive numerical order. 
• Verify PC-SS agreement for every PC. 
• Review the content and context of every PC for duplication and/or conceptual overlap with 

other PCs—removing duplicate material and combining PCs when possible and logical. 
• Confirm compliance of all PCs with the “how to word a public concern” guidelines (section 

10.3). 
• Correct all PCs for spelling, capitalization, and grammar (with particular attention for 

sentence fragments). 
• Correct all SSs according to “editing sample statements” guidelines (section 10.5.1). 
• Review all project specific style sheets and attribution lists. 
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Sample Database Printout with Analysis 
 
SOP 

 
Respondent 

 
Or 

 
Form 

Ltr 
No 

M/A Subject  
Code 

Rational
e code 

Cmt 
No 

 
Comment 
 

3 Dayna Greenroyd I  286 25300 MGMNT 700 1 Please do not poison the birds. There has got to be 
a humane way of relocating or exterminating these 
birds. Poisoning them is going to cause them to 
die slow, cruel, and sick deaths. In relation to 
docket #01-013-3 please find a more humane way 
to stop the birds. 
 

1 Judi Dipillo 
613 Bunting Ln 
Mount Prospect, IL 60056 

I  23 10000 PLANN 100 2 So get it and put your energy into worthwhile 
project—one that the public would favor for a 
change. 
 

3 Blaze Cascade Starkey I  446 70100 SOCIO 920 3 I find it disturbing that after people have 
completely destroyed much of there habitat 
needed by birds and other creatures, and then 
planted a vast amount of one of their favorite 
foods in a main migratory route, that some people 
would be willing to kill millions of a species over 
relatively small amount of money. 
 

3 Mary Roberts 
1000 Bourn Ave 
Columbia, MO 65203 

I  227 60100 NRCOM 906 3 And we shall be looking into companies who 
purchase seeds from those who might have 
accepted your generous offer. 
 

3 Jennifer Lutz 
380 Wild Turkey Lane 
Charlottesville, VA 22903 
 

I 
 

 
 

549 60100 NRCOM 906 1 I urge Morning Song to terminate business with 
farmers who are represented by the National 
Sunflower Association. I am IMMEDIATELY 
terminating my purchase of ANY seeds from 
companies that work with this association. 
 

3 Mollie Stapleton I  444 60100 MGMNT 920 1 I heartily object to the poisoning of fields directed 
at red wing blackbirds. I will go so far as to 
boycott the sunflower seeds of North Dakota, and 
postpone any travel to South Dakota if this takes 
place. It seems rash to put poison out willy nilly 
and poison lots of birds to kill one type especially 
ones so prolific. 
 

3 Allison Levin 
160 Frisbie St 

I  440 25300 MGMNT 425 1 I am opposed to the proposal to poison Redwinged 
Blackbirds in the Dakotas, as a means of 

This sample statement (SS) yields a clear public 
concern (PC): APHIS/Wildlife Services should not 
poison Blackbirds. 

There is no clear request for 
action in this SS. Perhaps it 
could have been better coded. 

Again, perhaps this SS should have been coded differently. It is 
unclear as to what this respondent is referring to.

This SS contains a clear PC: APHIS/Wildlife Services should not 
poison Blackbirds and a possible subconcern (SC): To prevent 
economic repercussions in the form of a boycott. 

A bit unclear as to what action this individual is requesting 
from the agency. The first SS better states the request that 
APHIS/Wildlife Services not use lethal methods to control 
Blackbirds. 

Difficult to write a PC for this SS as the 
respondent is requesting action from a 
private company, Morning Song. 
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Oakland, CA 94611 controlling their impact on sunflower seed 
production. 
I am concerned: 
–for the ENVIRONMENT.  Poisons always pose a 
greater threat to multiple species, clean waters, 
and healthy crops, than anticipated. 
–for the REDWINGS and OTHER BIRDS who 
will be killed, including Western Meadowlarks, 
Savannah Sparrows, Mourning Doves, and other 
grassland species associating with redwings in 
spring or feeding on their own in the treated fields. 
–for RAPTORS feeding on these birds, such as 
Northern Harriers and American Kestrals—
species which are already facing pressures from 
environmental loss. 
 

1 Jim Bob Davis 
1200 Main Street 
Baltimore, MD 12006 

I  123 25300 MGMNT 700 1 I do not agree with the plan to use lethal methods 
to control Blackbird populations. It seems very 
cruel and I shudder to think of those poor birds 
suffering. Every year I look forward to the 
Blackbird migration and it reminds me of when I 
was a young fellow and my father would take my 
out in the woods and we would seek out Blackbird 
roosts. We would always stop at the same café and 
have lunch. I knew spring was here when we took 
those trips.  
 

1 Dean Pedersen 
Agway Inc. 
PO Box 169 
Grandin, ND 58038 

I  160 25311 MGMNT 907 1 I am writing in support of removing 2 million 
blackbirds in a spring baiting program. I am 
employed by Agway, Inc. in Grandin N.D. and 
crop losses by blackbirds and other weather 
related problems directly affect my continued 
employment. I consider it more important to have 
food and shelter for my family of five than to have 
a few birds in our front yard feeder and am an avid 
hunter.  I believe in population management for 
available habitat.  It is clear that the blackbird 
population is too high. 
Again, removing 2 million blackbirds will not 
harm the future of blackbirds but it would provide 
some relief for those employed by the sunflower 
industry.  It is the right thing to do. 
 

1 Mary Jo Johnson 
215 Boston Street 

I  437 43000 ENVIR 200 1 I would encourage APHIS to pursue an alternative 
that protects water quality. It seems as though 

In this case, it is probably fine to leave the 
narrative information in the SS, as it is fairly 
relevant to the comment and request for 
action. 

Some of the personal narrative in this 
SS is irrelevant and can be deleted if 
this SS is used. 

Clear PC in this SS with several possible SCs 
PC: APHIS/Wildlife Service should not poison red-winged Blackbirds.
SC: Because of environmental reasons 
SC: Because of the impact on non-target bird species 
SC: Because of the impact on predators 
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North Platte, SD 43872 most of the alternatives include the use of poisons 
and I am concerned that this will adversely impact 
the water quality of our communities. I live quite 
close to areas where APHIS plans on applying 
DRC. We still rely heavily on well water. What if 
our water is poisoned? I agree that Blackbirds 
have gotten out of control in some areas bit I do 
not want Silent Spring in my community.  
 

1 Bill Pazzan 
50 Oak St 
Salt Lake City, UT 84103 

1  535 10000 PLANN 100 1 I cannot believe the federal government wants to 
exploit wilderness areas in Alaska to drill for oil. 
There is hardly any oil there and it is not worth the 
environmental risk. I believe we should pursue 
more sustainable energy source like solar and 
wind. 
 

 
 

 
 

Although this may appear to be a request for the agency to develop a 
new alternative—and in a sense it is—the comment was properly 
coded to the ENVIR section under water quality as this section better 
captures the sentiment of the respondent. 

This comment is clearly beyond the scope of this project and probably should 
not even be coded. If in doubt, check with a team leader in cases of comments 
that may be out of scope. 
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Chapter 11 ~ Writing Narratives 
Although some analysis projects only require the team to create a list of public concerns, 
most require us to write a narrative description of those public concerns. Narratives generally 
fall into one of two categories: executive/thematic summary or full summary. Thematic 
summaries require the analysis and discussion of the main themes extracted from the 
database and public concern list (hence the term “thematic”). Conversely, full summaries, 
which are often considered more difficult to write because of their specificity, require the 
discussion of each and every public concern. 

Section 11.1 ~ General Narrative Writing 
“It is an old observation that the best writers sometimes disregard the rules of rhetoric. When they do so, 
however, the reader will usually find in the sentence some compensating merit, attained at the cost of the 
violation. Unless he is certain of doing as well, he will probably do best to follow the rules.” – William 
Strunk 

An author must first know the rules of good writing in order to effectively break them. 
Disregard for these rules—without purpose—generates a muddled, incoherent, or 
meaningless expression that frustrates rather than enlightens the reader. While ‘purpose’ is an 
effective starting point, Professor Strunk argued that writers also need skill to successfully 
pull off composition transgressions. Narrative writing shares this fundamental truth. Certain 
skills are requisite to writing a narrative summary of public comment that is both creative 
and meaningful. Our narratives should be engaging and informative, clearly structured and 
astutely representative, insightful of complex relationships and useful for decision-makers as 
well as other interested parties. 

Though content analysis is involved in many aspects of government agency decision-making 
(such as public involvement and response to comment) the heart and soul of the content 
analysis is the systematic review of public comment. The application of carefully practiced 
analytical techniques will enhance the consideration of and response to public input. The 
team’s practical goal is to help meet agency legal requirements but our conceptual goal, as 
intended by existing statutes, is to facilitate more inclusive and responsive decision-making. 
Among the many tools is a narrative summary that distills boxes of letters and an entire 
database of comments into one relatively short, coherent, representative, and contextual 
presentation of the suggestions, questions, demands, and perspectives presented by project 
respondents. A critical step towards producing narratives that meet our goals is establishing a 
shared understanding among team members regarding key terms and concepts, basic 
expectations, and relevant applications of our individual knowledge and abilities. Completion 
of this step will allow us to confidently promise clients a meaningful analysis of the 
context—as well as the content—of what respondents submit for consideration. Anybody 
could break the content of letters into chunks. Most people could reasonably organize those 
chunks. Our narratives should do the first two steps AND make sense out of it all—otherwise 
we would offer no benefit to the decision-making process. 

This chapter of the technical guide presents some advice and tools; however, it does not share 
“tricks” or reveal formulas to success. This chapter does not present the ONLY approach to 
narrative writing. It simply provides a framework for getting started and remaining aware of 
the parameters that must influence all of our activities. The information and advice presented 
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in this chapter is founded upon the convictions that GOOD writing (and good analysis) is 
painful and rewarding; requires personal investment; is structured by the source material 
rather than stale formulas or safe patterns; and results from conscious choices of when to 
break the rules. 

The process of going from plan to implementation for any public project would go much 
faster if we didn’t evaluate the context of the proposed action. However, statutes (and 
common sense) dictate that faster decision-making doesn’t necessarily equate with better 
results. A long list of laws, regulations, and policies require federal agencies to act 
expeditiously AND to fully evaluate the context of their actions. Narratives should not only 
help our client agencies meet these expectations but should also follow the same principles. 
We must produce our documents in a timely manner while remaining conscious of both the 
substance and intent of our role in decisionmaking. The team does not simply apply formulas 
to separate public comment into discrete bits of information. The team helps to elucidate the 
content and context—from specific concerns to underlying themes—present within the letters 
we receive. Conscious decision-making should be evident in every aspect of our products. 

“Form follows function” is a famous phrase that has been applied to the writing profession. 
Though it is not the answer to all of writing’s confounding problems, it does summarize 
chapters of writing advice into a helpful reminder that the choices an author makes should be 
guided by a purpose. The purpose can be very literal (consistent use of key terms to clarify 
the relationship between ideas) or somewhat implicit (employing passive voice to change the 
pattern or tone of a paragraph). The definitions and examples that follow should help 
establish a structure for making choices regarding the form and function of our key narrative 
elements. Subsequent segments of this section explore the expectations placed upon writers 
as reflected by the concepts presented in this writing workshop as well as some rather 
philosophical applications of these materials. 

11.1.1 ~ Narrative Analysis 
Much of the analysis takes place during coding and public concern identification, so when 
you are writing narratives, analysis of comments primarily involves explaining why citizens 
have expressed a particular concern. The same reasons for supporting or criticizing one 
aspect of a proposal may underlie more than one public concern; look for ways to connect 
such concerns in your narrative. Keep in mind, however, that narratives are more useful to 
clients if they explicitly incorporate the “why” that goes with each “what”; in other words, 
the premises that support the conclusion.  

The reasons people support a particular course of action can be found in the sample 
statements that accompany your public concerns. It is a good idea to reread your sample 
statements to better understand and paraphrase exactly what the public is saying. To add 
stylistic variety, you may include cogent and clear quotations that elucidate a particular 
concern. However, as our job is to synthesize and analyze the public comment on a project, 
not replicate it, use direct quotations sparingly. 

The narrative is written in the present tense. People continue to feel, believe, and consider 
while we are writing the analysis. You should also avoid the urge to use esoteric jargon or 
“bureau-speak” like “publics.” While our primary audience is usually the client, our 
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documents should communicate clearly to both the agencies that hire us and the people who 
submit comments. 

Before you start writing your narrative in earnest, there are a few additional writing rules to 
keep in mind. Although you should avoid using acronyms in public concern statements, you 
usually can use them within narratives. Just be sure to write out the acronym the first time it 
is used in each chapter, and follow it immediately by the acronym in parentheses. Subsequent 
use of the acronym alone is acceptable: 

“Despite the fact that the proposed rule does not recommend changes in protection or 
management for the Southwestern Distinct Population Segment (SWDPS), many people offer 
comments on how the SWDPS should be designated and managed.” (Gray Wolf Narrative, 
Southwest Distinct Population Segment) 

Section 11.2 ~ Thematic Summary 
11.2.1 ~ Definitions and Examples 
Professional Writing Style/Creative Presentation of Factual Material – A concise, 
coherent, grammatically and structurally correct analysis of key ideas is the starting point for 
writing in a professional style. Further, professional writing should present objective analysis 
while creatively engaging readers such that they want to understand the material being 
presented and they are able to identify some meaning or relevancy to their own lives. Writers 
must recognize that our work will likely be read by more than just agency line officers—
potential litigants and respondents to the proposal are strong possibilities—so the language 
and structure of our analysis should be accessible to multiple audiences. We don’t intend to 
‘dumb down’ our narratives, but simply write to a ‘reasonably well informed’ reader who is 
not well versed in technical jargon. Clearly exploring complex relationships between 
disparate ideas and elucidating the contextual nature of strong arguments are important ways 
to accomplish the task of reaching out to multiple audiences. 

1. Introduction – An introduction serves several purposes: establish a central theme or 
range of topics; provide background to understand the context of topics and themes; offer 
an overview of what will be covered; and generate interest in the material (provide a 
“hook”). Introductions should be written for every chapter, section, subsection and 
paragraph. Ranging from several paragraphs to a single sentence, the detail of an 
introduction should be determined by the nature of the material to be presented. Try to 
avoid imparting too much content and context within your introduction. It will be more 
useful to the audience if you err towards keeping your introduction short rather than 
incline towards overloading it. The body of the narrative section is the appropriate place 
to examine the nuances of complex issues and divergent perspectives. 

1.1. Topic Statement – Though many fields of professional writing do not 
distinguish between topic statements and topic sentences, the analysis team does 
distinguish because they serve significantly different functions. A topic statement 
simply provides a list of topics that may or may not be discussed further within the 
narrative. These statements are often used within introductions but can also be helpful 
for body or conclusion paragraphs. Providing a concise list of topics can achieve valid 
purposes: offer a quick overview of topics to be covered; acknowledge a long list of 
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related concepts without needing to detail each individually; or establish a logical 
development between seemingly disparate ideas. The primary problem with topic 
statements is that they are content-centered, unable to reveal the context that allows 
the reader to understand a greater meaning to the topics. 

“Chapter One offers a comprehensive overview of public comment concerning the 
Herger-Feinstein Quincy Library Group (HFQLG) Pilot Project and related project 
documents, including the Draft Environmental Impact Statement (EIS).” (QLG Narrative, 
Purpose and Need) 

“Numerous comments ask that the U.S. Fish and Wildlife Service designate new DPSs 
for various geographic regions: the Pacific Coast states, including Washington, Oregon, 
and California; Southern Oregon/Northern California; the central states, including 
Nebraska, Kansas, Missouri, and Iowa; and the Southeast, including Virginia, Kentucky, 
the Carolinas, Georgia, and Tennessee.” (Gray Wolf Narrative, Distinct Population 
Segments) 

1.2. Topic Sentence – Often referred to as a “thesis statement” in persuasive writing, 
topic sentences precipitate our role as public comment analysts. They introduce key 
concepts as well as the context that will be further explored. The context provided 
within a topic sentence may range from unexpected interpretations of prevalent 
issues, conflicting positions among respondents, or informative relationships between 
issues and respondents. Topic sentences should challenge the reader to consider the 
complexity underlying public comment and agency decision-making. 

“In general, those who support the proposed rule see it as a necessary step to improving 
and preserving the health of roadless areas with respect to a number of factors; while 
those opposed see it as a barrier to forest health.” (2000 Roadless Narrative, 
Environmental Effects) 

“Though the breadth of public input regarding the Bitterroot National Forest’s Draft EIS 
addresses a wealth of resource areas, the comments, concerns, and requests they offer are 
rooted in the reality of the 2000 fires, how to manage the fuels that feed fires, and the 
desired future conditions of the Bitterroot Valley landscape.” (BBAR Narrative, Fire and 
Fuels) 

1.3. Introductory Paragraph – Whether employing a topic statement or sentence, 
introductory paragraphs should do more than simply begin analysis of a topic area. 
These paragraphs should provide enough background to help the reader understand 
why the topic area is of concern and how it relates to other segments of the analysis. 

“[Background - “hook”] Fire and fuels provided the genesis for the Bitterroot National 
Forest’s Burned Area Recovery project. During the summer of 2000 natural fire and 
forest fuels combined to transform much of the Bitterroot Valley landscape. This 
transformation crossed federal, state, and private boundaries. Decisions on how to deal 
with the transformed landscapes, as well as objectives to prepare for future fire events, 
cross those same boundaries. [Topic Sentence] Though the breadth of public input 
regarding the Bitterroot National Forest’s Draft EIS addresses a wealth of resource areas, 
the comments, concerns, and requests they offer are rooted in the reality of the 2000 fires, 
how to manage the fuels that feed fires, and the desired future conditions of the Bitterroot 
Valley landscape. [Overview] Fires - whether ignited naturally, accidentally, or 
intentionally by fire managers - directly impact particulate levels and visibility conditions 
throughout a region. For this reason, public comments regarding air quality are also 
addressed in this section.” (BBAR Narrative, Fire and Fuels) 
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“[Background - context] The planning process detailed in Chapter 1 of the Draft EIS 
establishes the framework for decision-making that the Bitterroot National Forest will 
follow to rehabilitate the landscapes burned or directly affected by the fires of 2000. 
Some of the fundamental steps to creating an adequate planning process include: clearly 
determining a purpose and need for action; defining what areas (resources, geography, 
conceptual scales) and management actions are within the scope of the purpose and need; 
identifying relevant sources for scheduling, reviewing, and implementing the proposed 
actions; and establishing methods to monitor the effectiveness of decisions and actions. 
[Topic Statement and Overview] In reflection of these elements, public comments on the 
Burned Area Recovery (BAR) project’s planning process are focused upon compliance 
with laws, regulations, and policies governing the stated purpose and need; clarification 
of the document’s language and intent; adherence to public involvement and scientific 
analysis requirements; and provision for adequate monitoring of effects.” (BBAR 
Narrative, Planning Process and Policy) 

2. Body – The bulk of our analysis appears in the body of the narrative. The body is 
where we are able to explore the nuances and interrelationships between issues and 
perspectives. Although the exact structure of paragraphs should vary throughout a 
section, there are some fundamental traits that should always be present: 1) meaningful 
topic sentences; 2) clear differentiation between general and specific ideas; 3) logical 
transition between themes and topics; 4) consistent references to link disparate material; 
5) insightful development of ideas rather than repetition of key terms; 5) obvious 
relationship to the paragraphs which precede and follow. 

2.1. Transition – [highlight relationships] [flow of ideas] [word(s), phrases, or whole 
sentences] [introduce a new topic or perspective] [introduction or middle of 
paragraph] 

“However, some respondents think the Preferred Alternative has the potential to backfire 
. . . .” (Santa Fe Narrative, Alternatives) 

“[A paragraph about where and when many respondents believe wolves should be 
reintroduced.] 

While many believe that the U.S. Fish and Wildlife Service’s primary goal should be the 
reintroduction and recovery of the gray wolf throughout its former range, others contend 
that the agency’s paramount concern should be the education of the public...” (Gray Wolf 
Narrative, Purpose and Need for the Proposed Action) 

2.2. Parallel Structure – Words, phrases, and clauses should be parallel within a 
sentence. Additionally, words, phrases, and clauses can be parallel between different 
sentences to clarify the relationship between concepts. For parallel structure within a 
sentence, balance nouns with nouns, prepositional phrases with prepositional phrases, 
main clauses with main clauses, and so on. Parallel structure allows the writer to 1) 
create an easy information flow, 2) make points concisely, and 3) emphasize logical 
progression or inter-relationships. Each portion of a parallel structure should read 
logically within the sentence if the other portions are removed. This technique is 
useful for complex sentences but should not be overused as it quickly becomes 
tedious and distracting. 

“This proposed rule would (1) establish four Distinct Population Segments for the gray 
wolf in the conterminous United States and Mexico, (2) reclassify naturally occurring 
gray wolves within three of these Distinct Population Segments from endangered to 
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threatened status, (3) delist gray wolves in areas outside Distinct Population Segments, 
and (4) establish three special regulations under section 4(d) of the ESA.” (Gray Wolf 
Narrative, Introduction) 

“To aid the reader in understanding the relationship between themes elucidated in this 
summary and the content of the Draft Environmental Impact Statement (EIS), this report 
is organized into four general sections that parallel chapters in the Draft EIS. Section one 
addresses concerns regarding the plan, its purpose, and the planning process in general. 
Section two includes analysis of public comment about the various alternatives offered in 
the Draft EIS. Section three summarizes public concerns regarding effects on the 
biological environment. Section four explores issues that affect the human and social 
environment.” (Santa Fe Narrative, Introduction) 

2.3. Internal Reference – Another way of tying sentences, paragraphs, and sections 
together involves internal reference, such as using reference words that point back to 
an idea mentioned previously. This, these, those, such, and that are obvious reference 
words but they must be combined with the important words and phrases from 
previous sentences or paragraphs to make the connection complete. Descriptive 
phrases can also tie together disparate elements of a narrative. 

“The concerns over threats facing gray wolves nationwide are similar to those voiced 
concerning wolves in the NEDPS.” (Gray Wolf Narrative, Northeastern Distinct 
Population Segment) 

“As noted in the introduction to this summary, many of these people view development of 
new rules for forest road management as an opportunity to implement a permanent ban 
on road building in roadless areas.” (1999 Roads Narrative, Purpose and Need) 

3. Conclusion – Conclusions are often the most difficult part of the analysis to write. 
However, writers need to keep in mind that the conclusion is often what readers 
remember most. The conclusion should: synthesize the topics and major perspectives 
addressed within the segment, reassert the significance of the issues analyzed, and give 
the segment an element of closure. Formal conclusions need to be written for all chapters 
and sections. Informal conclusions, such as a closing sentence, should be provided for all 
subsections as well. Conclusions should: answer the question “So What?” (reassert what 
is meaningful and useful); synthesize rather than summarize (confirm that the material 
and your analysis was not random, but fits together); and reestablish a larger context 
(redirect readers to consider how these ideas impact the agency’s proposal). 

“In summary, respondents voice a number of concerns relative to access, identification of 
other unroaded areas, exemptions, environmental effects, public involvement, forest 
dependent communities, cumulative effects, and the alternatives and development of the rule. 
Concerns are rich and varied, reflecting as they do the rich and varied perspectives of 
individual citizens and groups. For the most part, however, respondents tend to support or 
oppose the proposed rule depending on their beliefs and assumptions regarding the nature and 
role of forest lands. As pointed out earlier, proponents see the rule as a positive step toward 
protecting what wildlands we have left, ultimately toward improving human well-being and 
preserving the health of our planet. Opponents see it as an assault on human freedom, an 
attack on their way of life, and a recipe for forest degradation. These competing beliefs shape 
the concerns respondents raise relative to specific issues and inform the deeply emotional 
character of this debate.” (2000 Roadless Narrative, Development of the Rule) 

4. Contextual Analysis of Content 
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4.1. Concerns/Topics/Themes – Concerns, topics and themes (within the realm of 
content analysis) are largely dependent concepts that are best defined by their 
relationships to each other. Concerns are the relatively specific concepts we identify 
from public letters. They are direct expressions that may take the form of questions, 
suggestions, clarifications, requests, or declarations. Topics are the larger subjects, 
resources, or issues that often generate the specific concerns people submit in 
response to an agency proposal. They tend to connect multiple concerns, although a 
single concern may present a topic. Conceptually, topics overlay concerns in that they 
represent a grouping, synthesis, or simplification of concerns. They may be directly 
expressed or may need to be extrapolated from direct expressions. Topics can take 
many forms, from an entire resource area addressed within an EIS, to methods of 
conducting a preferred action, to support/oppose dichotomies. Themes capture the 
underlying context that gives meaning to and reveals relationships between both 
concerns and topics. Themes are almost exclusively the product of extrapolation and 
may be expressed through a variety of forms. Identifying common characteristics 
between respondents (‘valley residents,’ ‘professional foresters,’ ‘supporters of the 
proposed action,’ etc.), presenting a spectrum of viewpoints from which to examine 
extreme positions as well as compromise perspectives (‘though most respondents 
either support or oppose the proposal, many suggest alternative approaches’), and 
recognizing implicit associations (‘though few directly express a preference for the 
No Action Alternative, many ask the FS to maintain current management directions’) 
are all examples of the forms the team uses to capture a theme. 
The following is an imprecise simplification, but it may help clarify the relationship 
between these concepts. People possess motivations, beliefs, and/or goals that inspire 
them to respond to an agency’s proposal (revealed as themes). These elements are 
focused by choices to write about certain issues (organized by topics). In writing a 
letter, they detail specific points-of-view (expressed as concerns). 

“Those favoring restoration and accompanying reduction (or outright ban) of developed 
activities are not insensitive to those whose livelihood and cultural traditions are deeply 
rooted in commodity production from these Forests. [long sentence detailing concepts 
supporting this analysis]” (Southwest Idaho Ecogroup Narrative, Public Comment – 
General Overview) 

“With a few notable exceptions, the majority of public comments regarding forest 
vegetation extend from one of two basic positions: to remove burned trees or to leave 
them. Respondents give many different reasons for and against removal, and, generally, 
these either emphasize the benefits of leaving burned timber for ecological reasons or 
emphasize the economic benefits of salvage logging.” (BBAR Narrative, Forest Plant 
Communities—Threatened, Endangered, and Sensitive Plants) 

From a reverse perspective, a section of our analysis may contain the following four 
concerns: ‘the agency should evaluate the impacts of W;’ ‘the agency should evaluate 
the impacts of X;’ ‘the agency should include report Y in their analysis of impacts;’ 
‘the agency should consider Z as an alternate approach.’ One topic that can be 
identified among these truncated concern statements is failure to adequately analyze 
impacts. We can examine that topic further by reading the sample statements to 
search for a theme. We may find the SSs for all four PCs are based in a belief that the 
agency’s proposal will significantly damage the landscape—that evaluating W and X, 
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including report Y, and considering Z are all just different ways of saying they want 
the agency to choose a direction with less potential for environmental damage. We’ve 
found a theme; now we should further explore the relationships between these 
expressions because the topic we identified may still be an important part of the 
context. Even though the concern statements for numbers three and four may not say 
anything about adequate analysis, the SSs may reveal an important relationship—if 
the agency includes report Y it will force them to acknowledge inadequate analysis 
AND if they consider Z it will require more comprehensive analysis—that gives more 
substance/meaning to this expression than simply stating, “some respondents don’t 
support the agency’s proposal.” 
4.2. Attribution – It is imperative that we link specific sentiments to those 
respondents who explicitly stated them. Just as important is that we try to provide our 
audience with some context to which respondents express the themes we identify. 
Meaningful attribution should move beyond, “Many people believe . . . . Others argue 
. . . .” We should not force titles or categories upon respondents but our analysis will 
become more consequential to the audience when we acknowledge relevant 
relationships between those who are presenting similar OR contrasting ideas. 

“Responses to some sections of the Affected Environment and Environmental 
Consequences chapter are dominated by funded entities––conservation organizations, 
timber representatives, and professional resource experts. However, an array of 
individuals and organizations (local, regional, and national) present concerns regarding 
the Fire and Fuels section of this chapter.” (BBAR Narrative, Fire, Fuels and Air 
Quality) 

“These respondents, including numerous elected representatives and government agency 
officials, assert the proposal will circumvent local Forest Service authority.” (1999 Roads 
Narrative, Local and Regional Expertise/Authority) 

4.2. Extrapolation – A collection of respondents will often express the same basic 
idea in different ways. These differences may be expressed through slight alterations 
of text or drastically different styles. Our analysis often requires that we extrapolate 
one concern, one topic, or one theme from these expressions. Additionally we often 
must extrapolate connections between different sections of an analysis even if the 
public concerns and sample statements we use a references for that section do not 
explicitly make the connection for us. 

“Although several people believe the EIS team should carefully consider the impacts of 
the pilot project on ephemeral streams and advocate selection of Alternative 5 for its 
water quality protection emphasis, others question whether interference with these 
streams truly poses a threat to forests' ecological integrity.” (QLG Narrative, Aquatic, 
Riparian, and Wet Meadow Ecosystems Management) 

“It is fair to characterize many of the comments as either pro-salvage logging or anti-
salvage logging, even though respondents offer a wide spectrum of considerations to 
support their positions.” (BBAR Narrative, Forest Plant Communities—Threatened, 
Endangered, and Sensitive Plants) 

5. Internal Integrity – Usually several authors contribute to the documents, introducing 
the potential for glaring differences in style, language, and structure. One of the primary 
roles of the project editor is to establish an electronic template, style guide, and 
attribution sheet for every project in order to reduce these impacts on the final product. In 
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general, final documents can accommodate some minor differences in style but should be 
consistent in approach and tone. It is important to note that internal integrity encompasses 
more than just aesthetic and procedural elements. We must strive to give proportional 
representation (not necessarily equal) to every section incorporated into the final 
document. Thus, internal integrity refers to both the style and the substance of the 
documents. 
6. Self-conscious Authorship – Acknowledging our role in the analysis of public 
comment strengthens our work and downplays the perception that we are simply 
recapitulating what people wrote. We make decisions to condense or expand our analysis 
throughout the process of coding letters, evaluating the database reports, drafting public 
concerns, and writing narratives. Our decision-making should be explicit in the narrative 
analysis rather than subverted. 

“Throughout this section you will read about conservation organizations, professional 
societies, and individuals accusing the Bitterroot National Forest of failure to adequately 
consider and disclose long-term, cumulative impacts. . . . Conversely, a strong contingent of 
timber industry representatives and local citizens (though by no means exclusively or 
unanimously local) focus attention on the isolated, short-term impacts they believe 
necessitate immediate action. . . .” (BBAR Narrative, Affected Environment and 
Environmental Consequences) 

“Though some respondents delineate a direct connection between their comments on the 
interim rule and the 2000 rule, in most cases the link is implicit at best. Additionally, a few 
individuals express alarm regarding the contents of an unpublished, internal-draft document 
detailing substantive revisions of the 2000 regulations. The nature of these comments 
necessitates separate review in order to avoid misrepresenting concerns by placing them 
within a context the author may not have intended.” (2001 Planning Regulations Interim 
Rule, The 2000 Regulations and Future Revisions) 

Adequacy of Analysis – We must remain mindful of the relationship between the narrative 
summary and the public concern list. The narrative summary is organized primarily to assist 
decision-makers and members of the public in understanding the overarching context, 
emotions, and relationships present in public comments. The public concern list is organized 
primarily to assist the client’s resource specialists in identifying specific matters that need to 
be addressed within the planning process. Therefore, the public concern list is intended to be 
specific, while the narrative is intended to be more general. Ultimately, the analyst must 
decide whether or not she or he has adequately captured the depth and breadth of public 
comment directed to a particular section of the analysis. There is no direct correspondence 
between the number of concerns and the length of narrative summary but a general rule is 
that no section should be longer than five pages. Presenting the major themes within a 
meaningful context is the objective from which to gauge the adequacy of a narrative analysis. 

Meeting Timeframes – All content analysis products, including narrative summaries, must 
be conducted in accord with a balance of thoughtfulness and timeliness. While the team 
strives for an engaging style and a thoughtful analysis, the analyst’s narrative approach must 
also be determined by the amount of time and resources available. The analysis team 
maintains a solemn objective to deliver products by the dates specified in our contracts. 
Overtime work is one means to achieving this objective but this option is not a substitute for 
doing good work in a timely manner. The team must remain committed to working 
efficiently. 
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Section 11.3 ~ Full Summary 
Ordering Your PC List 

A systematic approach to writing full and narrative summaries follows. This is only one of 
many possible writing approaches; it is designed for beginning writers but may also be useful 
for more experienced people suffering from writer’s block or working on an extremely tight 
deadline. If you have done a good job of creating your public concern list, you will have 
already ordered your concerns in a logical manner to facilitate narrative writing. If not, this is 
your first and most important writing task. Similar concerns should be grouped together, and 
within each sub-group, concerns should be ordered from general to specific, if possible. 
Arranging your public concerns in a logical, easy-to-write order is literally half of the 
narrative writing task.  

Once your public concern list is complete and ordered, you can begin writing your narrative. 
Your public concerns and sample statements should already be in a document template with 
all the correct formatting in place. A quick and easy way to construct a good outline of your 
narrative is to simply copy your public concern statements and paste them into paragraphs in 
the CA body text font. Since we will be using sample statements later on in the process to 
help flesh out the narrative, some writers like to paste both their public concern statements 
and at least one sample statement into CA body text font. The examples that follow will only 
contain the public concern statements. 

For full summaries, all public concerns are incorporated into your narrative in the order they 
appear in your public concern list. Unlike thematic summaries, full summary sections have 
public concerns and sample statements attached, so it is important to first order your entire 
list of public concerns into logical paragraphs. Not only does this give you structure and a 
starting point, but it also ensures that you will be writing about your concerns in the order 
they appear in your list. Such an outline has been created below from the public concerns 
identified in one section of a CA document: 

The Yosemite Valley Plan should provide for the restoration of sensitive habitats. The 
Yosemite Valley Plan should protect meadow, black oak, and riparian areas from 
pedestrian traffic. The Yosemite Valley Plan should allow grazing in meadows in 
Yosemite National Park. 

The Yosemite Valley Plan should prohibit the removal of any trees in Yosemite 
Valley. The Yosemite Valley Plan should require the retention of tall pine trees in 
Yosemite Valley. The Yosemite Valley Plan should require low-impact management 
techniques for restoration of closed campgrounds. 

The National Park Service should utilize carefully managed prescribed fire to 
improve habitat conditions. The National Park Service should consider mechanical 
treatments to enhance Yosemite National Park vegetation. The National Park Service 
should eliminate controlled burning in Yosemite National Park. 

The first paragraph deals with general vegetation restoration practices as well as meadow 
communities. The second paragraph groups concerns regarding trees in the valley, while the 
third paragraph addresses fire management and its effects on vegetation. 
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When writing a full narrative, writers often find it easier to group similar concerns into 
subsections, thus eliminating the need to create transitions between disparate subject areas. 
Sections that contain 15 or more public concerns probably should be divided into subsections 
for both the ease of the writer and reader. Generally speaking, two pages of full narrative is 
the maximum limit of comprehension and readability. If your full narrative exceeds two 
pages, you either need to cut text or split your section into subsections. 

In the example we are using, we could split the section into three subsections: meadows, 
trees, and fire. Although our use of subsections has eliminated the need to connect the three 
subsections with transitional sentences, it would be a good idea to start off such a subdivided 
section with a general road map. (It is important to note that such roadmaps are generally 
only used at the beginning of chapters and subdivided sections; non-subdivided sections do 
not necessitate such a road map.) 

Section 4.5 ~ Vegetation 
Protecting and enhancing the vegetative components of impacted ecosystems in 
Yosemite Valley is an important consideration for many respondents. Section 4.5.1 
summarizes concerns addressing the adequacy of analysis of vegetative impacts and 
the restoration of meadows. Comments regarding the removal of trees in Yosemite 
Valley are covered in section 4.5.2, while concerns relating to the use of prescribed 
fire can be found in section 4.5.3. 

4.5.1 ~ Meadows 
The Yosemite Valley Plan should provide for the restoration of sensitive habitats. The 
Yosemite Valley Plan should protect meadow, black oak, and riparian areas from 
pedestrian traffic. The Yosemite Valley Plan should allow grazing in meadows in 
Yosemite National Park. 

4.5.2 ~ Trees 
The Yosemite Valley Plan should prohibit the removal of any trees in Yosemite 
Valley. The Yosemite Valley Plan should require the retention of tall pine trees in 
Yosemite Valley. The Yosemite Valley Plan should require low-impact management 
techniques for restoration of closed campgrounds. 

4.5.3 ~ Fire Management 
The National Park Service should utilize carefully managed prescribed fire to 
improve habitat conditions. The National Park Service should consider mechanical 
treatments to enhance Yosemite National Park vegetation. The National Park Service 
should eliminate controlled burning in Yosemite National Park. 

We’ve mapped out a starting structure, but because we only have nine concerns in this 
example, we probably don’t need to divide them into subsections (and we won’t). 
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11.3.1 ~ Converting Public Concerns into Full Narrative 
Since we are summarizing and analyzing the comments of others, all statements within your 
narrative must attribute the action expressed in your sentence to the person or group that 
submitted it. Attributions comprise two components, an actor and a verb, and are essential to 
creating a document that objectively presents public comment. (A list of attribution actors 
and verbs is included in section 3.4 of this chapter). Preliminary sentences can be created by 
simply choosing an attribution actor and verb and then connecting those to your public 
concerns. 

A common mistake for writers is starting all paragraphs and sentences with “many 
respondents believe” or similar constructions written in subject-verb-object order. These 
constructions are often the most clear and direct, and many editors recommend them for 
other types of writing. In writing, however, subjects (respondents, people, individuals, 
organizations) and verbs (believe, suggest, recommend, advise) vary little from sentence to 
sentence. If all sentences follow the same pattern, narratives become painfully monotonous.  

To improve readability, vary the placement of your attributions. They can be placed at the 
beginning, middle, or end of sentences. But keep in mind that attributions that work at the 
beginning of a sentence do not always work as well at the end. Placing the attribution at the 
end of a sentence may turn it into a run-on. This placement only works with very short 
sentences. Even then, such constructions can sometimes be awkward and require more 
careful phrasing. For long or complex sentences, try to place the attribution closer to the 
beginning of the sentence. If the sentence is very long and you cannot logically shorten it, use 
the subject-verb-object order discussed above.  

For variation, you can also replace general attributions with more specific attributions 
associated with the public concern. For example, if a person has a title (e.g., Tribal 
Chairman, US Senator), use it. You can also refer to the type of organization submitting the 
letter (e.g., conservation organization). Just read through your final sentence carefully to 
ensure that you are not giving false impressions regarding how many people, organizations, 
etc. are responding.  

Let’s examine a few different ways to convert two public concern statements into narrative: 

The Yosemite Valley Plan should provide for the restoration of sensitive habitats. The 
Yosemite Valley Plan should protect meadow, black oak, and riparian areas from 
pedestrian traffic. 

Can be written as: 

Many respondents believe that the Yosemite Valley Plan should provide for the 
restoration of sensitive habitats. Still others recommend that the Yosemite Valley 
Plan protect meadow, black oak, and riparian areas from pedestrian traffic. 

OR: 
The Yosemite Valley Plan should provide for the restoration of sensitive habitats, 
suggest many respondents. Of those recommending habitat restoration, several ask 
that the Yosemite Valley Plan protect meadow, black oak, and riparian areas from 
pedestrian traffic. 
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OR: 
Many respondents believe that the National Park Service should restore sensitive 
habitats—in particular meadow, black oak, and riparian areas. 

Now that we have sentences constructed, we need to add topic sentences and transitions. 
Whether you are writing a full or a thematic summary, a topic sentence describing the 
general direction of the subsequent section or paragraph is a writing requirement. Transitions 
between paragraphs are also required since they help the reader follow the logical order of 
your topics. If the topics between two paragraphs are very different, consider creating 
subsections (as previously mentioned), or just create a “two-clause” transition. A “two-
clause” transition takes the topic from the first paragraph in the first clause and connects it to 
the topic in the second paragraph in a second clause: 

While timeframes are problematic for some, the lack of economic analysis also raises 
many concerns. 

Although there really isn’t a logical connection between these two thoughts (other than the 
fact that people care about both), this type of transition will at least move the reader from one 
set of concerns to another. 

11.3.2 ~ Example of a Full Narrative 
Here is what your section may look like once you have included an analysis of the sample 
statements and included all necessary topic sentences and transitions: 

Section 4.5 ~ Vegetation 
Protecting and enhancing the vegetative components of impacted ecosystems in 
Yosemite Valley is an important consideration for numerous citizens. Of these 
respondents, many request that the National Park Service restore sensitive habitats—
in particular meadow, black oak, and riparian areas. While some believe that 
preservation and education will lead to vegetative restoration, others contend that the 
Yosemite Valley Plan should allow grazing in the Valley. Such grazing, they 
maintain, will keep the meadows open and promote the establishment of healthy 
perennial grasses. 

In addition to supporting meadow protection, many respondents support the 
preservation of the Valley’s trees. One constituent opposes the removal of the 
“beautiful tall pine trees which give the Valley so much of its present day character.” 
The disturbance or removal of vegetation and trees during restoration of closed 
campgrounds concerns many as well. “By removing trees, it could deface these sites 
for generations,” offers an individual.  

The use of fire is another vegetative management tool that elicits several comments. 
While some believe the National Park Service should utilize carefully managed 
prescribed fire to improve habitat conditions, others feel that the National Park 
Service should eliminate all controlled burning in Yosemite National Park. 
Additionally, the National Park Service should consider mechanical treatments to 
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enhance Yosemite National Park vegetation, according to another, “where fire cannot 
by itself sufficiently enhance the Park’s pine/oak forest/meadows mixture.”  

7-1. Public Concern: The Yosemite Valley Plan should provide for 
the restoration of sensitive habitats. 
“I support removing roads and utilities to restore sensitive meadow areas, as well as restoring any other 
sensitive types of habitat by removing structures and limiting access. I am a big fan of restoring areas 
to healthy and natural conditions. I feel that wherever possible, removing structures and restoring the 
area should be done. I am also a big fan of continuing to monitor areas after they have been restored. 
All restoration areas should have some kind of monitoring and evaluation schedule set up, as well as 
continued maintenance until the area has fully recovered.”  (Individual, Columbia, CA - #4235) 
“There is too much emphasis in the various alternatives in the draft plan on moving facilities from one 
place to another and on constructing new facilities in places unimpacted in the past. Emphasis should 
be placed on restoration under a clearly articulated set of priorities.”  (Conservation Organization, 
Fresno, CA - #7881) 

7-2. Public Concern: The Yosemite Valley Plan should protect 
meadow, black oak, and riparian areas from pedestrian traffic. 
“Some areas, which are in need of protection, are the meadow areas, the California black oak 
communities, and the riparian habitats. We respect that the protection of these areas is not always 
compatible with the goals of tourism in the area, however, with significant interpretive and educational 
services to visitors to the Park, the long-term protection may be achieved. Immediate preservation 
actions that may be taken could be the construction of raised wooden paths in certain areas of the 
meadow and California black oak habitats, along with construction of paths through a limited area of 
the riparian habitat. We believe that the only way that visitors will respect the ecological significance 
of the area is through educational programs that highlight the fragile nature of such communities.”  
(Individual, San Luis Obispo, CA - #1510) 

7-3. Public Concern: The Yosemite Valley Plan should allow 
grazing in meadows in Yosemite National Park. 
“Meadows should not be closed due to unsubstantiated claims of over-grazing or because of excessive 
use by another user group. Actions limiting use of any grazing area should be after a monitoring 
program acceptable to both users and administrators indicates a need for action, and after review by 
experts in range management. Responsible cattle grazing, where allowed by agency regulation, are an 
acceptable component of the ‘Multiple Use’ concept and should be tolerated by all users as trails are 
not closed to other user groups.”  (Recreational Organization, No Address - #3701) 
“Grazing of meadows by work animals should be implemented to help keep them open and promote 
healthy stands of perennial grasses. Hay transportation and feeding should be controlled, with only 
weed-free certified hay, covered when transported, and with feeding locations controlled to help 
prevent the spread of noxious weeds.”  (Individual, Sutter Creek, CA - #7305) 

7-4. Public Concern: The Yosemite Valley Plan should prohibit the 
removal of any trees in Yosemite Valley. 
“Don’t remove the trees, please. I think that they deserve to continue living. Maybe they are in the 
wrong place, but it’s not their fault.”  (Public Hearing, San Jose, CA - #20520) 

7-5. Public Concern: The Yosemite Valley Plan should require the 
retention of tall pine trees in Yosemite Valley. 
“[I oppose] restoring vegetation in such a way as to eventually eliminate the beautiful tall pine trees 
which give the Valley so much of its present day character. Doing this in the name of some distorted 
view of what the place looked like 100 years ago bears no relevance to what is most enjoyable for 
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visitors of today. I still recall my first impression of Yosemite Valley. On my first visit, I was 
overwhelmed by the enormous (especially for me as non-Californian) pine trees that fit so well with 
the larger-than-life magnificent views of cliffs, and monoliths and water coming down everywhere.”  
(Individual, Los Altos, CA - #3165) 

7-6. Public Concern: The Yosemite Valley Plan should require low-
impact management techniques for restoration of closed campgrounds. 
“I urge you to limit restoration of closed campgrounds to removing structures, pavement and subgrade, 
and possibly some underground utilities; then loosening soil and planting, where necessary. I see no 
merit in removing imported fill to restore the topography of the closed campgrounds. It would add to 
the cost of restoration - and likely postpone its start. It would add pollution and traffic of its own. It 
would destroy existing vegetation, particularly in Camp 9 and Lower River, where revegetation is 
already well underway. By removing trees, it could deface these sites for generations.”  (Individual, 
Oakland, CA - #3835) 

7-7. Public Concern: The National Park Service should utilize 
carefully managed prescribed fire to improve habitat conditions. 
“I feel that prescribed fire can and must be performed in an ever more sophisticated manner to avoid 
partial results and disasters as have occurred elsewhere in recent times. With that in mind, fire 
managers and resource managers must cooperate ever more closely to promote habitats that approach 
pre-settlement conditions.”  (Individual, Walnut Creek, CA - #3565) 

7-8. Public Concern: The National Park Service should eliminate 
controlled burning in Yosemite National Park. 
“Please end all ‘controlled burning’ within this (and all) Park systems. Allow private (and supervised) 
clearing and utilization of wood resources.”  (Individual, Planada, CA - #20513) 

7-9. Public Concern: The National Park Service should consider 
mechanical treatments to enhance Yosemite National Park vegetation. 
“Where fire cannot by itself sufficiently enhance the Park’s pine/oak forest/meadows mixture, then 
some mechanical removal of the Valley’s pine overstory along the lines of a natural landscape design 
should be promoted.”  (Individual, Walnut Creek, CA - #3565) 

Section 11.4 ~ Advice and Reference Materials 
11.4.1 ~ General Writing Advice 
Keep a dictionary and thesaurus at your desk. If you encounter an unfamiliar word, LOOK IT 
UP AND ADD IT TO YOUR VOCABULARY! If you use the same word repeatedly, FIND 
A NEW ONE! Take control of your language; don’t let it control you. 

Practice clear and meaningful writing. Don’t ignore emails, letters to family or friends, and 
instructions to a coworker as opportunities to practice and improve writing skills such as 
organization, clarity of ideas, parallel structure, and internal reference. 

Simplify your writing. This does not mean “dumb it down.” It means clarity must precede 
complexity—only when foundations and structures are clear can the nuances that reveal 
relationships and juxtapositions between ideas be meaningfully explored. 

Eliminate unnecessary, redundant, or tangential phrases that are an acceptable part of verbal 
exchanges but clutter or confuse written communication and often misrepresent reality. In 

Chapter 11 ~ Writing Narratives 11-15 



Technical Guide 
 

particular, avoid pat phrases (“concerned about the environment”—the environment is a 
multifaceted thing and concern for it is not necessarily the antithesis of multiple-use), 
clichés/clichéd constructs (‘loggers vs. environmentalists’—though extreme positions are an 
obvious reality within any public debate, we must ask ourselves every time whether the 
range of comment on a project is so clearly dichotomized and whether these groups are 
really the best examples), and excess/unexplained jargon (“defensible fuel profile zones”—
if the agency’s proposal discusses this term at length, it’s ok to use it in the narrative but you 
should still provide readers some context). 

Try planning out your writing before you start typing. Don’t let fuzzy thoughts become fuzzy 
narrative. If thinking fuzzily helps you get started, follow that direction to its fuzzy 
conclusion, but leave yourself plenty of time to revise your narrative for clarity! A free-
association approach may help you get started but don’t expect anyone else will want to get 
fuzzy with you, especially when a deadline is looming. 

Though not always recommended (as it may precipitate commitment papers), try reading 
your writing out loud. Find an acceptable place, away from coworkers who need to 
concentrate on their own work, to sound it out. Vocalization can tell you a lot about your 
writing. For example, if you are repeatedly out of breath after reading sentences, evaluate 
where you can vary the length/complexity of your sentences. Further, if you confuse yourself 
while trying to read a sentence as one coherent expression it is a good bet the reader will 
have even more difficulty. Ask yourself if too many sentences sound the same. Imagine a 
listener is hearing your material for the first time, is that person going to ask you, “What does 
that really mean?” when you are done? 

11.4.1.a ~ Strategies for Overcoming Writer’s Block 
Writer’s block is often caused by conflicted feelings. We want the writing to be engaging 
AND we want the thing done as soon as possible. We know what we know but we don’t 
know what our readers know. We have all the public concerns; we’ve sketched out the 
themes, but we don’t know what the final analysis should look like. We know what we have 
to say but we are afraid that it won’t measure up to our expectations or to our readers’. 

All of these feelings are natural and normal. Everyone finds writing a challenge. Many 
analysts, however, compound their problems by employing weak writing strategies. When 
these methods fail, they give up. 
Weak Strategies: 

1. Trial and error—since our short-term memory is limited, trying to juggle in your head all 
the possible ways to phrase something usually means we repeat the same rejected phrases 
over and over. One way to avoid this is to make a quick list of alternative phrases. 

2. Insisting on a perfect draft—the surest way to writer’s block. Expecting everything to jell 
at once leads to paralysis and heartburn. This is really much slower than several quick drafts 
focusing on different goals. 

3. Waiting for inspiration—sometimes it works, sometimes it doesn’t. What seems like 
inspiration is usually the result of internalized hard work. In a moment we’ll talk about some 
useful strategies for pushing “inspiration” along. 
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4.Words looking for an idea—we all know those phrases which click so easily into the 
keyboard but then go nowhere: “due to the fact that...” “it is imperative that...” “a wide 
variety ranging from ... to....” These phrases can be building blocks but they won’t help much 
until you know what you’re building. 
Powerful Strategies for Avoiding Writer’s Block: 

1. Making notes—jot down ideas and phrases as they occur to you. Free yourself from 
paragraphs and sentences for the moment—use flow charts, arrows, boxes, outlines, even 
pictures. Right now, you are worried about getting things down before you forget them. 

2. Freewriting/Brainstorming—when you’re not just blocked, when you’re stonewalled, try 
freewriting. Sit down for ten minutes and write down everything you remember about the 
concepts expressed in your public concern list. The object is to write without stopping for the 
whole ten minutes. If you can think of anything to say, write “blah, blah, blah” over and over. 
If other things occur to you as you write, go ahead and record them, even if they are not 
directly related to your topic. These distractions may be part of what is keeping you blocked. 

Freewriting is good for uncovering ideas—it’s a good way to nudge “inspiration.” But the 
main purpose of freewriting is to get you moving! Most of what you write in those ten 
minutes will go in the recycling bin, but you’ll be warmed up and your serious writing should 
go more smoothly. 

Brainstorming resembles freewriting but it is more goal-directed. You start not only with a 
topic, say ‘pros and cons of timber extraction’, but also with a goal: “What do readers need to 
know about the specific debates evident in this public comment project?” Then allow 
yourself to jot down ideas for a set amount of time without censoring any possibilities and 
without striving for perfect prose. When the “storm” has passed you can rearrange ideas, put 
thoughts into complete sentences, edit and polish. 

3. Piecework—sometimes, starting at the beginning induces Perfect Draft Syndrome. It may 
be easier to get started if you approach the task sideways. If you’ve got a plan for the section, 
choose a segment from the middle or a point you know well and start there. Then do another 
segment. After you’ve gained some confidence, you can work on the opening and smooth out 
the transitions. 

4. What I Really Mean Is (WIRMI)—when you’re stuck in a quagmire trying to find the 
perfect phrase, switch to What I Really Mean Is and just say it the way you think it. Once 
you know what you mean, it is easier to refine the phrasing. 

5. Satisficing (satisfy + suffice)—you ‘satisfice’ when you take the first reasonable solution 
instead of searching endlessly for just the right word or sentence. If you’re unhappy with the 
choice, you can bracket it and promise yourself you’ll fix it later. 

11.4.2 ~ Further Advice on Attributions 
As aforementioned, attributions are essential to presenting public comments as objectively as 
possible. Using attributions ensures that public concerns are presented as the thoughts and 
feelings of the citizens stating them, not as facts.  

It is best to vary the placement of your attributions, as well as the type of actor, for 
readability’s sake. Good narrative consists of a mix of general, specific, and pronominal 
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actors. Don’t forget to look at the actual attribution at the end of the sample statement to help 
you add variety to your list of actors; however, review your final sentence carefully to ensure 
it does not give the impression that this respondent was not the only one to make this type of 
comment. While editors prefer active voice over passive, you may occasionally use passive 
voice to create syntactic variety. 

Although attributions can be placed at the beginning, middle, or end of sentences, some 
placement can cause confusion. For example, it is confusing to the reader if the attribution is 
tacked on to the end of a very long sentence. Another common mistake is including an 
interrupting attribution within the body of the sentence without setting it off with commas. 

BAD 

Including the SWDPS would “divert agency resources and attention away from important 
restoration opportunities and may create significant and unnecessary complication with key 
cooperators in Mexico,” one person writes. 

Including the SWPDS one person writes would “divert . . . in Mexico.” 

Including the SWDPS, one person writes would “divert . . . in Mexico.” 

GOOD 
Including the SWDPS, one person writes, would “divert . . . in Mexico.” 

 
General Pronominal Specific 
respondent(s) some representative(s) of (a business) 

person  many member(s) of (a recreational organization) 

people others director of (a local environmental group) 

citizen(s) several (timber industry) representative 

constituent(s) a few lawyer representing (a local homeowners group) 

individual(s) one president of (a small banana republic) 

 

11.4.3 ~ General Writing Directives (borrowed from various sources) 
Vary the structure and length of sentences. Narrative prose becomes choppy (and dull) when 
every sentence begins with the main subject followed by a verb, and when sentences are of 
uniform length: Also, use transitional words and phrases to show relationships between 
sentences. “I stopped exercising. I gained 50 pounds.” We could improve these sentences by 
combining them: “After I stopped exercising, I gained 50 pounds.” Notice how, without any 
transitional words, we cannot be sure what the relationship is between “I stopped exercising” 
and “I gained 50 pounds.” Did the speaker stop exercising because he had gained fifty 
pounds? Or did he gain fifty pounds because he stopped exercising? Did exercise or the lack 
thereof have anything to do with the speaker’s weight gain? A revision should clarify this 
relationship. The following are some additional writing directives: 

1. Omit ‘which’ or ‘that’ when possible.  
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Wordy: “Because the fluid, which was brown and poisonous, was dumped into the river, the 
company that was negligent had to shut down.” Concise: “Because the brown, poisonous 
fluid was dumped into the river, the negligent company had to shut down.” 

2. Replace ‘is,’ ‘are,’ ‘was,’ ‘were,’ or ‘have + a gerund’ to a simple present or past tense 
verb.  

Wordy: “The South African government was undergoing significant changes.” Concise: “The 
South African government underwent significant changes.” 

3. Replace ‘should,’ ‘would,’ or ‘could’ with strong verbs.  

Wordy: “The environmental council could see several solutions.” Concise: “The 
environmental council saw several solutions.” 

4. Substitute strong verbs for ‘-tion’ and ‘-sion’ words whenever possible.  

Wordy: “I submitted an application for the job.” Concise: “I applied for the job.” 

5. Replace prepositional phrases with one-word modifiers when possible. Prepositional 
phrases, those little relationship words like ‘of,’ ‘from,’ ‘after,’ etc., tend to bring in a lot of 
‘-tion’ and ‘-sion’ words too.  

Wordy: “The President of the Student Senate was in charge of the lobbying against the 
merger at the Minnesota Congress.” Concise: “The Student Senate President oversaw 
lobbying the Minnesota Congress against the merger.” 

6. Use a colon after a statement preceding a sentence of explanation, and leave out the 
beginning of the next sentence  

Wordy: “The Theater has three main technical areas. These areas are costumes, scenery, and 
lighting.” Concise: “The theater has three main technical areas: costumes, scenery, and 
lighting.” 

7. Eliminate clutter, which often appears in the form of prepositional phrases, but also watch 
out for senseless or redundant phrases. 

Wordy: “There are many people who find success intimidating.” Concise: “Success 
intimidates many people” or “Many people fear success.” Wordy: “With careless 
nonchalance, she threw the bag over her shoulder.” Concise: “Carelessly, she threw the bag 
over her shoulder.” or “Nonchalantly, she threw the bag over her shoulder.” 

8. Avoid Misplaced and Dangling Modifiers 

Sometimes we become careless and place descriptive phrases far away from the words they 
modify, making our sentences unclear or inaccurate. These phrases are called misplaced 
modifiers. For example, in “I was told that I had been awarded the scholarship by my 
professor,” does this mean the professor did the telling or the awarding? If the professor did 
the telling, we could make the meaning of this sentence clearer by repositioning the phrase: 
“I was told by my professor that I had been awarded the scholarship.” Other times we write 
descriptive phrases that point to or modify words that are not clearly stated in our sentences, 
making our sentences illogical. These phrases are called dangling modifiers. For example, in 
“Walking to college on a subzero morning, my left ear became frozen,” the underlined phrase 
modifies “my left ear.” This doesn’t make sense; some person must have been doing the 
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walking. We can clarify the sentence by putting a logical word after the phrase: for example, 
“Walking to college on a subzero morning, I froze my left ear.” Or, we can change the phrase 
so that it has a logical subject and verb in it: “When I was walking to college on a subzero 
morning, my left ear became frozen.” 

11.4.3.a ~ Using Commas Correctly (adapted from Sherman & Johnson, Modern 
Technical Writing) 
The comma is important because it is the main device by which the grousing of words, 
phrases and clauses is indicated. Consequently it is used, and unfortunately misused, more 
than all the other marks combined.  

Its use, however, is not haphazard. Competent writers almost always use commas for one of 
two purposes: to set off some element of the sentence from what precedes, what follows, or 
both, or else to separate two elements as they might be separated by a pause or rising 
inflection of the voice if one were speaking. The few uses that fall into neither of these 
categories are the arbitrary use of commas on certain specific occasions, to be pointed out 
below, and the insertion of a comma when its presence is necessary for the sake of clarity.  

The rules that follow, though numbered consecutively throughout, are grouped in accordance 
with the uses referred to above.  
Commas Used to Set Off  

1. An appositive or a term of direct address is set off by commas: “The original factory, an 
old stone structure, is still standing.” 

Note: No comma is used when a noun and its appositive are so closely related as to join in 
expressing a single idea. For example: “The invasion was led by my brother John.” 

2. An adverbial clause preceding its principal clause, or an adverbial phrase at the beginning 
of a clause, is usually set off by a comma: “On all floors except the second and the fourth, the 
fire hazards have been removed.” 

Note: If an adverbial clause or phrase is extremely short, and if omission of the comma could 
not cause confusion, the comma may be omitted.  For example: “When he arrived he was 
immediately seated.” “During July the plant will be closed.” 

3. Independent elements, participial phrases, gerund phrases, and other such constructions at 
the beginning of a sentence are set off by commas: “No, the shipment has not yet arrived.” 
“Worried by the complaints, we began an investigation.” 

4. A conjunctive adverb (however, moreover, therefore, etc.) is usually set off by commas 
when it comes within the clause to which it applies. When it comes at the beginning of a 
clause, it may or may not be followed by a comma but will always be preceded by a period or 
semicolon: “His objection, therefore, was ignored.” “I had heard the rumor before; 
consequently, I did not believe it.” 

5. Any mildly parenthetical element is enclosed in commas if it seems desirable to set it apart 
from the rest of the sentence. A writer is called upon to use his own judgment in applying 
this rule, for too many commas will make a sentence jerky and hard to read: “The frame, he 
insisted, was too tight.” “The central section, for example, was undamaged.” 
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6. A terms such as namely or that is, used to introduce an example or a list, is usually set 
apart from that example or list by a comma. (The mark that precedes such an expression 
depends on the sentence structure.): “The crops—that is, wheat, peas and alfalfa—are in 
good condition.” “Three species of tree were observed, namely, pine, fir, and cedar.” 

7. Nonrestrictive clauses are set off by commas. Restrictive clauses, however, are not set off: 
“The south side, which had been exposed to the sun, was badly faded.” “He moved to 
Arizona, where the climate was not so moist.” 

Note: In these examples, the clauses introduced respectively by “which” and “where” merely 
add some additional facts. If they were omitted, the meaning of the remainder of the sentence 
would be unchanged. Hence they are nonrestrictive. However, some clauses introduced by 
“where” or “who” are restrictive. Each is used to limit—to restrict—the meaning of the main 
statement, which would be radically changed if the clause in question were omitted. “The 
roads went to pieces where the permafrost had been disturbed.” “All motorists who drive 
recklessly should be fined heavily.” 

Note: Sometimes a sentence does not make sense unless a clause is interpreted in a single 
way—restrictive or nonrestrictive. When this is true, an error in punctuation merely increases 
the difficulty of reading. There are times, however, when restrictive and nonrestrictive 
interpretations are equally reasonable. When this is the case, an error in punctuation leads a 
reader to misunderstand the meaning. Note how the meaning of the two sentences that follow 
depends on punctuation: “The people from Troy, who had come early, obtained seats.” “The 
people from Troy who had come early obtained seat choices.” 

8. A word or phrase placed in an abnormal position in a sentence should be set off by a 
comma or commas: “To a trained accountant, the problem would look easy.” 

9. A direct quotation is set off by a comma or commas: *“The tires are threadbare,” he 
asserted, “and will blow out at any moment.”* 

Exceptions: A quotation that blends into the regular structure of the sentence is not set off by 
commas. A title in quotation marks is not set off by commas unless some other rule makes 
commas necessary: *The poet’s prophecy about “airy navies grappling in the central blue” 
has become an unpleasant reality.* *The rhythm of “The Raven” is very striking.* 
Commas Used to Separate  

10. A comma is ordinarily used between two independent clauses that are joined by a 
coordinating conjunction. The coordinating conjunctions are “and,” “but,” “for,” “or,” and 
“nor.” (“Yet” and “so” may also be treated as coordinating conjunctions when this rule is 
applied.) “The building is old, but it has been kept in good condition.” 

Note: When both clauses are extremely short and simple, the comma may be omitted: “It was 
damaged but it still is usable.” 

Note: If a comma is used within one or both of two independent clauses, the comma between 
them is sometimes replaced by a semicolon.  

11. When a sentence contains a series, the elements in the series are normally separated by 
commas: “Cattle, sheep, and hogs are now selling for higher prices.” 
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Note: If a comma is used within any element in a series, it is often better to use semicolons 
rather than commas between the elements: “We visited Paris, Cannes, and Avignon in 
France; Frankfurt, Bonn, and Berlin in Germany; and Madrid and Seville in Spain.” 

Note: Opinions differ over whether to use a comma before a conjunction (“and” or “or”) that 
precedes the last item in a series. In technical and scientific periodicals and in material 
published by the United States Government, use of the comma is predominant. In journalistic 
and popular publications, usage is divided. Sometimes a comma is essential for clarity 
because of “and” or “or” being used within one of the items. For example: “The panels were 
painted red, green, yellow, and black and white.” 

Without the comma after “yellow,” it would be impossible to know whether “black” 
belonged with “yellow” or with “white.” In view of this, it seems advisable to regard the 
comma as normal punctuation rather than trying to check each series to see whether a comma 
is needed for clarity.  

12. Two or more adjectives preceding a noun are ordinarily separated by commas. (The 
comma before the last adjective is omitted, however, if that adjective is so closely associated 
with the noun that the two merge into a single thought unit.) Also, a comma is used between 
adverbs that modify the same object: “He has a modest, unassuming manner.” “The 
watchman was a feeble old man.” “Slowly, relentlessly, the stream wore away the dike.” 

13. Commas are variously used to separate items in dates, places, and numbers. In dates: “He 
was born on December 4, 1963, in Princeton.” In places and addresses: “San Francisco, 
California, is an important shipping point.” To separate adjacent sets of figures: “In 1950, 
675 men were added to the payroll.” Between the digits of Numbers: “C10,984; 234,617; and 
1,856,445.” (The comma is omitted in a number with only four digits unless the number 
occurs in a column containing numbers in which commas are used.) 
Commas Used Arbitrarily  

14. A comma is used between the last and the first name of a person when the last name 
appears first and also after the first name unless the sentence structure calls for some other 
mark: “Please insert the name Fitzgerald, Duane, in the proper place in the alphabetical list.” 

15. A comma is sometimes used to indicate the omission of one or more words: “July will be 
devoted to writing; August, to revision.” 

16. A comma may be used whenever it is necessary to force a pause for the sake of clarity: 
“Inside, the building was in better condition.” 

11.4.3.b ~ Transitions and Connective Phrases 
(adapted from the University of Wisconsin-Madison, Writing Center Handbook) 
 

To Join (Conjunctions) 
and   but 
or   for 
nor  
 neither 
so   yet 

To Introduce a Topic 
as for 
concerning 
with regard to 
with respect to 

To Summarize 
in all  that is
briefly  in 
short 
in other words 
in summary 

To Show Purpose 
in order that 
in order to 
so that 

To Show Cause and Effect 
accordingly 

To Compare 
by comparison 

To Contrast 
conversely 

To Explain/Reason
actually 

11-22 Chapter 11 ~ Writing Narratives 

http://www.wisc.edu/writing/Handbook/main.html


 Technical Guide 

as a consequence 
as a result 
consequently 
for this reason 
hence 
it follows that 
so/so that 
then 
therefore 
thus 

here again 
in the same way 
in a similar manner 
likewise 
similarly 
so too 
as 
also 
equally 

however 
instead 
in spite of that 
anyhow 
on the contrary 
on the other hand 
otherwise 
rather than 
still 
yet 

admittedly 
because 
certainly 
for example 
in fact 
indeed 
really 
of course 
since 
that is 

To Add Information/Reasons 
add to this 
again 
also 
besides 
equally 
further 
furthermore 
in addition 
moreover 
once more 
then too 
too 
yet again 
yet another 

To Show Various 
Conditions 
in these circumstances 
under such circumstances 
this (that) being so 
provided that 
in spite of 
none/nevertheless 
at the same time 
even if 
unless 
otherwise 
although 
even though 
though 
despite 

To Show Conviction 
at least 
apparently 
even so 
evidently 
certainly 
conceivably 
conclusively 
doubtless 
no doubt 
perhaps 
possibly 
presumably 
surely 
undoubtedly 

To Show 
Concession 
admittedly 
after all 
all the same 
at any rate 
granted 
however 
in any case 
in spite of 
it is true that 
nevertheless 
obviously 
of course 
still 
to be sure 

To Show Chronological Order 
after that    afterwards 
later     shortly 
subsequently   concurrently 
in the meantime  in the meanwhile 
now     simultaneously 
when/while   first, second, etc. 
formerly    earlier 
previously   before that 
then     already 
at last    at length 
by that time   finally 

To List or Show Logical Order 
for example   for instance
in particular   to illustrate
the one ... the other this ... that 
these ... those  here ... there  
either ... or   neither ... 
nor 
whether ... or   though ... 
yet 
wherever ... there  since ... then 
the more ... the more not only ... but also 

11.4.3.c ~ Attribution Verbs 
(adapted from Mic Metz, “Thoughts from a Fully Modern Grammar Wrangler”) 
  Note: Look up unfamiliar words before you use them 

NEUTRAL 
advance 
advise 
articulate 
ask 
believe 
call for 
comment 
conclude 
consider 
counsel 

NEUTRAL 
observe 
offer 
point out 
pose 
postulate 
present 
propose 
recommend 
reflect 
regard 

STRONGER 
advocate (+) 
affirm (+) 
assert 
attest 
aver (+) 
avouch (+) 
avow 
claim 
contend 
doubt (-) 

STRONGEST 
accuse (-) 
announce 
allege 
assume 
charge 
contest 
declare 
espouse 
exhort 
impugn (-) 
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credit 
deem 
encourage 
express  
extend 
hold 
indicate 
inform 
introduce 
maintain 
mention 

relate 
remark 
request 
say 
state 
speak 
submit 
suggest 
tell 
view 
write 

notify 
profess 
pronounce 
propound 
put forward 
question (-) 
uphold 
inform 
introduce 

insist 
persist 
proclaim 
protest (-) 
swear 
urge 
warn (+) 

       INDIRECT 
allude    denote   
 connote 
ascribe    hint   
  impute 
attribute    imply   
 convey 

    FUTURE 
forecast    predict 
imagine    presage 

 

11.4.3.d ~ Internet Resources on the Writing Process 
There are at least a hundred web sites where one can find self-help documents on the writing 
process. Many are gopher-based collections; a few are true hyperlinked writing guides that 
allow the user to follow links to different topics. Materials available vary widely in quality, 
presentation, and degree of detail. The following are some helpful website.. 

The University of Victoria’s Hypertext Writer’s Guide—
http://www.clearcf.uvic.ca/writersguide/welcome.html

The Write Place, St. Cloud State University—http://leo.stcloudstate.edu/

University of Wisconsin-Madison Writing Center—
http://www.wisc.edu/writing/Handbook/handbook.html

Temple University Writing Center—http://www.temple.edu/writingctr/cweb500.htm

Resources for Writers and Writing Instructors, Rutgers University—
http://andromeda.rutgers.edu/~jlynch/Writing/links.html
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Chapter 12 ~ Editing Documents 
Section 12.1 ~ Introduction 
Both writers and editors share responsibility for editing documents. As timelines are short, 
writers are expected to edit their own work before providing it to editors, and they also may 
serve as editors to other writers when needed. This chapter is designed for people serving 
both roles. 

The analysis team uses the The Gregg Reference Manual and the U.S. Government Printing 
Office Style Manual 2000 as its guides for grammar, usage, and style. This chapter offers 
specific guidance for ensuring consistency in documents, but does not attempt to teach 
material covered by the manuals. 

Section 12.2 ~ Roles and Expectations 
Short timelines require cooperation on the part of all employees. Following are expectations 
for writers, editors, and team leaders during the writing process. 
Writers will:  
• Submit first drafts for review as opposed to rough drafts. A first draft consists of a 

document that has been edited by the author with reference to all writing and attribution 
guidelines established for the project. Before submitting a draft for editing, writers should 
review their documents in light of the following checklist: 
• Confirm compliance with the Public Concern Rules, Proofreading Checklist, and 

Attribution Sheet.  
• Correct any sentence fragments and grammatically awkward sentences. 
• Verify Public Concern/Sample Statement agreement for each Public Concern. 
• Ensure that styles and formatting are used correctly and consistently.  
Particular to narrative writing 
• Confirm the order of public concerns matches the order of ideas presented in the 

narrative (for full summaries, not thematic summaries). 
• Trace a coherent theme or juxtaposition within each paragraph. 
• Establish a coherent progression of ideas within the overall organization of the 

narrative (with begrudging acceptance of periodic outlying issues). 
• Use a topic sentence to introduce sections. 
• Avoid beginning each paragraph with the same phrase or sentence structure. 

• Notify editors/team leaders of necessary adjustments in scheduled deadlines as soon as 
possible. 

• Recognize that editing is an evolving process and a first edit may not catch all possible or 
necessary edits. 

• Accept editorial guidance in light of the intent to improve documents. 
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Editors will: 
• Offer clear and concise feedback focused on clarity and accessibility of the final 

document, as opposed to directions based on personal preference and writing style. 
• Provide clear delineation between required changes and optional considerations. 
• Focus on providing constructive feedback, including positive as well as corrective 

remarks. 
• Establish consistent expectations and guidelines so writers do not receive conflicting 

feedback from different editors. 
If writers fail to meet these expectations, editors have the right to return documents to their 
authors and ask for corrections. Similarly, if editors fail to meet these expectations, writers 
have the right to return documents to the editors. 
Content Analysis Team Leaders will: 
• Assign roles and responsibilities to allow writers to work with the same editor as much as 

possible. 
• Intervene in situations where a writer and editor are unable to reconcile differences in 

approach to the writing assignment or failure to meet expectations. 

Section 12.3 ~ Elements of Editing 
12.3.1 ~ Reference Materials 
For writing and editing documents, use the following references: 
• The Gregg Reference Manual. Use the Gregg to check grammar and usage, and for 

editing/proofreading marks. 
• Technical Guide. Use the following resources from the technical guide: Public Concern 

Rules, Writing Rules, Find and Replace Checklist, Editing Checklist, Trusty/Creative 
Verb List. (provide location in tech guide) 

• Project-Specific Guidance.  
• Coding Structure and Letter Attribution Codes. 

12.3.2 ~ Mandatory versus Discretionary Edits 
Mandatory edits are marked by one or more of the following visual clues: 
• Text is crossed out (replacement text may or may not be provided); 
• Direct command words such as “rewrite” or “restructure” as well as fundamental writing 

trigger words/symbols such as “agreement (with arrows)” and the paragraph symbol. 

Discretionary edits are marked by one or more of the following visual clues: 
• Suggestion written above existing text but no text is crossed out; 
• Suggestion is followed by a question mark. 
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12.3.3 ~ Editing Marks 
We use basic editing marks found in the AP Stylebook and The Gregg Reference Manual (see 
sample below). For complex editing changes, editors are encouraged to use notes to help 
explain what is required of the writers. 
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12.3.4 ~ Proofreading Checklist 
Spell check: Run spell check. While you are editing, misspellings may distract you and 
cause you to miss other errors. 

Attributions: See the attribution sheet. 

Numbers: Spell out one through nine; use numerals for 10 and above. Use a comma as a 
thousands separator. 

Percentages: Spell out “percent” except in tables or charts. 

Acronyms: Introduce acronyms upon first reference in each chapter. Example:  “The 
National Park Service (NPS) requires . . .”  

States: Do not abbreviate in text. 

Measurements: Spell out; avoid abbreviations. 

Slashes: For clarity, avoid the use of “and/or” constructions. 

Quotations (The Gregg Reference Manual, paragraphs 227-284): Use smart quotes. Use 
double quotes around sample statements and around quotations within narratives and public 
concerns. Use single quotes for quotations within sample statements. 

Punctuation inside quotations (The Gregg Reference Manual, paragraphs 245-246): 
Make sure all periods and commas are inside quotation marks. Semi-colons and colons may 
be located inside or outside quotations, depending on the material.  

Commas (The Gregg Reference Manual, paragraphs 122-175): Use a comma before the last 
item in a series. Example: “Please buy apples, oranges, and pears.”  

Hyphenation (The Gregg Reference Manual, paragraphs 801-841): Words ending with “-
ly,” such as “federally,” do not get a hyphen. This is one of the few inviolable rules regarding 
hyphenation. Some words are hyphenated when used as adjectives but not hyphenated when 
used as adverbs. Consult the style sheet for each project, the dictionary, or The Gregg 
Reference Manual for specifics regarding hyphenation. Because the hyphenation or non-
hyphenation of some words may be dictated by preference, make sure the entire document is 
consistent. 

Ellipsis marks (The Gregg Reference Manual, paragraphs 274-280, 291): To show the 
omission of one or more words in the middle of a quoted sentence, use a standard ellipsis 
consisting of three spaced periods, with one space before and after each period. For the 
omission of words at the end of a quoted sentence, use a standard ellipsis followed by a 
period. If words are omitted at the beginning of a sentence, and the fragment can be read as a 
complete sentence, capitalize the first word of the remaining quoted material and do not use 
an ellipsis. If the fragment cannot be read as a complete sentence, use an ellipsis to indicate 
the omitted words. 
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Omitted words within a sentence: “I believe Yosemite National Park should be protected 
from . . . massive commercialization.” 

Omitted words at the end of a sentence: “Yosemite should be protected for future 
generations . . . . I want my children to experience it.”  

Spaces after periods: Use one space after periods.  

Spaces after colons: Use one space after colons.  

Fonts: Use the Word document template. 

Headers and footers: Check headers and footers for style, alignment, and page numbering. 
FIND: REPLACE WITH: 
Capitalization 

fish and wildlife service U.S. Fish and Wildlife Service 

forest service Forest Service 

yosemite national park Yosemite National Park 

environmental impact statement Environmental Impact Statement 
Acronyms (examples) 

EIS Environmental Impact Statement  

[spell out first time in narrative; add 
(EIS) immediately after the proper 
name; then use EIS later] 

FWS U.S. Fish and Wildlife Service  

(same as above) 

BLM Bureau of Land Management (same as 
above) 

FS Forest Service (same as above)  

 
Words and Phrasing (Gregg Paragraph 1101) 

pubic public 

affect/effect affect (v) to change 

affect/effect effect (n)  a result (effect can also be 
used as a verb, as in “to effect a 
change”) 

currently delete if unnecessary 

ongoing delete if unnecessary 

about approximately 

utilize use 
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insure ensure 

publics anything but “publics” (groups, 

stakeholders, etc.) 

concerned about concerned with 

scooping scoping 
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Hyphens (Gregg Paragraphs 801-841) 

e-mail email 

re-evaluate reevaluate 

re-emphasize reemphasize 

deemphasize de-emphasize 

preexisting pre-existing 
Punctuation (dashes represent spaces) 

.-- .- 

?-- ?- 

:-- :- 

.”-- .”- 

.’-- .’- (make sure this doesn’t apply to 
measurements in feet) 

’. .’ 

”. .” 

”, ,” 

’, ,’ 

.”--(attribution) .”-(attribution) 
Section Titles 

subsection 1.12.1 1.12.1  

Section 3.1 ~ Natural Resources Section 3.1. Natural Resources 

Section 3.01 Section 3.1 
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12.3.5 ~ Editing Checklist  
Bureauspeak: Replace bureaucratic language (such as “utilize” and other “-izes”) with 
common language wherever possible. When you must use jargon (such as “pig launcher”), 
remember to define your terms. Consider adding uncommon terms to the glossary. 

Comprised of: Comprise means “includes” or “consists of.” Avoid using “Comprised of,” 
as it is only correct when used as an intransitive verb.  

Dialog: Do not use this word as a verb. Avoid the popular yet incorrect inclination to use 
nouns as verbs. 

Due to: Avoid this construction unless you’re sure you can use it correctly. Only use “due 
to” when modifying a noun. 

Extraneous words and phrases: Delete extraneous words, phrases, and sentences. 

Fragments: Check for incomplete sentences. “While many people believe the forests should 
be harvested” is not a complete sentence. 

Gender-neutral language: In your narratives, do not use “he” to refer to a respondent even 
if you know the person is male. Sometimes you can avoid gender references by using plural 
subjects. But don’t fall into the trap of using “they” or “their” to refer to a singular subject. 
You can get by with this in conversation but not in formal writing. 

Misplaced modifiers: According to Strunk and White, “A participial phrase at the 
beginning of the sentence must refer to the grammatical subject.” They provide an example: 
“Being in a dilapidated condition, I was able to buy the house very cheap.” Reword sentences 
to avoid this kind of error. 

Parallel structure: Make sure you use parallel structure in lists, items in a series, and other 
appropriate places. 

Passive speech: Eliminate passive language wherever possible and use strong action verbs. 

Subject-verb agreement: When subjects and verbs are separated by several words, writers 
sometimes forget the two are related. Make sure a singular subject gets a singular verb and a 
plural subject receives a plural verb. 

Tense: Documents use present tense when discussing respondents’ comments. 

Word repetition: Avoid using the same word repeatedly, unless it is very common (such as 
“said”). Strive for variation.  
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12.3.6 ~ Sample Attribution Sheet 
GOVERNMENT AGENCY, ELECTED OFFICIALS 
N – International Agency 
Example:  (North Atlantic Treaty Organization, Brussels, Belgium - #2142) 

N – International Elected Official  
Example: (Prime Minister, Ottawa, Canada - #2142) 

G – Federal Agency 
Example: (U.S. Environmental Protection Agency, Washington, DC - #2142) 

G – Federal Elected Official  
Examples: (Name, U.S. Senator, Arkansas - #2142) 
    (Name, U.S. Representative, Tennessee - #2142) 

S – State Agency 
Example: (Oregon Department of Fish, Wildlife and Parks, Salem, OR - #2142) 

S – State Elected Official 
Examples:  (Name, Governor, Augusta, ME - #2142) 

     (Name, State Representative, Tulsa, OK - #2142) 

S – State Government Association 
Example:  (Association of State Governments, Denver, CO - #2142) 

C – County Agency 
Example: (Coconino County Department of Public Health, Flagstaff, AZ - #2142) 

C – County Elected Official    
Example: (Name, Chairman, Tuolumne County Board of Supervisors, Sonora, CA - #2142) 

C – County Government Association 
Example:  (Association of County Governments, Boise, ID - #2142) 

T – Town/City Agency or Department 
Example: (Grayling Animal Control Board, Grayling, MI - #2142) 

T - Town/City Elected Official 
Example: (Name, Mayor, Jericho, VT - #2142) 

T – Town/City Government Association 
Example:  (Association of Municipal Governments, Chehalis, WA - #2142) 

Q – Tribal Government 
Example: (Name, Chair, Confederated Salish Kootenai Tribes, Pablo, MT - #2142) 

Q – Tribal Government Association 
Example:  (Association of Tribal Governments, Washington, DC - #2142) 

INTEREST GROUPS 
QQ – Tribal Member 
Example:  (Tribal Member, Belcourt, ND - #2142) 

QQ – Non-Governmental Tribal Organization 
Example:  (Non-Governmental Tribal Organization, Santa Fe, NM - #2142) 
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D – Livestock Industry/Organization 
Example: (Livestock Industry/Organization, Kabetogama, MN- #2142) 

W – Agricultural Industry/Organization 
Example: (Agricultural Industry/Organization, Lac du Flambeau, WI - #2142) 

HT – Hunting and Trapping Industry/Organization 
Example: (Hunting and Trapping Industry, Northumberland, NH - #2142) 

L – Wood Products Industry/Organization 
Example: (Wood Products Industry/Organization, Ottumwa, IA - #2142) 

J – Mining Industry/Organization 
Example: (Mining Industry/Organization, Rapid City, SD - #2142) 

M – Oil Industry/Organization 
Example: (Oil Industry/Organization, Sleetmute, AK - #2142) 

B – Business 
Example: (Business, Ely, NV - #2142) 

P – Conservation Organization 
Example: (Conservation Organization, Seeley Lake, MT - #2142) 

AR – Animal Rights/Humane Treatment Organization 
Example: (Animal Rights Organization, Lompoc, CA - #2142) 

R – Recreational Organization 
Example: (Recreational Organization, Estes Park, CO - #2142) 

E – Place-Based Organization 
Example: (Place-Based Organization, Lajitas, TX - #2142) 

F – Property Rights Organization 
Example: (Property Rights Organization, Elmira, ID - #2142) 

Z – Multiple Use Organization 
Example: (Multiple Use Organization, Cebolla, NM - #2142) 

U – Utility 
Example: (Public Utility, Scranton, PA - #2142) 

Y – Other 
Example: (Other, Great Neck, NY - #2142) 

OTHER TYPE 
I – Unaffiliated Individual 
Example: (Individual, Rutland, NH - #2142) 

I – No Address 
Example: (Individual, No Address - #2142) 

A – University 
Example: (Department of Pedology, Whattsamatta University, Frostbite Falls, MN - #2142) 

A – Professional Society 
Example: (Professional Society, Wausau, WI - #2142) 
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Chapter 13 ~ Creating Appendices 
for Content Analysis Documents 
This chapter discusses the typical complement of appendices provided with each content 
analysis summary. A standard summary document may include the following appendices: 
Content Analysis Process, Coding Structure, List of Preparers, Demographics, Immediate 
Attention Report, Information Request Report, and Organized Campaign Letter Report. 
Sometimes, when requested by the agency, the analysis also includes an acronym appendix 
or a table of site-specific requests.  

Section 13.1 ~ Using the Appendices 
Templates 
We have created templates for each of the commonly used appendices. These templates 
include styles as well as blocks of sample text that need only a few changes. Templates are 
listed below. You may want to refer to the templates while reading the instructions for 
completing appendices. 
• Appendix A ~ Content Analysis Process  
• Appendix B ~ Coding Structure  
• Appendix C ~ Public Concern List  
• Appendix D ~ Demographics dot 
• Appendix E ~ Immediate Attention Letters  
• Appendix F ~ Information Requests  
• Appendix G ~ Organized Campaign Letter Report  
• Appendix H ~ List of Preparers  
CAT will provide these templates upon request. Open each template file and use the Save As 
command to rename the file and save it to the desired location. 

In each appendix, you will need to complete the tables and all the highlighted fields. After 
entering all the required information, you should also read through the entire document once 
to make sure no other pertinent details, including your header and footer, have changed for 
your project. As a final step, you should use the Template Organizer to ensure that the styles 
used in the appendix match those used in your project template. Copy all the styles in your 
final template over those used in each document. See page 273 in the book Using Word 2000 
for help in using the Template Organizer. 

If you need to create an entirely new appendix, you can use the general appendix template or 
save an existing template to a new file and delete all extraneous text. 
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Section 13.2 ~ Content Analysis Process 
Option 1: Provided in brief form with final document. 
Option 2: Provided in expanded form with final document. 

This appendix generally supplies a brief description of the content analysis process and 
provides information about how people can review letters firsthand. The team also can 
expand this appendix to provide a much more thorough description. The template for this 
appendix includes sample text for the brief version, which is used in most cases. Several 
fields must be completed. 

Section 13.3 ~ Coding Structure 
Option 1: Provided with final document.  

The coding structure is included as an appendix with the content analysis summary. 
Formatting is easiest if the coding structure is created with the coding structure template. 
You can leave this appendix in the landscape format, but make sure it is set apart from the 
rest of the document in a separate file or is delineated by section breaks.  

The template for this appendix includes coding structure styles. You may want to change the 
page setup to landscape before inserting the coding structure file. (If you like, leave the title 
page in portrait, insert a section break, and then change to landscape beginning on the second 
page. Then insert the coding structure file on the second page.) 

Section 13.4 ~ Public Concerns List 
This list is prepared automatically by using the Table of Contents feature in MS Word (see 
16.2.3d). To delete the hyperlinks, use the following instructions: 
Eliminating Hyperlinks in Public Concerns Lists 

1) Place the mouse pointer to the left of the beginning of the public concerns list. 

2) Click and drag the pointer into the public concerns list. This should select the entire 
thing. 

3) Key Ctrl+Shft+F9. This should convert the public concerns list to normal text. You 
may need to select the entire list and perform a Ctrl+Spacebar, because strange 
formatting is sometimes generated in the conversion to text. 

Note: If you change something within a document after the public concerns list has been 
generated, you will need to insert the list again, if you have eliminated the hyperlinks. If you 
have not eliminated the hyperlinks, you can select the public concerns list as described above 
and key Ctrl+F9. This is the command to Update Fields. You can also do a right-mouse-
click on the list to view a drop-down menu.  
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Section 13.5 ~ List of Preparers 
Option 1: Provided with final document. 

A list of employees who worked on a particular project is supplied with the content analysis 
summary, or if no summary is being prepared, the final public concern list.  

The template for this appendix includes sample text. In this appendix, you will not want the 
body text style to work exactly as planned. As it is a paragraph style, it will put extra space 
after each return; in this list, it would put extra space after each name. To avoid these extra 
spaces, use a different kind of return at the end of each name in a list. Use Shift+Enter to 
move to the next line without creating full paragraph spaces.  

Section 13.6 ~ Demographics 
Option 1: Provided with final document. (Reports include Number of Letters/ Signatures by 
Organizational Affiliation, Geographic Representation of Letters by Country and State, 
Number of Letters/Signatures by Letter Type.) 
Option 2: Provided following project validation. (Reports include Number of Letters/Signatures 
by Organizational Affiliation, Geographic Representation of Letters by Country and State, 
Number of Letters/Signatures by Letter Type.) 
Option 3: Provided with final document and provided in partial form mid-project on timeline 
negotiated with client. (Reports include Number of Letters/Signatures by Organizational 
Affiliation, Geographic Representation of Letters by Country and State, Number of 
Letters/Signatures by Letter Type.) 
Canned Reports in CA Oracle Program will generate these reports. Project specific report 
needs will require an Oracle Administrator.  

The template for this appendix includes sample text and empty tables, which you will 
complete from the computer demographics reports. Demographics reports are most accurate 
following project validation. However, clients often want these reports earlier, sometimes 
even mid-project. Some errors do not become apparent until you run demographics reports 
from the database. Especially if you are running demographics mid-project, you will want to 
give yourself a little extra time to check discrepancies and correct problems.  

Petitions also can cause discrepancies in demographic reports, depending on how clients 
have asked that petitions be processed. If only one mail ID is assigned to each petition, you 
can include petitions in demographics reports and the numbers will be accurate. If more than 
one mail ID is assigned to each petition, however, you will not be able to include petitions 
because they will create discrepancies.* If clients insist on multiple mail IDs per petition, 
follow the method used for Sierra Nevada Framework Plan demographics in August 2000 
(see example below). Petitions were separated from regular letters and reported on a different 
line. They were not broken out by state. 

Geographic Representation of Letters by Country and State  
Example with Petitions Not Broken Out By State 

Country State Number of Letters Number of Signatures 
United States Alaska   
 Alabama   
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Country State Number of Letters Number of Signatures 
    
    
 Unknown Location   
Total Without Petitions    
Petitions (not broken out by state)   
Total Including Petitions  0 0 

If demographic reports are supplied mid-project, it’s important to note that total numbers will 
only include records that have been entered into the project database. 

Section 13.7 ~ Early Attention Letters 
Option 1: Provided as interim reports as needed throughout the project. 
Option 2: Provided with final document. 

For each project, the analysis team determines the type of letters to which the agency wishes 
to be alerted. During the coding process, these letters receive a specific header code and are 
marked with a red flag. 

The template for this report includes sample text and empty tables, which can be completed 
using either a low-tech or high-tech method. The low-tech method involves physically 
checking all letters, pulling letters with red flags, and completing required report fields from 
all the red-flagged letters. This method works best when the project is very small. The high-
tech method involves exporting name, address, and red-flag information from Oracle or 
Access directly into Word using a mail merge feature. This method, described below in 
Section 13.9, works best on larger projects because you can save a lot of time by not typing 
in all the names and addresses. For this method, you will need the assistance of the computer 
technician or specialist.  

Section 13.8 ~ Information and Comment 
Extension Requests 
Option 1: Provided with final document. 
Option 2: Provided with final document and throughout project on timeline negotiated by the 
agency. 
Option 3: Not tracked or provided.  
Needs from Computer Technician/Specialist: For low-tech method, none. For high-tech 
method, information exported from Oracle into Access. 

The analysis team often provides a report that tracks information requests received on a 
particular project. During the coding process, letters with information requests receive a 
specific header code and are marked with a blue and yellow flag. For instructions on how to 
compile this report, see Immediate Attention Letters.  
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Section 13.9 ~ Organized Campaign Letters 
Option 1: Forms report provided with final document; petition report not provided. 
Option 2: Forms and petition reports provided with final document. 
Option 3: One or both reports provided with final document and mid-project on timeline 
negotiated with client. 
Needs from Computer Technician/Specialist: For forms, a report listing the number of each 
form received. For petitions, a report listing letter numbers and number of signatures for each 
petition. 

Typically, the analysis team supplies a form report for all projects. For some projects, the 
team may also supply a petition report. The template for this appendix includes sample text 
and empty tables which you will complete using the computer reports. (For large projects in 
which databases are kept for forms, you can use the method described in below.) To 
complete the “description” block, you will need to use hard copies of forms and petitions and 
write your own summaries. When summarizing the form or petition (see tables in Organized 
Campaign Letter template), be brief—keep your description to one sentence if possible. 

As with demographics reports, if supplied mid-project, forms reports comprise only those 
records that have been entered into the project database.*** 

Section 13.10 ~ Mail Merge Function for 
Reporting 
13.10.1 ~ Converting Database Fields to Word Tables via 
Mail Merge 
Selected data from the Red (IA), Blue (RI), and Yellow (CE) Flag and Forms database tables 
must be converted into Word tables for interim reports and the final appendices. This 
seemingly unfathomable task can easily be accomplished with the help of Mail Merge, an 
MSWord tool. 

1) From the Menu Toolbar, select Tools, then select Mail Merge.

The Mail Merge Helper will appear. 

2) Select Create, and then select Catalog. 
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3) Select New Main Document.

4) Select Get Data, and then Open Data Source. 

 
 
5) Open the source database (Access, Oracle, etc.). You will need help from the local 
database guru or computer specialist to find it the first time. At the bottom of the dialog box 
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for Open Data Source, make sure you select the file type you’re looking for (.mdb for 
Access) in the block Files of type or your files will not appear.  

 

 

 

 

 

 

6) Now that you have your database open, you are ready to edit your Main Document. 

Select Edit Main Document. 

 
7) First you need to set up the table format. 

Go to the Menu Toolbar and Select Table,  

Then select Insert. 

The Insert Table window appears 

Here you set up the parameters for your Table (# Rows, # Columns, etc.). 

 

 

 

Sample of Empty Table 
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8) Now it’s time to move the data from the data source into the table columns and format it 
for output. 

In the left side of the window above the ruler, select Insert Merge Fields and a list of fields 
from the data source appears in a drop-down menu. 

Here you select only the fields that you need in your table. 

9) Place the cursor in the first cell of the Table. 

Select the field(s) that you want displayed in the first cell from the drop down menu entitled 
Insert Merge Fields on the right side of the window. 

Press Enter. 

Sample of Table with First Field Inserted 

«ltr_no»   

 

You can place more than one field in a cell and arrange and format them so they print out any 
way you want them to.  
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Screen Captures Showing Fields Inserted 
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Sample Table Showing Multiple Fields Inserted and Formatted 

«ltr_no» «respondent_name» 

«address_1» 

«city», «state»  «zip_code» 

«blue_flag_description» 

You can add commas, spacing and other formatting between the fields. 

10) The table is now ready to merge!! Select 
Merge from the Mail Merge Helper window. 

 

The Merge window will appear. 

11) Select Merge. 
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Sample of Merged Table  

47 PAT  CROWSON 
1953 ROCK CUT PL 
CONLEY, GA  30288 
 

General request for other information: 

152 CHRISTINE C BOGDANOWICZ 
G 14 STIMSON HALL 
ITHACA, NY  14853 
 

General request for other information: 

382 DAWN  LEARY 
PO BOX 1961 
TAVARES, FL  32778 
 

General request for other information: 

528 HEATHER  MITCHELL 
PO BOX 1218 
POINT LOOKOUT, MO  65726-
1218 
 

General request for other information: 

599 KRISTAL  MUELLER 
23762 CASA BONITA 
QUAIL VALLEY, CA  92587 

General request for other information: 

 

12) Before you send the final report to the client, you will need to do several things. 
• Change the column margins to best fit your data. “Letter #” doesn’t require one-third of 

the page width. 
• Apply the Table Title, Table Heading, and Table Text styles to the appropriate text. 
• Check text for incomprehensible or awkward abbreviations and repair as necessary. 
• Add a header row, and tell Word to make it repeat on every page. (Select the row and go 

to Table, Table Properties. Select the Row tab and check the box that says Repeat as 
header row at the top of each page). 

• If you don’t want rows to break across pages, select all rows and go to Table, Table 
Properties. Select the Row tab and uncheck the box that says Allow row to break 
across pages. 

• Remove the data source. (Need detailed instructions for this). 

Sample of Merged Table After Formatting 

Letter # Name and Address Remarks 
47 PAT CROWSON 

1953 ROCK CUT PL 
CONLEY, GA  30288 
 

General request for other information: 

152 CHRISTINE C BOGDANOWICZ 
G 14 STIMSON HALL 
ITHACA, NY  14853 

General request for other information: 

382 DAWN  LEARY 
PO BOX 1961 
TAVARES, FL  32778 
 

General request for other information: 
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Letter # Name and Address Remarks 
528 HEATHER  MITCHELL 

PO BOX 1218 
POINT LOOKOUT, MO  65726-1218 
 

General request for other information: 

599 KRISTAL  MUELLER 
23762 CASA BONITA 
QUAIL VALLEY, CA  92587 

General request for other information: 

 
 
Note:  An Immediate Attention and Request for Information forms exist in the Oracle CAET 
Content Analysis Application. These forms can be used to record Letter #, respondent and 
remarks information. Reports can be generated that will provide the necessary output similar 
to the information above. You must provide information in the remarks field in order for that 
respondent’s information to appear in the report. This information can then be given to the 
responsible team members to handle these types of requests.  
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Chapter 14 ~ Working With Microsoft 
Access 
Microsoft Access is a relational database program that has been used by CAT primarily to 
store data associated with public concerns lists. Though it is more cumbersome to use for 
some aspects of CAT work than a standard word processing application such as Microsoft 
Word, Access provides tools for tracking, organizing, and sorting data not provided by a 
word processor. 

This chapter, which provides information on how to use Access in CAT applications, is 
divided into two main sections: Using Basic Access Features and Using Advanced Access 
Features. The first section describes how to use existing database components, such as forms 
and reports. The second section details how to design databases like those used in CAT 
applications. 

Section 14.1 ~ Basic Microsoft Access Processes 
This section describes how to enter data into a database using forms, extract data from 
databases using reports, and order data for reports. 

14.1.1  ~ Understanding Access Databases 
Before attempting to perform any operations in Access, it is helpful to understand the 
fundamental structure of an Access database and the terminology used to describe the 
components of such a database. In particular, it is important to understand the relationships 
between tables, forms, and reports, as well as the elements that make up these three main 
components. 
Tables 
Tables are the fundamental building blocks of all databases, including Access. In a database, 
all data is stored in one or more tables. Data that is stored in tables can be retrieved for 
presentation. 

Tables, are composed of columns and rows. In Access, columns are called fields, and rows 
are called records. Any single cell in a table is also referred to as a field. 
Forms 
Forms are visual interfaces through which data is entered into database tables. Data can be 
entered directly into a table, but forms are usually more user friendly. 

Forms are made up of a number of components. Though most of these components are not 
addressed here, one type of form component, with which it is important to be familiar, is a 
control. For this discussion, controls are the spaces on a form into which data is entered. For 
example, the space into which a public concern statement is entered is a control. Each such 
control is linked to a field in a table. For example, the PC # control on the Public Concerns 
form is linked to the PC # field in the Public Concerns table. Any addition or modification of 
information in one of these controls modifies data in the linked table field. 
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Another important type of control used in CAT databases is the subform control. This type 
of control enables the nesting of one form within another form. For example, the Sample 
Statement subform control on the Public Concerns form allows direct access to the Sample 
Statement form from the Public Concerns form. In other words, to make changes to the 
Sample Statement table, it is not necessary to open the Sample Statement form, such changes 
can be made directly from the Public Concerns form. 
Reports 
Reports are components that retrieve and format data from database tables for presentation. 
Like forms, reports usually contain controls that are linked to fields in tables. Report controls 
are used to retrieve data stored in particular fields, instead entering or modifying data within 
tables. Reports in CAT databases also contain subreport controls, which are analogous to 
subform controls on forms. 

14.1.2  ~ Entering Data Into Access 
This section describes the procedures and tools used to enter data into CAT Access forms. 
14.1.2.a ~ Opening a Data Entry Form 

1) Find the location of your database in 
Windows Explorer. 

2) Double-click the icon for the database. The 
Database window will appear. (See Figure 
14.1) 

3) Maximize all your windows: both the main 
Access window and the Database window. 
This exposes as many of the from c
as possible. 

omponents 

4) In the Objects frame (left side of the 
Database window) select Forms. This 
displays the data entry forms that are 
available in this database. (See Figure 14.1.) 

5) Double-click Public Concerns in the list of 
available forms. (See Figure 14.1.) The Public Concerns Form View window will appear. 
(See Figure 14.2.) 

Maximize Database 
window

Select Forms to display 
available forms 

Available Forms 

Figure 14.1: 
Main Access and Database Window
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14.1.2.b ~ Understanding the Layout of the Public Concerns Data Entry Form 

As mentioned earlier, a form is simply a structure through which data is entered into a database 
table. The primary form used for entering data in to CAT databases is the Public Concerns form. 
(See Figure 14.2.) 

In addition to containing its own set of controls, the Public Concerns form, also contains three 
subforms. The main form and each of the three subforms are linked to tables of the same name, 
and the controls on these forms are linked to fields with the same names as the controls. For 
example, the Sample Statement control on the Sample Statement  subform is linked to the 
Sample Statement field in the Sample Statements table. 

As with all forms, the Public Concerns form displays the data from one record at a time. For a 
form without subforms, this means that a form record displays data from one row of a table. 
Since the PC form is connected to four tables through the main form and its subforms, a record 
in this form displays data from four individual, but related rows: one row from each table. 
14.1.2.c ~ Navigating Through Records in the Public Concerns Form 

Sample Statements
Subform 

Subconcerns
Subform 

Subconcern 
Sample Statements

Sub-Form 

Public Concern/ 
Main Form 

Examples of Controls 

Figure 14.2: Public Concerns Form View Window 

To move between records in an Access form, a tool called the Navigation Bar is used. (See 
Figure 14.3.) Navigation bars are located in the lower left corner of a form. Five arrow buttons 
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and a record number display window comprise a navigation bar. Each of the fiver arrow buttons 
changes the record displayed in specific ways. 

Important! Since the Public Concerns form really contains four forms, it has four navigation 
bars: one for the main form and one for each subform. It is very important to choose the 
appropriate navigation bar for the desired action. Care is needed because the visibility of 
navigation bars can vary from computer to computer. In particular, navigation bars for subforms 
are often hidden below the lower edge for the form in which the subform is contained. If a 
subform’s navigation bar is not visible, it is necessary to scroll down in the form in which the 
subform is contained. 

First record 

Figure 14.3: Navigation Bar
Previous record 

Next record 

New record 

Last record 

14.1.2.d ~ Entering Data Into Form Fields 

The CAT Public Concerns form contains a set of fairly standard set of controls for entering data. 
The placement of these controls may vary somewhat in the future, but such variation should be 
minimal. The current standard controls, organized by the form or subform on which they appear, 
are as follows: 
Controls on the Public Concerns Form 

• Public Concerns (PC) Form: 
PC #, Section, Subject Code, Category Code, Assignment, Date, Public Concern, Status, and 
Status Comments. 

• Sample Statement (SS) Subform: 
PC #, SS #, Sample Statement (not labeled, but obvious), and Letter #. 

• Subconcern (SC) Subform: 
PC #, SC #, and Subconcern Statement (not labeled, but obvious). 

• Subconcern Sample Statement (SC-SS) Subform: 
PC#, SC #, SC-SS#, Subconcern Sample Statement (again, not labeled), and Letter #. 

Note: There may be additional controls on the Public Concerns form depending on the 
requirements of a project. 
Using the Tab Key to Move Between Controls 
CAT forms are setup such that the tab key moves the cursor from control to control in a logical 
order. The description of the controls above reflects the basic tab order for CAT forms. In other 
words, if you start in the PC # control of the PC form, tabbing moves the cursor through the 
controls in the order presented above. The one exception is that a Ctrl+Tab keystroke must be 
used to move from the SS subform to the SC subform. It is, of course, possible to move between 
controls using the mouse; however, to ensure that data is entered in all the required controls, use 
the tab key. 
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Note: See Section 0, 14.1.2.d ~ Data to be Entered into Each Control of the PC Form, for a more 
detailed description of data to be entered into controls on CAT forms. 
To Enter Data Into New Records: 

1) Open the PC form.  (See Section 0, 14.1.2.a ~ Opening a Data Entry Form.) The cursor 
should be in the PC # control. If not, put it there. 

2) Click the New Record button on the PC form Navigation Bar. The cursor should be  
flashing in the PC # control in the PC form, and all the controls should be blank except 
PC # control. 
No value is entered in this field; the Public Concerns table has been set up to 
automatically generate a PC # for each record. A number will appear in the PC # field as 
soon as data is entered into any subsequent control. 

3) Tab to the Section control. 
When entering new records, leave this control blank. This section can be organized later 
once it is known how the PCs should be organized. (For further details on this control, 
see Section 14.1.4,  ~ Ordering Public Concerns.) 

4) Tab to each of the remaining controls and enter the necessary information. 

5) After entering the data in all required controls, on both forms and subforms, place the 
cursor back in the PC # control of the PC form, and begin with Step 2 again. 

Note: Do not attempt to Save a record before moving on to the next record. Access automatically 
commits a record when you move to another record. 
14.1.2.d ~ Data to be Entered into Each Control of the PC Form 
Public Concern Form Data Entry Controls: 

1) PC # 
Do not enter any values; the number is automatically generated. 

2) Section 
Enter the appropriate value for ordering PCs, if known; otherwise, proceed to next 
control. 

3) Subject Code 
Enter the appropriate Subject Code. 

4) Category Code 
Enter the appropriate Category Code. 

5) Assignment 
Enter your two initials. 

6) Date 
Enter the appropriate date. This may either be the date the PC is entered or the date of a 
future report. 

7) Public Concern 
Enter the PC statement. 
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8) Status 
Enter the appropriate value, if a PC has been changed. Values are usually restricted to 
Modified or Deleted. In most cases, this control is left blank. 

9) Status Comments 
Enter comments regarding changes made to a PC. The format of these comments is 
usually decided by the project team. 

Sample Statement Subform Fields 

1) PC # 
Do not enter any values. This number is generated automatically. 

2) SS # 
Enter the number of the SS, beginning with one (1). This number is used to order SSs. 

3) Sample Statement (Not labeled on the form) 
Enter the SS and its attribution. 

4) Letter # 
Enter the letter number associated with the SS. 

Subconcern Subform Fields 

1) PC # 
Do not enter any values. This number is generated automatically. 

2) SC # 
Enter the number of the SC, beginning with one (1). This number is used to order SCs. 

3) Subconcern Statement (Not labeled on the form, but obvious.) 
Enter the SC statement. 

Subconcern Sample Statement Fields 

1) PC # 
Do not enter any values. This number is generated automatically. 

2) SC # 
Do not enter any values. This number is generated automatically. 

3) SC-SS # 
Enter the number of the SC-SS, beginning with one (1). This number is used to order SC-
SSs. 

4) Subconcern Sample Statement (Not labeled on the form, but obvious.) 
Enter the SC-SS and its attribution. 

5) Letter # 
Enter the letter number associated with the SC-SS. 

14.1.2.e ~ Modifying and Deleting Existing Records 
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Once records are created for PCs, it is often necessary to modify or delete them. The following 
procedures assume that the number of the PC to be modified or deleted is known. 
To Modify Existing Records: 

1) Open the appropriate database and the PC form. 

2) Place your cursor in the PC # control on the PC form. 

3) Activate the Find command. Choose Edit, Find from the menu toolbar. (Key Ctrl+F) 

4) Enter the number of the PC you wish to find and click OK. This should take you to the 
record you wish to alter. 

Note: The rest of this procedure assumes you wish to make changes that DO NOT include 
deleting entire records in either the main form or subforms. If you need to delete entire records, 
See To Deleting Records below. 

5) Go to the controls you wish to alter and make the necessary changes. 
To Delete Records: 

1) Open the appropriate database and the PC form. 

2) Place the cursor in a control on the form or subform, from which a record is to be deleted. 
For example, if it is necessary to delete and entire PC and its associated SSs and SCs, 
place the cursor in one of the controls on the main form. If is necessary to delete only a 
SS, place the cursor in one of the controls on the SS subform. 

3) Choose Edit, and Delete Record from the menu toolbar. 

14.1.3  ~ Working With Access Reports 
This section provides information on using Access to generate reports. 
Understanding Access Reports 
Reports are database components that retrieve data for presentation. The design of a report will 
determine what data will be present, as well as the arrangement and appearance of that data. 

CAT databases usually contain at least three PC reports: one for the client, and two for internal 
use. Client reports retrieve data from selected fields, because some of the data in the database is 
used only for CAT purposes. For example, the client report does not retrieve data from the 
Assignment field. 

Both of the internal CAT reports include data from fields that are not included in the client 
report. The internal reports differ, however, in the number of records retrieved. One report, 
usually named something like PC Report, is set up to include all the records in the database. The 
other report, usually named something like  PC Report by Individual, is designed to capture only 
those records associated with a particular team member. 

The process by which a report selects only certain records is called filtering. In addition to 
filtering options, Access reports can also organize data based on the values in fields. This 
process is called sorting. To create more useful reports, CAT employs the sorting feature in 
almost all reports. Whereas filtering eliminates data, sorting organizes the data that passes the 
filter. For example, suppose a report is filtered by the Assignment field, as indicated for the 
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internal report described above. It is probably still desirable to sort this report by the Section 
field to place the PCs in the desired order. 
Opening Access Reports 

1) Open the Database window. 
If the database has just been opened, it should display the Database Window. If the 
database is in a form screen or some other screen, choose Window on the menu toolbar 
and select the item labeled database. 

2) Click on Reports under Objects. (See Figure 14.4) 

3) Double-click the desired report. 
If a filtered report is selected, an input dialog box will appear. (See Figure 14.5) For a 
report filtered by Assignment, enter the initials of the person whose report is desired. 

An example of a report is given below (See Figure 14.14.); however, to understand the range of 
CAT reports available, copy an existing database and experiment with its reports. 

Choose Desired Report 

Choose Reports

Figure 14.5: Dialog Box 
Resulting from Report Filter

Figure 14.4: Reports Database Window 
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Scrolling in a Report Window 
Unfortunately, the vertical scroll bar in an open Access report window does not scroll through 
the entire document; it only scrolls up and down through one page. To move to other pages of 
the report, you must use the Navigation Arrows at the bottom of the report window. (See Figure 
14.6, below.) 

Navigation Bar 
Scrolls through pages of 

the document 

Vertical Scroll Bar 
Scrolls through one 

page of the document 

Figure 14.6: Unfiltered Access Report 

14.1.4  ~ Ordering Public Concerns 
The ability to order PCs as desired in reports is essential to CAT activities. Ordering allows the 
placement of PCs into logical groups and the arrangement of PCs in a logical sequence within 
groups. Such well-ordered PC lists facilitate the identification of the themes expressed in public 
comment and help eliminate duplication in the PC list. 

PCs are actually ordered within Access reports, which can be set up to sort PCs based on any 
field. For example, many CAT reports are sorted by Category Code. Such an Access report will 
place PCs with a category code of 40500 ahead of PCs with a category code of 40505, and it will 
place the PCs with a category code of 40505 ahead of PCs with a 40510 category code. 
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Reports sorted by Category Code are good for an initial organization of PCs, and convenient 
since Category Code values are entered with each PC. The Category Code field, however, has 
restrictions that limit its effectiveness as an organizational field. The primary problem with the 
Category Code field is that its value cannot be changed. For example, if it is necessary to place a 
PC in a different position in the PC list than the position resulting from sorting on the Category 
Code, the Category Code value cannot be altered to effect this change. Therefore, a field 
independent of such limitations is needed to order PCs. 

The independent field used in CAT databases for ordering PCs is the Section field. The Section 
field is located in the PC table, and there is a corresponding Section control on the PC form. The 
following procedures present one method of using the Section field to order PCs. 
14.1.4.a ~ Accessing and Arranging the Datasheet View 

The standard method for entering is probably not the best method for entering data for the 
Section field. The view normally used to enter data in the PC form is the Form View. This is the 
window that opens by default whenever a form is opened. As mentioned earlier, this view only 
displays the data for one record at a time. While viewing only one record at a time is good for 
entering data, it is not good for assessing where PCs should be situated relative to one another 
and assigning Section numbers to achieve the desired order. To determine the desired order of 
PCs, it is necessary to  compare PC statements. To do this, it is very helpful to be able to view 
multiple PCs at one time. Since each PC is in a different record, however, multiple PC 
statements cannot be viewed in the Form View. 

Multiple records can be viewed at one time, however, in the Datasheet View of a form. The 
Datasheet View of a form is a view that presents data in table format. The size of rows and 
columns can be manipulated in this view to facilitate the review of PCs for ordering. 
To Open the Form Datasheet View: 

1) If the PC form is not open, open it. (See Section 0, 14.1.2.a ~ Opening a Data Entry 
Form.) 

2) Choose View and Datasheet View. The Datasheet View of the form will open. (See 
Figure 14.7) 
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To view only those PCs by BW, place the cursor in 
an assignment field with those initials. Then select 
the Filter By Selection button. 

Filter By Selection

Resize Pointer 

Header Row 

Figure 14.7: Unsorted and Unfiltered Public Concern Table 

Resizing Rows and Columns 
It may be necessary to resize the rows to see all the text of your PCs and the Section column 
so that Section number figures fit on one line. 
To Resize Rows: 
1 First, remember to maximize all the windows. It may not be necessary to resize rows or 

columns, if the windows are maximized. 

2 Move the cursor to a row dividing line on the vertical bar on the left hand side of the 
Table window. The Resize Pointer should appear. (See Figure 14.7.) 

3 Click and hold when this pointer appears, and drag down to increase the size of the rows. 
This will resize ALL the rows, not just the rows where the pointer is located.) 

To Resize Columns: 
1 Place the cursor on the Header row for the table, on the right hand boundary of the 

Section column. (See Figure 14.7.) 

2 Click and hold when the Resize Pointer appears, and drag right to increase the size of 
the column. 
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To Filter Datasheet to View Only the Desired Public Concerns: 

1 Place your cursor in a cell in the Assignment column with your initials. 

2 Click on the Filter By Selection command button. The Datasheet View will be filtered to 
display only the PCs of the selected team member. (See Figure 14.7.) 

Figure 14.8: Datasheet Filtered by Assignment with No Section Numbers 

14.1.4.b ~  Determining and Entering Section Field Values 

The values entered into the Section control reflect the numbering structure of CAT reports. CAT 
reports can have up to four heading levels: Chapter, Section, Subsection, and Sub-subsection. 
Almost all reports will have either three or four of these heading levels. If a report has four 
heading levels, the format of the value input into the Section control is:  X.XX.XX.a.XX. If a 
report only requires three heading levels to organize PCs, the format is: X.XX.XX.XX. In both 
cases the first X stands for the Chapter number, the first pair of Xs stand for the Section number, 
and the second pair of Xs stand for the Subsection number. The final Xs, in both instances, 
represent a number used to order individual PCs within a subsection or sub-subsection. The a 
stands for the Sub-subsection, in reports with four heading levels. In a four-level report, for 
example, if a PC should be located in Chapter 3, Section 2, Subsection 3, Sub-subsection d, then 
3.02.03.d should be entered in the Section field control. 
Entering Section Field Values 
The following procedure presents on method of entering Section values to order PCs. This 
procedure assumes that only PCs within one Section of a report are being addressed. If there 
multiple Sections are involved, additional sorting and filtering steps may be helpful. 

Note: It is unnecessary and usually difficult to enter the entire Section control value at one time. 
Instead, the Section value can be entered in stages. The following steps are numbered only to 
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show the order in which they should occur. Any number of other activities or amount of time can 
pass between steps. 
To Enter Section Field Values: 

1 Enter Chapter and Section portions of Section number. 
For example, consider the datasheet in Figure 14.8. Assume that all these PCs are in 
Chapter 3, Section 2. The value entered in the Section control would be 3.02. 

2 Determine the appropriate subsection for each PC, and add the appropriate Subsection 
digits to the Section numbers that have already been entered. 
Again considering Figure 14.8, assume it has been determined that three subsections, 
numbered 1, 2, and 3, will be required to organize the PCs. Additionally, it has been 
decided that PCs 25 and 26 should be placed in Subsection 1, PCs 24, 8, 7, 5, and 6 
should fall in Subsection 2, and PCs 22, 10, and 2 belong in Subsection 3. 

3 Sort PCs by the Section field. 
To do this, place the cursor anywhere in the Section column of the datasheet, and click 
the Sort Ascending button. (See Figure 14.9.) A datasheet sorted by chapter, section, 
and subsection will result. (See Figure 14.10.) 

Figure 14.9: Form Design ToolbarSort Ascending Button 

4 Determine the appropriate order of PCs within subsections, and input the appropriate 
digits to achieve this desired order. 
Assume that in the example database, it has been determined that the order of the PCs 
within each subsection should be as follows: 
• Subsection 3.02.01: PC order: 25, 26 
• Subsection 3.02.02: PC order: 8, 5, 24, 6, 7 
• Subsection 3.02.03: PC order: 10, 2, 22 
Once the desired PC order within a subsection has been determined, digits can be added 
to the Section number to achieve the desired ordering. Simple sequential numbers like 1, 
2, 3, etc., could be assigned; however, since additional PCs may need to be inserted 
between the existing PCs later, it is good to leave gaps in this last numbering sequence. In 
the example, a series of 5, 10, 15, etcetera, was used. (See Figure 14.11.) 

5 Sort PCs by the Section field. The datasheet will display PCs sorted in the desired order. 
(Figure 14.12.) 
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Figure 14.10: Datasheet Filtered by Assignment and Sorted by Subsection Values 

PC Ordering 
Numbers

Figure 14.11: Datasheet Filtered by Assignment, with  
Sorting Numbers Added to Subsection Numbers, but Not Yet Sorted 
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Subsection 3.02.03 
PC Order: 10, 2, 22

Subsection 3.02.02 
PC Order: 8, 5, 24, 6, 
7 

Subsection 3.02.01 
PC Order: 25, 26 

Figure 14.12: Datasheet Filtered by Assignment and Sorted by Complete Section Numbers 
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Section14.1 ~ Exporting Access Reports to Word 
Since CAT creates public concerns in Access and publishes Content Analysis reports in Word, it 
is necessary to convert Access public concerns reports into Word documents. This procedure 
requires two main steps: exporting a report from Access to Word, then reformatting the Access 
generated report into a more useable format. This section addresses the first step, exporting a 
public concerns report to MS Word. The second step is described in Chapter 7, Converting 
Access Generated RTF Files into Word Document Files. 
To Export an Access Report to Word 

1 With the appropriate report open, choose File, and Export from the menu. The Export 
dialog box will open. 

Normally the report to be converted to Word is named something like Conversion_PC. 

2 Click the arrow to the right of the Save as type box, and choose Rich Text Format 
(.rtf). 

3 Choose an appropriate name and location for the file and click Save. A rtf file will be 
generated in the identified location. 
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Section14.2 ~ Designing Access Databases 
This section describes how to create the basic components of a CAT database: tables, forms, and 
reports. 

14.1.5  ~ Using Access Design Features for the First Time 
Many of the following processes begin with explanations of complex topics that, though 
important, may be confusing for first-time database designers. Therefore, it is recommended that 
first-time users open an existing database and experiment with it while reviewing these 
procedures.  

It is also recommended that the first-time user begin experimenting with procedures that do not 
involve the creation of new tables, forms, or reports. The processes below are divided into four 
main sections: Working With Database Tables, Working With Features Common to Forms and 
Reports, Working With Forms, and Working With Reports. The first procedure in each section, 
describes how to create new tables, forms, and reports, respectively. Instead of reviewing these 
procedures, first-time users should go directly to the Design View of an existing component and 
begin reading the processes for manipulating component design. 
To Access Design Views of Tables, Forms, and Reports: 

1 In Windows Explorer, double-click on an existing database. Access will open displaying 
the Database Window. (See Figure 14.13.) 

Figure 14.13: Database Window Showing Available Tables 

2 Click on Tables, Forms, or Reports from the list of objects on the left side of the 
Database Window. In the right-hand frame of the Database window, Access will display 
a list of the available tables, forms, or reports, depending on which item was selected. 
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3 Double-click the desired table, form, or report. Access will open it, but it will not be in 
Design View. 

4 Choose View and Design View from the menu toolbar. 

14.1.6  ~ Working With Database Tables 
Tables are the fundamental building blocks of databases. Data in a database can be manipulated 
in a huge variety of ways, but all of the data is stored within one or more tables. The number of 
tables in a database and the structure of these tables can also vary tremendously, and many 
decisions are necessary to determine the appropriate number and design of database tables. 

Before discussing the strategies for determining database table structure, it is important to 
understand some rudimentary properties of database tables. As discussed earlier (See Section 
14.1.1, Understanding Access Databases), database tables usually contain multiple fields 
(columns) and records (rows). Fields contain values that are distinctly different in nature or 
purpose. For example, consider two fields in a CAT PC table: the PC# and PC Statement fields. 
The PC# field contains a set of numbers, whereas the PC Statement field contains blocks of text. 
Despite their differences, the values in each field of a record are related. For instance, in the PC 
table, the PC# in any one record corresponds to the PC Statement in that record and only that 
record. 
14.1.6.a Determining Basic Database Table Structure 

Note: First time users may wish to skip ahead to Section 14.1.6.b, Creating Tables in Access and 
become familiar with various table design features and read the following section later. 

Note: The following discussion briefly touches on important items such as Fields and 
Relationships but only insofar as they are necessary to demonstrate the considerations that 
occur before establishing database tables. For more thorough treatment of these topics see 
Sections 14.1.6.b, Creating Tables in Access, and 14.1.6.d, Establishing Relationships between 
Tables. 

The following discussion presents one strategy for determining which tables are necessary in a 
database, as well as which fields are needed within each table, to capture the data required to 
generate a PC list. The first step is to identify the data you need to capture, and determine the 
tables and fields necessary to capture this data. Once you decide which tables and fields are 
necessary, you need to determine if additional fields will be required to link data between tables. 
Finally, you should consider whether additional fields that can help organize data or provide 
additional information about essential data will be needed. 
Tables and Fields Needed to Capture Essential Data 
To determine the number of tables required in a database, you must to identify all the essential 
information that needs to be captured, determine the relationships between the elements of this 
information, and determine the nature of the relationships you identified. 

For CAT projects, it is usually necessary to capture a minimal set of data. This basic set of data 
includes Public Concern Statements (PCs), direct Sample Statements (SSs), Subconcern 
Statements (SCs), Subconcern Sample Statements (SC-SSs), and Letter Numbers (Letter #s) 
associated with both types of sample statements. 
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In determining the structure of a database, the relationship between data elements is as important 
as the actual data to be captured. There are many relationships between the five types of essential 
data identified above. For example, PCs are related to SSs and SCs, SCs are related to SC-SSs, 
Letter #s are related to SSs or SC-SSs. 

Once relationships between data elements are identified, you must consider the nature of these 
relationships to determine the database structure. For example, it is significant that the 
relationships between PCs, SSs, SCs, and SC-SSs is different from relationships between SSs 
and Letter #s. Each PC can have many SSs and many SCs, and each SC can have many SC-SSs. 
These types of relationships are called one-to-many relationships. Unlike these one-to-many 
many relationships, though, each SS or SC is related to only one Letter #. This type of 
relationship is called a one-to-one relationship. (See Figure 14.13.) 

 Public Concerns Table Sample Statements Table 

Figure: 14.13: Relationships Between Public Concerns and Sample Statements 
There is a one-to-many relationship between the Public Concerns table and the Sample Statements 
table, because PCs such as 3 and 4 can have multiple SSs associated with them. 

The existence of one-to-many relationships between essential data elements is the primary reason 
CAT databases have four tables instead of just one. To capture a one-to-many  relationship in a 
single table, it is necessary to repeat the single element every time one of the multiple elements 
occurs. For example, consider a PC that has four SSs. In a single table, each SS would be placed 
in a separate record; i.e., on a separate row. To maintain its relationship with each SS statement, 
the PC would have to be placed in the same four records. So the PC is repeated four times. 
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This duplication creates many problems when reports are generated. To avoid these problems,  
CAT databases contain four separate tables: one table for each essential data element that is part 
of a one-to-many relationship. The four tables in a CAT database are named Public Concerns, 
Sample Statements, Subconcerns, and Subconcern Sample Statements. 
Fields Required to Establish Relationships between Essential Data Elements 
To link data, such as PCs and SSs, which are located in separate tables, it is necessary to have a 
field of the same data type and name in each the associated tables. Matching data values in such 
common fields link appropriate records between tables. The presence of PC # fields in both the 
PC table and the SS table is an example of the use of common fields used to create relationships. 
As an example of how the PC # fields work, imagine that PC #10 has four SSs. If both the PC 
table and the SS table contain a PC# field, the number 10 can be placed in the PC # field of the 
PC table on the row of the appropriate PC. The number 10 can also be placed in the PC# field of 
the SS table on all four rows with SSs that correspond to PC #10. Since the PC and SSs have the 
same PC #, Access will associate this data if a formal relationship is established between the two 
PC fields. (See Section 14.1.6.d, Establishing Relationships between Tables.) This means that a 
record of PC #10 displayed in an Access form or report will display the four SSs, and only those 
four SSs, associated with PC #10. 

It is also necessary to link PCs to SCs and SCs to SC-SSs. As with SSs, a PC # field in the  SC 
table, is used to link records in that table to the appropriate records in the PC table. To create 
relationships between records in the SC and SC-SS tables, a similar field is needed. A field 
named SC AutoNumber has been established in both tables to create the needed relationship. 
Fields Needed to Include Organizational and Additional Information 
A set of tables containing fields for essential data, as well as the fields for linking this essential 
data, is the most fundamental table structure in a relational database. Such a database, with the 
essential data and relationships described above for CAT databases, would produce a very basic 
PC list. Presenting the list in the order desired, however, would be difficult, because there are no 
fields that can be manipulated to place PCs in a different order. In addition, such a basic database 
does not provide any fields into which to place additional information about PCs, such as 
whether a PC has been modified or not. CAT database tables, particularly the PC table, include 
several fields that are used to organize and/or provide additional information about PCs. For 
example, the Section field is used to order PCs. Similarly, the Status field is used to provide 
additional information, if changes are made to a PC. Other such fields in a CAT database include 
the Subject Code, Category Code, Assignment, and Status Comments fields. 
14.1.6.b Creating Tables in Access 

Once you determine the number and structure of tables needed in a database, you can begin the 
process of constructing database tables. Your first steps in creating the necessary table structure 
are to open a new table and define its fields and field properties. 
To Generate a New Table: 

1) Open Access either by double-clicking the appropriate desktop icon or through the 
Windows Start Menu on the lower taskbar: Start, Programs, Access. A dialog box will 
appear. (See Figure 14.13.) 

1-20 Chapter 14 ~ Working With Microsoft Access 
 



Technical Guide January 20, 2005 

2) Under Create a new database using, select Blank Access database and click OK. A 
File New Database dialog box will appear. 

3 

2 

Figure 14.13: Create a 
New Database Dialog Box Figure 14.14: Database Window 

3) Choose an appropriate name and location for the database, and click Create. A Database 
window will appear. (See Figure 14.14.) 

4) Double-click Create a table in Design view. A blank table Design View window will 
appear. (See Figure 14.15. The table design window in this figure is not blank, but a new 
one would be.) 

Defining Field Names, Data Types, and Field Properties 
Once in the table Design View, it is necessary to define the Field Name and the Data Type for 
each field to be created. (See Figure 14.15 for an example of the following procedure.) 
To Define Field Names, Data Type and Field Properties: 

1) Enter desired Field Name. 
For example, if the PC table for a CAT database is being created, the PC # field might be 
created first first. In this case, PC # is be entered under Field Name. 

2) Choose appropriate Data Type for the field, from the drop down menu. (See Figure 
14.15. Also, see Appendix A for descriptions of the appropriate data types for fields 
currently in use on CAT PC forms.) For the PC # field example, the appropriate data type 
is AutoNumber. 

3) Enter a Description of the field if desired. 

4) Under Field Properties, click the General tab, if it is not already on top of the Lookup 
tab. 
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5) Assign the appropriate Field Properties to the field. (See Appendix ?.) 

2

1 

4 

5

3 

Figure 14.15: Table Design View 
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Figure 14.16: Table Design View For a Typical Public Concerns Table 

14.1.6.c Modifying Existing Tables 

After tables have been established, it may be necessary to modify them, due to new requirements 
or errors. Instructions on how to make such modifications follow.  

Note: Another reason to modify existing tables is to begin creating a new database. For 
example, instead of creating new database tables from scratch for a new project, it is usually 
easier to modify the tables in an existing database to meet the requirements of the new project. 
In this case, you would make a copy of an existing database, then follow the instructions below 
to modify it. 
To Modify Existing Databases: 

1 Open the appropriate database. 

2 Choose Tables from the Objects 
menu. 

3 Double-click on the table to be 
modified. The table will appear in 
Datasheet View. This means the table 
will appear as rows and columns with 
the data that has been input. 

Figure 14.18: Design/Datasheet View Button 

4 Switch to Design View. Choose View, and Design View  from the upper menu, or simply 
click the Design/Datasheet button on the upper toolbar. (See Figure 14.18.)  
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5 Make necessary changes and Save. 
14.1.6.d Establishing Relationships between Tables 

As mentioned earlier, to maintain the appropriate association between data elements located in 
different tables, it is necessary to establish relationships between certain fields in certain tables. 
For example, a relationship between the PC # fields in the PC and SS tables ensures that the 
appropriate SSs are associated with the appropriate PC. 

To establish the type of relationships used in CAT databases it is necessary to designate certain 
fields as primary keys, choose the tables between which relationships are to be created, and 
create the links between the appropriate fields. 
Setting Primary Keys 
To enable certain beneficial features of relationships established between tables, it is necessary to 
designate specific fields as Primary Keys. Primary Keys are fields that cannot contain duplicate 
values. 

In CAT database tables, specific fields involved in one-to-many relationships must be designated 
as Primary Keys. In a one-to-many relationship, the linking field in one table can contain 
duplicate values, whereas in the other table it cannot. Consider the PC # fields in the PC and SS 
tables. The PC # field in the SS table can contain duplicate values, because a PC can have 
multiple SSs. The PC # field in the PC table, on the other hand, can only contain unique values, 
because each PC has only one PC #. The table in which the linked field can only contain unique 
values is called the Base table, and the table in which duplicate values are permitted in the 
linked field is called the Related table. In CAT 
tables, all the linking fields in Base tables are 
designated as Primary Keys. 

Primary Key 

To Designate Primary Key Fields: 
1 From the table Design View window in the 

appropriate table, place the cursor in the field 
you wish to designate as the Primary Key. 

2 Click the Primary Key button on the upper 
toolbar. A key figure will appear in the 
column to the left of the designated field. Figure 14.19: Primary Key Location 

3 Save the table. 
To Choose Tables between which to Create Relationships: 

1 Open the Database window. 

2 Click the Relationships button on upper taskbar. (See Figure 14.19.) The Relationships 
dialog box will appear. (See Figure 14.20.) 

3 Click the Show Table button in the 
Relationships dialog box. The Show 
Table dialog box will appear. (See 
Figure 14.20.) 

4 Choose the tables between which you 
wish to create relationships. Select a 
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table and click the Add button, then repeat until all the necessary tables are added. (See 
Figure 14.21.) 
In the case of a CAT database, all four tables are involved in at least one relationship, so 
all four tables are added. 

Note: The Subconcerns table has to be added twice, because it is necessary to establish two 
relationships with different characteristics between the SC table and the SC-SS table. These two 
relationships are between the SC AutoNumber and SC # fields in each table. 

3 

4

Figure 14.20: Relationship Table with Show Table Dialog Box Open 

As tables are added, windows associated with each table will appear in the Relationships 
window. These tables can be resized and repositioned as seems best. (See Figure 14.21.) 
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Figure 14.21: Relationships Window Showing Tables with No Relationships Established 

Creating Links between Tables 
1 In the Relationships Window, click on the field to be linked in the Base table and drag 

it to the corresponding field in the Related table. The Edit Relationships dialog box will 
appear. (See Figure 14.22.) 
As an example, to create a relationship between the PC # fields in the PC and SS tables, 
click on the PC # field in the PC table and drag it to the PC# field in the SS table. 

2 In the Edit Relationships dialog box, check Enforce Referential Integrity, Cascade 
Update Related Fields, and Cascade Delete Related Fields. 
Checking these properties means that any change made to data in the linked field in the 
Base table will be reflected in the Related tables. For example, if you delete a Public 
Concern record, the corresponding Sample Statement records will be deleted. 

3 

2 

4

Figure 14.23: 
Join Properties Dialog Box 

Figure 14.22: 
Edit Relationships Dialog Box 
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3 Click the Join Type button. The Join Properties dialog box will appear. (See Figure 
14.23.) 

4 Select option 2, Include ALL the records from ‘the base table’ and only those 
records from ‘related table’ where joined fields are equal, in the Join Properties 
dialog box. This will create a one-to-many relationship from the Base table field to the 
Related table field. (See Figure 14.24 for an example of how relationship links will 
appear.) 

5 Repeat this process for each relationship that needs to established. 

6 Save these established relationships. 

Figure 14.24: Relationships Window Showing Established Relationships 

Note: Linked fields in Base tables must be designated Primary Key fields in order to enforce 
referential integrity between linked tables. See Designating Primary Keys above.) 

The relationship indicated between the SC # fields in the SC and SC-SS tables cannot be set up to 
enforce referential integrity, because SC #s are not unique values in either table, and therefore, 
no Primary Key can be established. The relationship is established in the manner described 
above; only Step 2 is omitted. 
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14.1.7  ~ Working With Features Common to Forms and 
Reports 

As noted earlier, both forms and reports are interfaces that enable access to data in tables. Even 
though forms and reports interact differently with tables, there are many similarities between 
them. The following section provides information on components, processes, and tools that are 
common to both forms and reports. 
14.1.7.a Components Common to Forms and Reports 

This section describes some important components that are common to both forms and reports. 
Objects 
An object is basically a component of a database. Each table, form, and report, as well as every 
control on a form or report, is and object. Other components of forms and reports, namely 
physical divisions, are also objects. 
Sections 
Sections are physical divisions of forms and reports. A form or report will always include a 
Detail section, and possibly various headers and/or footer sections. The Detail section 
corresponds to the main body of a document in a normal composition. A report might contain 
header and footer sections, since the primary purpose of reports is to generate printed material. It 
is less likely, however, that forms will contain such headers and/or footers. 
Controls 
Controls are objects on a form or report that display data, perform actions, or are used for 
decoration or to provide information. Three types of controls are common to CAT forms and 
reports: text boxes, labels, and subforms/subreports. (See Figure 14.25 for examples of these 
types of controls.) 
Text Box and Label Controls 
A text box is the standard type of control described in Section 14.1.1. Text boxes are linked to 
fields in tables. In the case of a form, a text boxes are the controls where you enter or modify 
data. A report text box, on the other hand, retrieves data from the table field for presentation. A 
label control simply contains text that identifies a text box. Whereas the text box control 
contains values which vary with each record, the label control contains a constant text value. 

Text box and label controls usually occur in pairs. In fact, when a text box is placed on a form or 
report, Access automatically generates a label control. In a CAT form or report, multiple text 
box-label controls are placed on the Detail section. For example, a CAT PC report normally 
contains a PC # label control and a PC # text box control. 
Subform/subreport Controls 
Subforms and subreports are completely analogous to one another with respect to the 
information presented here. Since subforms and subreports are so similar, only the subform will 
be described in this section. (See Section 14.1.9.b, Working With Subreports, for examples of 
subreport controls.) 
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A subform is a form within a form. The form, in which a subform is located, is called the main 
form. Subforms are especially effective when it is necessary to access data in tables that are part 
of a one-to-many relationship. (See Fields Required to Establish Relationships between Essential 
Data Elements, Section 14.1.6.a, Determining Basic Database Table Structure.) In such a case, a 
subform, which is connected to the related table of a one-to-many relationship, is placed on the 
main form, which is connected to the base table. The result of this arrangement is that subform 
only displays records associated with the record displayed in the main form. For example, in the 
CAT PC form, the SS subform only displays SSs associated with the PC displayed in the main 
form. 

Examples of 
label controls

Examples of 
text box controls

Examples of 
subform controls 

Figure 14.25: Example CAT Data Entry Form 

14.1.7.b Tools Used in Both Forms and Reports 

In Access, there are two basic ways to format objects on forms and reports: using tools on the 
report page or inputting values on the Property Sheet. (See Figure 14.214.) Formatting on the 
report page involves using the mouse to select objects and to reposition or resize these objects. 
Formatting with the Property Sheet requires inputting precise numerical or alphabetic values to 
define object properties. Most standard formatting tasks can be performed by either method, but 
generally, using formatting tools on the report page is easier. 
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Property Sheet 

Toolbox Toolbar 

Formatting Toolbar 

Form Design Toolbar 

Properties Button

Toolbox Button 

Figure 14.26: Form Design View with Property Sheet and Toolbox Toolbar Visible 

Formatting Controls on Forms and Reports Using the Mouse 
Access provides the ability to position, resize, and format form/report controls directly on the 
form/report page. 
To Move Text Boxes and/or Labels: 

1 Select the desired text box by 
clicking on it. Small black squares 
will appear around the text box. 
(See Figure 14.27.) At this point, 
both the text box and its label are 
selected. 

Selected Control

2 Click and drag the control to the 
desired location. 
It is necessary to be very precise 
when you move a text box and/or 
a label. The repositioning tool 
tends to move both objects 

Figure 14.27: A Selected Control 
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together, unless the pointer is in exactly the correct position. 
• To move both the text box and its label, drag the mouse pointer over the text box 

until a hand symbol appears. Make sure it is a flat hand, not a pointing hand. Click 
and drag. 

• To move just the text box, drag the mouse pointer over the larger black square in 
the upper left corner of the text box. A pointing hand will appear. Click and drag. 

• To move just the label, drag the mouse pointer over the larger black square in the 
upper left corner of the label box. A pointing hand  will appear. Click and drag. 

To Resize Text Boxes or Labels: 
1 Select the desired text box or label. 

2 Drag the mouse pointer over one of the smaller black squares that are located on both 
sides, on the top and bottom, and in the corners of the text box/label. A double-headed 
arrow should appear. Click and drag the text box/label to the desired size. 

To Delete Contols: 
1 Select the control to be deleted. The selected control will be surrounded small black 

squares. 

2 Strike the Delete key. 
This operation is used primarily in CAT reports to delete superfluous labels. 

Formatting Subform and Subreport Controls 
Subforms and subreport controls are very similar to text box controls. Like it does with a text 
box, Access automatically generates a label when a subform or subreport is created. In addition, 
repositioning and resizing subform/subreport controls is performed in exactly the same manner 
as it is with text boxes. 
Applying Paragraph and Character Formatting to Controls 
Most paragraph and character formatting, including attributes such as indents, styles, font size, 
and font style, can be applied directly on the form/report design page. The following process 
gives the general approach to applying such types of formatting. 
To Apply Paragraph and Character Formatting to Controls: 

1 Select the object to be formatted. 

2 Choose the desired formatting from the Formatting toolbar. (See Figure 14.214.) 
Formatting Form and Report Objects Using the Property Sheet 
Although it is more convenient to format most controls using the mouse, several formatting 
properties can only be set in the Property Sheet. For example, the property that allows a control 
to grow or shrink to accommodate varying text block size can only be set on the Property Sheet. 
Also, it can be advantageous to use the Property Sheet when very precise positions or sizes are 
required for an object. For example, it might be good to input the width of the report as exactly 
six inches in the Property Sheet, or at least check it there to ensure that it is exactly six inches. 
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To view the Property Sheet: 
1 Click the Properties button located on the Form Design Toolbar. The Property Sheet 

will appear. (See Figure 14.28.) 

2 Position and size the Property Sheet. 
The Property Sheet can be resized and positioned in the same way as any standard 
“window.” It is probably a good idea to place it as far as possible to the right to remove it 
from areas where controls are likely to be located. 

To Format Objects Using the Property Sheet 
1 Open the Property Sheet. 

2 Choose the Format tab. (See Figure 14.28.) 

3 Choose the Object—Form, Section, or Control—that is to be formatted. The Title Bar of 
Property Sheet will reflect which object is selected. 
An object can be selected by clicking on the desired Object, or using the Object button 
on the Form Design toolbar. (See Figure 14.28.) 

4 Set the properties for the object.  

Object Button

Selected Control Object 

Figure 14.28: Form View and Property Sheet with Inserted Field Selected 
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Using the Toolbox Toolbar 
Another feature commonly used in both form and report design is the Toolbox toolbar. As with 
most toolbars, the Toolbox toolbar consists of several command buttons. Most of the buttons on 
the Toolbox toolbar are used to place controls on either forms or reports. For example, the 
Toolbox toolbar contains the Text Box button which places text box controls on forms and 
reports. Since the Toolbox toolbar is often used in design work, it is expedient to make this 
toolbar visible when working on the design of a form or report. 
To view the Toolbox Toolbar: 

1 Click the Toolbox button located on the Form Design toolbar. The Toolbox toolbar will 
appear. (See Figure 14.29.) 

2 Position the Toolbox toolbar. 
As with the Property Sheet, it is a good idea to remove the Toolbox Toolbar from areas 
where fields are most likely to be located. This can be accomplished by moving the 

Toolbar to the right, but the Toolbox toolbar can also be docked, as with other toolbars, 
by dragging it to the top of the window. If it is dragged up far enough, it will be 
incorporated into toolbar bands at the top of the window. In the subsequent figures, the 
Toolbox toolbar has been docked at the top of the Form window. (See Figure 14.29.) 

Text Box 
Button 

Subform/Subreport 
Button 

Figure 14.29: Toolbox Toolbar As It Appears When Docked 

Note: Depending on how Access has been set up on your computer, the Toolbox toolbar may 
already be visible. 

14.1.8  ~ Working With Forms 
A form is an interface through which data in database tables can be viewed and modified. This 
section describes how to create a new forms. It include sections on creating the basic elements of 
a form, working with subforms, and designing form layout. 
14.1.8.a Creating the Basic Elements of a Form 

To generate a new form it is necessary open a new form page in Design View, make any 
necessary adjustments to the form’s size, choose a data source for the form, and place required 
controls on the form. 
To Create a New Form: 

1 Open the appropriate database. 

2 If necessary, maximize the main Access Window and the Database Window. 
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3 Click Forms under Objects. (See 
Figure 14.30.) 

3

4
4 Double-click Create form in Design 

view. A form Design View window 
should appear. (See Figure 14.30.) 

Note: If you want to modify a form in an 
existing database, open the database, then 
open the desired form, and then choose View 
and Design View. Figure 14.30: Forms Database Window 
Resizing Forms 
A new form generated by the procedure above (To Create a New Form) may need to be resized 
if it is not large enough to contain the required controls. Since forms are not normally printed 
sizing is not limited by printing considerations, such as the page margins. To allow the most 
flexibility in arranging and sizing individual controls, the form should be as large as is 
reasonably possible. Since it is normally desirable to have all controls visible on one screen (this 
avoids having to scroll either sideways or up and down), the maximum form size is usually that 
of the maximized form window. In other words, when initially creating a form, it is a good idea 
to resize it to fill the window. The size can be adjusted later once all the controls have been 
placed, sized, and arranged. 
To Resize the Form: 

1 Drag the mouse pointer to the lower right corner of the form. 

Sizing Tool 

Figure 14.31: Form Design View for a New Form 
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2 When the Sizing Tool pointer appears (See Figure 14.31.), click and drag the form to the 
desired size. 

Important! At this point in creating a new form, the Property Sheet should be opened and the 
Toolbar toolbox should be made visible. (See 14.1.7.b, Tools Used in Both Forms and Reports.) 

Selecting the Record Source for a Form 
With the form window arranged as desired, it is necessary to link the form to the desired table. 
This table is called the Record Source.  

Note: In Access, the Record Source for a form can be either a table or a query, but in CAT 
databases it is usually a table. 
To Select the Record Source: 
As an example, assume the Public Concerns 
form is being generated. 

Select Form 

Object Button 1 Select the entire form. This is 
accomplished by selecting the small 
square located at the convergence of 
the horizontal and vertical rulers, or 
selecting Form from the dropdown 
menu activated by clicking the arrow 
on the Object button on the Formatting 
Toolbar. (See Figure 14.32.) When the 
Form is selected, a small black square 
should appear within the corner square, 
and the word Form should appear on 
the Object button. 

Figure 14.32: Selecting the Entire Form 
2 Click the Data tab on the Property 

Sheet. (See Figure 14.33.) 

3 On the Data tab, click in the window 
by Record Source. An arrow will 
appear on the right side of the window. 
(See Figure 14.33.) 

4 Click the down arrow on the right side 
of the Record Source window, and 
choose the desired table: the Public 
Concerns table, in the example. A list 
of fields in the PC table will appear. 
(See Figure 14.34.) 

Figure 14.33: Selecting the Record Source 5 Save the Form. 
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To Place Controls on the Form: 
1 Select the desired field by clicking on it. 

To create a useful form, it is necessary to 
determine which fields are to be manipulated by 
the form, because a control is needed for each 
such field. Most CAT forms are set up to include 
all the fields in the associated table, since it is 
usually necessary to use or modify data in all the 
fields. For example, the PC form contains 
controls for all the fields in the PC table. The 
exceptions to this rule are the SC AutoNumber 
fields in the SC and SC-SS tables. No controls are placed on any forms to access these 
fields, because they are only used to link these two tables and data for them is generated 
automatically. 

Figure 14.34: Fields Table 

2 Click on the selected field and drag it onto the form. A text box with a label will appear. 
(See Figure 14.35.) 

Controls Linked to 
PC Table Fields 

Selected Fields

Figure 14.35: Form Design View Showing Controls for the Main PC Form 
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3 If placing fields individually, return to Step 1, and repeat for all the fields it is necessary 
to have on the report. As mentioned earlier, for the PC form of a CAT database, all the 
fields from the PC table are required. (See Figure 14.35 for an example of the main PC 
form with all the necessary controls placed on it.) 

4 Save the form. 

Tip: It is possible to create multiple controls at one time. If it is necessary to link all the fields 
to the form, simply select the first field, hold down the Shift key, and click on the last field in 
the list. (It may be necessary to scroll down to get to the last field.) Then click and drag the 
multiple fields onto the form. If only selecting certain fields, hold the Ctrl key while selecting 
the desired fields, then click and drag them onto the form. 

Creating Forms on which to Base Subforms 
It is important to realize that subforms are actually forms themselves. They only become 
subforms when they are placed within another form. Even when a form is used as a subform, it 
can still be opened and manipulated as a form independent of the main form. 

Forms that function as subforms can be created independently of the main form, or they can be 
created when subform controls are added to the main form. The procedures in this guide assume 
that these forms are created independently and connected to the main form later. (See Section 
14.1.8.b, Working With Subforms.) Therefore, for a CAT database, it is necessary to create SS, 
SC, and SC-SS forms after establishing a PC form. 

To create independent forms on which to base subforms, follow the preceding process from 
Opening a Form in Design View through the procedure for Placing Controls on Forms. The 
critical difference between forms in this process is that a different record source is chosen for 
each form. 

Note: At this point, all the controls on the example form are text boxes. Some of these controls, 
e.g., the Assignment control, are usually combo boxes on CAT forms. Such controls can be 
converted to combo boxes at any time. (See Creating Combo Boxes, Section 14.1.8.c, Designing 
Form Layout.) 
14.1.8.b Working With Subforms 

As noted earlier, a form without a subform can only be linked to one table. In CAT databases, 
however, it is necessary to interact with data in more than one table, since related data reside in 
four different tables. Therefore, it is necessary to place subforms on the main PC form. 
To Create a Subform: 

1 From the main form Design View, arrange the controls on the main form so that they will 
accommodate the predicted size and location of the subform(s). This is just a tentative 
arrangement. Control size and position can be adjusted more precisely later. (See Section 
14.1.7.b, Tools Used in Both Forms and Reports.) 
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2 Click on the Control Wizards button (See Figure 14.314.), on the Toolbox toolbar, if the 
Wizard is not activated. If the Wizard is activated, the button will appear depressed and 
you should proceed to the next step.  (See Section 14.1.7.b, Tools Used in Both Forms 

and Reports.) 

Subform/Subreport 
Control Control Wizard

Figure 14.36: Toolbox Toolbar 

3 Click the Subform/Subreport button on the Toolbox toolbar. (See Figure 14.314.) After 
this action, when the pointer is dragged back onto the body of the form, the pointer will 
appear as crosshair and box combination. 

4 Position and size the subform control by clicking and dragging across the form in the 
appropriate location. An empty box will appear on the form, and a Control Wizard will 
open. (See Figure 14.37.) 
The subform box need not be perfect; it can be repositioned and resized later. 

5 Choose Use an existing form from the Subform Wizard. A list of forms will appear in 
the Wizard’s window. 

6 Select the appropriate form. 
For example, if the SS form is being placed on the PC form, choose the SS form. 

7 Click Next. A new dialog box will appear. This dialog box will require you to choose the 
fields that will link the subform to the main form. (See Figure 14.37.) 

8 Select Choose from a list, and select the appropriate option to link tables. 
For example, in linking the SS and PC forms, choose Show Sample Statements for 
each record in Public Concerns using PC #. 

9 Click Next. A dialog box for naming the subform will appear. (See Figure 14.37.) 

10 Click Finish. The Wizard will close, and a subform will be displayed on the main form. 
(See Figure 14.38.) 

As with Step 1 above for the main form, the new subform and controls on it may need to be 
rearranged to best use space. 

The SC subform is placed on the PC form in the same manner as presented above. To place the 
SC-SS on the SC form, simply open the SC form and follow the procedure above to place the 
SC-SS form on the SC form. When the main, PC, form is opened again, it will contain the SC 
subform, and the SC-SS sub-subform. For an example of a possible arrangement of the CAT 
Public Concerns form, in Design View, see Example of Possible Arrangement of Public 
Concerns Form in Section 14.1.8.c, Designing Form Layout. 
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Figure 14.37: 
Subform Wizard 
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Sample Statement subform placed on 
the Public Concerns form. 

Figure 14.38: Form Design View Showing a Possible Subform Placed on a Main Form 
14.1.8.c Designing Form Layout 

Once controls are inserted, they must be arranged and formatted. The possibilities for formatting 
and arranging forms are endless, and only a few highlights will be addressed here. The main goal 
of form design is to facilitate data entry. One way to do this is to design a form that displays all 
the fields on one screen, so there is no need to scroll when entering data. 

Visual elements such as arrangement and color also help ensure accurate and efficient data entry. 
Controls probably should not be much wider than a standard page width. Using a standardized 
set of font sizes, styles, and colors is also a good idea. Background color(s) should be chosen 
with visual impacts in mind. 

For details on tools used to format form objects see Section 14.1.7.b, Tools Used in Both Forms 
and Reports. 
Creating Combo Boxes 
Several of the controls on the CAT Public Concerns data entry form provide a dropdown menu 
from which to choose values. Examples include the Subject Code, Assignment, Date, and Status 
fields. These controls are called Combo Boxes. 
To Convert a Text Box to a Combo Box: 
(See Figure 14.39 as and example of this process.) 
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1 Open the appropriate form in Design View, if it is not already open. 

2 Select the control to be converted to a combo box. 

3 With the mouse pointer over the selected control, right click. A dropdown menu will 
appear. 
The mouse pointer should be a flat hand when you right click. 

4 Choose Change To and Combo Box from the dropdown menu. 

5 With the control still selected, open the Property Sheet. (See Section 14.1.7.b, Tools 
Used in Both Forms and Reports.) The Property Sheet title bar should reflect that the 
control in question is selected. 

6 From the Row Source Type dropdown menu on the Property Sheet, choose Value List. 

7 In the Row Source space, insert the values for the combo box dropdown menu. Place 
values for the list inside quotation marks, and separate them by semi-colons. 
For example, if the Assignment control needs to be converted to a combo box, you must 
enter the initials of the team members working on the project. Suppose the initials of 
those team members are KB, BE, MM, JR, and DS. You would enter “KB”;“BE”;“MM”; 
“JR”;“DS”. 

8 If the values for the control in question are to be limited to the values in the combo box 
list, change the LimitToList property on the Property Sheet to Yes. 

9 Save the changes. The selected control will appear as a combo box, with an arrow on the 
right side that operates the dropdown list of values when the form is next opened in Form 
View. 

Note: Combo Boxes are used in many cases because it is often quicker and easier to select a 
value from a list than to remember a value to type. A Combo Box allows either method of entry. 
Additionally, values in the combo box list can usually be selected by typing one or two of the 
beginning characters of the value. For example, suppose a Subject Code combo box contains a 
value named ACCESS, and no other values beginning with the letter A. To enter ACCESS into 
the Subject Code control, it is only necessary to type the letter A into the combo box and then 
key Enter or Tab. 
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Row Source Type

Row Source: Insert 
List of Values 

Figure 14.39: Creating a Combo Box

Note: Adding New Combo Boxes 

A combo box control can also be placed directly on a form. To do this, open Microsoft Access 
Help, and click the Contents tab. Click through the following path: Working With Controls on 
Forms, Reports, and Data Access Pages; List Boxes, Combo Boxes, and Drop-down List 
Boxes; Create a bound or unbound combo box, drop-down list box, or list box. 

Once in this folder, the type of combo box must be determined. There are two types: combo 
boxes with fixed value lists, and combo boxes that retrieve values from a table or query. 
To Create a Fixed Value List: 

Follow the instructions under Create an unbound list box, drop-down list box, or combo box 
that displays fixed values 
To Create a Value List Based on a Table or Query: 

Follow the instructions under Create a bound list box, combo box, or drop-down list box in a 
Microsoft Access project or data access page that retrieves data from a record source; and 
follow the instructions. 
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Example of Possible Arrangement of Public Concerns Form 
Given the breadth of design possibilities, is suggested that a form designer experiment with 
possible design options. For an example of one possible arrangement of the CAT PC form, see 
Figure 14.40, below. 

Figure 14.40: Possible Design of the CAT Public Concerns Form 

Important! For details on the properties of the controls placed on each CAT form and subform, 
see Appendix X, Computer Information. 
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14.1.9  ~ Working With Reports 
As noted earlier, a report is an interface through which data in tables can be retrieved and 
formatted for presentation. Reports determine which data are retrieved and the appearance of that 
data. 
14.1.9.a Setting Up the Basic Elements of a Report 

Reports can include a wide array of design elements and combinations of design elements. This 
section focuses on establishing the basic elements that are critical to CAT reports. Section 
14.1.9.c, Designing the Layout and Appearance of Reports will focus on the layout and 
formatting of reports. 

To create a basic report, it is necessary to create a new report page, resize the report page to 
accommodate the required controls, choose the record source for the report, and add the 
appropriate controls to the report. 
To Create a Report Page: 

1

2 

1 In the Database window, click 
Reports under Objects. (See Figure 
14.41.) 

2 Double-click Create report in Design 
view. A report window will open up in 
Design view. 

3 Save the report. When File, Save is 
selected from the menu toolbar, a 
dialog box requests a name for the 
report. 

Figure 14.41: Reports Database Window

4 Enter an appropriate name for the report and click OK. 
To Resize a Report Page, including the Header and Footer: 

1 With the report open in Design View, place the cursor at the right edge of the page. A 
Resizing Tool should appear.  (See Figure 14.42.) 

2 When the Resizing Tool appears, click and drag to the right until the appropriate size is 
achieved. (See Figure 14.42.) 
For CAT reports, you should make the margins 6 inches wide. 

3 To resize the Detail, place the cursor on the top edge of the Page Footer bar. 
The Detail section of the page probably needs to be increased vertically to accommodate 
the controls to be placed on the report. Bigger is better as the Detail can always be resized 
more precisely later. 

4 When the Resizing Tool appears, click and drag down until the page is the desired size. 
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Select Record 
Source for Form

Resizing Tool Shown at 
Various Locations 

Property Sheet 

The entire form can be selected by clicking in this corner. 
The black box appears when the entire form is selected. 

Figure 14.42: New Report Page with Entire Report Selected and  
Record Source on Property Sheet Open, and Showing Resizing Tool 

Important! At this point in creating a new report, the Property Sheet should be opened and the 
Toolbar toolbox should be made visible. (See 14.1.7.b, Tools Used in Both Forms and Reports.) 

To Choose the Record Source for the Report: 
1 Make sure the entire Report is selected. Choose Edit, Select Report from the Menu 

toolbar. (See Figure 14.43.) 

2 On the Property Sheet, click the Data tab. (See Figure 14.43.) 

3 Click in the data entry space to the right of Record Source on the Data tab. (See Figure 
14.43.) 

4 Click the dropdown arrow on the right side of the Record Source data entry space. (See 
Figure 14.43.) 

5 Choose the table on which the report is to be based. The Field List will appear. (See 
Figure 14.43.) 

Tip: If a report is not going out to a client, headers and footers are not absolutely necessary and 
can be deleted to better utilize space on a page. 

• To delete a header, place the cursor at the top edge of the Detail Bar, and with the 
Resizing Tool, drag upward until the Detail Bar touches the Page Header Bar. 
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• To delete a footer, place the cursor at the bottom edge of the page, and with the 
Resizing tool, drag upward until there is nothing visible below the Page Footer Bar. 

Tip: It is possible to create multiple 
controls at one time. If it is necessary to 
link all the fields to the form, simply 
select the first field, hold down the Shift 
key, and click on the last field in the list. 
(It may be necessary to scroll down to 
get to the last field.) Then click and drag 
the multiple fields onto the form. If only 
selecting certain fields, hold the Ctrl key 
while selecting the desired fields, then 
click and drag them onto the form. 

Controls Placed on Form

Field List 

Record Source

Property Sheet 

Figure 14.43: Report Design View with Controls Initially Placed on the Form 

To Add Controls to a Report: 
1 In the Field List, click on a field name that needs to be placed on the report, and drag it 

onto the report. A text box-label combination control should appear on the report. (See 
Figure 14.43.) 

2 Save the report. 

Note: It is possible to create multiple controls at one time. If it is necessary to link all the fields 
to the form, simply select the first field, hold down the Shift key, and click on the last field in the 
list. (It may be necessary to scroll down to get to the last field.) Then click and drag the multiple 
fields onto the form. If only selecting certain fields, hold the Ctrl key while selecting the desired 
fields, then click and drag them onto the form. In the above, multiple fields have been selected at 
once and dragged onto the form. 
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Creating Reports on which to Base Subreports 
It is important to realize that subreports are actually reports themselves. They only become 
subreports when they are placed within another report. Even when a report is used as a subreport, 
it can still be opened and manipulated as a report independent of the main report. 

Reports that function as subreports can be created independently, or they can be created when 
subreport controls are added to the main report. The procedures in this guide assume that these 
reports are created independently, and connected to the main report later. (See Section 14.1.8.b, 
Working With Subforms.) To create independent reports on which to base subreports, follow 
earlier procedures for creating reports. (See Section 14.1.8.a, Creating the Basic Elements of a 
Form.) 

 
14.1.9.b Working With Subreports 

As noted earlier, a report without a subreport can only be linked to one table. In CAT databases, 
however, it is necessary to interact with data in more than one table, since related data reside in 
four different tables. Therefore, it is necessary to place subreports on the main PC report. 
To Create a Subreport: 

1 Arrange the controls on the main report so they will accommodate the predicted size and 
location of the subreport(s). This is just a tentative arrangement. Control size and position 
can be adjusted more precisely later. (See Section 14.1.9.a, Setting Up the Basic Elements 
of a Report.) 

2 From the main report Design View, click on the Control Wizards button (See Figure 
14.44.) on the Toolbox Toolbar, if the Wizard is not activated. 
If the Wizard is activated, the button will appear depressed and you should proceed to the 
next step. 
If the Toolbox toolbar is not visible, choose View, Toolbar, and Toolbox from the Menu 
toolbar. 

Subform/Subreport 
Control Control Wizard

Figure 14.44: Toolbox Toolbar 

3 Click the Subform/Subreport control button on the Toolbox Toolbar. (See Figure 
14.44.) After this action, when the pointer is dragged back onto the body of the report, the 
pointer will appear as crosshair and box combination. 

4 Position and size the subreport box by clicking and dragging across the report in the 
appropriate location. The subreport box need not be perfect, it can be repositioned and 
resized later. An empty box will appear on the report, and a Control Wizard will open. 
(See Figure 14.45.) 

5 Choose Use an existing report from the Subreport Wizard. A list of reports will appear 
in the Wizard’s window. 
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6 Select the appropriate report. For example, if the SS report is being placed on the PC 
report, choose the SS report. 

7 Click Next. A new dialog box will appear. This dialog box will require you to choose the 
fields that will link the subform to the main form. (See Figure 14.45.) 

8 Select Choose from a list, and select the appropriate option to link tables. 
For example, in linking the SS and PC reports, choose Show Sample Statements for 
each record in Public Concerns using PC #. 

9 Click Next. Another dialog box will appear for naming the subreport. 

10 Click Finish. The Wizard will close, and a subreport will be displayed on the main 
report. (See Figure 14.414.) 

 
 
 
 
 

Figure 14.45: 
Subreport Wizard 

As with the main report in Step 1 above, the new subreport, and controls on it, may need to be 
rearranged to best use space. 
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At this point, the SC subreport still needs to be placed on the PC report, and the SC-SS subreport 
needs to be placed on the SC report. The SC subreport is placed on the PC report in the same 
manner as presented above. To place the SC-SS on the SC report, simply open the SC report and 
follow the procedure above to place the SC-SS report on the SC report. When the main PC report 
is opened again, it will contain the SC subreport and the SC-SS sub-subreport. 

Subreport

Figure 14.46: Report Design View Showing Possible Arrangement of  
Public Concerns Report with Sample Statement Subreport 

Note: If reports on which to base subreports have not been created, subreports can still be 
created using the Wizard. To do this, choose Use existing Tables and Queries in Step 5. 
Instead of selecting a report, select the appropriate table. For example, to insert the SSs in the 
PC Report, it is necessary to select the SS table, then choose the Sample Statement field. 
Creating subreports in this manner actually generates an independent SS report. 
14.1.9.c Designing the Layout and Appearance of Reports 

Once controls are placed on a report, it is almost always necessary to change either the size, 
position, and/or appearance of various components of the report. The possibilities for formatting 
and arranging reports are endless, and only a few highlights will be addressed here. For a more 
detailed explanation of the tools used to format reports, see Section 14.1.7.b, Tools Used in Both 
Forms and Reports. 

Given the breadth of design possibilities, is suggested that a form designer experiment with 
possible design options. An example of a possible arrangement of the CAT PC report is provided 
below. (See Figure 14.47.) 
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Sample Statement 
Subreport 

Subconcern 
Subreport 

Figure 14.47:Report Design View Showing Possible Arrangement of  
Public Concerns Report with All Subreports Included 

Important! Reports that may be converted to MS Word require special attention. The macro that 
reformats documents converted from Access to Word is applicable only to one specific Access 
report format. (The initial macro for the Access-to-Word conversion was based on the formatting 
of the PC Report in the Gray_Wolf_USFWS database.) This means IF THE LAYOUT OF AN 
ACCESS REPORT IS CHANGED, THE WORD CONVERSION MACRO PROBABLY NEEDS 
TO BE MODIFIED! Since this is not easy, think carefully before making any purely cosmetic 
changes. 

Reformatting Performed on Example Report: 
The following formatting operations were performed on the example report. They are provided 
as an example of the typical kinds of formatting performed on CAT reports. 

• Deleted Page Footer 
• Deleted Page Header 
• Aligned labels left: 

Section, Subject Code, and Category 
Code; and Assignment, Status, and 
Status Comments 

• Aligned text boxes right: 
Section, Subject Code, and Category 
Code 

• Changed text boxes and labels to 
10 pt font: 
Section, Subject Code, Category 
Code, Assignment, PC Report Date, 
PC #, and Public Concern Statement 
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• Changed labels to Arial font: 
Section, Subject Code, Category 
Code, Assignment, and PC Report 
Date 

• Changed text boxes to Times New 
Roman font: 
Section, Subject Code, Category 
Code, Assignment, and PC Report 
Date 

• Changed text boxes to Arial Black 
font: 
PC #, Public Concern Statement 

• Changed label to Arial Black font: 
PC # 

• Deleted Public Concern Statement 
label 

• Formatted Assignment text box as 
All Caps 
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14.1.9.d Setting Important Format Properties for a Report 

Once all the control objects are placed on a report, it is usually necessary to set a number of 
properties for certain objects to achieve the desired appearance. Some of the important 
formatting properties assigned to objects in CAT reports are presented below. 

 
Object Property Setting Comments 
Detail Section  
(See additional note 
below.) 

Keep Together No If this property is set to yes, Access 
will insert needless page breaks in an 
effort to keep a PC and all its 
associated data on one page. 

 Can Grow/Shrink Yes Allows the Detail Section to shrink 
and grow vertically in response to the 
amount of data. 

Sample Statement 
Subreport 
(See additional note 
below.) 

Can Grow/Shrink Yes Allows the control to shrink and grow 
vertically in response to the amount of 
data. 

 Border Style Transparent By default, Access places a solid 
hairline border around subreports, so 
this must be changed if it is not 
desired. 

Subconcern 
Subreport 
(See additional note 
below.) 

Can Grow/Shrink Yes Allows the control to shrink and grow 
vertically in response to the amount of 
data. 

 Border Style Transparent By default, Access places a solid 
hairline border around subreports, so 
this must be changed if it is not 
desired. 

Subconcern 
Sample Statement 
Subreport 

Can Grow/Shrink Yes Allows the control to shrink and grow 
vertically in response to the amount of 
data. 

(See additional note 
below.) 

Border Style Transparent By default, Access places a solid 
hairline border around subreports, so 
this must be changed if it is not 
desired. 

Public Concern 
Statement 

Can Grow/Shrink Yes Allows the control to shrink and grow 
vertically in response to the amount of 
data. 

Status Comments Can Grow/Shrink Yes " 

Sample Statement Can Grow/Shrink Yes " 

Subconcern 
Statement 

Can Grow/Shrink Yes " 

Subconcern 
Sample Statement 

Can Grow/Shrink Yes " 

Detail Section 
Make the Detail area as small as possible vertically. Vertical areas not occupied by control 
objects are interpreted as space between objects, and therefore, are not affected by the Can 
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Grow/Shrink properties. Therefore, unnecessary vertical space in the Detail section results in 
unneeded space in reports. 
Subreports 
When setting the properties for subreports, it is important to make sure you select the subreport 
control, not the report within the control, to set the border. (Believe it or not, there is a 
difference.) As with other controls, small black sizing squares appear around the subreport when 
it is selected. Also, Subform/subreport: SubreportName will appear in the Property Sheet title 
bar, whereas Report will appear in the Property Sheet title bar if the report within the subreport 
control is selected. Clear? 
14.1.9.e Filtering Reports 

It is advantageous to limit data presented in a report based on certain categories. For example, 
there is often a CAT report that shows only the PCs of an individual team member. Such a report 
is filtered according to values in the Assignment field. 
To Filter a Report by Values in a Field: 
Consider, as an example, a CAT report that is filtered by the Assignment field. 

1 Open the appropriate report in Design View. 

2 Open the Property Sheet. (See Section 
14.1.7.b, Tools Used in Both Forms and 
Reports.) 

3 Select the entire report. Choose Edit and 
Select Report on the menu toolbar. 

4 Click the Data tab. The Data sheet of the 
Property Sheet will be revealed. (See 
Figure 14.48.) 

5 In the Filter data entry area, enter the 
expression to define how to filter data for 
the report. 
For example: If the report is to be filtered by assignment, 
then [Assignment]=[Enter Initials] might be entered, as 
is shown in Figure 14.48. The Assignment string defines 
the field on which the data is to be sorted, and the Enter 
Initials string determines the label that will appear on the 
Enter Parameter Value dialog box. The Enter Parameter 
Value dialog box will appear the next time the report is 
opened, or the next time Print Preview view is selected. (See Figure 14.49.) 

Figure 14.48: 
Property Sheet with Filter Defined and Activated 

Figure 14.49:Enter Parameter 
Value Dialog Box

6 Set the Filter On value to yes. 

7 Save the report. 
14.1.9.f Sorting and Grouping in Reports 

It is beneficial to organize report data by various categories. For example, data in CAT internal 
PC reports is often grouped and sorted by the Section control to place like PCs together. The 
Access Sorting and Grouping command enables such organization in reports. 
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To Sort and Group on Fields: 
1 With a report open in Design View, click the Sorting and Grouping button on the 

Report Design toolbar. (See Figure 14.50.) The Sorting and Grouping dialog box will 
appear. (See Figure 14.51.) 

Report Design Toolbar Sorting and Grouping Button 

Figure 14.50: Sorting and Grouping Button on the Report Design Toolbar 

2 Click the down arrow on the right side of the Field/Expression column and choose the 
desired field from the dropdown menu. As an example, choose Subject Code if you want 
to sort on that field. 

3 The Sort Order column should default 
to Ascending. If not, click in the Sort 
Order column, and choose the desired 
sort order: probably Ascending. (Sort 
Order is either Ascending or 
Descending.) 
At this point, data in a report is sorted 
by only one field. If this is sufficient, 
close the dialog box and save the 
report. It might, however, be desirable 
to sort the data by another field within 
each of the groups created by the first 
sorting field. To do this, proceed to 
step four. 

Figure 14.51: Sorting and Grouping Dialog Box

4 Set further levels of sorting and grouping if needed. Go to the second row under 
Field/Expression and choose the desired field. Up to ten levels of sorting and grouping 
can be defined for a report. 

5 Close the Sorting and Grouping dialog box and save the report. 

Tip: The Group Properties options on the Sorting and Grouping dialog box  provide additional 
options for manipulating the appearance of data. One of the most useful options is the Group 
Header feature. This option places a header in a report associated with the field which is being 
used to Sort and Group on. This header can be formatted to force a new page every time a new 
value is encountered in the sorting and grouping field. For example, if the Assignment field is 
assigned a Group Header, and the header is formatted to force a new page, then a page break 
will be placed ahead of each team member’s section. This could make splitting printouts much 
easier. 
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Chapter 15 ~ Formatting CAT 
Documents 
This chapter focuses on using Microsoft Word to format CAT documents, since most 
Content Analysis Reports are created in this application, and is divided into two sections. The 
first section, Formatting Basics, introduces some common Word tools and provides details 
for performing basic formatting operations, such as applying styles, on individual documents. 
The Advanced Formatting Features, in comparison, focuses on features used in creating 
project templates merging sections of CAT reports contained in multiple documents into one 
file. 

Section 15.1 ~ Formatting Basics 
CAT has used a variety of advanced features in MS Word to produce documents more 
quickly and accurately. Following are basic instructions for some of the most common tasks. 
These instructions presume an intermediate skill level with Word. For more detail on these 
and other features of Word, please see Using Word 2000 or Word 2000 for Dummies. 

15.1.1 ~ Word Tools and Settings 
The following section describes the setup and use of some of the most important features 
used when operating within MS Word, such as the manipulation of toolbars and the 
application of significant toolbar buttons. It also introduces the important concepts of Styles 
and Templates. 

15.1.1.a ~ Toolbars 
Toolbars are composed of buttons that execute various commands. The most commonly 
used toolbars, Menu, Standard, and Formatting, are usually found near the top of a Word 
window, and appear as Figure 15.1 below. If you do not have all these toolbars visible, 
perform the following procedure: 

Menu Toolbar 

Formatting Toolbar Standard Toolbar

Figure 15.1: Word Toolbars 
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Toolbar Settings: 
1 Select View, Toolbars, Customize. 

2 On the Toolbars tab: 
Make sure the Menu, Standard, and Formatting toolbars are checked. 

3 On the Options tab: 
If you are a minimalist, you can probably select the Share one row option, if not 
uncheck it. Other options are up to you. 

Note: The Commands tab should be avoided. There be dragons here! 

Your individual Standard and Formatting toolbars may contain more or fewer buttons than 
the toolbars shown in the example above. You can decide which buttons you want to be 
visible, but some of the most frequently used and important buttons on toolbars include: 
• Standard Toolbar: 

Undo, Redo, and Show All commands 
• Formatting Toolbar: 

Style box, Font style, Font size, Bold, Italics, and Underline 
Adding and Removing Toolbar Buttons 
You can add or remove toolbar buttons. On the 
right hand side of both the Standard and Formatting 
toolbars there are small down arrows. To add or 
remove buttons, click the down arrow that 
corresponds to the desired toolbar, and then click 
the down arrow in the resulting Add or Remove 
Buttons menu box. (See Figure 15.2.)

15.1.1.b ~ Show All Command 
When formatting a document, it is often helpful to 
see certain formatting symbols to troubleshoot 
problems. For example, inadvertently back spacing 
over a Section break can cause trouble with headers 
and footers, page numbering, and other associated 
formatting. The easiest way to do reveal formatting 
marks is to use Word’s Show All command. This 
command can be activated by selecting the Show All 
button on the Standard toolbar, if it is present. It is a 
square button with ¶ symbol on it. (See Figure 15.3.) If 
the Show All button is not available, the command can be 
initiated through the Menu toolbar by choosing Tools, 
Options, and the View tab, then checking the All box 
under Formatting marks. 

Add or Remove 
Buttons arrow 

Figure 15.2: Add or Remove Buttons on 
Toolbars 

Figure 15.3: Show All Button 

Show All
button 
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Some of the most important formatting symbols that are revealed when you activate the 

Show All command are shown in Figure15.4. 

Manual Line Break 

Tab Character 

Section Break 

Paragraph Mark 
Blank Space 

Page Break 

Keep with next/Keep lines together Mark 

Figure 15.4: Examples of Formatting Marks 
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15.1.1.c ~ Word Settings: Avoiding Unwanted Styles and Other Word 
Features 

If you have not unchecked some evil little default settings, you may be creating styles 
unknowingly. Unless you tell it not to, Word creates and applies styles based on your formatting, 
even when you make mistakes. This is not a good thing. When you merge your file with one 
created by someone else, all of these custom 
styles fight with each other and bizarre things s
happening to perfectly good formatting. 

Important! 
Uncheck! 

tart 

Before you install the CAT template and start 
typing, you have to check your computer’s 
settings. If you’re working at home or on anyone 
else’s computer, you also need to check these 
settings. If you don’t, and the wrong box stays 
selected, your document will start creating lots of 
horrible little styles that will infect any document 
they touch. 
Checking Word Settings: 
To correct auto settings affecting styles, select 
Tools, AutoCorrect Options on the menu 
toolbar. A dialog box with five tabs will appear. 
(See Figures 15.5 and 15.6.) You need to fix 
settings under both AutoFormat As You Type 
and AutoFormat. 

Figure 15.5 
Fixing AutoFormat As You Type: 
• Select AutoFormat As You Type. 
• Uncheck all the boxes under Apply as you 

type. 
• Leave all the boxes checked under Replace 

as you type. 
• Uncheck both boxes under Automatically as 

you type, ESPECIALLY the Define styles 
based on your formatting box; THIS LAST 
BOX IS THE MOST IMPORTANT! 

• Click OK. 
Fixing AutoFormat: 
• Uncheck Headings. 
• Uncheck Automatic bulleted lists. You may 

want to uncheck Lists. 
• Check Preserve styles. 

Figure 15.6 
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• Click OK. 

After you make sure all your AutoFormat settings are correct, you can utilize CAT templates 
with relative peace of mind that you will not encounter an undue number of mystical occurrences 

 
 been established, team members can use the template to create 

ocuments for the project. 

To 
 the appropriate team member. 

 

e file has a dot extension, 
at t e cument has a doc extension. 

3 

4 , and save the document with an appropriate name, in an 
ropriate location. 

ate a shortcut 
to a w re convenient location. Do the following: 

te icon. 

3 icon and click-and-drag, or cut-and-paste it to the desired location; 

 It is 

 You would only “open the template” if you were going to make changes to the 

e 

related to Word’s AutoFormatting features. 

15.1.2 ~ Creating a Document Based on a Project Template
Once a project template has
d

 
Create a Document Based On a CAT Project Template:  
1 Find out where your project template is located from

2 Locate the project template in Windows Explorer. 

Important: DO NOT right-click and select Open from the shortcut menu. This will open the file
as a TEMPLATE, not as a DOCUMENT. It is important to know whether you are working in a 
template or a document, because you usually do not want to make changes to templates. 
Fortunately, it is easy to tell what kind of document a file is. A templat

he nd of the filename, whereas a do

Double-click the template icon. 
Word will open an unnamed document based on the template. 

Choose File, Save As
app

Optional: 
When you locate the template the first time through Windows Explorer, you can cre

llo  access to the template from a mo

1 Right-click on the templa

2 Select Create Shortcut. 

Select the resulting 
e.g., your desktop. 

Note on semantics: CAT team members often use the term “opening the template” to describe 
the process above. This usage may cloud the understanding of what is actually happening.
MUCH more accurate to think of this process as “opening a DOCUMENT based on the 
template.”
template. 

15.1.3 ~ Employing Styles 
As indicated earlier, styles are very important to CAT word processing operations. Styles ensur
consistent formatting throughout a document with minimum effort. For example, if you want a 
heading to look a certain way, all you have to do is select the text and then apply the style that 
contains all the appropriate formatting information. You don’t have to individually select the 
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proper font, alignment, text size, spacing, etc. By selecting a style, you do all that at once. This 
takes less time and reduces the chance you will forget to change some formatting details. Styles 

ically generate items such as tables of 

 

T documents in the body of our documents. If you cannot get a 
style to achieve the appearance you think it should have, see the team member responsible for 

, 

ting 

be selected when the dialog box opens. If not, you will need to select 
les. In this case 

 that CAT 
following 

a stics: 

• 

• 

ch as font or paragraph 
style may contain attributes from any or all of the categories. All of these 

ries 

also give us a way to mark text, which allows us to automat
contents and indexes. 

Note: See Appendix G for a listing of current CAT Styles. 

An Admonition: DO NOT USE MANUAL FORMATTING and USE ONLY CAT STYLES. CAT
document formatting processes, such as page numbering and table of contents generation, are 
acutely dependent upon the use of appropriate styles. There should be no reason to use styles 
other than those created for CA

formatting the final document. 

15.1.3.a ~ Understanding Styles 
A style is a group of formatting characteristics such as font type and size, paragraph alignment
tab spacing, and other possible attributes. As an example of formatting characteristics attributed 
to a style, consider our standard narrative style, CAT Body Text. To determine the format
characteristics of a particular style, choose Format, Style from the menu toolbar. A dialog box 
such as Figure 15.7 will appear. If your cursor is in the paragraph for which you want to 
determine the style, it will 
it from the list of sty
the dialog box indicates
Body Text contains the 
ch racteri
Font Formatting: 
• Times New Roman 
• 12 pt 
• English (U.S.) 
Paragraph Formatting: 

Flush left margins 
• Single line spacing 

Space before paragraph = 6 pt 
(standard line =12pt) 

l (will not • Window/orphan contro

leave single lines at end or 
beginning of page) 

• No hyphenation at the end of a line 

Word divides formatting characteristics into several categories, su

Figure 15.7: Style Dialog Box 

Font 
Formatting

Paragraph
Formatting

formatting, and a 
formatting options are available under Format in the menu toolbar. The formatting catego
used most frequently in CAT documents, along with their associated attributes, are as follows: 
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Font formatting
Determines font type, font size, color, bold, italics, underlining, and other special effects. 

are divided into two groups: Indents and Spacing options, as 
 attributes. Options for these two categories are available on 

h in 

d 

blic 
ns that if we 

apply these styles incorrectly—i.e., we apply the section heading style to a table title just because 

ith next option prevents a page break between a paragraph to which this option has 
as 

sts, determines type and spacing of tabs. One less obvious 
AT 
re 

d 

tting is used for a second list in a document. Likewise, it is probably 
mbering through Bullets and Numbering formatting. (See Section 

Paragraph formatting 
Includes characteristics that apply to entire paragraphs, not just text within a paragraph. 

Paragraph formatting features 
well as Line and Page Breaks
separate tabs in the paragraph formatting dialog box. 
Indents and Spacing 
The Alignment command left aligns public concerns and centers subconcerns. 
The Spacing Before/After allows for precise and consistent visual breaks between paragraphs. 
For example, the CAT Section Heading style generates a significant space before a paragrap
this style in order to set it off from the preceding text. You won’t have to count paragraph marks 
any more, or change 15-point spaces to 12 point. You just hit enter once when you reach the en
of your heading, public concern, etc., and the styles provide the correct amount of spacing. 
The Outline level settings allow us to determine the hierarchy of our document for a table of 
contents and public concerns index. Chapter headings are first, followed by section headings, 
subsection headings, public concerns, and subconcerns. When we generate a table of contents, 
we can choose which levels to display. This means that we can now generate an automatic pu
concerns index that updates on demand and includes page numbers. This also mea

it looks good, or we manually format a section heading instead of using a style—we’ll have 
weird things showing up in our table of contents or the right things won’t appear. 

Line and Page Breaks
The Widow and orphan control and command prevents single lines of text from being isolated 
at the beginning or end of a page. 
The Keep w
been applied and the following paragraph. This attribute is used in styles applied to lines such 
section headings and public concerns, which should not be separated from the following 
paragraph. 
Tab formatting, as the name sugge
characteristic assigned through tab formatting is the insertion and style of tab leaders. In C
documents, the dotted lines that connect headings and page numbers in tables of contents a
generated though tab formatting. 
Bullets and Numbering formatting allows you to define various attributes of bulleted or 
numbered lists, as well as to apply Outline Numbering. (See following note!) 

Note: It is probably best NOT to assign numbered list formatting to styles. We have experience
various problems with this arrangement, such as not being able to restart numbering if a style 
with numbered list forma
best to apply Outline Nu
15.2.1,  
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Borders and Shading 
Provides various options for bordering and shading paragraphs and pages. This type of 
formatting is used to generate the underlining in the header, as well as the line defining the top of 

d 
5), all the styles in that template are available for your use. 

 box 

 
 see Section 15.1.1a, Toolbars.) When you click the arrow next to the Style box, a drop-

pear. 
To 

 on page 15-
24. 

g. 

it, you 

one paragraph, select the multiple paragraphs. 

Note: You must be sure to select an entire paragraph, NOT JUST THE TEXT within the 
paragraph. You can tell when an entire paragraph is selected because the darkened “selected” 
area will have an extra little space beyond the end of the paragraph. 

3 Select the proper style from the style box. 

the footer. 

15.1.3.b ~ Using Styles 
Once you have opened a document based on a CAT template (See Creating a Document Base
on a Project Template on page 15-5

Most CAT styles are paragraph styles. This means they apply to everything you type between 
one paragraph return and the next. They also establish distances between paragraphs, so you 
never need to hit “Enter” twice to get correct spacing. One paragraph return suffices, and the 
styles automatically tell Word to allow more space before or after a paragraph. 
Locating the Style
The easiest way to apply styles to paragraphs is to use the Style box. (See Figure 15.8 below.) 
The Style box is usually located on a toolbar at the top of the page. (If you cannot locate a Style
box,
down menu of available styles will ap

Apply a Style: 
Note: If you are applying Heading 1 for a chapter title, see Formatting Chapter 

If you haven’t started typing yet:  
Select the proper style from the Style box drop-down menu on the toolbar and start typin

If you want to apply a style to something already typed: 
1 Click your cursor in the paragraph you want to change. 

Note: Be careful to just insert the cursor; if you accidentally drag the mouse just a little b
will select text and Word will apply only the font formatting attributes of the style (NOT the 
paragraph formatting features) to the selected text. Such application of a style will not provide 
us with all those wonderful features associated with styles. 

2 If you wish to apply the style to more than 
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Style box. 
Click arrow.

Space created 
by paragraph 
return 

Figure 15.8 

As an example of applying styles, refer to Figure 15.8. The two blocks of text in the window are 
in normal style. If you selected both paragraphs, chose CAT Body Text from the style box, and 
deleted the extra paragraph return between the paragraphs, the text would appear as in Figure 
15.9. You will notice that the style has created an appropriate break between paragraphs. 
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Space created by paragraph 
formatting that is part of the style.

Figure 15.10: Applying Styles to Multiple Paragraphs 

As a further example, if you just wish to apply a particular style to one paragraph, you need only 
place the cursor in the paragraph you want changed. In the above example, if you placed the 
cursor in the first paragraph, and selected the Public Concern style, you would get the following 
result. 

Public Concern style

CAET Body Text style 

Figure 15.9: Applying Styles to Individual Paragraphs 
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Tips and Special Cases: 
• Eliminating manual formatting applied over styles 

Sometimes you may be working with a document in which someone has applied manual 
formatting over a style. Even if you change the style, the manual formatting will remain, and 
often produce undesired and confusing results. In this case, select the entire paragraph and 
perform a Shift + Spacebar keystroke, or just select the Default Paragraph Font from the 
style box. 

• Eliminating paragraph spacing associated with styles 
Sometimes you may want to apply a style to multiple paragraphs, but don’t want paragraph-
sized line spaces between them. For example, you may have a list of names and you want 
one name on each row, but you want only a single line space between each row. Or you may 
want to split a section title to two lines, but don’t want a paragraph-sized line space between 
the two lines. Use Shift+Enter to break the line without adding the extra space after the 
paragraph. This is called a manual line break. 

Cautions 
• Avoid accidentally modifying styles 

If you get a message that says, “Update the style to reflect recent changes?” don’t do it. 
Don’t update the style in any way, or it will conflict with other team members’ documents. 
Select “Reapply the formatting of the style to the selection?” instead. 

• Don’t panic if styles appear to do funny things 
Often when using Styles formatting, strange things appear to happen when one deletes the 
space between paragraphs. This most often happens because the paragraphs are in different 
styles. If one were able to see the computer commands that direct the computer to apply a 
style, these commands would be located at the beginning of the paragraph. In other words, 
they are located after the paragraph return for the preceding paragraph, but before the text for 
the paragraph in question. For example, if one were to delete the space between the 
paragraphs in the preceding example, Figure 15.9, all the text would become Public Concern 
style, as in Figure 15.10, because the commands for CAET Body Text were deleted with the 
paragraph return. 

Figure 15.11: Impact of Inadvertently Deleted Paragraph Returns on Styles 
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15.1.4 ~ Using Find and Replace Operations 
Word’s Find/Replace function provides a very powerful tool for locating and replacing strings of 
numbers and characters, formatting, and other characteristics. It is especially useful where such 
replacements need to be made many times throughout a document. 

To utilize Find and Replace actions most efficiently, you should try to make the group of 
characters—a string—for which you are searching as unique as possible. The more distinctive a 
search string, the fewer erroneous strings will be found. In the ideal situation, you will find 
ONLY those items you wish to replace. 

Note: You also have the option to use only the Find option of this command; use Edit, Find. 
When you initiate a find/replace o
a dialog box like the one to the right will 
appear. For finding simple combinatio
of characters and/or numbers, such
this example, the options available in t
following procedure suffice. For m
advanced options, 

peration, 

ns 
 as in 

he 
ore 

ations 
d. If it is the entire document, simply key Ctrl+Home, which 

No ed at the beginning of a document, you may encounter a 
t. If 

fter Word has 
er of 

u wish to replace the “found” text. 

LY

see Section 15.2.12, 
. 

Basic Find/Replace Oper
Advanced Find/Replace Operations

Figure 15.12: Find/Replace Dialog Box 

1 Select the area to be searche
moves your cursor to the beginning of the document, and begin. Otherwise, select the 
region you wish to search. 

te: If your cursor is not plac
message box that asks if you wish to continue searching at the beginning of the documen
your intent was to search the entire document, you should choose YES. 

Note: If you search a selected area, you will encounter a message box a
searched the selected area. This message box will ask if you wish to search the remaind
the document. If you only want to search the area you selected, you should choose NO. 

2 Select Edit, Replace from the upper toolbar. (Keystroke: Ctrl+H) 

3 Enter the text you wish to find in the Find what box. 

4 In the Replace with box, enter the text with which yo

5 Choose your replacement option 
Option 1: Replace All
If you are ABSOLUTE  certain that you have selected a totally unique string for your 

ent that you have defined a completely unique string, it is 

Replace (not the Replace All) button. 

document, and you want to replace all occurrences of that string, click the Replace All 
button. The example in Figure 15.13 above is probably such a case. 
Option 2: Find Next/Replace
If you are not absolutely confid
better to find and replace occurrences of the string one by one. This is accomplished by 
selecting the Find Next button. If this highlights a string you want to replace, select the 
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Section 15.2 ~ Advanced Formatting Activities 
15.2.1 ~ Creating a Project Template 
Templates are Word files that have a number of special features associated with them. All 
documents created in MS Word are based on a template. Even when you just open the Word 
application by clicking its icon, you are operating in a document base on Word’s Normal 
template. 

As you might expect, Word templates define basic structural elements of a document, such as the 
margins, as well as the size and position of headers and footers. Just as importantly, a Word 
template also contains an array of tools, such as styles  (See 15.1.3 ~ Employing Styles.) and 
macros (See 15.2.12 ~ Transferring Styles between Documents and Templates.). A document 
based on a particular template will have the same array of tools as the template. 

It is important to know whether you are working in a template or a document, because you 
usually do not want to make changes to templates. Fortunately, it is easy to tell what kind of 
document a file is. A template file has a dot extension, whereas a document has a doc extension. 

CAT project documents are usually based on a project template. These project templates, in 
turn, are based on a master template named, CAT_ProjectTemplate, which is located in the 
folder: K:\cat\procedures\Templates\ProjectTemplates. 
To create a new project template: 

1 Open the CAT_ProjectTemplate.dot AS A TEMPLATE. 

Note: You must have a password to open the master template. If you do not know the 
password, contact the appropriate team members to acquire it. 

Either right-click on the icon for the CAT_ProjectTemplate.dot file, or open MSWord 
and open the template via the File, Open procedure. (If you double-click on the icon, 
Word opens a file based on the template, NOT the template itself. When a template is 
open, the extension for the file should be .dot not .doc.) 

2 Save-As a new template, with a name based on the project, and in an appropriate 
location. 
At this point, the new project template, since it is based on the master template, is 
password protected. So you must now remove the password, or the documents team 
members create based on the new template will be password protected. 

3 With the project template open (as a template, still), choose Tools, Options, and the 
Save tab. 

4 Delete the contents of the Password to modify box. 

5 Save the file. 

Team members can now open a document based on the project template simply by double-
clicking on the project template icon. 
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Modifying a Project Template 
o 

 
If you modify a project template during a project, you need to ensure that the changes made t
the template are made in the documents based on the template. To do this, have individual team
members place their files on the network drive. 

If you have made style changes to the template, you can update styles using the Styles 
Organizer, once all the necessary files are on the network drive. See 15.2.12 ~ Transferring 
Styles between Documents and Templates. 
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15.2.2 ~ Creating Coding Structures 
One of the first documents created for a project is the Coding Structure. Two sections usually 
compose a coding structure. The first section contains the Demographic Codes and the second 

ons, the 
es 

g the Alternative Codes, if any Alternative Codes 
are employed on the project. For this section, the term Coding Structure, will refer to the 
section that defines the Subject and Category Codes. 

A detailed example of the structure of a Demographic Codes and Coding Structure 
Appendix is located in the following file: 
K:\cat\msla\Procedures\CAT_Templates\ProjectTemplates\Appendices_Samples\ 
AppB_DemoCodes_CodStruc.doc 
Refer to this file for basic layout of this appendix and formatting of its sections, including the 
appropriate application of styles. 
To Create and Format a Coding Structure 

1 Open a new document based on the Project Template, for the project on which you are 
working. (See Creating a Document Based on a Project Template, on page 15-5.) 

Note: Most of the time, team members create coding structures in a separate document 
from the demographic codes, which means that eventually the individual files will have to 
be merged into one. and this procedure is presented in this manner. 

2 Enter subject and category codes, and apply the styles which will automatically 
number these codes. 
Reference the coding structure example file located on the K-drive, mentioned above, and 
see Figure 15.13: Example of a Typical Coding Structure, below, for guidance on style 
application. 

3 If there are Alternative Codes, enter a section break at the end of the Coding Structure. 
(See Placing Section Breaks in CAT Documents, on page 15-26.) 

4 Enter and format Alternative Codes after the section break you have just inserted. 

Important! None of the Coding Structure styles should be used in either the Demographic 
Codes or Alternative Codes section. The Coding Structure styles are reserved for use in the 
actual coding structure. 

 

section contains the Subject Codes and Category Codes. In addition to these two secti
second section may be further broken into two divisions, the section defining the Subject Cod
and Category Codes, and the section definin
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Tongass Draft SEIS Coding S
(CAT_App Section Heading) tructure 

Coding Structure_Level 3
________ Coding Structure_Level 3 

 10 el 2 

Coding Structure_Level 3 

 10
nt administration ______________ Coding Structure_Level 3 

 10 Level 2 
PURP

 11200  Ecosystem preservation as guiding policy _ Coding Structure_Level 2 
 11300  Multiple-use as guiding policy __________ Coding Structure_Level 2 
 11400  Relationship to other laws, regulations____ Coding Structure_Level 2 
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Figure 15.13: Example of a Typical Coding Structure 

Purpose and Need _________________________ Coding Structure Section Heading 
PLANN ________________________________________ Coding Structure Subject Code 

10000  Planning, general ______________________ Coding Structure_Level 1 
 10100  Scoping and range of issues ____________ Coding Structure_Level 2 

Coding Structure Styles

 10200  Public involvement ___________________ Coding Structure_Level 2 
10210  Public meetings ___________________ Coding Structure_Level 3 
10220  Accessibility of information__________ Coding Structure_Level 3 

 10300  Project timeframe, comment period ______ Coding Structure_Level 2 
 10400  Adequacy of planning documents________ Coding Structure_Level 2 

10410  Adequacy and clarity of maps ________  
10420  Editorial _________________

 10500  Use of science in decision-making _______ Coding Structure_Level 2 
 10600  Interagency collaboration) _____________ Coding Structure_Level 2 

10610  Planning _________________________ Coding Structure_Level 3 
10620  Implementation ___________________ Coding Structure_Level 3 
700  Agency organization and staffing ________ Coding Structure_Lev
10710  Planning _________________________ Coding Structure_Level 3 
10720  Cost of implementation _____________
10730  Decision-making authority___________ Coding Structure_Level 3 
800  Trust and integrity, general _____________ Coding Structure_Level 2 
10810  Curre
10820  USFS ___________________________ Coding Structure_Level 3 
900  Other ______________________________ Coding Structure_

O ________________________________________ Coding Structure Subject Code 

11000  Purpose and Need, general ____________ Coding Structure_Level 1 
 11100  Biological diversity as guiding policy ____ Coding Structure_Level 2 
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15.2.2.a ~ Merging Coding Structures into Appendices 
At some point after a coding structure has been created, you will need to merge it with the 
demographic codes into a single appendix document: the following procedure describes how to 
do this. It is assumed that the document containing the demographic codes was created based on 
a project template. 
To Merge a Coding Structure into an Appendix 

1 In Windows Explorer, rename the Demographics Code file to an appropriate name for 
the appendix. 

2 Open the Appendix file and the Coding Structure file. 

3 Activate the Show All command in both files. See Show All Command, on page 15-2. 

4 In the Appendix file, go to the end of the document, and delete any unnecessary 
paragraph returns. There should be a paragraph return at the end of the last line of text 
and one on the next line, without any text. 

5 Place cursor before the last paragraph return. 

6 Apply CAT Body Text style to this line. 

7 Insert a Next page section break. See Inserting a Section Break, on page 15-27. Your 
document should appear similar to Figure 15.14, below. 

Figure 15.14: Example of an Appendix Document Prepared for the Insertion of a Coding Structure 
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8 Copy the contents of the Coding Structure document, and paste them into the Appendix 
of this file. 

d of 

bleshooting Automatically Numbered Coding 

The
betwee les, and the Outline Numbered gallery, it seems easy to accidentally 
elim bering gets out of sequence. 
Don p umbering through the Style 
fun

Of r t check 
some c

Note: address your coding structure problems, see 
Ou e 5-49. 
To p cture 

. 
er, don’t highlight any text. 

Choose ,  from the menu. The Styles dialog box will appear. 

document. Make sure your cursor is still by the last paragraph return 

9 Delete the last paragraph return in the document. An extra paragraph return at the en
a document might force an unnecessary extra page. 

15.2.2.b ~ Trou
Structures 

 automatic numbering in a coding structure can be finicky. Due to complicated interactions 
n templates, sty

inate auto-numbers—they just seem to disappear—or the num
’t anic. Usually all that is necessary is to reapply Outline N

ction. 

cou se, before assuming that you need to reapply Outline Numbering, you should spo
oding structure entries to make sure the correct styles have been applied. 

If the following procedure is insufficient to 
tlin  Numbering Coding Structures, on page 1
Ap ly Outline Numbering in a Coding Stru
1 Place your cursor in the first paragraph formatted in the Coding Structure_Level 1 style

This is usually the general Planning level code. Rememb

2 Format Style

3 From the Styles dialog box, choose Modify. The Modify Style dialog box will appear. 
See Figure 15.15, on page 15-20. 

4 From the Modify Style dialog box, choose Format, and Numbering. The Bullets and 
Numbering dialog box will appear. 

5 From the Bullets and Numbering dialog box, choose the Outline Numbered tab. The 
Outline Numbered gallery will appear. See Figure 15.16, on page 15-20. 

6 Choose the frame from the gallery that most closely resembles the formatting of the 
coding structure. 

Note: You can create the coding structure from any of these frames, it just takes more 
work if you do not choose the frame most closely resembling the desired appearance of 
the coding structure. For documents based on the current CAT Project Template, the 
frame second from the left, on the bottom, should be the frame that applies to the coding 
structure. 

7 Select the Customize button. The Customize Outline Numbered List dialog box will 
appear. 

8 For each of the four coding structure Levels, check to see that all the settings, as defined 
in the following four figures, is correct. Start with Level 4 and work your way back to 
Level 1.See Figures 15.17 to 15.20, on pages 15-21 and 15-22. 
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9 After the settings for all levels have been set, select OK in the Customize Outline 
Numbered List and Bullets and Numbering dialog boxes. 
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Figure 15.15: Modify Style Dialog Box with Format Button Selected 
 
 

Figure 15.16: Bullets and Numbering Dialog Box 
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Figure 15.17: Customize Outline Numbered List for Level 1 
 

Figure 15.18: Customize Outline Numbered List for Level 2 
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Figure 15.19: Customize Outline Numbered List for Level 3 
 

Figure 15.20: Customize Outline Numbered List for Level 4 

 15-22 

 
 



Technical Guide April 4, 2005 

15.2.3 ~ Compiling CAT Documents 

15.2.3.a ~ CAT Document Structure 
CAT has two basic types of Content Analysis Reports it produces for clients: reports with 
complete narrative summaries, referred to as narrative summary reports, and briefer executive 
summary narratives, referred to as executive summary reports. The substantive portions of both 
of these reports includes the narrative, a public concerns list, and various appendices. Both 
reports also include cover pages and tables of contents. In addition, narrative summary reports 
usually include a introduction before the narrative summary. 

The following lists display the normal layouts of narrative summary reports and executive 
summary reports 
Narrative Summary Reports 
Cover Page(s) 

Table of Contents 

Introduction 

Narrative Summary 

Public Concerns List 

Appendices 

Executive Summary Reports 
Cover Page(s) 

Table of Contents 

Narrative Summary 

Public Concerns List 

Appendices 
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Usually, it is necessary to insert section breaks between each of these sections, so that headers 
and footers can be formatted correctly. (See Placing Section Breaks in CAT Documents, on page 
15-26 and Formatting Headers/Footers, on page 15-28.) 

15.2.3.b ~ Merging Documents 
Normally it is necessary to merge documents at the end of projects, since discrete sections of 
reports are usually created by different individuals in separate files. This section will provide 
only a general procedure and some helpful hints for merging documents. See the other sections 
referenced below for more detailed procedures for merging documents. 
To Merge Multiple Documents into One Document 
Note: In this procedure, the term “master document” will refer to the document into which other 
files will be merged manually. It should not be confused with Word’s Master Document feature, 
which is a very specific, sophisticated program tool. 

1 Create a blank “master” document based on your project template. 

2 Place section breaks as needed in the master document. (See 
, .)

Placing Section Breaks in 
CAT Documents on page 15-26  

3 Format headers,  

4 At chapter breaks, adjust headers and footers as necessary to accurately reflect 
chapter/section titles and/or page numbering. (See Section 

.)
15.2.5 ~ Formatting 

Headers/Footers  

5 Insert chapter headings and titles in appropriate locations. 

6 Select and copy the TEXT of the document to be merged. 
A convenient way to do this may be to choose Edit, Select All, which selects the entire 
body of the document to be copied. 

7 Place the cursor in the appropriate location in the master document. 

8 Choose Edit, Paste from the Menu toolbar. (Or key Ctrl+V) 

9 Delete the  

10 Repeat steps 5 and 6 until all portions of the master document have been assembled. 

11 Check header, footers, and page numbering. 

15.2.3.c ~ Formatting Chapter Headings 
Formatting Unnumbered Chapter (or Level 1) Headings 
When you do not need formal chapter numbers in a document, you should simply apply the CAT 
Heading 1-Unnumbered style to the first-level headings in your document. As with numbered 
chapter structures, the CAT Section Heading will be the style of second-level headings, with 
CAT Subsection Heading, and CAT Sub-subsection Heading styles for subsequent heading 
levels. 
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Formatting Numbered Chapter Headings 
To use formal, or numbered, chapter headings in a document, you cannot simply apply the 
Heading 1 style as is done with other section heading styles. The Heading 1 style is 32 pt, 
however, our styles guidelines stipulate that the chapter numbers will be 32 pt font and that the 
chapter title will be 24 pt. The style guidelines also indicate that the chapter title will appear on a 
separate line below the chapter number. These conditions require that you format the chapter title 
separate from the chapter number as described below. 

Note: If it is necessary to change the formatting of the chapter number in Heading 1 style, see 
Automatically Numbering Headings, on page 15-44. 

Note: It might appear that the easiest way to generate chapter numbers and titles would be to 
have a different style for both the numbers and titles. However, this creates problems with the 
automatic generation of the table of contents. So, we use one style for both the numbers and 
titles, and manually format the chapter title. 
To Create a Chapter Heading 

1 Click the Show All, if formatting marks are not displayed. 

2 Apply the Heading 1 style. 
The chapter number should appear automatically. 

3 Enter a paragraph return. Trust me, this is important! 
The style for this new line should be CAT Body Text

4 Click back to the first paragraph mark. 

5 Insert a manual line break, Shift+Enter. 
The style of the new line should still be Heading 1. 

6 Place the cursor just to the left of the paragraph mark on the line with the chapter number. 

7 Choose Format, Font, and check the Hidden box on the Font dialog box, and click OK. 

8 Enter a few characters of text. We suggest HT or Hidden Text. 

9 Place the cursor to the left of the paragraph mark on the second line. 

10 Enter the chapter title. 

11 Select the text, and only the text, of the chapter title. Do not select the paragraph mark at 
the end of the line! 

12 Apply 24 pt font formatting from either the menu or the toolbar. 

The chapter title should appear as below. The first example displays the chapter heading with the 
Show All option selected, while the second example displays how the heading will actually 
appear. 

Figure 15.21: Formatting of Numbered Chapter Headings 
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Note: If the chapter number decreases in size to match the chapter title, this means the font 
formatting of the paragraph mark at the end of the chapter title has been altered. Highlight just 
the paragraph mark and reapply the Heading 1 style. Be sure to choose Reapply the 
formatting of the style to the selection in the Modify style box, when you reapply the style. 

Note: If the manual line break at the end of the chapter number line happens to get formatted 
as hidden text, the chapter title will appear on the same line as the chapter number. To remedy 
this, highlight just the manual line break mark and remove the hidden text formatting. 

15.2.3.d ~ Formatting Appendix Headings 
Formatting appendix headings is nearly identical to formatting chapter headings. (See 
Formatting Chapter Headings, on page 15-24.) The only difference between formatting chapter 
and appendix headings is that you use the Heading 2 style for appendix headings instead of 
Heading 1. The Heading 2 style will appear as Appendix A Heading 2 in the styles dropdown 
list. 

15.2.4 ~ Placing Section Breaks in CAT Documents 
Note: In this discussion, section means a section delineated by section breaks in Word. We are 
not referring to “sections” of CAT documents—e.g., Section 6.2, above. Do not use a Word 
section break for CAT sections unless you really need to. 

Section breaks are important because they allow you to alter structural formatting, such as page 
orientation, margins, as well as headers and footers, within a document. For example, if you wish 
to have one part of your document formatted as one column and another portion as two columns, 
you must place section breaks where such transitions occur. 

15.2.4.a ~ Location of Section Breaks 
In CAT documents sections breaks are usually located where either headers and/or footers 
change within a document. These locations change depending on the type of report being 
generated. See (15.2.3 ~ Compiling CAT Documents.) 

Depending on the type of report being generated, section breaks usually occur between the: 
Cover pages and Table of Contents 
Table of Contents and Introduction 
Introduction and Narrative (This includes both Narrative Summaries and larger narratives that 
are broken into chapters.) 
Introduction pages and an Executive Summary, if there is an Executive Summary 
Executive Summary and Narrative, if there is an Executive Summary (This includes both 
Narrative Summaries and larger narratives that are broken into chapters.) 
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Individual Chapters in a narrative 
Narrative Summary and PC List 
Narrative and Appendices, where the PCs are incorporated into the narrative 
Between Appendices 

In CAT documents, section breaks are usually required between chapters and between 
appendices. The primary purpose of these section breaks is to allow you to place different 
information in the footers for each chapter. Currently we place the chapter numbers and titles, as 
well as page numbering in the footer. Alterations between chapters (and appendices) associated 
with both of these items necessitate section breaks. These are, however, almost the only places 
you need section breaks. 

Note: See Section 15.2.33, Compiling CAT Documents. 

Warning: DO NOT USE A SECTION BREAK UNLESS YOU REALLY NEED TO! 

15.2.4.b ~ Inserting a Section Break 
To Insert a Section Break 

1 Put your cursor at the appropriate location. This is usually at the beginning of a new 
section, such as the beginning of a new chapter, or before the table of contents page. 

2 Note: If you are creating section breaks for a blank master project document 

3 From the menu toolbar, select Insert, Break, and Next Page under Section Break. You 
now have two sections and a page break between them. The cursor will be located in the 
new section. 

4 Make sure there is a paragraph return mark preceding each section break, and that it is 
formatted in CAT Body Text style. You may need to Enter a paragraph return and/or 
apply the style. 

5 For all sections except the Cover Page section, add an additional paragraph return before 
the first paragraph return. Format this paragraph in the appropriate style, and enter the 
appropriate title for the section. 
E.g.: In the Table of Contents section, you would format the title line in CAT Table of 
Contents Heading style, and enter Table of Contents for the title. If you were 
formatting the  

6 Make sure the section break is in CAT Body Text style. Place the cursor to the RIGHT of 
the of the paragraph return preceding the section break and apply the style. 

Note: Word numbers sections. However, section numbers are visible only when the View 
Header and Footer function is activated. To do this, choose View, Header and Footer from the 
Menu or double-click on a header or footer. Section numbering appears above the left-hand 
sides of headers and footers. 

Note: When manipulating section breaks, it is wise to have the Show All option selected. (See 
Section 15.1.1.b, Show All Command.) This allows you to see exactly where your section break is 
located. 
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15.2.5 ~ Formatting Headers/Footers 
CAT documents usually contain two headers, one of which is blank, and multiple footers. 
Wherever either the header or footer changes within a document a section break is required. 
Therefore, header and/or footer formatting changes occur at same locations as section breaks. 
These locations are described in Location of Section Breaks on page 15-26. 

Note: Remember, section means a section delineated by section breaks in Word, NOT 
numbered “sections” of a Word document. 

15.2.5.a ~ Formatting Headers 
In CAT documents a change in headers usually occurs only between cover pages and table of 
contents pages. The header for the cover pages is blank, whereas the header for the remainder of 

To Modify a Header 

the document contains the project name and the date as shown in the example below. 

eader and Footer or double click in the header section. The body of the 

2 Table of Contents 

3 r mouse across the icons on the Header/Footer toolbar until you see the words 

above 

us DO NOT appear above the right side of the header, you 

4 

5 Edit the header as desired. 

Footer toolbar to return to the body of the document. 

Figure 15.22: Typical CAT Header 

1 Select View, H
document will fade and the header will be emphasized, and the Header/Footer toolbar 
will appear. (See figure below.) 

Place the cursor in the header of the second section, usually the 
section. 

Drag you
Same as Previous. If the header is set to Same as Previous, which it usually is by 
default, the icon will appear depressed and the words Same as Previous will appear 
the right edge of the header. 
If the words Same as Previo
can proceed to edit the header as you desire without changing the preceding header. 

Click the Same as Previous icon. 
Same as 

Previous Icon 

Figure 15.23: Same As Previous Icon on Header and Footer Toolbar 

6 Click Close on the Header/
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15.2.5.b ~ Formatting Footers 

In CAT documents, footers usually change at all the locations you have section breaks. (See 
Location of Section Breaks on page 15-26.) These locations include transitions between cover 
pages and the table of contents, between the table of contents and the introduction, between the 
introduction and first chapters or primary sections, between chapters or primary sections, 
between last chapters or primary sections and the first appendix, and between appendices. An 
example of a typical CAT footer is presented in the figure below. 

Note: A primary section is a section under a heading with the CAT Heading 1-Unnumbered 
style. For example, in a document without formal chapter numbers, the introduction, narrative 
summary, and public concerns list are primary sections. In other words, primary sections 
correspond to the first organizational level of a document in documents without formal chapter 
numbers. 

Figure 15.24 

To Modify a Footer 
1 Select View, Header and Footer or double click in the footer section. If you choose the 

menu option, Word will open with the cursor in the header, and you will need to scroll 
down and click in the footer. See figure below for an example of a typical footer. 

2 Place your cursor in the footer you wish to change. 

3 Drag your mouse across the icons on the Header/Footer toolbar until you see the words 
Same as Previous. If the footer is set to Same as Previous, which it usually is by 
default, the icon will appear depressed and the words Same as Previous will appear above 
the right edge of the footer. 
If the words Same as Previous DO NOT appear above the right side of the footer, you 
can proceed to edit the header as you desire without changing the preceding footer. 

4 Click the Same as Previous icon, if the Same as Previous icon appears depressed. 

5 Insert the section title on the left hand side of the footer. For documents with formal 

chapters, you will insert the chapter number and title. For documents without formal 
chapters you will insert only the title of the primary section. (The primary section is a 
section under a heading with the CAT Heading 1-Unnumbered style.) 

Same as 
Previous Icon 

Figure 15.25: Same As Previous Icon on Header and Footer Toolbar 

6 Insert the page number at the right hand side of the footer. See Inserting and Formatting 
Page Numbers on page 15-30. 
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7 Click Close on the Header/Footer toolbar to return to the body of the document. 

15.2.6 ~ Inserting and Formatting Page Numbers 
Page numbering in CAT documents is fairly standard, with the one exception being that 
extremely long reports may include chapter numbers in their pagination, whereas more normal 
length reports do not. Standard pagination and formatting are as follows: 

Pagination Sequence and Format by Sections 

Section Sequence of Page Numbers Format of Page Numbers 

Cover Pages No numbers No numbers 

Table of Contents and 
Introduction 

Begins at page i and continues 
sequentially through both sections. 

Small Roman numerals. 

Main body primary sections: 
E.g.: Narrative Summary, Public 
Concerns List 

Page numbering begins at one (1) 
and continues sequentially through 
all sections. 

Arabic numerals. 

Chapters (when formal chapter 
numbering is used) 

Page numbering begins at 1-1 for 
Chapter 1 and restarts at the 
beginning of each chapter. 

Arabic numerals. The page number 
includes the chapter and page 
number separated with a dash, 
beginning with the chapter number. 
E.g.: 2-34, 4-46. 

Appendices Page numbering begins at A-1 and 
restarts at the beginning of each 
appendix. 

Combination of capital alphabetic 
letters and Arabic numerals. The 
page number includes appendix 
letter and page number separated by 
a dash, beginning with the appendix 
letter. E.g.: A-28, B-6. 

Table 1: Pagination Sequence and Format by Sections 

15.2.6.a ~ Inserting Page Numbers 
In CAT documents, page numbers are found on the top line of the footer, at the right margin. The 
format of page numbers vary by project and section. In most reports, the format of page numbers 
changes at the same locations where section breaks occur (See 15.2.3 ~ Compiling CAT 
Documents), chiefly, where headers and footers change. 

Note: It is most likely that page numbers will already be inserted and formatted as part of any 
project template, so section 15.2.6.b will be used mostly to direct modification of page numbers, 
especially the modification of page number sequence. 
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To Insert a page number in the footer 
1 Activate the Show All command. (See Section , .)15.1.1.b Show All Command  

2 Select View, Header and Footer. 

3 Scroll down to the footer, and place your cursor in the appropriate location. For CAT 
documents this is just to the far right of the top line in the footer. (See Figure 15.20.) 
The CAT footer style is set up so that there is a right tab on the right hand margin of the 
footer. This means that after the you insert the appropriate title for the footer, “Chapter 1: 
Planning Process and Policy” in the above below, you need to enter a tab to place the 
cursor in the appropriate location to insert page numbers. 

Page number position 

Figure 15.26: Typical CAT Document Footer with Chapter Number Included 

4 Drag your cursor across the Header/Footer toolbar until you see the words Insert Page 
Number. (See Figure 15.19.) 

5 Click on the Insert Page Number icon. 

Insert Page Number

Figure 15.27: Insert Page Number Icon on Header and Footer Toolbar 

Including the Chapter/Appendix Number With the Page Number in Each Section: 

You can simply type the chapter number next to the page number, but this will prevent you from 
having the chapter number appear with the page number in the table of contents. For the table of 
contents to work properly, you must tell Word to put the chapter number in the footer 
automatically. The only way you can do this is to format the chapter. (See Section .)

15.2.6.b ~ Formatting Page Numbers 
To Format the Page Numbers in a Tables of Contents Section 

1 Make sure that section breaks have been properly formatted (See Formatting 
Headers/Footers on page 15-28.) and that page numbers have been inserted (See 
Inserting Page Numbers, above.). 

2 Double-click in a footer within the Table of Contents section. The footer will be 
emphasized and the Header and Footer toolbar will appear. 

3 Choose the Format Page Numbers icon on the Header and Footer toolbar. The Page 
Number Format dialog box will appear. 

Format Page Number 
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4 Choose the small Roman numerals from the Number format dropdown list. See figure 
below. 

Figure 15.29: Page Number Format Dialog Box for Table of Contents 

5 The Include chapter number box should NOT be checked. 

6 Click the Start at button so that it is selected. 

7 The Start at box should contain i; correct it if it does not. 

8 Proceed to formatting the Introduction page numbers. See To Format the Page Numbers 
in an Introduction Section below. 

To Format the Page Numbers in an Introduction Section 
1 Make sure that section breaks have been properly formatted (See Formatting 

Headers/Footers on page 15-28.) and that page numbers have been inserted (See 
Inserting Page Numbers, above.). 

2 Place the cursor in the footer in the Introduction section. If you are already in Header 
and Footer view, just scroll down to the Introduction and click in the footer. If not, 
double-click on the Introduction footer. The footer will be emphasized and the Header 
and Footer toolbar will appear. 

3 Choose the Format Page Numbers icon on the Header and Footer toolbar. The Page 
Number Format dialog box will appear. See Header and Footer figure below and Page 
Number Format figure above. 

Format Page Number 

Figure 15.30: Format Page Number Icon on Header and Footer Toolbar 
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4 Choose the small Roman numerals from the Number format dropdown list. 

Figure 15.31: Page Number Format Dialog Box for Introductions 

5 The Include chapter number box should NOT be checked. 

6 Click the Continue from previous section button so that it is selected. 

7 Save and proceed to formatting the next section, usually either a narrative summary 
(See To Format the Page Numbers in Primary Sections below.) or a formally numbered 
chapter (See To Format Page Numbers in Formally Numbered Chapters below.) 

To Format the Page Numbers in Primary Sections 
1 Make sure that section breaks have been properly formatted (See Formatting 

Headers/Footers on page 15-28.) and that page numbers have been inserted (See 
Inserting Page Numbers, above.). 

2 Place the cursor in the footer in the Narrative Summary section. If you are already in 
Header and Footer view, just scroll down to the Narrative Summary and click in the 
footer. If not, double-click on the Narrative Summary footer. The footer will be 
emphasized and the Header and Footer toolbar will appear. 

3 Choose the Format Page Numbers icon on the Header and Footer toolbar. The Page 
Number Format dialog box will appear. See the Header and Footer figure and the Page 
Number Format figure below. 

Format Page Number 

Figure 15.32: Format Page Number Icon on Header and Footer Toolbar 
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4 Choose the standard Arabic numerals from the Number format dropdown list. 

Figure 15.33: Page Number Format Dialog Box for Leading Primary Section Formatting 

5 The Include chapter number

6 Click the Start at 1 in the Start at box. 

7 Move to the footer in the , and click 
Format Page Number Page Number 
Format

8 Check to ma rals and that the Include 
chapter number

 box should NOT be checked. 

 button so that it is selected, and type or select 

next section, usually the Public Concerns list
 icon (See Header and Footer figure above). The 

 dialog box will open. See  , below. 

ke sure the Number format is still in Arabic nume
 is still NOT checked. 
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9 Click the Continue from previous section button so that it is selected. See  

Repeat 10 

 
To For

1 ave been properly formatted (See Formatting 
d (See 

Inserting Page Numbers, above.). 

2 Place the cursor in the footer of Chapter 1. If you are already in Header and Footer 
view, just lick on Chapter 
1 footer. The footer will be emphasized and the  toolbar will appear. 

Page 
Number Format  and Footer figure and the Page 
Number Form

4 Choose the standard  dropdown list. 

x so that it is checked. 

7  box, and choose - (hyphen). 

8 Click the Start at button so that it is selected, and type or select 1 in the Start at box. 

9 Proceed to the next chapter and repeat Steps 3 - 8. 

Figure 15.34: Page Number Format Dialog Box for Non-leading Primary Sections 

Figure 15.35: Format Page Number Icon on the Header and Footer Toolbar 

Figure 15.36: Page Number Format Dialog Box for Numbered Chapters 

rmat Dialog Box for Numbered Chapters 

Steps 7 - 11 until all the primary sections’ page numbers are formatted. 

11 Proceed to formatting appendices. 
mat Page Numbers in Formally Numbered Chapters 
Make sure that section breaks h
Headers/Footers on page 15-28.) and that page numbers have been inserte

 scroll down to Chapter 1 and click in the footer. If not, double-c
Header and Footer

3 Choose the Format Page Numbers icon on the Header and Footer toolbar. The 
 dialog box will appear. See the Header

at figure below. 

Arabic numerals from the Number format

Format Page Number 

Figure 15.37: Page Number Fo

5 Click the Include chapter number bo

6 Click arrow by the Chapter starts with style box, and choose Heading 1. 

Click arrow by the Use separator
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10 Proceed to formatting appendices. 
mat Page Numbers in Appendices 

 
To For

2  

f

3 Choose t lbar. The Page 
Number Fo re and the Page 

4 Choose the standard  dropdown list. 

ecked. 

ng 2. 

. 

Figure 15.38: Format Page Number Icon on the Header and Footer Toolbar 

1 Make sure that section breaks have been properly formatted (See Formatting 
Headers/Footers on page 15-28.) and that page numbers have been inserted (See 
Inserting Page Numbers, above.). 

Place the cursor in the footer for Appendix A. If you are already in Header and Footer
view, just scroll down to Appendix A. If not, double-click on the Appendix A footer. The 
ooter will be emphasized and the Header and Footer toolbar will appear. 

he Format Page Numbers icon on the Header and Footer too
rmat dialog box will appear. See the Header and Footer figu

Number Format figure below. 
Format Page Number 

Arabic numerals from the Number format

Figure 15.39: Page Number Format Dialog Box for Appendices 

5 Click the Include chapter number box so that it is ch

6 Click arrow by the Chapter starts with style box, and choose Headi

7 Click arrow by the Use separator box, and choose - (hyphen). 

8 Click the Start at button so that it is selected, and type or select 1 in the Start at box. 

9 Proceed to the next appendix and repeat Steps 3 - 8
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15.2.7 ~ Creating Automated Tables of Contents 
Generating a table of contents automatically can save you hours compared to creating it 

ent 

 

. (Creating a Table of Contents Within a Single Document, 

ng a Table of Contents Within a Single Document 

1 Activate the Show All command, by clicking on the Show All icon on the Standard 
Toolbar. See Show All Command, on page 15-2. 

2 Insert your cursor at the location where you want the table of contents. (This line should 
be formatted in the CAT Body Text style.) 

3 Choose Insert, Indexes and Tables. The Index and Tables dialog box will appear 

manually. This is particularly important since the table of contents is the last part of a docum
created, often just before a project report is due. 

You can create tables of contents from several kinds of format markings, but as CAT uses styles 
to format headings, this section provides only instructions on how to create them based on styles.
Creating a table of contents based on styles means that Word searches a document (or 
documents!) for text in styles that have been identified by the user. Word then sequentially 
arranges the retrieved text in a table of contents. 

Generating tables of contents for CAT documents requires the use of one of two methods: 
creating a table of contents from within a single document or creating a table of contents from 
multiple documents. Most often, you can group all the sections of report into one document and 
generate the table of contents within that document. In these cases, you can use the first method 
for generating the table of contents
below.) With longer reports, however, you may need to maintain sections of the document in 
separate files, for ease of editing, printing, and emailing. In these cases, you will have to generate 
the table of contents from multiple files. (See Creating Tables of Contents From Multiple 
Documents, on page 15-41.) The following sections describe how to use both of these methods. 

15.2.7.a ~ Creati
To Create a Tables of Contents 
The following procedure assumes that you have configured your document such that the table of 
contents is being inserted on a blank page that is a separate section from the other sections of 
the document. (See Compiling CAT Documents, on page 15-23 and Placing Section Breaks in 
CAT Documents, on page 15-26.) The top of your table of contents page should look similar to 
Figure 15.40, below. 

Figure 15.40: Typical Table of Contents Page, before Inserting Table of Contents 
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4 Choose the Table of Contents tab. The Table of Contents tab will appear. (See Figure 
15.41.) 

Figure 15.41: Table of Contents Tab on the Index and Tables Dialog Box 

5 The following options should be defined as in Figure 15.41: 
• Show page numbers 
• Right align page numbers 
• Tab leader 
• Formats 
• Show levels 
The only one of these options you will probably have to change is Show levels. 
Apparently the default setting is 3. 
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6 Choose Options. The Table of Contents Options Dialog Box will appear. 

Figure 155.42: Table of Contents Options Dialog Box 

7 Make sure the appropriate TOC Level is assigned to the correct style or styles and choose 
OK. 
The following list defines the TOC level that should be assigned to each style. The only 
style for which the TOC level should need to be changed is the Heading 2 style. 

 
Style 

TOC 
Level 

CAT Heading 1-Unnumbered 1 

Heading 1 1 

Heading 2 1 

CAT Section Heading 2 

CAT Subsection Heading 3 

CAT Sub-subsection Heading 4 

CAT Grammatical/Editorial 5 

CAT Public Concern 6 

CAT Subconcern 7 
 

Note: By default, Word assigns the TOC Level corresponding to a style’s Outline 
Level. (See Understanding Styles, on page 15-6.) These outline levels were assigned to 
reflect our four level heading structure, so almost all of the styles will be assigned their 
appropriate TOC Level by default. However, Word does not allow us to redefine the 
Outline Level for certain built-in styles, and some of these styles must be used to employ 
features such as including chapter/appendix numbers in page numbering. This limitation 
on assigning Outline Levels is the reason you must manually assign the TOC level for 
Heading 2. 
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8 Click OK in the Index and Tables dialog box. Word will automatically generate a 
hyperlinked table of contents. 

15.2.7.b ~ Eliminating Unwanted Formatting in Tables of Contents 
Unfortunately, Word’s automatic table of contents feature does not handle styles that have been 
formatted very well, and this is the case with our numbered chapter heading and appendix 
heading styles. Therefore, you must eliminate this manual formatting in tables of contents after 
they are generated. 
To Eliminate Unwanted Formatting in a Table of Contents 

1 Place the mouse pointer to the left of the first line of the table of contents. 

2 Click and drag the pointer into the table of contents. This should select the entire table of 
contents. 

3 Key Ctrl+Spacebar. This should eliminate the unwanted formatting. 

15.2.7.c ~ Eliminating Hyperlinks in Tables of Contents 
When you insert a table of contents, Word automatically hyperlinks all the entries in the table. In 
CAT documents, we usually eliminate these hyperlinks. 
To Eliminate Hyperlinks in a Tables of Contents 

1 Activate the Show All command by clicking on the Show All icon on the Standard 
Toolbar. See Show All Command, on page 15-2. 

2 Place the mouse pointer to the left of the table of contents. 

3 Click and drag the pointer into the table of contents. This should select the entire table of 
contents. 

4 Right-click or key Shift+F10, and choose Toggle Field Codes. The field codes for the 
table of contents will be revealed. They will probably look similar to the following: 

 
5 Delete the \h and the following space. 

6 Place the cursor somewhere in the field code, and key F9. The Update Table of 
Contents dialog box will appear. 

7 Select Update entire table and click OK. 

8 Eliminate any unnecessary formatting. See Eliminating Unwanted Formatting in Tables 
of Contents, above. 

15.2.7.d ~ Updating Tables of Contents 
If you change something within a document after the table of contents has been generated, you 
will need to update the table of contents. 
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To Update a Table of Contents 
1 Place the mouse pointer to the left of the first line of the table of contents. 

2 Click and drag the pointer into the table of contents. This should select the entire table of 
contents. 

3 Key F9. The Update Table of Contents dialog box will appear. 

le documents, all the 

4 e table, and click OK. 

ating Unwanted Formatting in Tables of 

15.2.7.e ~ Creating Tables of Contents From Multiple Documents 
ord 

ents become so big that it is unwieldy to work with them in a single file. 

d or 

ultiple documents basically is the same as creating 
 

emite National Park projects. We will 
assume that we wish to create a table of contents in a separate document for three chapters that 
are contained in individual files. 

Figure 154.43: Update Table of Contents Dialog Box 

Note: If you are updating a table of contents created from multip
referenced documents must be closed. See Creating Tables of Contents From Multiple 
Documents, below. 

Select Update entir

5 Eliminate unwanted formatting. See Elimin
Contents, above. 

Note: For more detail on tables of contents created from multiple documents, see Using W
2000, pages 663-664. 

Sometimes CAT docum
In these cases, the document is usually divided into multiple files. Such a divided document  
usually will be composed of a set of files similar to the following: an introductory file that 
includes the cover pages, table of contents, and introduction; individual chapter files; and 
individual appendix files, though these may be combined into one file. In addition to this 
structure, occasionally other combinations of document sections are used. Sometimes, for 
example, the file containing the cover pages, etcetera, is combined with the first chapter, an
the appendices are combined in one file. 

Creating a table of contents (TOC) from m
one within a single document, except that you must tell Word’s TOC feature where to look for
the other files that make up your document. This is done by inserting Referenced Document 
(RD) fields in the file where the TOC is being created. 

As an example we will use a report from one of the Yos
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To Create a Table of Contents from Multiple Documents 
1 Open the file in which the TOC is to be located. As noted above, this is usually a file tha

contains the cover pages a
t 

nd introduction, in addition to the TOC. This procedure 
opriate section breaks and 

2 rd 

3  enter a paragraph return (Key Enter). 

atting. 
 inadvertently 

7 From the 

assumes that this file has been formatted with the appr
headings. See CAT Document Structure,  and 

, 
on page 15-23 Placing Section Breaks in 

CAT Documents on page 15-26. 

Activate the Show All command, by clicking on the Show All icon on the Standa
Toolbar. See Show All Command, on page 15-2. 

Go to the end of the document and

4 Format the last paragraph with CAT Body Text style. 

5 Select the last paragraph marker with your cursor and apply Hidden Text form
Choose Format, Font, and Hidden Text. This prevents the RD fields from
creating an unneeded page break. 

6 With the cursor placed at the end of the document which will contain the TOC, select 
Insert, Field. The Field dialog box will open. 

Categories list, select All. 

Figure 15.44: Field Dialog Box 
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8  OK. A set of RD field brackets will 

9 Place the cursor between the space and the last bracket, and enter the complete 
Pathname of the first file from which you want to retrieve table of contents information. 
Use double backslashes to separate directories in the pathname. See figure Figure 

he first chapter file, however, sometimes contains all these sections, 
INCLUDING, the table of contents. If the first chapter is to be located in the table of 

rmation 
es 

eld. 

11 Continue entering RD fields for all the files that make up the document, in the order in 

nd if any are not apply hidden text: choose Format, Font, 
and Hidden Text.  This prevents the RD fields from inadvertently creating an unneeded 

13 
to a single document. See Creating a Table of Contents Within a Single 

Document, above. 

15.2.7
Note: For more information, see also Using Word 2000, pages 679-680. 

f contents. 
f text. For example, if 

one Subsection Heading does not appear in the table of contents, but others do appear, the one 
subsection heading probably does not have CAT Subsection Heading style applied to it. 

Figure 15.45: Example of Referenced Document Fields for Creating a TOC from Multiple Documents 

From the Field names list, select RD, and click
appear. It will look like this: 

 

15.45, below. 

Note: In our example, the TOC is in a document with the cover pages and the 
introduction. T

contents, do not include it in the list of RD fields. If you do, table of contents info
for chapter one will appear twice: once because the table of contents feature retriev
information from within the file in which it is located, then again because of the RD fi

10 Go to end of the line (outside the last bracket), and key Enter. 

which they should appear. 

12 Check to make sure that the paragraph return marks at the end of each RD field line is 
formatted in Hidden Text, a

page break. You should not have to do this if the preceding procedure was followed 
precisely. 

After the RD fields have been inserted, follow the procedures for inserting a table of 
contents in

.f ~ Troubleshooting Tables of Contents 

Problem: Some of the entries are missing from your table o
It’s likely that styles have not been applied correctly to the original piece o
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Someone may have simply applied manual formatting to the text to make it look like the other 

00, pages 679-680. 

mbering Headings 
T 

ments were numbered, but this is rarely 
 a project in which the 

 
apters, sections, subsections, and sub-subsections, and each of these 

s, you 

the 

ther 
ly Outline Numbering to all four CAT heading level styles. 

 and created the third section in that chapter, 
d be preceded automatically by Section 3.3. 

Formatting Page Numbers to Include Chapter and Appendix Numbers 

subconcerns (bad, bad analyst!). 
Problem: When creating a table of contents from multiple documents, you get an error 
that says “bookmark not defined.”  
Make sure you have saved and exited the files from which you are building your table of 
contents. See also Using Word 20

15.2.8 ~ Automatically Nu
This section details how to use Outline Numbering to automatically number headings CA
documents. At one time, the headings in all CAT docu
the case now. You should number headings only if you are working on
report is extremely large. 

Word’s Outline Numbering feature enables you to automatically number some or all the 
heading levels in a document. There are several ways to apply Outline Numbering, but linking 
Outline Numbering to styles is the easiest way. In CAT documents, for example, we normally
use four heading levels: ch
heading levels is associated with a particular style. To automatically number these heading
have to link the styles you want to be numbered to a particular Outline Numbering scheme. 
These schemes are simply hierarchical formatting structures. Word has numerous default 
schemes, but the Outline Numbering feature allows you to customize the appearance and 
hierarchy of any of these schemes. 

In CAT documents, we have used two different Outline Numbering schemes for headings. In 
first scheme, we apply Outline Numbering to only the chapter style. In this case, usually a 
numbered title leader, such as Chapter 1, automatically precedes the chapter title. In the o
Outline Numbering scheme, we app
The normal scheme for this Outline Numbering is as follows: 

So, if you were working in Chapter 3 of a document,
the title for that section woul

In addition to automatically numbering headings, Word’s Outline Numbering enables you to 
format page numbers to include chapter and appendix numbers. In other words, page 6 of 
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Chapter 2 will appear as 2-6. This page number formatting in turn enables the table of contents 

usually 
neral Planning level code. Remember, don’t highlight any text. 

log box will appear. 

Bullets and 

5  dialog box, choose the Outline Numbered tab. The 

6 at most closely resembles the formatting of the 

st takes more 
of 

re. For documents based on the current CAT Project Template, the 
 

7 

8  the four coding structure Levels, check to see that all the settings, as defined 

ee Figures 15.17 to 15.20, on pages 15-21 and 15-22. 

feature to automatically include the chapter or appendix number in the table of contents 
numbering. 
To Apply Outline Numbering to Chapter Headings Only 

1 Place your cursor in the first paragraph formatted in the Heading 1 style. This is 
the ge

2 Choose Format, Style from the menu. The Styles dia

3 From the Styles dialog box, choose Modify. The Modify Style dialog box will appear. 
See Figure 15.15, on page 15-20. 

4 From the Modify Style dialog box, choose Format, and Numbering. The 
Numbering dialog box will appear. 

From the Bullets and Numbering
Outline Numbered gallery will appear. See Figure 15.16, on page 15-20. 

Choose the frame from the gallery th
coding structure. 

Note: You can create the coding structure from any of these frames, it ju
work if you do not choose the frame most closely resembling the desired appearance 
the coding structu
frame second from the left, on the bottom, should be the frame that applies to the coding
structure. 

Select the Customize button. The Customize Outline Numbered List dialog box will 
appear. 

For each of
in the following four figures, is correct. Start with Level 4 and work your way back to 
Level 1.S

9 After the settings for all levels have been set, select OK in the Customize Outline 
Numbered List and Bullets and Numbering dialog boxes. 
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Figure 15.46: Modify Style Dialog Box with Format Button Selected 
 

15.2.8.a ~ Applying and Formatting Outline Numbering for All Heading 
Levels 
This procedure describes how to apply Outline Numbering to as many heading levels as you 
wish, so Word will automatically number not only the chapter headings, but also the section, 
subsection, and sub-subsection headings. In all likelihood, you will never have to use this 
complete procedure for a CAT project, since outline numbering will be already one of the 
features of any project template. Even if you create a new template for a project, you probably 
will be basing it on an existing template and modifying it. The primary use of this section, then, 
is to give you the understanding to modify the Auto Numbering features to suit your needs. 

As with the preceding process, this procedure applies to both chapter and appendix formatting. 
The only difference is that you may not need to specify all four levels of numbering for 
appendices. For any item that addresses Chapter features, simply substitute Appendix. 

It is important to remember that the Outline Numbering levels, in this procedure, should 
correspond to the Outline Levels assigned to each heading style. These Outline Levels are as 
follows: 

First and highest level: Heading 1 (your chapter/appendix heading) 
Second level: Section Heading 
Third level: Subsection Heading 
Fourth level: Sub-subsection heading 
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Applying and Formatting Outline Numbering for All Heading Levels 
1 Click in the text for your chapter title (at the top of your first page where you want your 

title to appear, NOT in your header or footer), and apply the style Heading 1, or just 
apply Heading 1 if you are in a new document. Make sure you have only typed the 
chapter title, not the chapter number. Word will insert the chapter number for you once 
you complete this process. 

Warning: To those modifying templates: Do not 
use a style you created for your chapter heading 
style. You must use Word’s Heading 1 style for 
the automatic page numbering to work.  The 
Heading 1 style can be formatted in any manner 
in which a style can normally be formatted, so 
you can make it look any way you wish. It should 
also be noted that after applying Outline 
Numbering, the Heading 1 style should appear as 
Chapter X ~ Heading 1 in the style box list, 
where X is the chapter number you assign. 

2 From the Format menu on the main 
toolbar, select Bullets and Numbering. A 
dialog box will appear. (See Figure 1

Select th

5.16.) 

3 e Outline Numbered tab. 

(See 

5 stomize button. Another 
) 

6 
he More button, so you can see all 

You wi
for each of the four Outline Number levels: those 

 be sure that you are on 1 in the Level box. 

r and space~space after the number. 

ng this procedure you are most likely creating a 

Figure 15.16 

Figure 15.17 

4 Select the icon that has hierarchical 
numbering with each level adding a 
decimal point and an additional digit. 
Figure 15.16.) 

Click on the Cu
dialog box will appear. (See Figure 15.17.

From the dialogue box that appears, 
choose t
the control features. 

ll repeat a process similar to what follows 

levels you want numbered automatically. (See 
Figure 15.18.) 

7 Check to

8 Go to the Number Format box. 
Insert Chapter before the numbe
For Number Style, select 1, 2, 3. 
For Start At, use 1. (If you are usi

template, so using 1 will be fine.)
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9 Make sure Number Position is Left, that the number is Aligned at zero. 

10 Under Text Position, insert zero in the Indent at box. (This may change with project 
formatting.) 

11 Click the down arrow beside the Link level to style box, and choose Heading 1. This is 
the style with Outline Level = 1. 

12 Click the down arrow beside the Follow number with box, and choose Nothing. Since 
you already have a space in the Number format no space is necessary. 

13 Choose 2 under Level and restart this procedure. The only differences between levels is 
as follows: 
Level 2 should have Section and a space inserted ahead of the number in the Number 

format box. 
For levels 3 and 4, no text is inserted before the number. 
For the Link level to style box, each level should correspond to the appropriate style. 
For levels 2, 3, and 4, the Restart numbering after figure should be the preceding level. 

For example, level 3 should have 2 in this box. This should be the default. 
Problems with Outline Numbering 
If Outline Numbering is causing problems that cannot be resolved, you can remove this feature 
from each style. To do this: 

1 Place your cursor in a chapter heading line 

2 Select Format, Bullets and Numbering. 

3 Choose Outline Numbered tab. 

4 Select None, and click OK. 

5 Open the Style box and choose Heading 1. 

6 When the dialog box appears, make sure Update the style to reflect recent changes is 
checked, and click OK. 

7 Repeat this procedure for each heading 
level to which Outline Numbering has 
been applied. 

Figure 7.18 

Note: See also Using Word 2000, pages 607-616. 
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15.2.9 ~ Advanced Automatic Numbering of Coding 
Structures and Headings 

CAT employs Word’s Outline Numbering feature for two purposes. First, it is used to 
automatically number coding structures, and second, it is used to automatically number chapter 
and/or section headings in long documents. Earlier sections (See cross reference) detail how to 
utilize Outline Numbering in these two situations. This section is presented in the case that the 
Outline Numbering in a document becomes so corrupted that you are forced to start from scratch. 
The procedures that follow are written as if no outline numbering had ever been applied to the 
coding structure styles. This should never be the case. However, the procedures that follow 
should give the user the full explanation of how Outline Numbering schemes are developed and 
help them solve the most difficult Outline Numbering problem in CAT documents. 

15.2.9.a ~ Outline Numbering Coding Structures 
To Create an Outline Numbered Coding Structure from Scatch 
This procedure is broken into five sections: one section describing the steps getting to the 
Customize Outline Numbered List, and one for each of the four coding structure levels you 
must define. 
To Get to the Customize Outline Numbered List Dialog Box 

1 Place the cursor in a line with the Coding Structure_Level 1 style. 

2 Choose Format, Style from the menu. The Styles dialog box should appear, and the 
Coding Structure_Level 1 style should be selected. 

3 From the Styles dialog box, choose Modify. The Modify Style dialog box should appear. 

4 Choose Format, Numbering from the Modify Style dialog box. The Bullets and 
Numbering dialog box will appear. 

5 From the Bullets and Numbering dialog box, choose the desired frame. It can be any 
except the None frame. As mentioned in section Troubleshooting Automatically 
Numbered Coding Structures, on page 15-18, it is easiest to choose the frame that most 
resembles your desired coding structure formatting. For this example, however, we will 
intentionally use an Outline Numbering scheme that is initially unlike the desired result, 
to show more completely how the Outline Numbering feature works.  

6 It should be noted that, if you are working on a document based on a CAT Project 
Template, the frames in the Bullets and Numbering dialog box will not appear like 
those in the example below. If you wish to practice Outline Numbering with the same 
schemes in the Bullets and Numbering dialog box, you will have to Reset some of the 
frames. You can do this by following this procedure until the Bullets and Numbering 
dialog box is open. Then, select the frame you wish to reset, click on the Reset button, 
and click Yes in the message box that appears. It should appear as in Figure 15.47, on 
page 15-50. 

7 Click the Customize button. The Customize Outline Numbered List dialog box will 
appear, with Level 1 selected. 
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8 Click the More button on the Customize Outline Numbered List dialog box. 

9 You are now ready to define the Outline Numbering for Level 1. 

Figure 15.47: Bullets and Numbering Dialog Box 
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To Define Level 1 Outline Numbering 
1 In the Customize Outline Numbered List dialog box, make sure 1 is selected in the 

Level box. See Figure 15.48, on page 15-52, for the appearance of the Customize 
Outline Number dialog box. 

2 Delete Chapter and the space preceding the number in the Number format box. The 
remaining grayed number is a field linked to Level 1. 

3 Add three zeros and two spaces to the right of the number in the Number format box. 

4 Change the remaining settings to match those in Figure 15.49, on page 15-53. 

5 Proceed to defining Level 2 Outline Numbering 
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Figure 15.48: Customize Outline Numbered List Dialog Box Before Changing Level 1 Formatting 
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Figure 15.49: Customize Outline Numbered List Dialog Box After Changing Level 1 Formatting 
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To Define Level 2 Outline Numbering 
1 Click on 2 in Level box. See Figure 15.50, on page 15-55, for the appearance of the 

Customize Outline Number dialog box. 

2 Place cursor in the Number format box. 

3 From the Previous level number box, choose Level 1. If you set everything correctly 
for Level 1, a 10 should appear in the Number format box. Also, the cursor should be on 
the right side of the 10. 

4 From the Number style box, choose the 1,2,3 . . . option. A grayed 1 should appear after 
the 10 in the Number format box, and the cursor should be to the right of this field. 

5 To the right of all the fields in the Number format box, insert two zeros and two 
spaces. 

6 Change the remaining settings to match those in Figure 15.51, on page 15-56. 

Important!  When choosing the Link level to style, scroll down the dropdown menu list using 
your mouse. DO NOT scroll down using arrow keys. If you are formatting Level 2 or lower, and 
you scroll down using arrow keys, you will scroll through styles that have been previously linked 
to an Outline Numbered  level. If this happens, Word breaks the link to the previously assigned 
style, even if you don’t select that style. Thanks a lot, Bill Gates. 
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Figure 15.50: Customize Outline Numbered List Dialog Box Before Changing Level 2 Formatting 
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Figure 15.51: Customize Outline Numbered List Dialog Box After Changing Level 2 Formatting 

To Define Level 3 Outline Numbering 
1 Click on 3 in Level box. See Figure 15.52, on page 15-57, for the appearance of the 

Customize Outline Number dialog box. 

2 Place cursor in the Number format box. 

3 From the Previous level number box, choose Level 1. If you set everything correctly 
for Level 1, a 10 should appear in the Number format box. Also, the cursor should be on 
the right side of the 10. 

4 From the Previous level number box, choose Level 2. A 1 should appear in the Number 
format box to the right of the 10. Also, the cursor should be on the right side of the fields. 

5 From the Number style box, choose the 1,2,3 . . . option. A grayed 1 should appear after 
the 101 in the Number format box, and the cursor should be to the right of these fields. 

6 To the right of all the fields in the Number format box, insert one zero and two spaces. 

7 Change the remaining settings to match those in Figure 15.53, on page 15-58. 
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Figure 15.52: Customize Outline Numbered List Dialog Box Before Changing Level 3 Formatting 
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Figure 15.53: Customize Outline Numbered List Dialog Box After Changing Level 3 Formatting 

To Define Level 4 Outline Numbering 
1 Click on 4 in Level box. See Figure 15.54, on page 15-59, for the appearance of the 

Customize Outline Number dialog box. 

2 Place cursor in the Number format box. 

3 From the Previous level number box, choose Level 1. If you set everything correctly 
for Level 1, a 10 should appear in the Number format box. Also, the cursor should be on 
the right side of the 10. 

4 From the Previous level number box, choose Level 2. A 1 should appear in the Number 
format box to the right of the 10. Also, the cursor should be on the right side of the fields. 

5 From the Previous level number box, choose Level 3. A 1 should appear in the Number 
format box to the right of the 101, and the cursor should end up on the right side of the 
fields. 

6 From the Number style box, choose the 1,2,3 . . . option. A grayed 1 should appear after 
the 1011 in the Number format box, and the cursor should be to the right of this field. 

 15-58 

 
 



Technical Guide  

7 To the right of all the fields in the Number format box, insert two spaces. 

8 Change the remaining settings to match those in Figure 15.55, on page 15-60. 

 

Figure 15.54: Customize Outline Numbered List Dialog Box Before Changing Level 4 Formatting 
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Figure 15.55: Customize Outline Numbered List Dialog Box After Changing Level 4 Formatting 
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15.2.9.b ~ Outline Numbering Headings 

15.2.10 ~ Setting Up the Overall Document Structure 
Word separates many formatting features that apply to the structure of the entire document or 
sections of a document, such as margins, directional layout, and header/footer formatting, from 
other formatting which applies to more discrete blocks of text. These features are located under 
File, Page Setup on the Menu toolbar. On a CAT project, the Page Setup options will normally 
be predetermined in the  project template. However, if it is necessary to do any of the following 
actions, it is necessary to modify the Page 
Setup options: 

• Change margins 
• Change header and footer sizes 
• Create mirror margins 
• Create a different header or 

footer for the first page of a 
section or document 

• Change section or document 
orientation between portrait 
and landscape 

• Change a section break 
between Continuous and New 
page 

Other formatting options may be controlled from the Page Setup window, these however require 
a level of expertise in Word beyond the scope of this guide. 

15.2.11 ~ Advanced Find/Replace Operations 
Word features many options for directing searches in Find/Replace operations. These advanced 
search features are based primarily upon how text is formatted. To access the more advanced 
features of this function, click the More button in the Find/Replace dialog box. The dialog box 
will expand to reveal additional features like the one shown below. 

As an example, Figure 15.26 shows the settings for a common CAT use of the find/replace 
features. When documents are converted from Access to Word, the resulting document does not 
have the appropriate styles applied, so we use this function to apply one of the appropriate styles. 
In this case, the Find what box is set up to find what should be a totally unique string of 
characters. To make it even more specific, we selected the Match case option which directs the 
computer to find only cases that are capitalized as this one is. We have entered identical text in 
the Replace with box, and we have directed the computer to apply the Public Concern style. 
This is accomplished by selecting the Format button, then Styles, and finally the appropriate 
style. 

15.2.11.a ~ Find and Replace Strategies 
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The basic strategy employed in 
find/replace operations is to make your 
search as specific as possible. You can do 
this by using very unique strings in your 
search. In the above example, the “Public 
Concern:” string is very unique in our 
documents. The use of the Match Case 
option makes the search even more 
exclusive. Narrowing searches in this way 
gives you more confidence that your 
search item is truly unique. The more 
singular your search item, the fewer times 
Word will select erroneous strings, thus 
speeding your editing time. 

Another strategy that can be employed in 
Find/Replace operations is to substitute 
one character, say character B, for another character, character A, temporarily. This can be used 
in situations where character A is desired in some locations, but not in others. If the characters 
surrounding Character A in the desired location are sufficiently unique, you can use Find and 
Replace to substitute Character B for Character A, in these desired locations. At this point, you 
only have Character As remaining in undesired locations. Using another Find/Replace operation, 
you can eliminate the unwanted Character As. Now you can simply replace Character B with 
Character A, and you have Character As back where you want them. This strategy is crucial to 
our conversion of Access generated Word reports into acceptably formatted documents. 

Figure 7.26 

15.2.11.b ~ Find/Replace Special Options 
As indicated above, Word provides a great many options for refining searches. Two very useful 
categories of features for narrowing searches are formatting options and Special characters. 
These features are accessed through the Format and Special buttons, located on the expanded 
Find/Replace dialog box. 
Formatting Options 
The options provided under the Format button correspond roughly to the formatting options 
available to you under Format on the menu toolbar. Some of these Format search features 
include Font, Paragraph, Tabs, and Styles. This means you can search for occurrences of a 
specific style, which can be extremely useful. For example, CAT project documents normally 
should not contain any occurrences of the Normal style. Using just the Find function of a 
Find/Replace operation, you can find any such erroneous occurrences (See Figure 15.27) and 
correct them. The Styles feature, in particular, is used extensively in Access to Word 
conversions and in editing checks of CAT documents.
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1 
3

2 

Figure 7.27 

Special Character Options 
The following are some of the frequently used characters available through the Special button 
on the Find/Replace dialog box. The “keystrokes” provided allow you to enter the characters 
directly without having to go through the Special button: 

• Paragraph Mark 
Finds code generated at the end of 
paragraphs when you hit Enter. 
Key strokes: ^p 

• Manual Line Break 
Finds code generated at the end of lines 
when you hit Shift+Enter. 
Key strokes: ^l 

• Manual Page Break 
Finds code that forces a page break, 
which is generated though Insert, 
Break, Page break. 
Key strokes: ^m 

• Tab Character 
Finds tabs. 
Key strokes: ^t 

• Any Character 
Finds any number or letter. 
Key strokes: ^? 

• Any Letter 
Finds any letter. 
Key strokes: ^$ 

• Any Digit 
Finds any numerical digit. 
Key strokes: ^$ 
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Search Options 
The Search Options, located in the lower left of the dialog box, provide additional features for 
refining searches. At this point in time, the only one of these frequently employed in CAT 
processes is the Match case option. 

Note: You cannot enter the special characters described above in Find/Replace boxes by simply 
striking the keys you would normally use to insert them when entering text; you must either use 
the Special button, or the keystrokes indicated. 

15.2.11.c ~ Find/Replace Procedure 
1 Enter Ctrl+Home; this places the cursor at the very beginning of your document. This is 

very important to ensure that you search the entire document. 

2 Select Edit, Replace from the upper toolbar. (Keystroke: Ctrl+H) 

3 Enter text and/or special characters to be searched in the Find what box, if any. (You 
may just be searching for a style replacement.) 

4 Apply any formatting or Special Options to the “find” string. 

5 Enter text and/or special characters on which search in the Replace with box, if any. 

6 Choose your replacement option. 
Option 1: Replace All

If you are absolutely certain that you have selected a totally unique string for your 
document, and you want to replace all occurrences of that string, click the Replace All 
button. 

Option 2: Find Next/Replace
If you are not absolutely confident that you have defined a completely unique string, it is 
better to find and replace occurrences of the string one by one. This is accomplished by 
selecting the Find Next button. If this highlights a string you want to replace, select the 
Replace (not the Replace All) button. 

15.2.11.d ~ Commonly Used Find and Replace Operations 
Under Development 
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15.2.12 ~ Transferring Styles between Documents and 
Templates 
Sometimes it is helpful to be able to transfer styles between documents, as well as between 
documents and templates. One such case can occur when personnel managing project templates 
make changes to the standard CAT styles during a project. When there are such changes, the 
modified style in the template differs from the corresponding style in all the documents that have 
been created based on the project template. At some point, before the release of the final report, 
it will become necessary to rectify the differences. 

Unless style changes are major or numerous, you can probably resolve style conflicts after 
individual team members’ files have been merged. After merging the files, you will need to 
import the latest styles from the project template into the resulting file(s). 
To Transfer Styles from a Template to a Document: 

1 Open the document for which you wish to update styles. 

2 Choose Format, Style from the menu toolbar. The Styles dialog box will appear. 

3 Click the Organizer button. A dialog box similar to Figure 15.12 will appear. 
In this example, TechnicalGuide_Template.dot is the template associated with the 
techguide_word.doc document. 
The window on the left contains 
styles that are in your current 
document, while the window on 
the right will contain styles in 
Word’s Normal template. 

4 Choose Close File under the right 
window. The button will change to 
Open File. 

5 Click Open File. An Open dialog 
box will appear. 

6 Browse to the location of the 
project template and open it. All 
the styles associated with the 
project template will now appear in the right window. 
In the Figure 15.12 example, TechnicalGuide_Template.dot is the template associated 
with the techguide_word.doc document. 

Figure 7.12 

7 Select the styles from the right window you wish to update, and choose Copy. 
On most occasions you will want to update all your styles, so you can simply click on the 
first style and drag your mouse down the window until you have scrolled to the end of the 
styles. (Many styles are below the styles that are initially seen in the right window, but 
more will appear as you drag the mouse arrow below the bottom of the window. 
Basically, it scrolls like other Word lists.) In special cases you may need to copy only 
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select styles. In this case select them individually, or, if there are several, you can select 
them all at once by keying Ctrl while you click the desired styles with your mouse. 

Note: For more detailed information on styles, see Using Word 2000, Chapter 6, beginning on 
page 230. 
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Appendix A ~ Frequently Asked Questions (FAQs) 
The following is a list of Frequently Asked Questions about the CAT Oracle program. They 
are divided into subject categories: General Inquiries, Content Analysis application, Mail 
ID application, Header Entry form, Mail ID LOV form, and Query Comments form. 

General Inquiries 
What are the buttons at the bottom of the forms? 
The buttons at the bottom of the Mail ID and Content Analysis applications open the various 
forms of the CAT program. In the bottom, right-hand corner of each form is a Close button 
that closes the form currently displayed on the screen.  

Figure 1.1: Buttons Displayed in the Content Analysis Application 

Figure 1.2: Buttons Displayed in the Mail ID Application 

What do the field colors signify? 
Blue and pink fields are required fields, yellow fields indicate the application is in query 
mode, white fields are optional fields, and the information in gray fields fills in 
automatically. 

Is there a keyboard shortcut for closing message boxes that appear on my screen? 

Yes. Press [Enter] and the boxes will close. 

How do I close a form when it is in query mode? 

Click on the [Close] button located at the bottom right-hand corner of the form. A message 
box appears that says “Query Cancelled,” press [Enter] to cancel the query and close the 
form. 

How do I know what task each button in the toolbar performs? 
Rest the mouse over the button and a prompt appears providing the function of the button and 
its keyboard shortcut. 

Figure 1.3: Prompt for Edit Button 

Why should I not minimize forms? 
Minimizing forms is not recommended. In the Oracle program there is only one window 
(called the “Dummy Window”) in which different forms exist. There are not separate 
windows like in a Microsoft Office program. The forms in the CAT program do not need to 
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be minimized because the buttons can be used to navigate to the different forms. If you do 
minimize a form, it will minimize behind the Welcome form, which will then need to be 
minimized as well. 

The “Dummy Window” is the gray window you will see when logging on to the program. If 

ysis application to the Mail ID application 

-down menu. 

 of 

Why can’t I open a different form? 
ently viewing is in query mode. You cannot open a 

Content Analysis Application 
ignatures” and “Total Signatures?” 

s 

s the total number of signatures for all MIDs associated 

this window displays, minimize it and ignore it. 

Is there a way to move from the Content Anal
without clicking on the button at the bottom left-hand corner of the form? 

Yes. Use the Windows keyboard shortcut <Alt+W> to access the Windows drop
The menu lists all of the open forms in the CAT program, a number precedes each form 
name and a check mark indicates the title of the form currently viewed. Enter the number
the desired form and it will display on the screen. This shortcut will not work if the form 
currently viewed is in query mode. 

Figure 1.4: Window Drop-Down Menu 

Check to see that the form you are curr
different form if the form currently viewed is in query mode. Remember, the fields of the 
form are yellow when the form is in query mode. 

What’s the difference between “Number of S
The “Number of Signatures” in the Respondents block displays the number of signature
associated with the MID displayed. 

The “Total Signatures” field display
with the response. 

Total Signatures 

Number of Signatures 

Figure 1.5: Signature Fields in the Content Analysis Form 
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Is there a way to move the cursor from the Respondents block to the Comments block 
without using the mouse? 

Yes. Use the keyboard shortcut <Ctrl+Page Down> to move the cursor from the 
Respondents block to the Comments block. An alternate method is the <Alt+R> shortcut that 
lists the Record drop-down menu. From the Record menu press <N> (which selects Next 
Record) then press [Enter]. 

How do I enter a response with multiple MIDs? 

Enter the first MID number then press the [down arrow] key. This clears the field so a new 
MID can be added. If the Mail ID field is not clear, typing a different MID will replace the 
MID displayed in the Mail ID field. 

In the Respondent’s block, why do the “Org” and “Number of Sigs” fields default to I 
and 1? The majority of the responses CAT receives is sent from individuals and has only one 
signature. The Organization field and the Number of Signatures field default to “I” and “1.” 
If the Org type or the number of signatures is different than the default update those fields. 

Is there a way to commit and begin a new comment without using the mouse? 

Yes. Press [F10] to commit then press [F6] to insert a new record. This moves the cursor 
from the “Comment” field to the “Comment Number” field. 

Why does the Content Analysis Application Project block open in query mode? 
The block opens in query mode to ensure the correct Project ID is entered. When the Project 
ID is queried and the correct Project ID is retrieved, there is no chance of a typographical 
error. 

Mail ID Application 
Why do the “City,” “State” and “County” fields fill in automatically when I enter the 
zip code? 
This feature saves time and improves accuracy. It is important to verify that the city and state 
fields display the correct information. Navigate the cursor through the city and state fields 
and they highlight to remind you to check that the information corresponds to the information 
the response. 

Does the fax field automatically add dashes when I exit the field? 
Yes. This occurs in both the Mail ID application and the Foreign Mail ID form. 

Are the MID fields in the same order as how they will print on a label? 
Yes. This is true for the Mail ID application and the Foreign 
Mail ID form. 

How do I query all of the MIDs I have created and modified 
for one day? 
Enter your profile in the “Created by” field and the date you 
want to query in the “Create Date” field. Be sure to add a % 
after the date, this retrieves all of the MIDs for the day. 

Figure 1.5: Query by Profile 
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Header Entry Form 
Why do I execute instead of commit, when saving information in the Header Entry 
form? 
Use the “Execute” button because the information you have just entered will be validated. 
The letter numbers and MIDs are checked against the project ID. If a letter number or MID is 
not attached to the project ID listed in the Header Entry form an error message is displayed 
on the screen. 

When I am using the Header Entry form how many responses and MIDs can be entered 
before I need to execute? 
The number of MIDs and letter numbers that can be entered in this form are limitless, in 
theory. If you reach a maximum, however, there are several explanations. The limitation 
could be due to the memory of your PC, how many windows you have open (Word, Internet, 
etc.), and the physical limitations of your Server Database. You may need to close a program 
to avoid this. 

Mail ID LOV Form 
Why does the LOV form take so long to appear? 
The LOV form is slow to appear because the form is associated with a large database that 
takes time to retrieve. 

Why do the Content Analysis application and the Mail ID application size when the 
LOV form is selected? 
In Windows, if a form is sized (reduced from maximum size) then all forms are sized. The 
LOV form is sized to allow the user to check the Mail ID application in case they need to 
verify what they are querying. Therefore, all of the open forms are sized to permit the user to 
view the Mail ID application. 

Query Comments Form 
In the Query Comments form, when I enter query mode and the cursor is in the “Letter 
No” field, the cursor automatically moves to the “Comment” field. Why? 
This form exists for querying comments. The “Comments” block will most likely be the 
block that is queried in this window. The cursor defaulting to this field saves time. 
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Appendix B ~ Glossary of Terms and Acronyms 
Alternative Code Additional codes used on some projects to identify specific 

information not provided by subject, category, and rationale 
codes. These codes are comment-specific and follow the subject 
and category code entries in the left margin of the coded letter. 
Examples include codes for standards and guidelines numbers, 
regulation numbers, alternative numbers, and geographic areas. 

Application A set of Oracle programs that solve a company’s business needs. 

Attachment A supplemental document attached to an original letter 

Block A container for fields in Oracle Forms. Blocks can be related to 
tables in the database. 

Blue Flag Blue post-it flag attached to the left margin of a letter to show that 
it contains an information request. These letters are often referred 
to as “blue flag letters.” 

Brackets [ ] A) A set of characters used in the Remarks field of the Mailing 
List Application. B) A set of characters used to indicate the 
beginning and end of a coded comment. C) A set of characters 
used to indicate added text in a comment. 

CAT Program The program used by the Content Analysis Team for creating and 
maintaining an Oracle database. 

Category Code Five-digit numeric code that defines a specific subtopic within a 
subject code. These codes are comment-specific and are written 
in the left margin of the coded letter. 

Clean Copy A copy of a project related letter that is kept free of any CAT 
related markings or notations except the letter number. 

Code An alpha or numeric sequence used to categorize and sort 
information. To code is to assign these sequences to letters or 
comments.  
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Coding Structure A topical outline with alpha and numeric codes attached. A 
coding structure is used as a tool to identify public comments and 
sort them into recognizable categories. 

Comment A coherent segment of text that will stand alone as a suggestion, 
idea, request, or critique. Each comment is assigned a subject and 
category code from the coding structure. 

Commit An instruction for the database to save all of the changes made to 
the database. 

Common Interest 
Classification

A code used in some past projects to record preference for 
specific alternatives (currently not being used). 

Content Analysis A systematic method of compiling, categorizing, and capturing 
the full range of public viewpoints and concerns regarding a plan 
or project.  

Content Analysis 
Application

The application wherein the comments of a letter and its Mail ID 
are linked and added to the database. 

Database Report A printout of comments sorted by subject code, category code, 
letter number, and comment number. 

Date Received Stamp The mark on the letter identifying the date CAT received the 
letter. 

Delivery Address 
Components

The specific elements that comprise the delivery address line of 
an address. 

Demographic Codes Numeric codes that identify organization affiliation, letter type, 
and number of respondents for a letter. 

Drop-Down Menu A menu of command options that appears temporarily when you 
click the mouse button on a selection. The menu appears directly 
beneath the command selected. 

Duplicate Letter A letter that exactly matches the content of a letter already 
received by CAT. 
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Duplicate Letter Number The same number that is inadvertently assigned to two different 
letters. 

Rationale Code The third in the series of codes used to classify comments. It is a 
three digit code that follows the five alpha character subject and 
five numeric character category codes. 

Field A space allocated for a particular item of information. Fields are 
the smallest units of information in a database. A field can be 
required, optional or calculated. A required field (pink in the 
CAT program) is one in which you must enter data, while an 
optional field (white in the CAT program) is one you may leave 
blank. A calculated field (gray in the CAT program) is one whose 
value is derived from some formula involving other fields. You 
do not enter data into a calculated field; the system automatically 
determines the correct value. 

Footnotes A note of reference, explanation, or comment usually placed 
below the text on a letter. Enter coded footnotes as “[Footnote 1: 
content]” exactly where it appears in the text of the letter. 

Form Five or more letters received separately but containing identical 
text.  

Form Master A form chosen from a group of identical forms. The form master 
is coded and entered into the database and it is used as a template 
for all of the forms it represents. 

Form Plus Identical to an already identified form but with one or more 
additional comments included which may or may not be codable. 

Full Summary A comprehensive narrative that summarizes and discusses all 
public concerns identified for a project. 

Header Codes Alpha and numeric codes contained within a stamped set of 8 
boxes located at the top of each letter. The header comprises both 
demographic and administrative codes, including the following: 
organization type, number of signatures, letter type, immediate 
attention, user type, form number, common interest class, and 
information request. Organization type, number of signatures, and 
letter type are always supplied. The completion of other boxes 
depends on both the individual letter and the needs of the project. 
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Immediate Attention 
Code

A numeric code applied to letters requiring an immediate letter 
from the client. CAT and clients work together to determine 
which categories of letters require this designation. A letter that 
requires immediate attention receives a red flag on its left margin 
and a specific code in its header box. 

Information Request 
Code

An alpha code applied only to letters with specific requests for 
information pertaining to the proposal. The client determines the 
level of specificity for identifying and flagging information 
requests. A letter that meets client specification receives a blue 
flag on its left margin and a specific code in its header box. 

Interim Report A general term applied to any report provided a client before the 
completion of the project. Interim reports are sometimes 
produced for public concerns, Immediate Attention letters, 
information requests, organized letter campaigns, and 
demographics. 

Letter Any document submitted as comment on a project, including 
mail, email, public hearing transcripts, comment forms, 
resolutions, forms, postcards, and petitions. For Response Type 
code, “letter” specifically refers only to mailed and faxed 
correspondence.  

Letter Generator Letters containing selected comments that are identical to those 
from a larger form. These letters are usually created through an 
interactive website that offers people a selection of comments and 
allows them to choose which to use in creating a letter. 

List of Values In each form in the CAT program there are buttons indicating a 
List of Values (LOV). This list displays all of the possible entries 
for a field.  

Letter Number A number applied to any document or piece of correspondence 
submitted as comment on a project. Letter numbers are assigned 
sequentially for each project. 

Log A tracking system in the form of an Access Database that 
provides a list of each letter number and its corresponding 
respondent. 
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Mail ID A unique number defined by the mailing and/or demographic 
information provided by an entity or individual that is used to link 
the respondent’s mailing information to their letter. This number 
can follow an entity or individual from project to project. 

Mail Log in Sheet The sheet used to track the letter number blocks assigned in the 
Central Processing Area on a given day. The mail processor then 
knows at which number to begin the following day. 

 Mailing Label Used for project related mailings. Each label contains the mailing 
information of each respondent. Labels are only printed for 
respondents that are on the mailing list of a project.  

Mailing List Application The application used for creating and updating Mail Identification 
Numbers for each respondent on a project. 

Management Action These are the primary subject and category codes used to identify 
the topic or subject of the requested action(s) that management 
should take. 

Military Address 
Components

The parts of a military address for both domestic and overseas 
locations. The components include APO (Army Post Office), 
FPO (Fleet Post Office), AE (armed forces in Europe, the Middle 
East, Africa and Canada), AP (armed forces in the Pacific), AA 
(armed forces in the Americas). 

Narrative A generic term that refers to any written summary—full or 
thematic—produced for a project. 

Oracle Oracle's relational database stores information and the Oracle 
application is used to develop forms & reports. 

Organization Type A code that identifies a specific type of organization, association, 
agency, government agency, elected official, or individual. 

Organized Letter 
Campaign

A term that refers to both forms and petitions.  

 

Original Letter That from which clean and working copies are made. The original 
is used in the logging process. 
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Out of Scope Letters considered beyond the range of concerns contained in a 
specific project. 

Petition A single letter signed by multiple members of the public.  

Phase Used to identify where the project is in the NEPA process (e.g., 
prescoping, scoping, draft and final). 

Balloon Help On-screen help displayed in a cartoon-style dialogue box that 
appears when the pointer (cursor) is placed over the object in 
question. 

Protected Field A field that is filled in automatically and cannot be updated by 
the user. 

Public Concern A statement that extracts a key concept from public comment and 
presents the matter as an action or decision to be made by the 
client agency, or a topic to be addressed in subsequent 
publications of the agency’s proposal. Conceptually, it conveys 
the “who,” “what,” and “where,” upon which the agency’s 
response to comment is founded. A concern statement suggests 
who should respond (which may actually be a document); what is 
the question, problem, suggestion, or interest expressed by the 
respondent; and where (hierarchically or geographically) the 
question, problem, suggestion, or interest would most likely be 
addressed. Most public concerns are written as “should” 
statements: e.g., “Public Concern: The National Park Service 
should allow camel tours on backcountry trails in Yosemite 
National Park.” 

Query Specifying a set of data to be retrieved from a database. 

Record A group of related fields. 

Red Flag Red post-it flag attached to the left side of a letter to show that it 
meets the requirements for one of the Immediate Attention 
categories. Immediate Attention letters are often referred to as 
“red flag letters.” 

Remarks The information in the Mailing List application that specifies the 
letters and projects for each respondent in the database. 
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Replicate The function used when one or more of the comments of one 
letter are identical to one or more of the comments of another 
letter. 

Respondent A person, organization, association, or other entity submitting 
comment on a project. On reports, “number of respondents” and 
“number of signatures” is synonymous. 

Response  “Response” is sometimes used as being synonymous with letter. 

Response Type The specific format of a letter as recorded in the RT field at the 
top of each letter, e.g., form letter, petition, public comment form, 
etc.  

Sample Statement A relevant, coherent excerpt from a respondent’s letter that 
expresses distinct concepts the client agency can or should 
address. 

Section Symbol § ISM notes the section symbol as “[section].” 

Signatures The number of names attached to a letter. This number is 
recorded in the header box at the top of each letter. For reports, 
“number of signatures” is synonymous as “number of 
respondents.” 

Site Specific Additional code that may be used on some projects to identify 
geographic locations; i.e., Tally Lake RD, Kootenai NF.  

SQL (Structured Query Language) A language used to interrogate and 
process data in the Oracle database. 

Stage of Process The Stage of Process indicates a period of time that is within the 
phase of the project. 

Standard Abbreviations Abbreviations that follow the standards of the United States 
Postal Service. 

Subject Code Five-character alpha codes that represent broad themes of 
management actions associated with a project, such as natural 
resources, economics, lands, etc. These codes are comment-
specific and are written in the left margin of the coded letter. 
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Thematic Summary A concise summary that discusses the major themes and concerns 
identified for a project. 

Validation The process by which a project database is checked for accuracy 
and completeness. 

Validation The act of verifying all entered data in the database. 

Working Copy The copy of the letter that is put through the CAT process (e.g., 
assigned a MID, coded and entered into the database). 

Zip+4 Website Displays the standardized mailing address based on the 
information entered into the form provided. 

 

ACRONYM LIST 
 
AAC American Alpine Club 
ACA Aquatic Conservation Area 
ACEC Areas of Critical Environmental Concern 
ACMP Alaska Coastal Management Plan 
ACS Aquatic Conservation Strategy 
ACWI Advisory Committee on Water Information 
ADA Americans with Disabilities Act 
AF&PA American Forest & Paper Association 
AFA Alaska Forest Association Inc 
AFOS Animal Feeding Operation System 
AGNA Anglo Gold North America Inc 
AHC American Horse Council 
AIARMA American Indian Agricultural Resource Management Act  
AIRFA American Indian Religious Freedom Act 
AITFMRA American Indian Trust Fund Management Reform Act 
ALJ Administrative Law Judge 
ALSE Area of Late Successional Emphasis 
AMA American Mining Association 
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AMD Acid Mine Drainage 
AMP Allotment Management Plan 
AMS Analysis of the Management Situation 
ANCSA Alaska Natives Claims Settlement Act 
ANILCA Alaska National Interest Lands Conservation Act 
ANPR Advanced Notice of Proposed Rule 
APA Administrative Procedures Act 
APHIS Animal and Plant Health Inspection Service 
APP Aquifer Protection Permit 
ARB Air Resources Board 
ARD Acid Rock Drainage 
ARPA Archaeological Resources Protection Act 
ARVC National Association of RV Parks & Campgrounds 
ASQ Allowable Sale Quantities 
ATNI Affiliated Tribes of Northwest Indians 
ATV All Terrain Vehicle 
AWF AZ Wildlife Federation 
BA/BE Biological Assessment/Biological Evaluation 
BAT Best Available Technology 
BBF Billion Board Feet 
BC Benefit-Cost 
BCAS Black Canyon Audubon Society 
BEA Bureau of Economic Analysis 
BHNF Black Hills National Forest 
BIA Bureau of Indian Affairs 
BLM Bureau of Land Management 
BLS Bureau of Labor Statistics 
BMP Best Management Practices (to prevent or reduce water pollution) 
BPS Best Professional Management 
C Co Curry Company 
CAA Clean Air Act 
CAFÉ Corporate Average Fuel Economy 
CAS Capable, Available and Suitable (refers to land classification) 
CASPO California Spotted Owl 
CBC California Bicycle Coalition 
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CCA Central Cascades Alliance 
CDCA California Desert Conservation Area 
CDF California Department of Forestry 
CDFG California Dept of Fish and Game 
CE  Categorical Exclusion 
CEA Cumulative Effects Analysis 
CEQ Council on Environmental Quality 
CERCLA Comprehensive Environmental Response, Compensation and Liability Act 
CFBF California Farm Bureau Federation 
CFR Code of Federal Regulations 
CIP Continuous Improvement Process 
CNG Compressed Natural Gas 
COE US Army Corps Of Engineers 
CORVA California Off-Road Vehicle Association 
COS Committee Of Scientists 
CPUC California Public Utilities Commission 
CSOSC California Save Our Streams Council 
CSP Concessions Services Plan (Yosemite) 
CWA Clean Water Act 
CWAP Clean Water Action Plan 
CWD Course Woody Debris 
CWHR California Wildlife Habitat Relationship 
DBH Diameter At Breast Height (4.5 ft above ground, uphill side of tree) 
DC Desired Condition 
DCP Lodge Development Concept Plan (Yosemite) 
DEIS Draft Environmental Impact Statement 
DFC Desired Future Condition 
DFPZ Defensible Fuel Profile Zone 
DN Decision Notice 
DOA Department Of Agriculture 
DOC Department Of Commerce 
DOD Department Of Defense 
DOE Department Of Energy 
DOI Department Of Interior 
DPS Distinct Population Segments 
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DWMA Designated Wildlife Management Area 
EA Environmental Assessment 
EAWS Ecosystem Analysis at the Watershed Scale 
EBMUD East Bay Municipal Utility District 
EEI Edison Electric Institute 
EEO Equal Employment Opportunities 
EIS Environmental Impact Statement 
EMS Emergency Medical Services 
EO Executive Order 
EPA Environmental Protection Agency 
ERU Ecological Reporting Unit 
ES Executive Summary 
ESA Endangered Species Act 
ESE Executive Summary 
EU Ecological Units 
EUE Ecological Units 
EVC Existing Visual Conditions 
F&WS Fish and Wildlife Service (DOI) 
FACA Federal Advisory Committee Act 
FCRPA Federal Cave Resources Protection Act 
FDSR Forest Develop System Roads 
FEIS Final Environmental Impact Statement 
FEMAT Forest Ecosystem Management Assessment Team 
FERC Federal Energy Regulation Commission 
FHM Forest Health Monitoring 
FIA Forest Inventory and Analysis 
FLPMA Forest Land Policy and Management Act 
FOIA Freedom Of Information Act 
FONSI Finding Of No Significant Impact 
FOYV Friends Of Yosemite Valley 
FRAP Forest Resources Assessment Project 
FRRRPA Forest and Rangeland Renewable Resources Planning Act 
FRZ Fuel Reduction Zone 
FS Forest Service 
FSEEE Forest Service Employees for Environmental Ethics 
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FSH Forest Service Handbook 
FSLN Forest Service Library Network 
FSM Forest Service Manual 
FTE Full-Time Equivalent 
FVS Forest Vegetation Simulator 
FY Fiscal Year 
GAO Government Accounting Office 
GFDWS General Field Data Worksheets 
GIS Geographic Information System 
GMP General Management Plan (Yosemite) 
GPRA Government Performance and Results Act 
GRN Gulf Restoration Network 
GSP Gross State Product 
HCA Habitat Conservation Area 
HFQLG Herger-Feinstein Quincy Library Group Forest Recovery Pilot Project 
HONOR Honor Our Neighbor's Origins and Rights 
HP Housing Plan (1992, 1996 YVP) 
HRM Human Resources Management 
HRV Historical Range of Variability 
IAC Idaho Association of Counties 
IBLA Interior Board of Land Appeals 
ICBEMP Interior Columbia Basin Ecosystem Management Project 
ICE Internal Combustion Engines 
IGRA Indian Gaming Regulatory Act 
IIM Individual Indian Money Accounts 
IMPROVE Interagency Monitoring of Protected Visual Environments 
INFISH Interior Anadromous FISH Strategy 
IPAA Independent Petroleum Assoc of America 
IPAMS Independent Petroleum Assoc of Mountain States 
IPM Integrated Pest Management 
IPRL Indian Probate Reinvention Lab 
IRFA Initial Regulatory Flexibility Analysis 
IRS Internal Revenue Service 
ISDRA Imperial Sand Dunes Recreation Area 
ISTEA Inter-modal Surface Transportation Efficiency Act 
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LAC Limits of Acceptable Change 
LFA Louisiana Forestry Association 
LLC Limited Liability Corporation 
LLP Limited Liability Partnership 
LMP Land Management Plan 
LRMP Land and Resource Management Plan 
LSLA Lake States Lumber Association 
LSOG Late Successional Old Growth 
LTBMU Lake Tahoe Basin Management Plan 
LTRO Land Titles and Records Office (within BIA) 
MA Map Area 
MARS Management Attainment Reporting System 
MATP Most Appropriate Technology and Practices 
MBTA Migratory Bird Treaty Act 
MCCHD Missoula City County Health Department 
MCFB Modoc County Farm Bureau 
MCL Maximum Containment Levels 
MDP Meadow Protection Zone 
MIS Management Indicator Species 
MMPA Mining and Mineral Policy Act 
MOA Memorandum Of Agreement 
MOU Memorandum Of Understanding 
MRL Montana Rail Link 

MRP 
Merced River Plan (formerly Yosemite CMP-Comprehensive Management 
Plan) 

MSHA Mine Safety and Health Administration 
MUC Multiple Use Classification 
MUCC Michigan United Conservation Clubs 
MUSYA Multiple-Use Sustained Yield Act 
NAAQS National Ambient Air Quality Standards 
NACo National Association of Counties 
NAGC National Alliance of Gateway Communities 
NAGPRA Native American Graves Protection and Repatriation Act 
NAS National Academy of Sciences 
NATCO NATure COnservancy (CAET acronym) 
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NBMG Nevada Bureau of Mines and Geology 
NCAI National Congress of American Indians 
NCSL National Conference of State Legislatures 
NEDC Northwest Environmental Defense Center 
NEPA National Environmental Policy Act 
NFMA National Forest Management Act 
NFS National Forest System 
NFSL National Forest and GrasSLands  (?!) 
NHPA National Historic Preservation Act 
NHTSA National Health Testing Services Association (?) 
NIMBY Not In My Back Yard 
NIPF Non-Industrial Private Forest 
NMA National Mining Association 
NMDA New Mexico Department of Agriculture 
NOI Notice Of Intent 
NPCA National Parks and Conservation Association 
NPDES National Pollution Discharge Elimination System 
NPR National Performance Review 
NPS National Park Service (DOI) 
NRA National Recreation Area 
NRC National Research Council 
NREPA Northern Rockies Ecosystem Projection Act 
NWFP NorthWest Forest Plan 
NWPS National Wilderness Protection System 
OA Organic Act 
OGC Office of the General Council 
OHA Office of Hearings and Appeals (DOI) 
OHV Off-Road Vehicle 
OIG Office of the Inspector General 
OMB Office of Business Management 
ONRW Outstanding Natural Resource Waters 
OPS Office of Pipeline Safety 
ORV Off-Road Vehicle 
OSHA Occupational Safety and Health Administration 
OSM Office of Surface Mining 
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OST Office of Special Trustee for American Indians 
OSV Over-Snow Vehicle 
OTFM Office of Trust Funds Management 
PAC Protected Activity Center (area under CASPO EA interim guides) 
PACFISH Pacific Anadromous Fish Strategy 
PAH Polynuclear Aromatic Hydrocarbons 
PC Professional Corporation 
PDMC Phelps Dodge Mining Company 
PHS Public Health Service 
PILT Payment in-Lieu-of Taxes 
PIT Passport In Time 
PLA Public Lands Advocacy 
PLF Public Land Foundation 
PLLP Private Limited Liability Partnership 
PLP Public Land for the People 
PM Particulate Matter 
PNFF Prescott N F Friends 
PNV Present Net Value 
PNW Pacific North West Forest Plan 
POO Plan Of Operations 
PPRC Pulp & Paper workers Resource Council 
PR Planning Regulations 
PRA Paperwork Reduction Act 
PRC Pacific Rivers Council 
PRIA Public Rangelands Improvement Act 
PSD Prevention of Significant Degradation 
QLG Quincy Library Group 
RACR Roadless Area Conservation Rule 
RAMP Recreation Area Management Plan 
RARE I & II Roadless Area Review and Evaluation (1970s) 
RBA Riparian Buffer Area 
RCA Riparian Conservation Area 
RCP Riparian Conservation Plan 
RCRA Resource Conservation and Recovery Act 
RCRC Regional Council of Rural Counties 
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RDEIS Revised Draft Environmental Impact Statement 
RFA Regulatory Flexibility Act 
RFRA Religious Freedom Restoration Act 
RHCA Riparian Habitat Conservation Area 
RMO Riparian Management Objective 
RMP River Management Plan 
RNA Research Natural Areas 
ROC Recreation Outdoors Coalition 
ROD Record Of Decision 
ROS Recreation Opportunity Spectrum 
ROW Right Of Way 
RPA Rangelands Renewable Resources Planning Act of 1974 
RPZ Riparian Protection Zone 
RRPA Renewable Resource Planning Act 
RVUR Resources Valuation and Use Research 
S&PF State and Private Forestry 
SAA Southern Appalachian Assessment 
SAMS Sierra Nevada Access, Multiple Use & Stewardship Coalition 
SARA Superfund Amendments and Re-Authorization Act 
SAT Scientific Analysis Team 
SBREFA Small Business Regulatory Enforcement Fairness Act 
SBRFA Small Business and Regulatory Flexibility Act 
SCADA Supervisory Control and Data Acquisition 
SCAG Southern California Association of Governments 
SCFW South Carolina Forest Watch 
SCIF Safari Club International Foundation 
SCS Soil Conservation Service 
SDWA Safe Drinking Water Act 
SEACC Southeast Alaska Conservation Council 
SELC Southern Environmental Law Center 
SIA Special Interest Areas 
SIP State Implementation Plan  
SMCRA Surface Mining Control and Reclamation Act 
SMZ Streamside Management Zone 
SNCCF Sierra Nevada Conservation and Collaboration Framework 
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SNCF Sierra Nevada Conservation Framework 
SNEP Sierra Nevada Ecosystem Project 
SNFP Sierra Nevada Framework Project 
SOHA Spotted Owl Habitat Area 
SOR Statement of Requirements 
SOTIA Southern Oregon Timber Industry Association 
SPCC Spill, Prevention, Control and Countermeasure 
SPRA Strategic Planning and Resource Assessment (formerly RPA) 
SQS Soil Quality Standards 
SRME Southern Rocky Mountain Ecoregion 
SUP Special Use Permits 
SVS Stand Visualization System 
SWPA Source Water Protection Act 
SX/EW Solvent Extract and Electrowinnowing Wastes 
T&ES Threatened and Endangered Species 
TCP Traditional Cultural Property 
TES Terrestrial Ecosystem Survey 
TIA Takings Implication Assessment 
TLAA Tribal Land Acquisition Area 
TLMP Tribal Land Management Plan 
TMDL Total Maximum Daily Load 
TRI Toxic Release Inventory 
UDL Upper Diameter Limit 
UFP Unified Federal Policy 
UMRA Unfunded Mandates Reform Act 
USDA United States Department of Agriculture 
USDOI United States Department Of the Interior 
USDOT United States Department Of Transportation 
USFS United States Forest Service 
USFWS United States Fish and Wildlife Service 
USGS United States Geological Survey 
UUD Unnecessary and Undue Degradation 
UWA Unified Watershed Assessment 
VERP Visitor Experience and Resource Protection 
VGC Vegetation Ground Cover 
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VMS Vehicle Management System 
VQO Visual Quality Objective 
VTS Visitor Transportation System 
WA Wilderness Act 
WEC Wilderness Education Coalition 
WGA Western Governors Association 
WIDNR Wisconsin Department of Natural Resources 
WQLS Water Quality Limited Segments 
WSA Wilderness Study Area 
WSRA Wild and Scenic River Act 
WUWC Western Urban Water Coalition 
ZEZ Zero Emission Zone 

 

 18



 Technical Guide  

Appendix C ~ Mail ID Samples 
The following are some formatting examples of Mail IDs to be used as guidelines when 
entering mailing information into the Mail ID application. 

Governmental Bodies 

Federal 
Example of Org: Federal (United States Department of Commerce) 
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Example of Org: Federal (US House of Representatives/House District #) 
Title: Representative (REP) 
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Example of Org: Federal (United States Department of Agriculture Forest 
Service/Nine Mile Ranger District) 
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Example of Org: Federal (US Department of Interior/Fish & Wildlife Services) 
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Example of Org: Lead Agency Employee (Yosemite National Park Project-Lead 
Agency) 
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Example of Org: Federal (US Senate) 
Title: Senator (SEN) 
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State 
Example of Org: State  
Addr: Fifth Floor 
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Example of Org: State (State Legislature/House of Representatives/HD #) 
Title: Representative (REP) 

C-8 Appendix C ~ Mail ID Samples 



 Technical Guide  

Example of Org: State (Governor’s Office) 
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Example of Org: State (State Legislature/House of Representatives/HD #) 
Title: Representative (REP) 
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Example of Org: State / Department / Division  
Addr: Room 
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Example of Org: State (Department / Division)  

Attn: (used only when specified by the author)  
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Example of Org: State (State Legislature/Senate/Senate District #) 
Title: Senator (SEN) 
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County 
Example of Org: County (Planning Commission) 

C-14 Appendix C ~ Mail ID Samples 



 Technical Guide  

Example of Org: County (Board of Supervisors) 
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Town/City 
Example of Org: Town/City Agency or Department 
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Tribal 
. Example of Org: Tribal (General Council [with no address] representing Cherokee 
Nation) 
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Utility Group or Organization 
Example of Org: Utility (Bonneville Power Administration) 
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Conservation District 
Example of Org: Conservation District 

Appendix C ~ Mail ID Samples C-19 



Technical Guide 

International 
Example of Org: Business 
Addr: Foreign (Ukraine) 
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Example of Org: Business  
Addr: Foreign (Canadian) 
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Industry and Business  

Oil, Coal, and Pipeline Industries 
Example of Org: Oil & Pipeline Industries 

MSC: Mail Stop Code 
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Mining Industry/Association 
Example of Org: Consultants / legal representatives writing on behalf of Mining 
Industry  
Client: Mining Inc (Asarco Incorporated) 
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Example of Org: Mining Industry 
Addr: Highway Contract (keep HC and Box # on same line) 
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Timber/Wood Products Industry/Association 
Example of Org: Wood Products Industry/Company 
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Agricultural Industry/Association 
. Example of Org: Agricultural Industry or Association (Farm Bureau) 
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Range/Grazing Organization 
Example of Org: Grazing (South Umpqua Grazing Association) 
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Civic Organizations 

Preservation/Conservation Organizations 
Example of Org: Preservation / Conservation (with a group) 
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Recreational Organizations (Non-Motorized) 
. Example of Org: Recreational (non-motorized) 
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Recreational Organizations (Motorized) 
Example of Org: Recreational (motorized) 
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Multiple Use, Wise Use, and Land Rights Organizations 
Example of Org: Multiple Use/Land Rights  
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Place-Based Groups 
Example of Org: Place Base Group (Quincy Library Group) 
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Civic Groups 
Example of Org: Civic Group 
 

 
 

Appendix C ~ Mail ID Samples C-33 



Technical Guide 

University/Professional Society/Researchers/Scientists 
Example of Org: University or Professional Society (writing on behalf of University 
“We”) 
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Government Employee Organizations and Unions 
Example of Org: Government Employee Org/Union 
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Individuals 
Example of Org: Individual 
Addr: Ranch (writing on behalf of self, not the ranch) 
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Example of Org: Individual 
First Name ONLY (exception): Use first name for Sisters of the Catholic Church 
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Example of Org: Individual (enrolled at college/university) 
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Appendix D ~ Database Reports 
After public comments, mailing address information, and associated project setup codes are 
entered into the database, CAT organizes the data in order to efficiently analyze it. CAT does 
this by running database reports in which the data is sorted by certain project setup codes. 

Categories of Reports 
• Validation Reports corroborate data within the database. 
• Mailing List Reports generate the name and address information of respondents. 
• Content Analysis Reports consist of report sub-categories and individual reports: 

• Report sub-categories are: 
• Demographic Reports (Responses/Respondents/Signatures) 
• Comment Reports (text of comments, respondent and coding information) 

• Reports are: 
• Comments by subject (form) 
• Immediate Attention Description 
• Information Request Description 

Running Database Reports 
From any form in the CAT program, go to the File drop-down menu to display the three 
categories of reports.  Select a category, and another menu appears containing either a sub-
category of reports or a list of reports.  Another list of reports will be within the sub-menu of 
the selected sub-category. 

Figure E.1: Accessing Database Reports 

Report 

Report Sub-category 

Report Category
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Select the required report. A prompt screen appears requesting report parameters. 

Figure E.2: Selecting the Report 

Report Parameters

• Select the appropriate Output Device: 
• Screen: Displays the report on the screen, without any printer formatting 
• Preview: Displays the report on the screen, with printer formatting  (similar to print 

preview).  Use preview if you are going to print the report. 
• Printer: Sends the report directly to the printer without displaying it on the screen. 
• File: Writes the report to a file. 
• Mail:  Sends the report via email as a postscript (.eps) file. 

• Select the correct Report Parameters (Project ID, Phase, and Stage of Process) from 
the drop-down menus. 

• Click the Run Report button.  A Report Progress screen appears until the report is 
done. 
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• The Report Previewer screen appears showing the completed report.  In the Previewer 
screen, you can view, print or mail the report. 
• View:  Click on the Next button to view the next page of the report.  Click on the 

Previous button to view the previous page of the report.  The First button will 
display the first page of the report and the Last button will display the last page. 

• Print:  Click the Print button.  A Print screen appears.  Select the appropriate 
printer from the Printer Name drop-down menu.  Click the OK button. 

• Mail:  Click the Mail button.     
• If it is the first time you use the mail option, a setup wizard will appear.  In the first 

window choose Lotus Notes only then click next.  Enter your Lotus Notes password 
then click next.  A confirmation screen appears – click Next.  In the Next screen 
click Finish, and then setup will be complete. 

• A mail screen appears.  Put the appropriate e-mail address in the To field.  When 
sending the report to another Forest Service employee, use their outside e-mail 
address (example: sbear@fs.fed.us).  Click the yellow envelope icon to send the 
report. 

Report Descriptions and Examples 
Validation Reports 
Last Names 
• Lists all names from all mail ID’s sorted by last name.  This report is used for eliminating 

duplicate mail id’s and errors in names. 

Figure E.3: Validation Report 
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Organization 
• Lists all organizations from all mail id’s sorted by organization.  This report is used to 

keep organization names consistent regarding abbreviations and spelling. 

Figure E.4: Validate Organization Report 

Zip Codes 
• Lists every variation of city, state, and zip for all mail ids.  This report is used to ensure 

cities are tied to the correct zip code and state.  

Figure E.5: Validate City/State/Zip Report 
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City Names 
• This lists every variation of city and state for all mail ids.  This report is used to validate 

licate Mail IDs 

city spellings and city/state relationships. 

Dup
organization, address 1, address 2, city, state, zip, and e-mail address 

 

Figure E.6: Validate City/State Report 

• Lists name, title, 
when there is more than one mail id with the same values in these fields.  This report is
used to eliminate duplicate mail ids. 

Figure E.7: Duplicate Mail IDs Report 
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Mail ID’s for a Project 
• Lists mail id, letter number, mailing list status, form number, creator, and respondent 

information for all letters from a certain project, sorted by mail id.  

Figure E.8: Validate Mail IDs for Letter Entered Report 

Letter numbers for a Project 
• Lists the letter number, mail id, respondent information, and entered by fields from all of 

the letters from a certain project. 

Figure E.9: Validate Letter Numbers Entered Report 
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Mailing List Reports 
Name/address by Last Name 
• Lists name and address information for all respondents from a certain project, sorted by last 

name. 

Figure E.10: Name and Address by Last Name Report 

Name/address by zip 
• Lists name and address information for all respondents from a certain project, sorted by zip 

code. 

Figure E.11: Name and Address by ZIP Code Report 
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Name/address by mail ID 
• This lists the mail ID, mailing list status, and letter number, name, and address information 

for all respondents from a certain project, sorted by mail ID. 

Figure E.11: Name and Address by Mail ID 

Name/address for Immediate Attention 
• Lists the organization type, immediate attention code, and letter number, name, and address 

information for respondents with an immediate attention code from a certain project, sorted 
by immediate attention code, then letter number. 

Figure E.12: Name and Address by IA Report 
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Avery 8462 labels 
• Prints out address information for all respondents from a certain project, sorted by zip code.  

This report is formatted to print Avery 8462 labels (4” x 1.33”/14 labels per page). 

Figure E.13: Avery 8462 Labels Report 

Content Analysis Reports 

Responses/Respondents/Signatures (Demographic Reports) 
Demographic Reports list the number of responses, respondents, and signatures for a certain 
project, broken down by certain codes (see examples below).  
Response: a piece of correspondence 
Respondent: a mail id (can be more than one person, i.e. two people writing from the same 
address.) 
Signatures: Represents a signature on a response. 
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Responses/Respondents/Signatures by Comment Period Extension 
This lists each comment period extension code and the number of responses, respondents, and 
signatures within that code for a certain project. 

Figure E.14: Responses/Respondents/Signatures by 
Comment Period Extension Report

Responses/Respondents/Signatures by Common Interest Class 
• This lists each common interest class code and the number of responses, respondents, and 

signatures within that code for a certain project. 

Figure E.15:Responses/Respondents/Signatures by Common 
Interest Class Report
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Responses/Respondents/Signatures by county 
• This lists each county and the number of responses, respondents, and signatures from that 

county for a certain project. 

 

Figure E.16: Responses/Respondents/Signatures by County 
Report

Responses/Respondents/Signatures by city 
• This lists each city and the number of responses, respondents, and signatures from that city 

for a certain project. 

by City 

Appendix D ~ Dat
Figure E.17: Responses/Respondents/Signatures by City 
ReportFigure E.17: Responses/Respondents/Signatures 
Report 
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Responses/Respondents/Signatures by Foreign Country 
This lists each foreign country and the number of responses, respondents, and signatures from 
that foreign country for a certain project. 

Figure E.18: Responses/Respondents/Signatures by Foreign 
Address Report

Responses/Respondents/Signatures by Form Number 
• This lists each form number and the number of responses, respondents, and signatures from 

that form number for a certain project. 

Figure E.19: Responses/Respondents/Signatures by Form 
Number Report
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Responses/Respondents/Signatures by Immediate Attention 
• This lists each immediate attention code and the number of responses, respondents, and 

signatures from that code for a certain project. 

Figure E.20: Responses/Respondents/Signatures by 
Immediate Attention Report

Responses/Respondents/Signatures by Letter Generator Number 
• This lists each letter generator number and the number of responses, respondents, and 

signatures from that letter generator number for a certain project. 

Figure E.21: Responses/Respondents/Signatures by Letter 
Generator Report
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Responses/Respondents/Signatures by Organization Type 
• This lists each organization type code and the number of responses, respondents, and 

signatures from that code for a certain project. 

Figure E.22: Responses/Respondents/Signatures by 
Organization Type Report

Responses/Respondents/Signatures by Request for Information 
• This lists each request for information code and the number of responses, respondents, and 

signatures from that code for a certain project. 

Figure E.23: Responses/Respondents/Signatures by Request 
for Information Report
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Responses/Respondents/Signatures by Response Type 
• This lists each response type and the number of responses, respondents, and signatures from 

that response type for a certain project. 

Figure E.24: Responses/Respondents/Signatures by 
Response Type Report

Responses/Respondents/Signatures by State 
• This lists each state and the number of responses, respondents, and signatures from that state 

for a certain project. 

Figure E.25: Responses/Respondents/Signatures by State 
Report
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Responses/Respondents/Signatures by User Type 
• This lists each user type and the number of responses, respondents, and signatures from that 

user type for a certain project. 

Figure E.26: Responses/Respondents/Signatures by User 
Type Report

Responses/Respondents/Signatures by Zip Code 
• This lists each zip code and the number of responses, respondents, and signatures from that 

zip code for a certain project. 

Fig e ure E.27: Responses/Respondents/Signatures by Zip Cod
Report
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Comments by Category  
Selected SOP (Stage of Process) 
• Lists respondent information, organization type, form number, letter number, management 

action, subject code, category code, comment number, and comment text, for a selected 
project and stage of process, sorted by category code. 

Figure E.28: Comments by Category Report 

All SOP’s (Stages of Process) 
• Lists stage of process, respondent information, organization type, form number, letter 

number, management action, subject code, category code, comment number, and comment 
text, for a selected project, sorted by category code. 

Figure E.29: Comments by Category (All SOPs) Report 
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Immediate Attention Comments 
• Lists immediate attention code, respondent information, organization type, form number, 

letter number, management action, subject code, category code, comment number, and 
comment text, for all letters for a certain project that have an immediate attention code, 
sorted by category code. 

Figure E.30: Immediate Attention Comments Report 

Optional Reports 
Comments by subject (form) 
• You can query the letter number, comment number, category code, and text for a certain 

project in this form.  This is used for cutting and pasting sample statements into a document. 
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Immediate Attention Description 
• This lists the letter number, immediate attention code, and a previously entered comment 

about the letter for all letters from a certain project. 

Figure E.31: Immediate Attention Description Report 

Information Request Description 
• This lists the letter number, information request code, and a previously entered comment 

about the letter for all letters from a certain project.  

Figure E.32: Request for Information Report 
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Additional Database Reports 
The computer staff provides database reports other than the reports that are available through the 
Content Analysis Application.  These reports consist of any requested fields from the database 
and are available in a wide variety of formats: 
• Word processing programs:  reports can be put into most word processing programs 

format. 
• Spreadsheets:  reports can be put into any type of spreadsheet format. 
• Databases:  reports can be put into any type of database format. 
• Text:  reports can be formatted as a text file. 
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Appendix E ~ Coding Structure Templates and 
Sample Reports 
 

Appendix E contains the following Coding Structure Templates: 

• Standard and optional demographic or letter attribution codes (OT, S, RT, DT, IA, 
UT, LG, F CIC, RI and CE ) 

• Standard Subject and Category (Management Action) codes for land and resource 
management plans. 

• Standard Category 2 (Affected Resource) codes for land and resource management 
plans. 

• Standard Subject and Category (Effects or Rationale) codes for proposed rules or 
policies. 

 

___________________________________________________________________________ 

[Project Name] 
Letter Attribution Codes 
Coders will identify organization type, number of signatures, response type and delivery type 
on all letters by filling in the proper box. Use CIC (Common Interest Class) field only if this 
information is requested by the Administration. Fill in additional fields when necessary. 

Header Order: MID, OT, S, and RT, and DT fields are required. IA, UT, LG, F, CIC, RI, 
and CE fields are optional fields and used only where necessary. The TS (Total Signatures) 
field will tally automatically in Oracle. A stamp containing these fields will be placed on the 
working copy. 
 

             
MID OT S RT DT IA UT LG F CIC RI CE TS 

MID FIELD - Mail Identification – required  

MID is a unique respondent number assigned in the CAT Oracle Program. The Oracle form 
contains mailing information needed to create mailing labels and also is needed to obtain 
project specific demographic information about a respondent.   
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OT FIELD - Organization Type - required 
The Organization Type code identifies a specific type of organization, association, agency, 
elected official or individual. The following are standard organization types: 

Government Agency/Elected Officials 
Code Description 
F Federal Agency/Elected Official 
N International Government/Association  
S State Government Agency/Elected Official/Association 
C County Government Agency/Elected Official/Association 
T Town/City Government Agency/Elected Official/Association 
Q Indian Country Government/Elected Official/Tribal Member/Assn 
 

Interest Group (includes legal representatives of interest groups) 

A Agriculture Industry or Associations (Farm Bureau) 
B Business (my/our (someone speaking for or as a business 

owner), chamber of commerce) 
D Place Based Group (homeowner’s associations, planning 

cooperatives, i.e. Quincy Library Group) 
E Government Employees/Union 
G Domestic Livestock Industry (incl. permittees) 
H Consultants/legal representatives 
I Individual (unaffiliated, unknown or unidentifiable) 
J Civic Group (Kiwanis, Elks, Community Councils) 
K Special Use Permittee (Rec. homes, Backcountry huts, 

Outfitter/Guides) 
L Timber or Wood Products Industry or Associations 
M Mining Industry/Association (locatable) 
O Oil, Natural Gas, Coal, or Pipeline Industry (leasable) 
P Preservation/Conservation 
R Recreational (motorized/non-motorized, conservation, non-

specific (-use this general code when client does not require the 
specific recreational organizations- see below) 

U Utility Group (water, electrical, gas) 
X Conservation District 
Y Other or unidentified Organization 
Z Multiple Use or Land Rights Organization 
 

Possible Optional Organization Codes (Project Specific) 

AD Academic (professor, research scientist, university department) 
AR Animal Rights (humane treatment org) 
BL BLM employee 
BI BIA employee 
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CF Commercial Fishing 
CH Church/Religious Group 
EO Extension Office (University) 
FS Forest Service Employee (analyzed separately) 
HT Hunting/trapping industry or Organization 
KS Special Use; Ski Industry (operators, management, interest 

group 
LO Private Land Owner 
MN Miners (unspecified) 
NP National Park Employee 
PA Professional Association/Society 
QQ Tribal Non-Governmental Organization/Member 
RB Mechanized Recreation (bicycling) 
RC Recreation/Conservation Organization (Trout Unlimited, Elk 

Foundation) 
RM Motorized Recreation (4X4, OHV, snowmobiling) 
RN Non-Motorized/Non-Mechanized Recreation (hiking, x-c ski, 

horse/stock animals) 
SF Small farms/farmers 
XX Regional/other governmental agency (multi-jurisdictional) 

Notes on Organization Type Identification: 
Letters from businesses are categorized as “B” only if you believe or they assert they are 
impacted by the decision, otherwise they are considered to be individual responses. A letter 
from a member of an organization is considered to be an individual response unless the 
author is writing on behalf of the organization.  
 
Letters from government employees submitted as personal are categorized as “I” rather than 
as codes F, N, S, C, T Q, which are reserved for official comments from an elected official or 
government agency or department. Letters from government employees submitted on 
government letterhead or via government email are considered to be internal comment, and 
are separated from public comment and analyzed separately. 

S FIELD - Signatures - required 
To determine the number of Signatures, look first at the signature itself.  If the 
correspondence is signed John Doe, but the return address says John and Jane Doe, count it 
as one signature, because it was signed by one person.  If the return address says John Doe, 
but is signed by John and Jane Doe, or Mr. and Mrs. Doe, count it as two signatures.  If no 
signature is present or response is anonymous, count it as one. If signed John Doe and 
Family, count it as one.   

RT FIELD - Response Type - required 

The Response Type identifies the specific format of the correspondence.  

 



Technical Guide 

E- 4 Appendix E ~ Coding Structure Templates 

Code Description 

1 Letter (postal service, express service, etc.) 
2 Form or Letter Generator 
3 Resolution 
4 Action Alert 
5 Transcript (dictated audio, video or telephone response) 
 

Optional RT codes (Project Specific) 

6 Public Meeting Comment Form 
7 Public Meeting Transcript (hearing/oral testimony) 
8 Public meeting/workshop group notes 
9 Workshop notes (other than at Public Meetings) 

10 Web-based comments (optional project specific) 
 11 Petition 

DT FIELD - Delivery Type – required 
The Delivery Type is the method by which the response is originally delivered. 

Code Description 

 E Email 
 F FAX 
 H Hand-delivered or oral testimony (personally delivered) 
 M US Mail or commercial carrier (UPS, FedEx) 
 T Telephone 
 U Unknown 

IA FIELD - Immediate Attention - Red Flags (place on LEFT side of copy) 

Immediate Attention codes are applied only to those documents requiring an immediate 
response from the team. The Immediate Attention codes are listed in order of priority. If 
more than one code applies to a single document, the code with the highest priority is 
attached. Fore example, if a State Congressman threatens bodily harm to a Forest Service 
representative, the letter would receive a “1” instead of a “6”. A red flag is attached to the left 
side of the page with the IA code written on it.  

Code Description 

1 Threat of harm  
2 Notice of appeal or litigation  
3 Freedom of Information Act request (FOIA)  
4 Provides proposals for new alternatives  
5 Requires detailed review 
6 Government entities  
7 Requests public hearing 
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Optional IA codes (Project Specific) 

5a Provides extensive technical edits – deletions/replacements  
5m Map(s) attached  
6a Requests cooperating agency status  

UT FIELD - User Type 

This is an optional project specific code. A User Type code defines the purpose for which an 
individual, organization, or agency uses public lands. User types vary depending on the 
project or client needs. Examples: 

 Code    Description 
A Area residents 
B Businesses and services 
K Bikers 
C Campers 
F Anglers 
H Hikers 
P Photographers 
W Non-motorized watercraft users 
R Rock climbers 
S Stock users 

LG FIELD - Letter Generator 

A Letter Generator is a response that enables respondents to extract specific text from a 
selection of prewritten comments. These responses are usually created through an interactive 
website that offers a selection of comments and allows the respondent to choose which 
paragraphs to include in their personal letter. Assign a consecutive LG number to these 
responses. Enter this number. 

F FIELD - Forms (Organized Response Campaigns) 
Forms or organized response campaign responses are identified when the mail processor 
receives 5 or more responses with identical or nearly identical text, or portions thereof, from 
different (unaffiliated) respondents. Enter the form number assigned by the team.   

CIC FIELD - Common Interest Class  
The Common Interest Classification codes are an optional. The code represents an effort to 
capture each respondent’s overall view on a proposal. The range of views on a project 
assumes an almost infinite number of values, as each respondent contributes something 
personal and subjective to the analysis. 
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CIC codes are not used as a voting procedure. However, CIC categories provide managers 
with an estimate of the respondent’s range of interests, including a range of management 
actions that respondents deem appropriate. CIC Roman numeral codes vary depending on the 
customer needs. 

Some examples of Common Interest Classifications are: 

Code Description 

0 No preference stated. Category O responses are requests for 
information or are requests to extend the comment period and contain 
no indication of position or preference. 

I Respondent favors a more restrictive combination of alternatives/policy 
options. This category includes all responses that claim the chosen 
alternatives do not offer strong enough protection to roadless areas.  
These responses may include suggestions for policies not discussed. 

II Respondent favors a less restrictive combination of alternatives/policy 
options. 

III This category includes most responses that convey a degree of 
support for the direction of the policy, but with specific exceptions. 

IV Respondent favors no action, a combination of alternatives, or general 
opposition to the plan. 

V Respondent favors the preferred combination of alternatives or 
expresses general support for the plan. 

RI FIELD - Requests for Information - Blue flag (place on LEFT side of 
copy) 

Requests for Information codes are applied only to those responses with specific requests 
for information pertaining to the proposal. The client determines the level of specificity for 
identifying information requests. A blue flag is attached to the left side of the page with the 
IR code written on it.  

Code Description 

A Mailing list only or nothing to code (do not attach a flag) 
B Request to be removed from mailing list (do not attach a flag) 
C Request copy of Federal Register Notice 
D Other request for specific information 
E Request for confirmation of receipt of letter 
 

Optional RI codes (project specific) 

F Request for hard copy of summary of the DEIS 
G Request for full hard copy of DEIS 
H Request for full CD version of DEIS 
I Request for hard copy of summary of FEIS 
J Request for full hard copy of FEIS 
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K Request for CD version of FEIS 
L Request for draft copy of proposed rule/policy 
M Request for final copy of rule/policy 
Ch Request for hard copy of Fed Register Notice of the Proposed Rule 
Cd Request for CD of Fed Register Notice of Proposed Rule 
Ce Request for electronic copy of Fed Register of Proposed Rule 

CE FIELD - Comment Extension - Yellow Flag (place on LEFT side of copy) 
Comment Extension codes are used when a respondent has a specific request for extending 
the comment period. 

Code Description 

   0  No specific time mentioned or other 
 15 Request for 15 Day comment period extension 
 30 Request for 30 Day comment period extension 
 45 Request for 45 Day comment period extension 
 60 Request for 60 Day comment period extension 
 90 Request for 90 Day comment period extension 
         120 Request for 120 Day comment period extension 

TS FIELD - Total Signatures  

The Oracle automated field totals all signatures for all MIDs assigned to a response. Do not 
enter any codes here. 
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Standard Coding Structure Template 
LAND AND RESOURCE MANAGEMENT PLANS 
 
Action Codes – Subject/Category 
 
PRCSS 10000-19999 

10000 Purpose and Need for Proposed Action 
10100  Desired Future Condition (management strategies) 
10200  Need for an EA or EIS 

10210 FINDING OF NO SIGNIFICANT IMPACT/CATEGORICAL 
EXCLUSION  

 
11000 Decisionmaking  

11100 Role/Authority 
11110 PRESIDENT/EXECUTIVE BRANCH 
11120 AGENCY 
11130 LEGISLATIVE BRANCH (CONGRESS) 
11140 JUDICIAL BRANCH (COURTS) 
11150 STATE, COUNTY, AND MUNICIPAL GOVERNMENTS 

11200 Role/influence of Interest Groups 
11210 ENVIRONMENTAL GROUPS 
11220 MULTIPLE USE/ WISE USE GROUPS 
11230 INDUSTRY/BUSINESS GROUPS 

11300 Role/influence of General Public  
11310 LOCAL CITIZENS/COMMUNITIES 
11320 NATIONWIDE CITIZENS/COMMUNITIES 

 
12000 Public Involvement 

12100 Adequacy/Availability of Information 
 

12200 Outreach/Agency Communication Efforts 
12210 PUBLIC EDUCATION 

12300 Use of Public Involvement/Comment 
12410 METHODOLOGY AND TECHNIQUES 

12400  Public Meetings 
12500  Adequacy of Comment Period 

12510 EXTENSION NEEDED 
12520 NO EXTENSION NEEDED 

12600  Adequacy of Entire Timeframe 
12700  Collaboration with Other Government Entities 

12710 TRIBAL OFFICIALS 
12720 OTHER FEDERAL AGENCIES 
12730 STATE OR LOCAL GOVERNMENTS/OFFICIALS 
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   13000 Relation to or Consistency with Other Plans, Directives, Etc. 
      13100 Agency Rules 
      13200 Rules of Other Agencies 

   
14000 Use of Science In Decisionmaking General 

14100 Best Available Science  
(for general comments about BAS, for specific resources, use that resource code) 

 
15000 Agency Organization and Funding 

15100 General Comments About The Agency 
15200 Funding, General 

15210 FUNDING FOR PLANNING PROCESS 
15220 FUNDING FOR IMPLEMENTATION OF PROPOSED ACTION 
15230 FEES 

15300 Staffing General 
15310 STAFF TRAINING, EDUCATION 

 
ALTER 20000-22999 

20000 Alternatives General 
20100 Alternative Development/Range 
20200 Alternatives Not Considered In Detail 
20300 Alternatives Developed by Others 

 
  21000 Specific Alternatives (list) 

21100 Alternative A 
21200 Alternative B 
etc. 

 
LEGAL 23000-25999 

23000 Relation to Laws, Act, Policies General 
23100 Constitution 
23200 Federal Laws, Acts, and Policies 

23210 NEPA 
23220 NFMA 
23230 OTHER 

23300        State Laws, Acts, and Policies 
 

TRIBL 26000-29999 
26000 Indian Country Rights and Interests General 

26100 Federal Trust Responsibilities 
26200 Tribal Government Issues 

 
27000 American Indian Use of Public Lands 

27100 Cultural Interests  
27200 Economic Interests 
27300 Spiritual Interests 
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ENVIR 30000-39999 
30000 Environmental Management General 

30100 Multiple Environmental Resources 
30200 Managing Ecosystem Integrity 
30300 Short-Term Vs. Long-Term Productivity/Risks 

 
31000 Physical Elements Management, General 

31100 Multiple Physical Resources Management 
31200 Soils and Geology 
31300 Water Resources 
31400 Air Quality 
31500 Noise 

     31600  Scenery and Visual Resources Management 
31700 Climate, Weather, and Atmospheric Processes 

 
32000 Biological Elements Management, General 

32100 Multiple Biological Resources 
32200 Biodiversity  
32300 Ecosystem/Habitat Composition and Function 

 
33000 Wildlife Management General 

33100 Wildlife Population Management 
33200 Terrestrial Wildlife and Habitat 
33300 Fisheries and Aquatic Wildlife 
33400 Species of Special Concern  
33500 Wildlife Structures (guzzlers, barriers) 

 
35000 Botanical Resources Management 
 35100  Mushrooms 
 35300  Medicinal Plants 

TRANS  40000-44999 
40000 Forest Transportation System Management (infrastructure)  
 40100  Roads analysis 
 
41000 Roads Infrastructure Management General  
(Use resource codes for specific use or type access) 

41100 Construction 
41200 Road Maintenance 
41300 Road /Removal/Decommissioning  
(Use recreation codes for use mgmt.& closures to use) 
41400 Bridges/culverts/stream crossings 
41500 Tank traps/gates/barriers 

42000 Trails Infrastructure Management General  
42100 Trails Construction 
42200 Trails Maintenance 
42300 Trails /Removal/Decommissioning  
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42400 Trail bridges/culverts/stream crossings 
43000 Motorized Routes 
44000 User-Created Roads and Trails 
45000 Structures 

45100 Road Signs and Safety Barriers 
46000 General/Multiple Access (Use resource codes for specific types of access) 
 

RECRE 45000-49999 
45000 Recreation Management General 

45100 Multiple Recreational Activities/Laundry Lists 
45200 Use of Volunteers 
45300 User Conflicts 

46000 Non-Commercial, Dispersed, Or Unspecified 
46100 Motorized Recreation and Access General 
46200 Mechanized Recreation 
46300 Non-Motorized, Non-Mechanized Recreation 
46400 Hunting and Fishing 
46500 Camping, Dispersed 
46600 Equestrian Recreation 
46700 Other 

 
47000 Developed Facilities, Commercial Use, Special Use Permits, and Fees  

47100 Campgrounds and Picnic Areas 
47200 Trailheads, Signage, and Parking 
47300 Fee Demonstration Project and User Fees 
47400 Outfitter-Guides 
47500 Ski Areas 

 
LANDS and SPECIAL DESIGNATIONS 50000-55999 

50000 Landownership  
50100 Lands Acquisition By Agency 
50200 Land Exchanges and Disposal 

50210 APPRAISALS AND VALUATION 
50300 Boundary Adjustments 

 
51000 Rights-of-Way (for utility rights of way, see utilities under NRMGT) 

51100 Rights-of-Way to Public Lands Across Private Property 
51200 Rights-of-Way to Private Property Across Public Lands 

 
53000 Special Land Designations General 

53100 Roadless Areas 
53110  INVENTORIES 
53120  IRAS AND WILDERNESS RECOMMENDATIONS  
(DO/DO NOT RECOMMEND) 

 
53200 Designated Wilderness 
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53300 Other Special Designations 
53310 WILD, SCENIC, AND RECREATIONAL RIVERS 
53320 SPECIAL INTEREST AREAS 
53330 RESEARCH NATURAL AREAS 

54000 Specific Management Prescriptions 
55000 Heritage and Cultural Resource Management 

 
NRMGT 60000-69999 

60000 Natural Resources Management General 
60010 COMPARATIVE VALUES OF DIFFERENT RESOURCES 

60100 Multiple Natural Resource/Management Activities 
60200 Guiding Management Philosophy 

60210 MULTIPLE USE MANAGEMENT 
60220 ECOSYSTEM MANAGEMENT 

60300 Adaptive Management 
       60310 MONITORING AND EVALUATION 

 
61000 Timber Resources Management 

61100 Allowable Sale Quantity 
61200 Harvest Methods 
61300 Alternatives to Wood Products 

 
62000 Forested Vegetation Management  

62100 Forest Structure/Mosaic 
      62110 Species Composition 
      62120 Age Composition 

 62121  LATE SUCCESSIONAL/OLD GROWTH 
 62122   EARLY SUCCESSIONAL 

       62130 Disturbance regimes  
           62140 Clearings and Canopy Openings 
62200 Non-Timber Wood Products 
       62210  Firewood 
        62220 Christmas Trees  

   
  63000 Forest Health Management 

63100 Noxious Weeds 
63200 Insects and Disease 
63300 Use of Pesticides and Herbicides 

 
64000 Fire Management 

64100 Wildland Fires 
64110  ACCESS FOR FIRE MANAGMENT 

64200 Role of Fire in Ecosystems 
64300 Fire Plans 
64400 Prescribed Fire 

64410 SMOKE MANAGEMENT 
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 64500 Mechanical Thinning 
 
65000 Domestic Livestock Management 

65100 Livestock Grazing 
65200 Fences, Water Troughs, Facilities 

 
66000 Mineral Resources Management 

66100 Leasable (Oil, Gas, Coal, Pipelines) 
66200 Locatable (Hardrock) 
66300 Salable (Gravel, Rock, Etc.) 
66400 Palentological Resources 

 
67000 Special Use Facilities Management 

67100 Communication Sites and Facilities 
67200 Hydroelectric Development 
67300 Utility Corridors 
67400  Utility Access and Rights-of-Way 
67500 Research and Educational Facilities 
67600 Military Structures and Facilities 

 
SOCIO  70000-79999 

70000 Social Values Management (Includes Socio-Economic General) 
70100 Demographics 
70200 Quality of Life 
70300 Public Health and Safety 
70400 Equity  

 
ECONO  80000-89999 

80000 Economic Values Management 
81000 Economic Contribution/Role of Agency-Administered Lands  

81100 International  
81200 U.S.  
81300 Local/Regional 
81400 Employment 
81500 Business Viability 
81600 Private Property Values 
81700 Tax Base and Payments To States 

 
82000 Net Public Benefit and Agency Accounting 

82100 Cost Benefit Analysis General 
82200 Non-Market Products and Services (Valuation/Externalities) 
82300 Commodities Valuation and Subsidies 

 
ATTMT 99999 

 
 



Technical Guide 

E- 14 Appendix E ~ Coding Structure Templates 

POSSIBLE OPTIONAL CODES 
Project specific. These add a level of complexity. Use only if requested. 
 
Theme Codes 

XX  Default, None Mentioned 
AA  Adequacy of Analysis (including adequacy of supporting 

data, use of best available data,  
  analysis of cumulative effects, etc.) 
IN  Inventories, Mapping, and GIS 
LE  Legal 
MM Monitoring and Mitigation 
EE  Education and Enforcement 
FU  Funding 
AL  Allow Activity 
PR  Prohibit/Restrict Activity 
ED  Editorial 

 
Site Specific Codes 

XXX.X.111    Road/Trail Numbers 
XX  Ranger Districts 
XX  Forests  
XX  Management Areas 

 
Specific Alternative Codes 

A  Alternative A 
B  Alternative B 
 Etc. 
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Category 2 Code –Rationale or affected resource  
This code is used to indicate either the reason for the management action requested  
or the resource that would be affected.  

000 – No affected resource/reason 

010 – Persons and Groups  
 020 – Government 
  022 – President/Executive Branch 
  024 – Agency (Forest Service) 
  025 – Specific National Forest 
  026 – Other Agencies 
  027 – Legislative Branch (Congress) 
  028 – Judicial Branch (Courts) 
  030 – State, County, and Municipal Governments 
  032 – Indian Country 
 040 – Interest Groups 
  042 – Environmental Groups 
  044 – Multiple Use/ Wise Use Groups 
  045 – Recreation Groups 
  046 – Industry/Business Groups (econ. issues to 900+) 
  048 – Political Parties 
 050 – General Public 
  052 – Local Citizens/Communities 
  054 – Nationwide Citizens/Communities 

060 – Laws, policies 

 061 – Democracy (as affected by…) 
 062 – Federal, General/Multiple 
  064 – Constitution 
  066 – Federalism, States’ Rights 
  067 – Individual Rights, Public Owns Fed Lands 
  068 – General Welfare, Public Good, Public Interest 
        070 – Federal Laws 
  071 – NEPA 
  072 – NFMA 
  078 – Court decisions (past or pending) 
 080 – Indian Country Treaties 
 084 – Agency Rules, Plans, etc. 
  086 – This Plan 
 090 – Rules, Plans, etc. of Other Federal Agencies 
 092 – State Rules, Plans, etc.  
 094 – County or Municipal Policies, Plans, Etc. 
 
100 – Resources, General/Multiple (Three+: Envir, Recre, Socio, Econo) 
 (Use the following with “Comparative Weighting” Action code): 
 122 – Environment / Environment 
 127 – Environment / Social 
 128 – Environment / Recreation 
 129 – Environment / Economic 
 177 – Social / Social 
 178 – Social / Recreation 
 179 – Social / Economic 
 188 – Recreation / Recreation 
 189 – Recreation / Economic 
 199 – Economic / Economic 
 
200 – Natural Environment, General/Multiple  
 204 – Environmental Quality and Ecosystem Integrity 
 206 – Inherent worth of the environment  
  (apart from human benefits/use/enjoyment/need) 
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210 – Physical Elements, General/Multiple 
 220 – Soils and Geology 
  222 – Soil (Productivity, Disturbance, Erosion) 
  226 – Cave Resources 
  228 – Minerals 
  230 – Paleontological Resources 
 240 – Water Resources 
  242 – Surface Water 
  244 – Groundwater 
  246 – Riparian Areas and Wetlands 
  248 – Water Quantity 
  250 – Water Quality 
  252 – Watershed Condition 
  
 270 – Air Quality 
 280 – Climate, Weather, and Atmospheric Processes 
 
300 – Biological Elements General/Multiple Biological Resources 
 310 – Biodiversity, Extinctions 
 312 – Genetic Diversity 
 314 – Ecosystem/Habitat Composition and Function 
 316 – Fragmentation, Perforation, and Connectivity 
 318 – Disturbance Regimes 
 320 – Habitat/Vegetation Composition 
  321 – Snags 
  322 – Downed Woody Debris 
  323 – Forest Structure/Mosaic 
  324 – Species Composition 
  325 – Age Composition 
  326 – Early Successional 
  327 – Late Successional, Old Growth 
  328 – Clearings and Canopy Openings 
  
 330 – Wildlife General 
  332 – Species of Special Concern, General/Multiple 
   334 – Threatened, Endangered, Proposed, Sensitive 
   336 – Species XX 
   338 – Species YY 
   340 – Regional Forester Sensitive Species   
   342 – State or Local Listed/Rare 
   350 – Management Indicator Species 
   352 – Species ZZ  
  360 – Terrestrial Wildlife 
   364 – Terrestrial Game Species  
  366 – Birds 
  368 – Insects and Other Invertebrates  
  370 – Aquatic Wildlife 
   372 – Fisheries 
 
370 – Vegetation, General/Multiple 
  372 – Mushrooms 
  374 – Medicinal Plants 
  376 – Noxious or non-native plants 
 
400 – Public and Private Lands  
 410 – National Forest System Lands 
 412 – Designated Areas 
  413 – Wilderness 
  414 – Roadless Areas 
  416 - Wild and Scenic River 
 420 – Rights-of-Way to or through lands 
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 430 – Road and Trail Beds 
 440 – General Access 
450 – Recreational Uses 
 452 – User Conflicts 
 454 – Value to Individuals, Families, Seniors, Disabled, etc. 
 460 – Motorized Recreation General 
  462 – Summer or Year-Round 
   464 – Motorboats, personal watercraft 
   466– Winter 
 470 – Mechanized Recreation 
 
480 – Non-Motorized, Non-Mechanized 
  481 – Hiking, Backpacking 
  482 – Skiing, Backcountry/Cross-Country 
  483 – Hunting and Fishing 
  484 – Camping, Dispersed 
  485 – Equestrian 
  486 – Canoeing, kayaking, rafting, swimming 
 490 – Outfitters, Guides 
 492 – Ski Areas 
 
600 – Natural Resources 
 602 – Timber Resources 
 604 – Non-timber Veg Resources 
 610 – Forest Health 
  612 – Insects and Disease 
  614 – Fire 
 616 – Range and Livestock 
 620 – Mineral Resources 
 622 – Facilities and Infrastructure 
  624 – Communication Sites and Facilities 
  626 – Hydroelectric Development 
  628 – Utility Strucutres and Corridors 
  630 – Research and Educational Facilities 
  632 – Military Structures, Facilities, Operations 
   
700 – Social Conditions/Values General (Including Socio-Economic) 
 710 – Quality of Life (tradition, traditional way of life) 
  712 – Indian Country 
  714 – Spiritual Values, Solitude 
  716 – Scenery, Visual Resources 
  718 – Noise 
 
 
  720 – Health and Safety 
 730 – Anthropological Heritage and Cultural Resources  
  (not “the environment is America’s heritage…”) 
 740 – Private Property 
 750 – Equity, Justice 
  752 – Future Generations, Legacy Values 
  754 – Environmental Justice 

 756 – Class and Income Equity 
  758 – International: Transfer of Effects or Role Model 
 770 – Demographics 
  772 – Population, Community Structure and Stability 
  776 – Urbanization and Development 
  
800 – Economic Conditions and Values, General/Multiple 
 810 – Economic Role of Agency-Administered Lands/Resources 
  812 – International  
  814 – US 
  816 – Tribal 
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  818 – State/Regional/Local 
  820 – Employment/Jobs 
  822 – Property Values 
  824 – Tax Base and Payments to States, Counties, etc. 
 840 – Business Viability, Profits, Profit Motive 
  842 – Tourism 
  844 – Timber 
  846 – Agriculture, Livestock 
  848 – Mining, Oil 
 860 – Net Public Benefit and Agency Accounting 
  864 – Non-Market Products/Services/Costs/Externalities) 
  866 – Tax Dollars
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STANDARD CODING STRUCTURE TEMPLATE  
FOR RULES OR POLICIES 

 
Primary Codes – Subject/Category 
 
PLANN 10000-19999 

10000 Purpose and Need for Proposed Action 
 10100  Implement rule/policy because 
 10200  Do not implement rule/policy because 
 10300  Alternatives to the rule/policy 
11000 Decisionmaking  

11100 Role/Authority 
11110 PRESIDENT/EXECUTIVE BRANCH 
11120 USDA/FOREST SERVICE 
11130 LEGISLATIVE BRANCH (CONGRESS) 
11140 JUDICIAL BRANCH (COURTS) 
11150 STATE, COUNTY, AND MUNICIPAL GOVERNMENTS 

11200 Role/influence of Interest Groups 
11210 ENVIRONMENTAL GROUPS 
11220 MULTIPLE USE/ WISE USE GROUPS 
11230 INDUSTRY/BUSINESS GROUPS 

11300 Role/influence of General Public  
11310 LOCAL CITIZENS/COMMUNITIES 
11320 NATIONWIDE CITIZENS/COMMUNITIES 

 
12000 Public Involvement 

12100 Adequacy/Availability of Information 
12200 Outreach/Agency Communication Efforts 
12300  Educate the Public 
12400 Use of Public Involvement/Comment 

12410 METHODOLOGY AND TECHNIQUES 
12500 Public Meetings 
12600 Adequacy of Comment Period 

12610 EXTENSION NEEDED 
12620 NO EXTENSION NEEDED 

12700 Adequacy of Entire Timeframe 
    
13000 Collaboration with Other Government Entities 
 13100  Tribal Agencies or Officials 
 13200  Other Federal Agencies or Elected Officials 
 13300  State Agencies or Elected Officials 
 13400  County and Municipal Agencies or Elected Officials 

   
14000 Relation to Laws, Act, Policies General 

14100 Constitution 
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14200 Federal Laws, Acts, and Policies 
14210 NEPA 
14220 NFMA 
14230 OTHER 

                          14300        STATE LAWS, ACTS, AND POLICIES 
 

15000 Use of Science in Decisionmaking General 
15100 Best Available Science 

 
16000 Agency Organization and Funding 

16100 General Comments about the Agency 
16200 Funding, General 

16210 FUNDING FOR PLANNING PROCESS 
16220 FUNDING FOR IMPLEMENTATION OF PROPOSED ACTION 

16300 Staffing General 
16310 STAFF TRAINING, EDUCATION 

 
SECTN 20000-29999 
Rule/Policy Sections (list) 

 20000   Section XXX.xx – Definitions 
  20100  Section XXX.xxx 
  20200     ETC 

  
25000 Regulatory Impacts 

25100   Regulatory Environmental Impacts 
25200 Impacts on Energy Production 
25300 Controlling Paperwork Burdens 
25400 Federalism 
25500  Consultation with Tribal Governments 
25600 Takings Implications 
25700 Civil Justice Reform 
25800 Unfunded Mandates 

 
 

ENVIR 30000-39999 
30000 Environmental Values General 

30100 Multiple Environmental Resources 
30200 Environmental Quality and Ecosystem Integrity 
30300 Short-Term Vs. Long-Term Productivity/Risks 

 
31000 Physical Elements, General 

31100 Physical Resources 
31200 Soils and Geology 
31300 Water Resources 
31400 Climate, Weather, and Atmospheric Processes 
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32000 Biological Elements, General 
32100 Multiple Biological Resources 
32200 Biodiversity  
32300 Ecosystem/Habitat Composition and Function 

 
33000 Wildlife  
34000 Vegetation 
 34100  Botanical Resources 

 
TRANS  40000-44999 

40000 Forest Transportation System General (infrastructure) 
41000 Roads Infrastructure Management General  

 42000 Trails Infrastructure Management General  
 43000 User-Created Roads and Trails 

 
RECRE 45000-49999 

45000 Recreation Management General 
46000 Non-Commercial, Dispersed, or Unspecified 
47000 Developed Facilities, Commercial Use, Special Use Permits, and Fees 

General 
 

LANDS 50000-52999 
50000 Landownership General 

50100 Lands Acquisition by Agency 
50200 Land Exchanges and Disposal 

50210 APPRAISALS AND VALUATION 
51000 Rights-of-Way General 

51100 Rights-of-Way to Public Lands across Private Property 
51200 Rights-of-Way to Private Property across Public Lands 

 

SPECL 53000-55999 
53000 Special Designations General 

53100 Roadless Areas 
53200 Designated Wilderness 
53300 Other Special Designations 

54000 Heritage and Cultural Resource Management 
 
NRMGT 60000-69999 

60000 Natural Resources Management General 
60100 Multiple Natural Resource/Management Activities 
60200 Guiding Management Philosophy 
60300 Adaptive Management 

 60310  MONITORING AND EVALUATION 
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61000 Timber Resource Management 
61100 Allowable Sale Quantity 
61200 Harvest Methods 
61300 Commercial Timber Sale/Harvest 

62000 Other Forest Products 
63000 Domestic Livestock Management 
64000 Fire Management 
65000 Forest Health Management 
66000 Mineral Resources 
67000 Utility Facilities 
68000 Research and Educational Facilities 

 
SOCIO  70000-72999 

70000 Social Values General (Includes Socio-Economic General) 
70100 Demographics 
70200 Quality of Life 
70300 Public Health and Safety 
70400 Equity  

 
75000 Tribal Rights and Interests General 

 75100 Federal Trust Responsibilities 
 75200 Tribal Government Issues 

 75300 American Indian Use of Public Lands 
 75400 Cultural Interests  
 75500 Economic Interests 
 75600 Spiritual Interests 
 
ECONO  80000-89999 

80000 Economic Values General 
81000 Economic Contribution/Role of Agency-Administered Lands  

81100 International  
81200 U.S.  
81300 Local/Regional 
81400 Employment 
81500 Business Viability 
81600 Private Property Values 
81700 Tax Base and Payments to States 

85000 Net Public Benefit and Agency Accounting 
85100 Cost Benefit Analysis General 
85200 Non-Market Products and Services (Valuation/Externalities) 
85300 Commodities Valuation and Subsidies 

ATTMT 99999  
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Category 2 Code –Rationale or affected resource  
This code is used to indicate either the reason for the management action requested  
or the resource that would be affected.  

000 – No affected resource/reason 

010 – Persons and Groups  
 020 – Government 
  022 – President/Executive Branch 
  024 – Agency (Forest Service) 
  025 – Specific National Forest 
  026 – Other Agencies 
  027 – Legislative Branch (Congress) 
  028 – Judicial Branch (Courts) 
  030 – State, County, and Municipal Governments 
  032 – Indian Country 
 040 – Interest Groups 
  042 – Environmental Groups 
  044 – Multiple Use/ Wise Use Groups 
  045 – Recreation Groups 
  046 – Industry/Business Groups (econ. issues to 900+) 
  048 – Political Parties 
 050 – General Public 
  052 – Local Citizens/Communities 
  054 – Nationwide Citizens/Communities 

060 – Laws, policies 

 061 – Democracy (as affected by…) 
 062 – Federal, General/Multiple 
  064 – Constitution 
  066 – Federalism, States’ Rights 
  067 – Individual Rights, Public Owns Fed Lands 
  068 – General Welfare, Public Good, Public Interest 
        070 – Federal Laws 
  071 – NEPA 
  072 – NFMA 
  078 – Court decisions (past or pending) 
 080 – Indian Country Treaties 
 084 – Agency Rules, Plans, etc. 
  086 – This Policy/Rule 
 090 – Rules, Plans, etc. of Other Federal Agencies 
 092 – Rules, Plans, etc. of States 
 094 – County or Municipal Policies, Plans, Etc. 
 
100 – Resources, General 
 
200 – Natural Environment, General/Multiple  
 204 – Environmental Quality and Ecosystem Integrity 
 206 – Inherent worth of the environment  
  (apart from human benefits/use/enjoyment/need) 
 
210 – Physical Elements, General/Multiple 
 220 – Soils and Geology   
 240 – Water Resources  
 270 – Air Quality 
 280 – Climate, Weather, and Atmospheric Processes 
 
300 – Biological Elements General/Multiple Biological Resources 
 310 – Biodiversity, Extinctions 
 312 – Genetic Diversity 
 314 – Ecosystem/Habitat Composition and Function 
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 316 – Fragmentation, Perforation, and Connectivity 
 318 – Disturbance Regimes 
 320 – Habitat/Vegetation Composition   
 330 – Wildlife General 
 340 – Species of Concern 
 370 – Vegetation, General 
  
400 – Public and Private Lands  
 410 – National Forest System Lands 
 412 – Designated Areas 
 420 – Rights-of-Way to or through lands 
 430 – General Access 
 
450 – Recreational Uses 
  
600 – Natural Resources 
 602 – Timber Resources 
 604 – Non-timber Veg Resources 
 610 – Forest Health 
 616 – Range and Livestock 
 620 – Mineral Resources 
 622 – Facilities and Infrastructure 
   
700 – Social Conditions/Values General (Including Socio-Economic) 
 710 – Quality of Life (tradition, traditional way of life) 
 712 – American Indian Values/Uses 
 714 – Spiritual Values, Solitude 
 716 – Scenery, Visual Resources 
           718 – Noise 
 720 – Health and Safety 
 730 – Anthropological Heritage and Cultural Resources  
  750 – Equity, Justice 
  752 – Future Generations, Legacy Values 
  754 – Environmental Justice 

 756 – Class and Income Equity 
  758 – International: Transfer of Effects or Role Model 
 770 – Demographics 
  772 – Population, Community Structure and Stability 
  776 – Urbanization and Development 
  
800 – Economic Conditions and Values, General/Multiple 
 810 – Economic Role of Agency-Administered Lands/Resources 
  812 – International  
  814 – US 
  816 – Tribal 
  818 – State/Regional/Local 
  820 – Employment/Jobs 
  822 – Property Values 
  824 – Tax Base and Payments to States, Counties, etc. 
 840 – Business Viability, Profits, Profit Motive 
  860 – Net Public Benefit and Agency Accounting 
  864 – Non-Market Products/Services/Costs/Externalities) 
  866 – Tax Dollars
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 [Project Title] 
Early Attention Report 

The following report consists of early attention letters received through [date]. Included in the 
report are [sample-two letters requesting public hearings]. 

This report is intended primarily for an internal audience. The relevant designations are outlined 
below and followed by the report tables. 

1 Threat of harm – Any response that threatens physical harm to project or agency personnel. 

2 Notice of appeal or litigation – Any response that describes respondent’s intent to appeal 
an action or bring legal suit to bear on the agency.  

3 Freedom of Information Act (FOIA) – Any response that officially requests information 
and documentation under the FOIA. 

4 Proposals for new alternatives – Any response that suggests new alternatives to the 
proposed action. These do not include critiques of alternatives or partial changes of existing 
alternative. 

5 Requires detailed review – Any response that requires further review by the client. Well-
written analyses of the issues may need to be reviewed by the client. Response may include 
enclosures that need to be reviewed by the client. 

5a Provides extensive technical edits (deletions/replacements) – Any response that includes 
extensive use of lined out text, suggestions to delete text, and/or replace text. 

5m Provides maps – Any response that includes map enclosures. 

6 Government entities – Any response from an elected official, writing in his/her official 
capacity, from federal, tribal, state, county, or municipal governments; or any official 
correspondence from a government agency. 

6a Cooperating agency status – Any response that requests cooperating agency status. 

7 Public hearing – Any response that requests a public hearing. 
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Table 1 Early Attention Letters Code 1 – Threat of harm 

There were no early attention letters containing a threat of harm.  
Letter 
Number 

Name and Address Comment 

   

Table 2 Early Attention Letters Code 2 – Notice of appeal or litigation 

There was one early attention letters containing notice of appeal or litigation.  
Letter 
Number 

Name and Address Comment 

2145 Rocky Mountain Foundation 
1511 W. Water Street 
Denver, CO  84118 

Respondent notes that this proposal failed to adequately 
address cumulative effects. States that they intend to 
initiate legal action to enjoin the policy. 

Table 3 Early Attention Letters Code 3 – Freedom of Information Act (FOIA) 

There were no early attention letters dealing with the Freedom of Information Act or requesting 
information or material filed under FOIA. 
Letter 
Number 

Name and Address Comment 

   

Table 4 Early Attention Letters Code 4 – Proposal for a New Alternative 

There were no early attention letters containing a proposal for a new alternative.  
Letter 
Number 

Name and Address Comment 

   

Table 5 Early Attention Letters Code 5 – Requires Detailed Review 

There were two early attention letters requiring a detailed review.  
Letter 
Number 

Name and Address Comment 

 RT 5671 Nicole Whittington-Evans 
Assistant Regional Director 
The Wilderness Society 
 

Opposes exempting the Tongass National Forest from 
the Roadless Area Conservation Rule and asserts that 
the Forest Service has not adequately justified the 
proposal. Disagrees with the State of Alaska’s assertion 
that the Rule violates the Alaska National Interest 
Conservation Act regarding the “no more” clause 
contained therein. Suggests that the State’s assertions 
are not legitimate and that the Administration is using 
the State’s settlement to benefit the timber industry at 
the expense of the forests’ scenic and ecological values. 
Disagrees with the Forest Service’s decision not to 
support the Rule, which it contends was based on sound, 
science and economics, and unprecedented public input. 
States that the Advanced Notice of Proposed 
Rulemaking was predecisional in exempting the 
Tongass and Chugach and disagrees with the affects of 
the exemptions as stated. Contents that public support of 
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the Rule, including protection of the Tongass and 
Chugach roadless areas, is strong both within Alaska 
and in the rest of the country. States that protection of 
roadless areas on the Tongass makes better fiscal sense 
than logging due to below-cost timber sales, dollars 
spent to create direct timber jobs, and the transition in 
Alaska away from timber dependence. States that the 
Forest Service is not obligated under the Tongass 
Timber Reform Act to log roadless areas on the forest, 
that the Tongass and Chugach are the “crown jewels” of 
the National Forest System and deserve roadless area 
protection, that the Tongass forest plan does not 
adequately protect wildlife habitat, and that the Forest 
Service must complete a new environmental impact 
statement to consider exempting the Tongass and 
Chugach from the Rule. 

Table 6 Early Attention Letters Code 5a – Provides extensive technical edits, 
deletions/replacements 

There were no early attention letters providing extensive technical edits, deletions/replacements.  
Letter 
Number 

Name and Address Comment 

   

Table 7 Early Attention Letters Code 5m – Map(s) Attached 

There were no early attention letters with maps attached.  
Letter 
Number 

Name and Address Comment 

Table 8 Early Attention Letters Code 6 – Government or Tribal Entity 

There were 12 early attention letters from government entities. These entities include federal, 
tribal, state, county, and local agencies, elected officials, and organizations. 
Letter 
Number 

Name and Address Comment 

RT 1117 Jay Inslee et al. 
(88 Representatives’ signatures) 
United States Congress 
Washington, D.C. 

Suggests that the Administration is attempting to 
dismantle and undermine the Roadless Area 
Conservation Rule by proposing to exempt the Tongass 
National Forest and by jeopardizing the status of the 
Chugach National Forest. Comments on the value of the 
land area in question as the last remaining old-growth. 
Expresses concern that the Administration’s actions are 
contrary to the wishes of the American people and that a 
court ruling upheld the decision. 

RT 1673 Tom Osborne 
Representative 
United States Congress 
507 Cannon House Office Building 
Washington, D.C.  

Briefly summarizes the existing status of the Roadless 
Area Conservation Rule for national forests. States that, 
after much discussion, modification to the Rule includes 
a proposal to allow State governors to request 
exemptions and that the Tongass National Forest would 
be excluded and a special rule proposed. Mentions 
Representative Inslee’s resolution introduced on June 5, 
2003 and advises that the author will consider 
comments. 
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RT 6645 Anne Norton Miller 
Director 
Office of Federal Activities 
United States Environmental 
Protection Agency 
Washington, D.C. 20460 

States that inventoried roadless areas contain important 
environmental values that warrant protection and that 
permanent exemption from the Roadless Area 
Conservation Rule would result in using the current land 
management plans for management of the Tongass and 
Chugach National Forests. Maintains the importance of 
adequate resources available for monitoring and 
evaluation to ensure that the measures in the Tongass 
forest plan are effective. Believes that the approach in 
the Advanced Notice of Proposed Rulemaking (July 15, 
2003) should ensure that the ecological values of the 
inventories roadless areas on the Tongass and Chugach 
National Forests are fully protected. 

RT 2415 
duplicate 
RT 4179 

Victor Wellington Sr. 
Mayor 
Council Annette Islands Reserve 
Metlakatla Indian Community 
P.O. Box 8 
Metlakatla, AK 99926 

Supports a proposal to exempt the Tongass National 
Forest from the Roadless Area Conservation Rule. 
Believes the Rule is misguided and that local 
communities that are already economically and socially 
compromised community would suffer additional 
substantial direct negative effects if the Tongass is not 
exempted. 

RT 2574 Don Hoff Jr., aka Aan Kadax Tseen 
Clan leader, Gunnax a di clan 
Raven house (Yeil hit) 
Tongass Tribe (Taan da Kwaan) 
Raven4Eagle@aol.com 

Provides a brief history of the Tongass Tribe and 
ancestral territories. Opposes any exemptions to the 
Roadless Area Conservation Rule on the Tongass 
National Forest. Opposes the proposed bridge project to 
Gravina Island via Pennock Island. 

RT 2977 Frank H. Murkowski 
Governor 
State of Alaska 
P.O. Box 110001 
Juneau, AK 99811-0001 

Supports a permanent exemption from the Roadless 
Area Conservation Rule for both of Alaska’s national 
forests and the temporary exemption of the Tongass 
National Forest until a permanent rule exempting it and 
the Chugach National Forest is established. States that 
application of the Rule would dictate management of a 
significant percentage of acres on both forests as 
wilderness and would prevent development of 
community infrastructure thus, having long-term 
negative social and economic consequences. Believes 
that the forest planning process is the proper tool to use 
to decide how to manage these forests. 

RT 5673 Galen Fox  
State Representative, District 23 
State of Hawaii 

Requests protection for roadless wilderness areas in 
Alaska. 

RT 1203 Larry Phillips 
Council member, District 4 
Metropolitan King County Council 
King County Courthouse 
516 Third Avenue, Room 1200 
Seattle, WA 98104-3272 
Larry.phillips@metrokc.gov 

Supports the Roadless Area Conservation Rule as 
issued. Opposes the proposed exemptions of the 
Tongass and Chugach National Forests. States that the 
Rule is a landmark conservation policy with the 
overwhelming support of the American people. 
Suggests that amending or rewriting the Rule is contrary 
to the will of the American people. 

RT 6107 Garrett Ous 
Land Commissioner 
Itasca County Land Department 
123 N.E. 4th Street 
Grand Rapids, MN 55744-2600 
 

Supports the proposed rulemaking to permanently 
exempt the Tongass and Chugach National Forests from 
the Roadless Area Conservation Rule. States that 
application of the Rule on these forests would have 
long-term social and economic impacts, that it violates a 
number of Federal statues, and that it threatens 
legitimate multiple use activities. Suggests that existing 
management plans on the Tongass and Chugach should 
focus on preserving forests and prohibiting logging.  
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RT 582 Sally Smith 
Mayor 
City of Juneau 
155 So. Seward Street 
Juneau, AK 99801-1397 
Sally_Smith@ci.juneau.ak.us 
 

Supports the exemption of the Tongass National Forest 
from the Roadless Area Conservation Rule. States that 
such a policy on the massive land area of the Tongass 
affects the region’s ability to have a sustainable 
economy. Believes that the Tongass Land Management 
Plan is sufficient to protect and preserve the wild 
character of the Tongass. Suggests that passage of 
Alaska Native Claims Settlement Act concluded land 
withdrawals on the Tongass. 

RT 664 David Wallen 
Mayor 
City of Port Alexander 
P.O. Box 8068 
Port Alexander, AK 99836-8068 

Supports the inclusion of the Tongass National Forest in 
the Roadless Area Conservation Rule to ensure a 
healthy, intact ecosystem that supports subsistence, 
fishing, and tourism. Suggests that the Forest Service 
should remember the support expressed by the public 
for no more roads in roadless areas, including the 
Tongass, and that the cost of new road building in 
pristine areas is high. 

RT 1674 Theodore A. Smith 
Mayor 
City of Petersburg 
P.O. Box 329 
Petersburg, AK 99833 

Considers the action to exempt the Tongass National 
Forest from the Roadless Area Conservation Rule a 
single-purpose study and agrees with the State’s 
position that the Alaska National Interest Lands 
Conservation Act prohibits such studies. States that 
timber harvest on the Tongass meets the standards and 
guidelines as established in the land management plan 
and that additional regulations restricting activities 
would inhibit the timber industry’s ability to globally 
compete.  

Table 9 Early Attention Letters Code 6a – Request for Cooperating Agency Status 

There were two early attention letters requesting cooperating agency status. 
Letter 
Number 

Name and Address Comment 

RT 6108 Patrick J. Crank , WY Atty. General 
Ken Salazar, CO Atty. General 
Wayne Stenehjem, ND Atty. 
General 
Gregg Renkes, AK Atty. General 
Lawrence Wasden, ID Atty. General 
Mark Shurtleff, UT Atty. General 
Office of the Atty. General 
123 Capitol Building 
Cheyenne, WY 82002 

Support Judge Brimmer’s decision on the Roadless 
Area Conservation Rule. Suggest that the Forest Service 
must assess roadless areas in forest plans and that the 
public and the Western States were not allowed 
sufficient time or input before the Clinton 
Administration’s decision. 

RT 7636 Willie R. Taylor 
Director 
Office of Environmental Policy and 
Compliance 
United States Department of the 
Interior 
Washington, D.C. 20240 

States that the Fish and Wildlife Service (FWS) would 
like to work with the Forest Service in the management 
of the Tongass and Chugach National Forest as 
concerns protections under the Endangered Species Act. 
Comments that the Department is pleased with the 
involvement that the FWS has had regarding the 
planning process on the Chugach. Expresses concern 
about the effect that management actions might have 
regarding section 810 of the Alaska National Interest 
Lands Conservation Act compliance on Sitka black-
tailed deer and their harvest by subsistence users. 
Suggests that biologists should evaluate, analyze, and 
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develop a research course to gain a better understanding 
about the issue and that consideration of deer habitat 
needs and subsistence use be incorporated into future 
land management decisions on the Tongass. Species of 
Concern list provides as an enclosure. 

 

Table 10 Early Attention Letters Code 7 – Request for Public Hearing 

Letter 
Number 

Name and 
Address 

Remarks 

314 LastName, FirstName 
Address 
City, ST Zip 

Requests public hearing in the future south of Wasau. 
They state that meetings should be held in communities 
with high populations, namely Madison, Milwaukee, 
and Chicago. 

372 LastName, FirstName  Requests public hearing in LaCrosse, WI. 



Report Title  

Information and Comment Extension Request Interim Report Example 
 

[Project Name] 
Requests for Information and/or Comment Period Interim Report 

Specific requests for additional information, excluding Freedom of Information Act requests, are 
displayed in the table below. Included in the report are five requests for additional information 
and two requests for an additional comment period. 

Requests for Specific Information  

Letter 
Number 

Name and 
Address 

Remarks 

323 LastName, FirstName 
Organization  
City, State 00000 

Requests a winter comment period, stating that the 
current comment period falls during the 
snowmobiling off-season. 

325 LastName, FirstName 
Organization  
City, State 00000 

Requests conformation of receipt of letter. 

334 LastName, FirstName 
Organization  
City, State 00000 

Requests a winter comment period, stating that the 
current comment period falls during the 
snowmobiling off-season. 

390 LastName, FirstName 
Organization  
City, State 00000 

Requests hard copy of DEIS before the close of 
comment period. 

461 LastName, FirstName 
Organization  
City, State 00000 

Requests a hard copy of the final forest plan upon 
completion. 

500 LastName, FirstName 
Organization  
City, State 00000 

Requests that FS maps be corrected to demonstrate 
that Forest Service Road 2864 ends on the 
respondent’s landline. Currently the map shows 
that the road crosses his property line. He states 
that members of the public frequently trespass and 
have cut locks off of his gate. 

833 LN, FN Requests to be removed from the mailing list. 
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36 CFR Part 219 – National Forest System 
Land and Resource Management Planning; 
Proposed Rules 
Planning 
PLANN 
10000  Planning rules, general 

10100  SHOULD implement the rule 
10200  SHOULD NOT implement the rule 
10300  Organization and structure of the proposed rules 

10310  Adequacy of planning documents  
10320  Clarity of planning documents 

10400  Need for EA/EIS in development the proposed rules 
10500  General concerns  

10510  Environmental 
10520  Resource Extraction 
10530  Recreation 
10540  Multiple Use 

 

11000  Decision-making authority, general 
11100  Role/authority (including trust and integrity comments) 

11110  President/Current administration 
11120  USDA/Forest Service 
11130  Legislative Branch 
11140  Judicial Branch 
11150  Regional  
11160  State Governments 
11170  County/City Governments 

11200  Role of Interest Groups 
11210  Environmental groups 
11220  Multiple Use/Wise Use groups 
11230  Industry/Business groups 

11300  Role of General Public 
11310  Local Citizens 
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11320  Nationwide citizens/communities 
 

12000  Public involvement for the proposed rule, general 
12100  Adequacy/availability of information 

12110  Federal Register notice 
12120  Timeliness of notice (date of release, released with other plans) 

12200  Outreach/agency communication efforts 
12210  Clarity/comprehensibility 
12220  Website/E-mail 

12300  Use of public involvement/comment (specific to public comment on the proposed 
rule, see 219.19(a), OBJEC regarding public comment and objection) 

12310  Public comment analysis 
12400  Public meetings 

12410  Diversity Workshop 
12500  Adequacy of comment period 

12510  Extension needed 
12600  Adequacy of timeframe 
12700  Collaboration 

 

13000  Agency organization and funding, general 
13100  General comments about the USFS (planning) 
13200  Funding, general 
13300  Funding for the planning process 
13400  Staffing, general 
13500  Staff Training, education 
13600  Use of Science in decision-making  

13610  Relationship and authority of COS (Committee of Scientists) 
 

14000  Preamble, general (try to code to applicable section of proposed rule) 
14100  Language of Preamble 
14200  Implementation (problems with implementability of the 2000 Rule) 

14210  Funding 
14220  Other 

14300  Comparison between proposed rule and 1982 or 2000 rule 
 

15000  Regulatory Certifications, general 
15100  Regulatory Impacts 
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15200  Environmental Impacts 
15300  Energy Effects 
15400  Controlling Paperwork Burdens on the Public 
15500  Federalism 
15600  Consultation with Tribal Governments 
15700  No Takings Implications 
15800  Civil Justice Reform 
15900  Unfunded Mandates 

PURPO 

16000  219.1 Purpose and applicability (general comments on FS purpose, future 
direction, etc) 

16100  (a) (NFMA) National Forest Management Act  
16200  (b) (MUSYA) Multiple-Use to Sustained-Yield Act 

SCOPE 
17000  219.2 Nature and Scope of a land and resource management plan 

17100  (a) Fundamental Purpose of a plan  
17110  FS Stewardship 
17120  FS Mission  

17200  (b) Requirements (see following for specific requirements for planning process) 
17210  (1) Must address issues at appropriate time frames and geographic scales, use of 

best science, etc 
17220  (2) Must conducted using interdisciplinary, collaborative approach 
17230  (3) Must consult with States and local governments, Federal agencies, federally 

recognized Indian Tribes 
17240  (4) Must provide opportunities for the public, both organizations and individuals 
17250  (5) Must provide for uses, benefits, products, services, and visitor opportunities 

that are consistent with the multiple use objects 
17260  (6) Must address social, economic and ecological components of sustainability 
17270  (7) Must identify the monitoring and evaluation necessary to assess the 

achievement of desired conditions 
17280  (8) Management direction should reflect the limits/variability of agency budgets 

17300  (c) Integration of authorities 
17310  (1) Statutory authorities (Federal Laws, Acts, Policies and Regulations, for NEPA 

see 21000) 
17320  (2) Agency directives  

17400  (d) Force and effect of plans 
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LEVEL 

18000  219.3 Levels of planning and planning authority 
18100  (a) Chief of the Forest Service – national  
18200  (b) Supervisor (National Forest, Grassland or Prairie) – single unit 
18300  (c) Regional Forester – multiple units 
18400  (d) Experimental forests  

 

DECIS 

19000  219.4 Decisions embodied in plans 
19100  (1) Desired Conditions 
19200  (2) Objectives 
19300  (3) Standards 
19400  (4) Identification of suitable and unsuitable land uses 

19410  Outdoor recreation 
19420  Livestock grazing 
19430  Timber Harvest (general comments pertaining to this section) 
19440  Energy resource development 
19450  Mining/Extraction activities 
19460  Watershed restoration 
19470  Cultural and heritage interpretation 
19480  Other 

19500  (5) Special designations and other management areas (comments specific to this 
section, otherwise code to special designations 30000) 

19510  Wilderness 
19520  Wild and Scenic Rivers 
19530  National Trails 
19540  National Monuments 
19550  National Recreation Areas 
19560  Other 

19600  (6) Monitoring and evaluation requirements 
 

INDIC 

20000  219.5 Indicators of need to amend or revise plan 
20100  (a) Origination of issues or opportunities 
20200  (b) Consideration of issues and opportunities 

20210  (i) Scientific basis and merit of available information and analysis 
20220  (ii) The scope, complexity, intensity, and geographic scale of the issue 
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20230  (iii) Statutory requirements or valid existing rights 
20240  (iv) Organizational and available resources, including FS budget 
20250  Other  

 

COMPL 

21000  219.6 Compliance with NEPA 
21100  (a) Role of responsible official 
21200  (b) Development, amendment, or revision of plan 

21210  Need for EIS/EA 
21220  Extraordinary Circumstances  
21230  Categorical Exclusions (CE), general 

21231  EIS or EA required to issue CEs 
21232  Cumulative impacts of multiple CEs 
21233  Limit on number of CEs during certain period of time 
21234  Limit on CEs within a certain area 
21235  Public comment 

 

AMEND 
22000  219.7 Amending a plan 

22100  (a) Purpose (add, modify, or rescind plan decisions) 
22200  (b) Issues and opportunities 
22300  (c) Consultations and collaborations (comments specific to this section) 
22400  (d) Significant Amendment/Notice of Intent (NOI) 
22500  (e) Objections 
22600  (f) Interim Amendment 

22610  (1) Responsible official 
22620  (2) Duration of the amendment 
22630  (3) Public Notification 
22640  (4) Objection process 

 

REVIS 

23000  219.8 Revising a plan 
23100  (a) Initiating revision (15-year cycle and as needed) 

23110  (1) Preparing revision 
23120  (2) Consultation 

23200  (b) Public notice to revise a plan/Federal Register notice 
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23300  (c) Notice of availability of draft proposed action 
23400  (d) Notice of objection process (code general comments about objection to 219.19) 

 

DEVEL 

24000  219.9 Developing a new plan 
24100  (a) Determine need for a new plan for new Forest Unit (new National Forests, 

Grassland, Prairie, etc.) 
24200  (b) Establish separate plan for new Forest Unit (development and approval of new 

plan) 
 

APPLI 
25000  219.10 Application of plan direction 

25100  (a) Application of new plan, plan amendment or plan revision to existing 
authorizations and approved projects 

25200  (b) Application of plan direction during amendment or revision process 
25300  (c) Application of plan direction to approved projects in light of new information 
25400  (d) Amendments made through site-specific project decisions 
25500  (e) Testing and Research 

 

MONIT 

26000  219.11 Monitoring and evaluation 
26100  (a) Monitoring requirements  

26110  (1) Changes in Monitoring methods 
26120  (2) Coordinating of monitoring (joint monitoring between FS and other 

government and non-government entities) 
26200  (b) Evaluation requirements (Id trends, validate info, assess, determine 

effectiveness) 
26300  (c) Data Sources (specific to monitoring and evaluation) 
26400  (d) Recording and Reporting (specific to monitoring and evaluation)  

 

COLLA 

27000  219.12 Collaboration, cooperation and consultation 
27100  (a) Providing opportunities for collaboration in FS planning 

27110  (1) Engaging interested individuals and organizations 
27120  (2) Engaging State and local governments and Federal Agencies 
27130  (3) Engaging Indian Tribes and Alaska Natives 

27200   (b) Forest Service participation in other planning efforts 
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SUSTA 

28000  219.13 Sustainability 
28100  (a) Social and economic components of sustainability (general) 

28110  Social components 
28120  Economic components 
28130  Ecological components 

28131  Options, general (comments specific to Options) 
28132  Comparison of Options ( with 2000 Rule, 1983 Rule etc) 

28200  OPTION 1 (for Paragraph b) 
28210  (b) Ecological component of sustainability  

28211  (1) Ecological information and analysis 
28212  (i) Consideration and evaluation of ecosystem diversity 

28220  Contribution of National Forest System lands to ecosystem 
diversity 

28230  (A) Characteristics of ecosystem diversity 
28231  (B) Evaluation of ecosystem diversity 

28240  (ii) Consideration and evaluation of species diversity 
28250  (A) Characteristics of species diversity 
28260  (B) Evaluation of species diversity  

28261  (2) Plan decisions 
28270  (i) Ecosystem diversity 
28280  (ii) Species diversity 

28300  OPTION 2 (for Paragraph b) 
28310  (b) Ecological component of sustainability  

28311  (1) Ecological information and analysis 
28312  (i) Consideration and evaluation of ecosystem diversity 

28313  (A) Characteristics of ecosystem diversity 
28314  (B) Evaluation of ecosystem diversity 

28315  (ii) Consideration and evaluation of species diversity 
28316  (A) Characteristics of species diversity 
28317  (B) Evaluation of species diversity 

28318  (iii) Further analyses of biological diversity 
28319  (A) Consideration and evaluation of spatial and temporal scales  

and patterns 
28320  (B) Consideration and evaluation of disturbance regimes 
28321  (C) Consideration and evaluation of landscape context 

28322  (2) Plan decisions 
28323  (i) Biological diversity 
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28324  (ii) Contributions of NFS lands 
 

SCIEN 

29000  219.14 The consideration of science in planning 
29100  (a) Decision must be consistent with best available science 

29110  (1) Demonstrate how the planning process considered and use best science 
29120  (2) Evaluate and disclose any substantial uncertainties in that science 
29130  (3) Evaluate and disclose substantial risks associated with plan decisions 
29140  (4) Validate that the science was appropriately interpreted and applied  

29200  (b) Responsible official evaluation of consistency and application of science (peer 
review, science advisory board, etc) 

 

DESIG 
30000  219.15 Special Designations 

30100  Identifying and designating suitable uses (general comments on land classifications) 
30110  (1) Congressional designated areas 

30111  Wilderness areas 
30112  Watersheds/Wild and scenic rivers 
30113  National trails 
30114  Scenic areas 
30115  Recreation areas 
30116  National Monuments 
30117  Other 

30120  (2) Administratively designated areas 
30121  Geological areas 
30122  Significant caves 
30123  Botanical areas 
30124  Cultural/heritage areas 
30125  Research areas 
30126  Scenic byways 
30127  Other  

30130  (3) Inventoried roadless areas 
30131  Consideration for potential wilderness designation  
30132  Roadless Area Conservation Rule 

TIMBR 

31000  219.16 Determination of lands available for timber harvest/suitable for 
production 
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31100  (a) Lands NOT SUITABLE for timber production 
31110  (1) Land that is not forest land 
31120  (2) Technology not available 
31130  (3) No reasonable assurance of restocking within 5-years 
31140  (4) Lands where timber production would violate statute 
31150  (5) Lands that have been withdrawn from timber production 
31160  (6) No justified based on physical, ecological, social, or economic factors 

31200  (b) Lands SUITABLE for timber production 
31300  (c) Lands where trees may be harvested for Multiple use values other than timber 

production 
31310  Temporary or permanent openings for wildlife/fish habitat improvement 
31320  Grazing, mining 
31330  Fire management 

31331  Establish fuel breaks or reduce fuels 
31340  Create vistas 
31350  Non-timber commodities (firewood, mushrooms, hemp) 
31360  Enhance recreation use 
31370  Manage cultural/heritage sites 
31380  Salvage dead or dying trees 
31390  Other multiple use purposes not related to timber production 

 

32000  219.17 Limitation on timber harvest 
32100  (a) Estimate of the long-term sustained-yield capacity 
32200  (b) Limitation on timber harvest (sustained yield, allowable sale quantity (ASQ) 

requirements) 
32300  (c) Exceptions to limitations of timber harvest  

32310  Government subsidized timber sales 
 

MAINT 

33000  219.18 Plan documentation, maintenance, and availability 
33100  (a) Plan description (text, maps, tables, charts, etc) 
33200  (b) Maintenance of the plan 

33210  (1) Corrections and updates of data and maps 
33220  (2) Corrections of Typographical errors and other non-substantive changes 
33230  (3) Changes in monitoring methods 

33300  (c) Availability of planning documents (public access to documents, etc) 
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OBJEC 

34000  219.19 Objections to new plans, plan amendments, or plan revisions 
34100  (a) Exceptions 
34200  (b) Public notice of the objection period 
34300  (c) Content of public notice of the objection 
34400  (d) Submitting objections (limitations on public comment, use of forms, etc) 
34500  (e) Responding to objections 
34600  (f) Use of other administrative review process 
34700  (g) Compliance with the Paperwork Reduction Act 

 

APPEA 
35000  219.20 Appeals of plan amendments in site-specific project decisions 
 

NOTIC 

36000  219.21 Notice of plan decisions and effective dates 
36100  (a) Notice of decision 
36200  (b) Effective date 

 

TRANS 

37000  219.22 Transition (implementation of new/revised management plans) 
37100  Applicability 

37110  Timeframes for transition period 
37120  Procedures for transition period 

 

DEFIN 

38000  219.23 Definitions 
 

TABLE 
39000  Tables 

39100  Table 1: Comparison of 2000 Rule with Proposed Rule 
39200  Table 2: Ecological sustainability options side-by-side  

 

ATTAC 

40000  Attachments 
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1.1.1 ~ Rational codes 
001 – No affected resource 

002 – Multiple affected resources 

100 – Planning decisions/decision authority 

101 – Other rules/policies 

102 – Administrative effectiveness/efficiency  

103 – Trust and integrity - general 

104 – T&I USDA/Forest Service 

105 – Influence of interest groups 

106 – Influence of industry groups 

107 – Influence of environmental groups 

108 – Public relations/public involvement/public 
opinion 

109 – Adequacy/availability of information 

111 – Public education/understanding 

112 – Relations with other agencies/orgs 

113 – Agency funding/staffing/structure 

200 – Alternatives 

230 – Laws, policies, and legal issues 

260 – American Indian cultural resources 

       – American Indian traditional lands and uses 

300 – General environment 

301 – Environmental Quality and Ecosystem 
Integrity 

302 – Short-Term vs. Long Term 
Productivity/Risks 

303 – Specific ecosystem/ecoregions 

304 – Watershed health  

305 – Water quality/clarity 

306 – Water quantity/runoff 

307 – Wetlands/Riparian areas 

308 – Vegetation and botanical resources 

309 – Plant species diversity 

310 – Exotic/nuisance plant species 

311 – Soil quality 

312 – Biodiversity general  

320 – Wildlife and habitat 

321 – Insect population 

322 – Game species 

323 – Non-game wildlife 

324 – Aquatic wildlife and habitat 

325 – Threatened, endangered, or sensitive 
species (animal or plant) 

330 – Livestock/domestic animals (see 605) 

340 – Air quality 

341 – Climate, Weather and Atmospheric 
Processes 

400 – Recreation General 

401 – Motorized recreation 

402 – Non-motorized recreation 

403 – Access 

500 – Public property 

501 – Private property 

520 – Special Designations 

521 – Roadless Areas 

522 – Wilderness Areas 

600 – Resource commodities 

601 – Agricultural products 

602 – Timber resources 

603 – Mining and Minerals 



Technical Guide  

Appendix E ~ Coding Structure Templates E-13 

604 – Range and Grazing  

610 – Forest Health 

611 – Fire and Firefighting                 

700 – Society and social values 

701 – Population/demographics 

702 – Intrinsic/non-market values 

703 – Quality of life 

704 – Public Health and Safety 

705 – Spiritual values 

706 – Future generations 

707 – Scenic and aesthetic values/resources 

708 – Noise levels 

709 – Cultural and historic resources 

800 – Economy and economic values 

801 – National economy 

802 – State/local economy 

803 – County/State agricultural base 

804 – Jobs/employment 

805 – Private property values 

806 – Cost-benefit analysis 

808 – Best available science/scientific advances 

809 – Use of taxpayer money/subsidies 

1.1.2 ~ Theme Codes (rarely used) 
 IR  Implement  
 DR  Don’t Implement   
 ED  Editorial 
 XX  Default 
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Appendix F ~ Numbering Labels 
 
• Open the Excel Program 
• In the first and second cell, enter the assigned or first letter(s) to the Project before the 

letter (respondent) number 
• Highlight the first two cells, put cursor on the right corner and drag, making sure the 

number ends in 80 or multiples of it (80 labels to a sheet)     

Go to File > Save as > Desktop > and name this File > Save 

 

 

 
Figure K.1: Excel Spreadsheet 

 
Figure K.2: Creating Letter Numbers 
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Figure K.3: Saving Excel Spreadsheet 

 
 
 
 
 

 
 
 
 
 
 

• Open the Access Program  
• On the Microsoft Access box click 

Blank Access Database > OK 
• Save on the Desktop and Name the 

File > Create 

 

 

 
                                                                                                    
 
 

                Figure K.4: Blank Access Database 
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Figure K.5: Saving New Database 

 
 
File > Get External Data > Import 

• When the Import Box comes up, click on your Desktop and go to Files of type and click 
on the drop down menu 

• Click in Excel (*.xls) and highlight the file you saved, click Import 
  

 

 
Figure K.6: Importing Excel File 

 

 

 
• Import Spreadsheet Wizard box appears 

Click Next > Next> Next > No Primary Key >Next 
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Figure K.7: Import Spreadsheet Wizard 
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• Name the table and Click Finish > OK 
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                             Figure K.8:  Successful Import   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure K.9: Label Wizard 
 

• On the Database screen click on Reports > Create report by using Wizard> New 
• The New Report box comes up click on Label Wizard 
• Click on the drop down box, the name of the file you saved should be there 
• Double click to insert the File and click OK 
 
 

 
Figure K.10: Label Selection 
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• In the Label Wizard box go to Label Type to the drop-down menu first, and choose Avery 
USA 5167 

• After you choose the type of label you need the Unit of Measure, click English 
• Scroll down until you find Avery USA 5167 ½” x 1 3/4", this is the right size for letter 

numbering 
 
• Click Next 
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• The next screen will 
ask you to choose the 
Text Appearance for 
your labels 

• Size should be 18 or 
20 font 

• Click Next 
 
 
 
 

 
                                Figure K.11: Sample Label 
 
 
 
 
 
 
 
 
• What would you like on your mailing 

label?  Click on arrow ({Field1}) 
• Click Next 
 
 
 
 
 
                                  
                                                                                                         
Figure K.12: Label Fields 



  Technical Guide 
 
 
 
 
 
 
 
 
 
• Which fields would you like to sort by?  None> Next 
 

 
Figure K.13: Label Wizard 

 
 
 
 
• Name your table and Click Finish 
 

 
Figure K.14: Naming Labels 
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Figure K.15: Preview of Labels 

 

• This screen will give a preview of what your labels look like 
 
 
 
 
                                                                                       Figure K.16: Design View 
If you want to format (change 
font, size etc., center) your 
labels, go to View > Design 
View 
• Click on the box and make 

your changes (Always 
Center) 

• Go to File > Save any 
changes that you have 
made 

• When you are ready to 
print, put label sheet(s) in 
printer according to 
manufacturer instructions 

• Go to File > Print > Print 
 
 



 

 

  
  
 



 Technical Guide  

Appendix G ~ CAT Styles List 
This appendix displays the various styles used in CAT documents. The styles are divided into 
the following categories: Cover Page Headings, Table of Contents Headings, Narrative and 
Public Concerns Headings, Appendix Geadings, and Coding Structure Headings. 

Cover Page Headings 

CAT_Cover Title 
(Font: Arial 28 pt. bold, align left; single spacing; window/orphan control; don’t hyphenate) 

Table of Contents Headings 

CAT Table of Contents Heading 
(Font: Arial 20 pt. bold, align left; space after 6 pt.; window keep with next; don’t hyphenate) 

 

TOC 1 (Level 1 – to designate Chapter level or highest organizational level) 
(Font: Arial 12 pt. bold, single space; space before 6 pt; after 3 pt.align left; window/orphan 
control; tabs 6.5”; leader) 

 
TOC 2 (Level 2 – to designate Section level or 2nd highest organizational level) 

(Arial font; 12 pt.; indent left 0.25”; line spacing: single; space before 6 pt; tabs 6.5”; 
window/orphan control; right, leader) 
 

TOC 3 (Level 3 – to designate Subsection level or 3rd highest level) 
(Arial font; 12 pt.; indent left 0.5”; line spacing: single; space before 6 pt; tabs 6.5”; 
window/orphan control; right, leader) 
 

TOC 4 (Level 4 – to designate Sub-subsection level or 4th highest level) 
(Arial font; 12 pt.; indent left 0.75”; line spacing: single; space before 3 pt; tabs 6.5”; 
window/orphan control; right, leader) 
 

TOC 5 (Level 5 – to designate Visual Heading/Editorial; not always 
needed) 

(Arial font; 12 pt.; indent left 1.0”; line spacing: single; space before 3 pt; tabs 6.5”; 
window/orphan control; right, leader) 
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TOC 6 (Level 6 – use only when creating a TOC to include all Public Concerns) 
(CAT public concern format +Arial font; 11 pt.; keep with next; don’t hyphenate; level 6; 
right leader) 
 

TOC 7 (LEVEL 7 – SUBCONCERNS, USE ONLY WHEN CREATING A TOC TO INCLUDE ALL SUB-CS) 
(CAT subconcern format = Arial font; 9 pt bold; all caps; centered; line spacing single; space 
before: 9 pt,; window/orphan control; keep with next; don’t hyphenate; left leader; 
automatically update) 
 

Narrative and Public Concerns Headings 

Chapter 1 
 
Chapter Heading (Level 1 in format hierarchy) 
(Note: Formatting Numbered Chapter Headings is complicated. See Chapter 16, Formatting 
Chapter Headings.) 
(Font: Arial 32 pt. condensed by 1.5 pt.; kern at 16 pt.; left; line space: single; space before 
12 pt., after 12 pt.; window/orphan control; keep with next; level 1; outline numbered + level: 
1 + numbering style 1,2,3 … + start at: 1; alignment: left + aligned at 0” + tab after: 0” + 
indent at: 1”) 

CAT Heading 1-Unnumbered 
(For use when chapters are not being used and main sections do not need to be numbered. 
 See Chapter16, Formatting Chapter Headings) 
(Font: Arial 24 pt. bold, condensed by 1.25; left; line spacing: single; space before 12 pt; 
after 12 pt.; window/orphan control; keep with next; don’t hyphenate; level 1) 

CAT Section Heading (Level 2) 
(Font: Arial 20 pt. bold, condensed by 1.25; left; line spacing: single; space before 18 pt; 
after 12 pt.; window/orphan control; keep with next; don’t hyphenate; level 2) 
 

CAT Subsection Heading (Level 3) 
(Font: Arial 16 pt. bold; left; line spacing: single; space before 18 pt; after 12 pt.; 
window/orphan control; keep with next; don’t hyphenate; level 3) 
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CAT Sub-subsection Heading (Level 4) 

(Font: Arial 12 pt. bold; left; line spacing: single; space before 18 pt; after 12 pt.; 
window/orphan control; keep with next; don’t hyphenate; level 4) 
 

CAT Visual Heading (Level 5 – use only when truly necessary) 
(Font: Arial 12 pt.; left; line spacing: single; space before 12 pt; after 6 pt.; window/orphan 
control; keep with next; don’t hyphenate; level 5) 

 

CAT Grammatical/Editorial (Also level 5) 
(Font: Arial 12 pt.; left; line spacing: single; space before 12 pt; after 6 pt.; window/orphan 
control; keep with next; don’t hyphenate; level 5) 
 

CAT Public Concern 
(Font: Normal + Arial 11 pt. bold; space before 12 pt; keep with next; level 5; automatically 
update) 
 
CAT Sample Statement 
(Font: Times New Roman 10 pt.; left; line spacing single; space before 6 pt; after 3 pt.; 
window/orphan control) 

CAT SUBCONCERN 
(Font: Arial 9 pt. bold, all-caps; centered, line spacing single; space before 9 pt.; 
window/orphan control; keep with next; don’t hyphenate, level 7) 
 

CAT Body Text 
(Font Times New Roman 12 pt.; left; line spacing single; space before 6 pt.; window/orphan 
control) 
 

CAT Level 2 Body Text 
 

(For use when indented text needed, such as lengthy quote from the DEIS used in 
narrative) 

(Font Times New Roman 12 pt.; indent left 0.25”; left; line spacing single; space before 3 pt.; 
window/orphan control) 
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Appendix Geadings 

Appendix A ~  
Appendix Geading (Level 1 in format 
hierarchy) 
Note: Formatting Chapter and Appendix Geadings is complicated. See Chapter 16, 
Formatting Appendix Geadings.) 
(Font: Arial 32 pt. condensed by 1.5 pt.; left; line space: single; after 3 pt.; window/orphan 
control; keep with next; level 2; outline numbered + level: 2 +; numbering style A, B, C … + 
start at: 13+; alignment: left + aligned at 0” + tab after: 0” + indent at: 0”) 
 

CAT_App Section Heading (Level 2) 
(Font: Arial 20 pt. bold, condensed by 1.25; left; line spacing: single; space before 18 pt; 
after 12 pt.; window/orphan control; don’t hyphenate; level 2) 
 

CAT_App Subsection Heading (Level 3) 
(Font: Arial 16 pt. bold, condensed by 1.25; left; line spacing: single; space before 18 pt; 
after 12 pt.; window/orphan control; don’t hyphenate; level 3) 
 

CAT_Table Title (Display as “Table X.1 – Name of Table) 

(Font: Arial centered, line spacing: exactly 12 pt.; space before 12 pt; after 6 pt.; 
window/orphan control; keep with next; don’t hyphenate) 
 
CAT_Table Heading 

(Font: Arial 9 pt. bold, left; line spacing: 
exactly 12 pt; space after 3 pt.; 
window/orphan control; keep with next; 
don’t hyphenate) 
 

CAT_Table Heading 

CAT_Table Text 

(Font: Times New Roman 9 pt.; left; line 
spacing single; space before 3 pt; after 3 pt.; 
window/orphan control; don’t hyphenate) 
 

CAT_Table Text 

CAT_Table Text  CAT_Table Text 
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Coding Structure Headings 

Coding Structure Section Heading 
(Font: Arial 16 pt. bold, left; line spacing: exactly 12 pt; space after 3 pt.; window/orphan 
control; keep with next; don’t hyphenate) 

Coding Structure Subsection Heading 

Coding Structure Sub-subsection Heading 

CODING STRUCTURE SUBJECT CODE 
10000 Coding Structure_Level 1 

10100 Coding Structure_Level 2 
10110 Coding Structure_Level 3 

10111 Coding Structure_Level 4 
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Appendix H ~ Attribution Model for 
Demographics 
Standard Format 
One space following end of comment, then in parentheses - organization type, city, state, 
dash, letter number, comment number, category 1 and category 2 codes:  

(Individual, Seattle, WA - #36.3.43000.700) 

(Timber Industry, Roseburg, OR - #216.9.46000.210) 

 

When either city or state, or both, is missing:  
(Individual, No Address - #36.3.43000.700) 

Attributions for Federal, State, County, Town/City, 
Tribal 
Federal Agency 

Name of the agency in place of org type: 
(United States Environmental Protection Agency, Washington, DC - #97.10.12100.300) 

 

Federal Elected Official 

Name of the official and office: 
(Max Cleland, United States Senator, State of Georgia, Washington, DC - #414.8.23000.121) 

(Cynthia McKinney, United States Representative, State of Georgia, Washington, DC - # 
36.2.35000.340) 

 

State Agency 

Agency name in place of org type: 
(Colorado Department of Natural Resources, Denver, CO - # 321.22.45100.260) 

 

State Elected Official 

Name of official: 
(Arthur Ravenel, Jr., State Senator, State of South Carolina, Columbia, SC – #89.56.62000.610) 
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(Marlene J. Simons, State Representative, State of Wyoming, Cheyenne, WY – #617.11.26000.150) 

 

County Agency 
(Millard County Department of Natural Resources, Eureka, MN – # …) 

 

County Elected Official 
(Tom Saxhaug, Chairperson, Itasca County Board of Commissioners, Grand Rapids, MN – # …) 

(Clair Nelson, Commissioner, Lake County Board of commissioners, Two Harbors, MN - # …)  

 

City/Town Agency 
(Salt Lake City Water Department, Salt Lake City, UT – # …) 

 

City/Town Elected Official 
(Joseph P. Riley, Jr., Mayor, City of Charleston, Charleston, SC – # …) 

Gered Lennon, Councilperson, Folly Beach City Council, Folly Beach, SC – # …) 

 

Tribal Agency 
(Division of Resource Management, Mescalero Apache tribe, Mescalero, NM – # …) 

 

Tribal Elected Official 
(Samuel N. Penney, Chairperson, Tribal Executive Committee, Nez Perce Tribe, Lapwaii, ID – # …) 
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